
v5.50

This Computer program (including software design, programming structure, graphics, manual, and 
on-line help) was created and published by STRUCTUREPOINT, formerly the Engineering Software 
Group of the Portland Cement Association (PCA) for the engineering analysis and design of 
reinforced concrete beams and slab floor systems

While STRUCTUREPOINT has taken every precaution to utilize the existing state-of-the-art and to 
assure the correctness of the analytical solution techniques used in this program, the responsibilities 
for modeling the structure, inputting data, applying engineering judgment to evaluate the output, and 
implementing engineering drawings remain with the structural engineer of record. Accordingly, 
STRUCTUREPOINT does and must disclaim any and all responsibility for defects or failures of 
structures in connection with which this program is used.

Neither this manual nor any part of it may be reproduced, edited, or altered by any means electronic or 
mechanical or by any information storage and retrieval system, without the written permission of 
STRUCTUREPOINT LLC.

All products, corporate names, trademarks, service marks, and trade names referenced in this material 
are the property of their respective owners and are used only for identification and explanation 
without intent to infringe. spSlab® and spBeam® are registered trademarks of STRUCTUREPOINT 
LLC.

Copyright © 2002 – 2018, STRUCTUREPOINT LLC All Rights Reserved.



|   2   |

Chapter 1: INTRODUCTION

1.1 Introduction........................................................................................................................10
1.2 Program Features ...............................................................................................................10
1.3 Program Capacity ..............................................................................................................11
1.4 System Requirements ........................................................................................................12
1.5 Terms .................................................................................................................................12
1.6 Conventions .......................................................................................................................13
1.7 Installing, Purchasing and Licensing spSlab/spBeam .......................................................13

Chapter 2: METHOD OF SOLUTION

2.1 Introduction........................................................................................................................16
2.2 Geometric Checks..............................................................................................................16
2.3 Code Checks ......................................................................................................................17

2.3.1 Minimum Thickness - One-Way Construction.........................................................17
2.3.2 Minimum Slab Thickness - Two-Way Construction ................................................17
2.3.3 Drop Panel Dimensions ............................................................................................21
2.3.4 Beam Dimensions .....................................................................................................22

2.4 Special Considerations for One and Two-Way Joist Systems...........................................22
2.4.1 Rib Dimensions.........................................................................................................22
2.4.2 Minimum Thickness for Joist Systems.....................................................................23
2.4.3 Joist System Analysis and Design ............................................................................23

2.5 Material Properties.............................................................................................................25
2.6 Equivalent Frame Method .................................................................................................27

2.6.1 Stiffness Characteristics............................................................................................28
2.6.2 Slab Beams ...............................................................................................................29
2.6.3 Columns ....................................................................................................................29

2.7 Loading ..............................................................................................................................35
2.7.1 Self-Weight ...............................................................................................................36
2.7.2 Superimposed Loading .............................................................................................36
2.7.3 Lateral Loading.........................................................................................................36
2.7.4 Load Patterns ............................................................................................................37
2.7.5 Load Combinations...................................................................................................39

2.8 Column and Middle Strip Widths ......................................................................................42
2.9 Strip Design Moments .......................................................................................................45

2.9.1 ACI 318 and CSA A23.3-94.....................................................................................46
2.9.2 CSA A23.3-14/04 .....................................................................................................49

2.10 Moment Redistribution ......................................................................................................50
2.11 Shear Analysis of Slabs .....................................................................................................52

2.11.1 Critical Section for Interior Supports of Interior Frames .........................................55



|   3   |

2.11.2 Critical Section for Exterior Supports of Interior Frames ........................................55
2.11.3 Critical Section for Interior Supports of Exterior Frames ........................................56
2.11.4 Critical Section for Exterior Supports of Exterior Frames .......................................57
2.11.5 Computation of Allowable Shear Stress at Critical Section .....................................57
2.11.6 Computation of Factored Shear Force at Critical Section ........................................59
2.11.7 Computation of Unbalanced Moment at Critical Section.........................................60
2.11.8 Computation of Shear Stresses at Critical Section ...................................................60
2.11.9 Shear Resistance at Corner Columns........................................................................62

2.11.10 Shear Resistance in Slab Bands ................................................................................62
2.12 One-Way Shear Analysis of Longitudinal Beams and Slabs ............................................63

2.12.1 Shear Calculations for ACI 318 and CSA A23.3-94 ................................................63
2.12.2 Shear Calculations for CSA A23.3-14/04.................................................................66
2.12.3 Shear Distribution .....................................................................................................68
2.12.4 One-Way Shear in Slab Bands (CSA A23.3-14/04).................................................69
2.12.5 Shear in Drop Panels.................................................................................................69

2.13 Torsion and Shear ..............................................................................................................69
2.13.1 Additional Longitudinal Reinforcement for ACI 318 and CSA A23.3-94...............72
2.13.2 Additional Longitudinal Reinforcement for CSA A23.3-14/04 ...............................73
2.13.3 Investigation Mode ...................................................................................................74

2.14 Area of Reinforcement.......................................................................................................75
2.14.1 Design for Combined Flexure, Shear, and Torsion ..................................................79

2.15 Reinforcement Selection....................................................................................................80
2.16 Concentration and Additional Reinforcement ...................................................................85
2.17 Structural Integrity Reinforcement ....................................................................................86
2.18 Corner Reinforcement........................................................................................................87
2.19 Deflections .........................................................................................................................88

2.19.1 Instantaneous Deflections .........................................................................................88
2.19.2 Cracking....................................................................................................................88
2.19.3 Long-Term Deflections.............................................................................................90
2.19.4 Deflections of two-way systems ...............................................................................91

2.20 Material Quantities ............................................................................................................93
2.21 References..........................................................................................................................94

Chapter 3: spSlab/spBeam INTERFACE

3.1 spSlab/spBeam Interface....................................................................................................97
3.2 File Menu...........................................................................................................................99
3.3 Input Menu.......................................................................................................................103
3.4 Solve Menu ......................................................................................................................107
3.5 View Menu ......................................................................................................................108
3.6 Options Menu ..................................................................................................................111



|   4   |

3.7 Window Menu .................................................................................................................113
3.8 Help Menu .......................................................................................................................114
3.9 Control Menu...................................................................................................................115

3.10 Program Toolbar ..............................................................................................................116

Chapter 4: OPERATING spSlab/spBeam

4.1 Introduction......................................................................................................................121
4.2 Creating New File ............................................................................................................121
4.3 Opening File ....................................................................................................................121
4.4 Saving File .......................................................................................................................122

4.4.1 Save the data with the same file name....................................................................122
4.4.2 Change the format or rename the file .....................................................................123

4.5 Most Recently Used Files (MRU) ...................................................................................123
4.6 Specifying Model Data (Menu Input)..............................................................................124

4.6.1 Data Input Wizard...................................................................................................124
4.7 Defining General Information .........................................................................................124

4.7.1 Defining Solve Option ............................................................................................125
4.7.1.1 Two-way systems ..........................................................................................126
4.7.1.2 One way/beam systems..................................................................................128

4.7.2 Using Span Control.................................................................................................129
4.7.3 Defining Material Properties ..................................................................................133
4.7.4 Defining Slabs/Flanges ...........................................................................................135
4.7.5 Defining Longitudinal Beams.................................................................................137
4.7.6 Defining Ribs ..........................................................................................................138
4.7.7 Defining Longitudinal Slab Bands .........................................................................140
4.7.8 User Defined Column Strip Widths........................................................................141
4.7.9 User Defined Moment Distribution Factors ...........................................................142

4.7.10 Defining Columns...................................................................................................143
4.7.11 Defining Drop Panels..............................................................................................145
4.7.12 Defining Column Capitals ......................................................................................147
4.7.13 Defining Transverse Beams....................................................................................149
4.7.14 Defining Transverse Slab Bands.............................................................................150
4.7.15 Defining Boundary Conditions ...............................................................................151
4.7.16 Defining Moment Redistribution Factors ...............................................................153
4.7.17 Defining Reinforcement Criteria for Slabs and Ribs..............................................154
4.7.18 Defining Reinforcement Criteria for Beams...........................................................156
4.7.19 Defining Column Strip Bars for Two-Way Slab Systems......................................158
4.7.20 Defining Middle Strip Bars for Two-Way Slab Systems .......................................159
4.7.21 Defining Beam Bars for Two-Way Slab Systems ..................................................161
4.7.22 Defining Beam Stirrups for Two-Way Slab Systems.............................................162
4.7.23 Defining Flexure Bars for Beams and One-Way Slab Systems .............................164
4.7.24 Defining Stirrups for Beams and One-Way Slab Systems .....................................164



|   5   |

4.7.25 Defining Torsional Longitudinal Bars for Beams ..................................................165
4.7.26 Defining Load Cases...............................................................................................167
4.7.27 Defining Load Combinations..................................................................................168
4.7.28 Span Loads..............................................................................................................169
4.7.29 Defining Area Load on Span ..................................................................................170
4.7.30 Defining Line Load on Span...................................................................................171
4.7.31 Defining Point Force on Span.................................................................................173
4.7.32 Defining Point Moment on Span ............................................................................174
4.7.33 Defining Line Torque on Span ...............................................................................175
4.7.34 Defining Point Torque on Span ..............................................................................177
4.7.35 Defining Support Loads and Displacements ..........................................................178
4.7.36 Defining Lateral Effects..........................................................................................180

4.8 Executing Calculations (menu Solve)..............................................................................181
4.8.1 Execute....................................................................................................................181
4.8.2 Viewing Results ......................................................................................................181

4.9 View Program Output (menu View)................................................................................182
4.9.1 Zooming in on Floor System ..................................................................................182
4.9.2 Change Isometric View Angle................................................................................183
4.9.3 Viewing Specific Member Type.............................................................................184
4.9.4 Plan View................................................................................................................185
4.9.5 Elevated View.........................................................................................................186
4.9.6 Side View................................................................................................................188
4.9.7 Isometric View........................................................................................................189
4.9.8 Loads.......................................................................................................................191
4.9.9 View Graphical Results ..........................................................................................192

4.9.9.1 Viewing Internal Forces Diagrams ................................................................192
4.9.9.2 Viewing Moment Capacity ............................................................................194
4.9.9.3 Viewing Shear Capacity ................................................................................196
4.9.9.4 Viewing Reinforcement .................................................................................197
4.9.9.5 Viewing Deflected Shapes.............................................................................199

4.9.10 Printing Results.......................................................................................................201
4.9.10.1 Printing Analysis and Design Results............................................................201
4.9.10.2 Printing Current View Window.....................................................................202

4.9.11 Print Preview...........................................................................................................203
4.9.12 Copy Graphs to Clipboard ......................................................................................204

4.10 Customizing Program (menu Options) ............................................................................205
4.10.1 Changing Colors .....................................................................................................205
4.10.2 Changing Fonts .......................................................................................................206

4.11 Working with View Windows (menu Window)..............................................................208
4.12 Obtaining Help Information (menu Help) .......................................................................208

4.12.1 Opening Table of Contents of the Help System .....................................................208
4.12.2 Displaying the Manual............................................................................................208
4.12.3 Checking for Updates .............................................................................................209
4.12.4 Obtaining Information about the Program..............................................................209



|   6   |

Chapter 5: OUTPUT DESCRIPTION

5.1 Output Elements ..............................................................................................................213
5.2 Cover & Contents ............................................................................................................213
5.3 Input Echo........................................................................................................................213

5.3.1 General Information................................................................................................213
5.3.2 Material Properties..................................................................................................214
5.3.3 Reinforcement Database .........................................................................................214
5.3.4 Span Data ................................................................................................................214
5.3.5 Support Data ...........................................................................................................214
5.3.6 Load Data................................................................................................................214
5.3.7 Reinforcement Criteria ...........................................................................................215
5.3.8 Reinforcing Bars .....................................................................................................215

5.4 Design Results .................................................................................................................215
5.4.1 Strip Widths and Distribution Factors ....................................................................215
5.4.2 Top Reinforcement .................................................................................................215
5.4.3 Top Bar Details .......................................................................................................216
5.4.4 Band Reinforcement at Supports ............................................................................216
5.4.5 Bottom Reinforcement............................................................................................217
5.4.6 Bottom Bar Details - Bottom Bar Development Lengths.......................................217
5.4.7 Flexural Capacity ....................................................................................................217
5.4.8 Longitudinal Beam Shear Reinforcement Required ...............................................217
5.4.9 Longitudinal Beam Shear Reinforcement Details ..................................................218

5.4.10 Beam Shear (and Torsion) Capacity .......................................................................218
5.4.11 Slab Shear Capacity ................................................................................................218
5.4.12 Flexural Transfer of Unbalanced Moments at Supports .........................................218
5.4.13 Punching Shear Around Columns...........................................................................219
5.4.14 Punching Shear Around Drops ...............................................................................219
5.4.15 Integrity Reinforcement at Supports.......................................................................219
5.4.16 Corner Reinforcement.............................................................................................219
5.4.17 Shear Resistance at Corner Columns......................................................................220
5.4.18 Material Takeoff .....................................................................................................220

5.5 Deflection Results: Summary ..........................................................................................220
5.6 Detailed Results ...............................................................................................................220

5.6.1 Column Forces and Redistributed Column Forces .................................................220
5.6.2 Non – Redistributed and Redistributed Internal Forces: M – V .............................221
5.6.3 Internal Forces: T....................................................................................................221
5.6.4 Deflections - Load Cases ........................................................................................222
5.6.5 Required Reinforcement .........................................................................................222

5.7 Graphical Output..............................................................................................................222

Chapter 6: EXAMPLES

6.1 Example 1 Spandrel Beam with Moment Redistribution ................................................226



|   7   |

6.1.1 Problem Formulation ..............................................................................................226
6.1.2 Preparing Input .......................................................................................................227
6.1.3 Assigning Properties ...............................................................................................227
6.1.4 Solving ....................................................................................................................232
6.1.5 Viewing and Printing Results .................................................................................233

6.2 Example 2 Spandrel Beam with Torsion .........................................................................249
6.2.1 Problem Formulation ..............................................................................................249
6.2.2 Preparing Input .......................................................................................................250
6.2.3 Assigning Properties ...............................................................................................251
6.2.4 Solving ....................................................................................................................257
6.2.5 Viewing and Printing Results .................................................................................258

6.3 Example 3 Design of a Continuous Beam .......................................................................274
6.3.1 Problem Formulation ..............................................................................................274
6.3.2 Preparing Input .......................................................................................................275
6.3.3 Assigning Properties ...............................................................................................275
6.3.4 Solving ....................................................................................................................281
6.3.5 Viewing and Printing Results .................................................................................282

6.4 Example 4 Flat Plate Floor System..................................................................................301
6.4.1 Problem Formulation ..............................................................................................301
6.4.2 Preparing Input .......................................................................................................302
6.4.3 Assigning Properties ...............................................................................................302
6.4.4 Solving ....................................................................................................................307
6.4.5 Viewing and Printing Results .................................................................................308

6.5 Example 5 Two-way Slab System ...................................................................................327
6.5.1 Problem Formulation ..............................................................................................327
6.5.2 Preparing Input .......................................................................................................328
6.5.3 Assigning Properties ...............................................................................................328
6.5.4 Solving ....................................................................................................................334
6.5.5 Viewing and Printing Results .................................................................................334

Chapter 7: spReporter MODULE

7.1 Program Description ........................................................................................................358
7.2 Toolbar.............................................................................................................................358
7.3 Export / Print Panel..........................................................................................................360
7.4 Explorer panel..................................................................................................................361

Chapter 8: spResults MODULE

8.1 Introduction......................................................................................................................364
8.2 Toolbar.............................................................................................................................364
8.3 Explorer panel..................................................................................................................366



|   8   |

Chapter A: APPENDIX

A.1 Conversion Factors - English to SI ..................................................................................368
A.2 Conversion Factors - SI to English ..................................................................................368
A.3 Contact Information.........................................................................................................369



|   9   |

CHAPTER

1 INTRODUCTION

1.1 Introduction ...................................................................................................... 10
1.2 Program Features ............................................................................................ 10
1.3 Program Capacity ............................................................................................ 11
1.4 System Requirements ..................................................................................... 12
1.5 Terms ................................................................................................................ 12
1.6 Conventions ..................................................................................................... 13
1.7 Installing, Purchasing and Licensing spSlab/spBeam ................................. 13



INTRODUCTION

|   10   |

1.1 Introduction

Formerly pcaSlab and ADOSS, spSlab is a computer program for the analysis and design of 
reinforced concrete beams and slab floor systems. Two-way slab systems are analyzed using the 
Equivalent Frame Method. Beams and frames of up to 22 spans can be analyzed and designed. In 
addition to the design option spSlab has the capability of investigating existing beams and slab 
systems. spSlab includes provisions for slab band systems as well as punching shear check and 
deflection calculations using cracked or gross sections. For beams, moment redistribution as well 
as combined shear and torsion design are available. Material quantity take-offs are computed. In 
addition to the required area of reinforcing steel at the critical sections, spSlab provides a complete 
bar schedule that includes number of bars and bar sizes and lengths. spSlab checks the applicable 
provisions of the relevant code.

Formerly pcaBeam, spBeam is a limited version of spSlab. It includes all elements that apply to 
beams and one-way slab systems. Topics describing these elements are denoted with  icon 
because they are included in both spSlab and spBeam. Two-way slab systems are available in 
spSlab only and topics related to two-way slab systems are denoted with  icon.

1.2 Program Features

• ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, ACI 318-02, ACI 318-99, CSA 
A23.3-14, CSA A23.3-04, and CSA A23.3-94

• English and Metric (SI) units

• Design and investigation of beams, one and two-way slabs including one-way joist sys-
tems (standard and wide module) and two-way joist systems (waffle slabs)

• Slab band system design and investigation for CSA A23.3-14/04

• Flexure and shear design and investigation with live load reduction and patterning 

• Torsion design and investigation for beams/one-way slab systems

• Longitudinal reinforcement for combined flexure, shear, and torsion per CSA A23.3-14/
04

• Automatic or manual moment distribution factors and strip widths

• Moment redistribution for beams/one-way slab systems

• Calculation of instantaneous deflections at three load levels; dead load, dead load plus sus-
tained live load, and dead load plus live load

• Calculation of incremental long-term deflections
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• Instantaneous and long-term design strip deflections for two-way systems

• Analytical modeling of variable support stiffness in systems with rectangular, and circular 
supports

• One and two-way (punching) shear investigation considering the effects of drop panels, 
column capitals, longitudinal beams, transverse beams, and slab bands.

• Boundary conditions including vertical and rotational springs

• Top and bottom bar details including development lengths and material quantities

• Specialty design requirements including crack control, integrity reinforcing, and corner 
column checking

• Frame solution results including tabulated column axial forces and moments 

• Mixed span types within one-way or two-way systems

• Auto-input wizard with instantaneous data checking 

• Graphical display of geometry, loads, and results

• Advanced view, print, display settings and options

• Customizable detailed results report

• Import input data from ADOSS v6.0x/7.0x, PCA-Beam, and pcaSlab

• Detailed manual and online help

1.3 Program Capacity

• 21 supports (22 spans including left and right cantilevers) 

• 6 load cases

• 50 load combinations

• 999 partial dead loads per case

• 999 partial live loads per case

• 2 top bar layers (Design mode)

• 2 bottom bar layers (Design mode)

• 15 bar sets per span
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1.4 System Requirements

Any computer running Microsoft Windows XP, Windows Vista, Windows 7, Windows 8 or 
Windows 10 operating system is sufficient to run the spSlab and spBeam programs. For 
instructions on how to troubleshoot system specific installation and licensing issues, please refer 
to support pages on StructurePoint website at www.StructurePoint.org.

1.5 Terms

The following terms are used throughout this manual. A brief explanation is given to help 
familiarize you with them.

Windows refers to the Microsoft Windows environment as listed in System 
Requirements.

[ ] indicates equivalent value expressed in metric unit or CSA code 
requirement corresponding ACI code requirement

Click on means to position the cursor on top of a designated item or location 
and press and release the left-mouse button (unless instructed to use 
the right-mouse button).

Double-click on means to position the cursor on top of a designated item or location 
and press and release the left-mouse button twice in quick 
succession.

Marquee select means to depress the mouse button and continue to hold it down 
while moving the mouse. As you drag the mouse, a rectangle 
(known as a marquee) follows the cursor. Release the mouse button 
and the area inside the marquee is selected.



INTRODUCTION

|   13   |

1.6 Conventions

Various styles of text and layout have been used in this manual to help differentiate between 
different kinds of information. The styles and layout are explained below…

placed in a topic header means that the topic applies to both spSlab 
and spBeam
placed in a topic header means that the topic applies to spSlab only

Italic indicates a glossary item, or emphasizes a given word or phrase.
Bold All bold typeface makes reference to either a menu or a menu item 

command such as File or Save, or a tab such as General 
Information or Columns

Mono-space indicates something you should enter with the keyboard. For 
example type “c:\*.txt”.

KEY + KEY indicates a key combination. The plus sign indicates that you should 
press and hold the first key while pressing the second key, then 
release both keys. For example, “ALT + F” indicates that you 
should press the “ALT” key and hold it while you press the “F” key. 
Then release both keys.

SMALL CAPS Indicates the name of an object such as a dialog box or a dialog box 
component. For example, the OPEN dialog box or the CANCEL or 
MODIFY buttons.

1.7 Installing, Purchasing and Licensing spSlab/
spBeam

To purchase StructurePoint software please visit StructurePoint.org/buy.asp

To download and install a trial version of StructurePoint software please visit StructurePoint.org/
download-trial.asp

For setup, installation, and licensing please use the StructurePoint Setup & Licensing Guide

https://www.structurepoint.org/buy.asp
https://www.structurepoint.org/download-trial.asp
https://www.structurepoint.org/download-trial.asp
https://structurepoint.org/setup_licensing/index.html
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2.1 Introduction

The user should be aware of the assumptions made by the program during the design stage. These 
include details regarding loading, strip widths, reinforcement selection, deflection computations, 
material quantities, etc.

2.2 Geometric Checks

spSlab and spBeam provide various geometric checks to avoid an analysis with an inconsistent 
system. Dimensions of slabs, beams, drops, bands and column capitals are checked and modified 
to produce a code compliant system.

If a slab cantilever length is less than one-half the column dimension in the direction of analysis, 
c1, or less than the lateral extension of the transverse beam into the cantilever, the cantilever length 
will be increased to the larger of these two lengths. If the slab width is less than one-half the 
column dimension transverse to the direction of analysis, c2, or less than one-half the longitudinal 
beam width, the slab width will be increased to the larger of these two widths.

If a drop panel extends beyond the end of a slab cantilever, the drop panel dimensions will be 
reduced so that it extends only to the cantilever tip.

Guidance is absent from all standards and reference documents regarding continuous extension of 
drop panels between supports. If a slab band is discontinuous, to model this condition, it must be 
completed with a user-defined drop panel of corresponding width and thickness on a 
discontinuous end, as a minimum, in order to complete the analysis.

When a column capital is defined, the program checks if capital side slope (depth/extension ratio) 
is more than 1, i.e. the angle between capital side and column axis is no greater than 45 degrees1. 
The upper limit for the side slope is 50. If a column with capital frames into a drop panel (or a 
beam), extension of the capital will be automatically adjusted – if necessary – so that projected 
sides of the capital do not fall outside of the drop panel (or the beam) edges before reaching slab 
soffit (see Figure 2-1). The modified column capital extension will be used when computing 
column stiffness and in punching shear calculations.

1. ACI 318-14 (Ref. [1]), 8.4.1.4; ACI 318-11 (Ref. [1]), 13.1.2; ACI 318-08 (Ref. [3]),13.1.2; ACI 318-05 
(Ref. [4]), 13.1.2; ACI 318-02 (Ref. [5]), 13.1.2; ACI 318-99 (Ref. [6]), 13.1.2; CSA A23.3-04, 2.2; CSA 
A23.3-94, 13.1
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Figure 2.1 Maximum Capital Width

2.3 Code Checks

2.3.1 Minimum Thickness - One-Way Construction

The program checks beam or one-way slab thickness based on minimum requirement for ACI-
3182 code as specified in Table 9.5(a) or for CSA code3 according to Table 9.2. For lightweight 
concrete with density

90 lb/ft3 ≤ wc ≤ 115 lb/ft3 [1440 kg/m3 ≤ wc ≤ 1840 kg/m3] for ACI 318-14, ACI 318-11, and ACI 
318-08 

90 lb/ft3 ≤ wc ≤ 120 lb/ft3 [1440 kg/m3 ≤ wc ≤ 1920 kg/m3] for ACI 318-05 

90 lb/ft3 ≤ wc ≤ 120 lb/ft3 [1500 kg/m3 ≤ wc ≤ 2000 kg/m3] for ACI 318-02, and ACI 318-99, 

the minimum slab thickness is additionally increased by adjustment factor (1.65 – 0.005wc), but 
not less than 1.09. For CSA standards, the adjustment is calculated as (1.65 – 0.0003wc), but not 

less than 1.0, for structural low density (wc ≤ 1850 kg/m3) and structural semi-low density (1850 

kg/m3 ≤ wc ≤ 2150 kg/m3) concrete4.

2. ACI 318-14,7.3.1.1.,9.3.1.1; ACI 318-11, 9.5.2.1; ACI 318-08, 9.5.2.1; ACI 318-05, 9.5.2.1; ACI 318-
02, 9.5.2.1; ACI 318-99, 9.5.2.1;

3. CSA A23.3-14, 9.8.2.1; CSA A23.3-04, 9.8.2.1 (Ref. [10]);
4. CSA A23.3-04, 2.2; CSA A23.3-94 (Ref. [13]), 2.1
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2.3.2 Minimum Slab Thickness - Two-Way Construction

The program checks slab thickness against minimum slab thickness defined by design standards 
for two-way systems with long to short span ratio not greater than 2.05. Slabs with thickness below 
the minimum value will be flagged by the program, however, they are allowed provided that 
calculated deflections do not exceed maximum permissible computed deflections6.

For two-way system with a long to short span ratio greater than 2.0, the program will calculate 
minimum thickness requirements based on the provisions of one-way construction including any 
cantilevered spans.

Minimum thickness of slabs with beams spanning between supports on all sides is calculated for 
ACI 318 codes in US customary units from7

Eq. 2-1

in metric unit system for ACI 318-14, ACI 318-11, ACI 318-08, and ACI 318-05 from8

Eq. 2-2

and in metric unit system for ACI 318-02 and ACI 318-99 from9

5. ACI 318-14, 8.3.1.1; ACI 318-11, 9.5.3.1, 13.6.1.2; ACI 318-08, 9.5.3.1, 13.6.1.2; ACI 318-05, 9.5.3.1, 
13.6.1.2; ACI 318-02, 9.5.3.1, 13.6.1.2; ACI 318-99, 9.5.3.1, 13.6.1.2; CSA A23.3-14, 13.2.2, 2.2; CSA 
A23.3-04, 13.2.2, 2.2; CSA A23.3-94, 13.3.2, 13.1

6. ACI 318-14, 8.3.2.1; ACI 318-11, 9.5.3.4; ACI 318-08, 9.5.3.4; ACI 318-05, 9.5.3.4; ACI 318-02, 
9.5.3.4; ACI 318-99, 9.5.3.4; CSA A23.3-14, 13.2.7; CSA A23.3-04, 13.2.7; CSA A23.3-94, 13.3.6

7. ACI 318-14, 8.3.1.2; ACI 318-11, 9.5.3.3; ACI 318-08, 9.5.3.3; ACI 318-05, 9.5.3.3; ACI 318-02, 
9.5.3.3; ACI 318-99, 9.5.3.3

8. ACI 318M-11, 9.5.3.3; ACI 318M-08, 9.5.3.3; ACI 318M-05, 9.5.3.3
9. ACI 318M-02, 9.5.3.3; ACI 318M-99, 9.5.3.3
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Eq. 2-3

where

ln = longer clear span measured face-to-face of beams,
β = ratio of the clear spans in long to short direction,
fy  yield stress of reinforcing steel,
αm = average value of α, the ratio of flexural stiffness of a beam section to the 

flexural stiffness of a width of slab bounded laterally by centerlines of adjacent 
panels on either side of the beam, for all beams supporting the edges of a slab 
panel.

The program assumes that beams are present on all sides of a panel if the span under consideration 
includes a longitudinal beam and there are transverse beams defined at both ends of the span. If 
this assumption is satisfied but in reality beams are not present on all sides (e.g. design strip next 
to the one under consideration has no longitudinal beam) then the user is advised to check 
deflections even if slab thickness is larger than the minimum slab thickness reported by the 
program.

For the design of ACI slabs without beams (αm ≤ 0.2) spanning between interior supports the 
minimum thickness shall conform to ACI 318 Table 9.5(c) and will not be less than 5.0 in. 
[125 mm for ACI 318M-11/08/05 or 120 mm for ACI 318M-02/99] for flat plates (slabs without 
drop panel) and not less than 4.0 in. [100 mm] for two-way flat slab systems (slab with drop 
panels)10. For flat slabs that contain valid drop panels (see Figure 2-2), Table 9.5(c) reduces the 
minimum thickness by approximately 10%. For values of fy between the ones given in the table, 
minimum thickness is determined by linear interpolation.

For design strips that have neither beams between all supports nor beams between interior 
supports (e.g. exterior strips with beams on the outside edges only), the program reports maximum 
value of minimum slab thickness resulting from both Table 9-5(c) and Equations. However, since 
this case is not explicitly covered by the ACI code, the user is advised to check deflections even if 
slab thickness is larger than the minimum slab thickness reported by the program.

10.ACI 318-14, 8.3.1.1; ACI 318-11, 9.5.3.2; ACI 318-08, 9.5.3.2; ACI 318-05, 9.5.3.2; ACI 318-02, 
9.5.3.2; ACI 318-99, 9.5.3.2; ACI 318M-08, 9.5.3.2; ACI 318M-05, 9.5.3.2; ACI 318M-02, 9.5.3.2; ACI 
318M-99, 9.5.3.2
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For CSA A23.3 standard11, the minimum thickness of slab with beams spanning between all 
supports is

Eq. 2-4

with the value of αm evaluated for CSA A23.3-04 using the following beam moment of inertia

Eq. 2-5

For flat plates and slabs with column capitals12, the minimum slab thickness is

Eq. 2-6

For slabs with drop panels13, the minimum slab thickness satisfies the conditions

Eq. 2-7

Eq. 2-8

where (hd − hs) shall not be greater than hs and

xd = dimension from face of column to edge of drop panel, but not more than ℓn/4
2xd/ℓn = the smaller of the values determined in the two directions
h = additional thickness of the drop panel below the soffit of the slab and shall not 

be taken more than hs.

11.CSA A23.3-14, 13.2.5; CSA A23.3-04, 13.2.5; CSA A23.3-94, 13.3.5
12.CSA A23.3-14, 13.2.3; CSA A23.3-04, 13.2.3; CSA A23.3-94, 13.3.3
13.CSA A23.3-14, 13.2.4; CSA A23.3-04, 13.2.4; CSA A23.3-94, 13.3.4
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The minimum thickness in a span that contains a discontinuous edge will be increased by 10%, if 
the edge beam provided has a stiffness ratio, α, of less than 0.8014. The first and last spans are 
considered to contain a discontinuous edge as well as a span that contains an exterior edge.

The minimum thickness of slab bands follows the requirements for the beams15.

2.3.3 Drop Panel Dimensions

Per ACI16, a valid drop must extend in each direction at least one-sixth the center-to-center span 
length in that direction (Figure 2-2). The depth of an invalid drop will not be used in the 
calculation of the depth used to reduce the amount of negative reinforcement required over a 
column17. If the valid drop depth is greater than one-quarter the distance from the edge of the drop 
panel to the face of the column (x) the excess depth exceeding ¼x will not be considered in the 
calculation of the effective depth used to reduce the amount of negative reinforcement required at 
a column (Figure 2-3)18. Slabs that contain valid drops are allowed a 10% decrease in minimum 
slab depth19.

14.ACI 318-14, 8.3.1.2; ACI 318-11, 9.5.3.3 (d); ACI 318-08, 9.5.3.3 (d); ACI 318-05, 9.5.3.3 (d); ACI 318-
02, 9.5.3.3 (d); ACI 318-99, 9.5.3.3 (d), CSA A23.3-14, 13.2.3, 13.2.4; CSA A23.3-04, 13.2.3, 13.2.4; 
CSA A23.3-94, 13.3.3

15.CSA A23.3-04, 13.2.6
16.ACI 318-14, 8.2.4; ACI 318-11, 13.2.5; ACI 318-08, 13.2.5; ACI 318-05, 13.2.5; ACI 318-02, 13.3.7.1, 

13.3.7.2; ACI 318-99, 13.3.7.1, 13.3.7.2
17.ACI 318-14, 8.2.4; ACI 318-11, 13.2.5; ACI 318-08, 13.2.5; ACI 318-05, 13.2.5, 13.3.7; ACI 318-02, 

13.3.7; ACI 318-99, 13.3.7
18.ACI 318-14, 8.5.2.2; ACI 318-11, 13.3.7; ACI 318-08, 13.3.7; ACI 318-05, 13.3.7; ACI 318-02, 

13.3.7.3; ACI 318-99, 13.3.7.3; CSA A23.3-14, 13.10.7; CSA A23.3-04, 13.10.7; CSA A23.3-94, 
13.11.6

19.ACI 318-14, 8.3.1.1; ACI 318-11, 9.5.3.2; ACI 318-08, 9.5.3.2; ACI 318-05, 9.5.3.2; ACI 318-02, 
9.5.3.2, ACI 318-99, 9.5.3.2
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Figure 2.2 Valid Drop Dimensions

The input drop dimensions will be used for self-weight computations, when computing slab 
stiffness to determine deflections, moments, shears, and when computing punching shear around a 
column20.

Figure 2.3 Excess Drop Depth

20.ACI 318-14, 8.2.4; ACI 318-11, R13.2.5; ACI 318-08, R13.2.5; ACI 318-05, R13.2.5
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2.3.4 Beam Dimensions

The program follows linear distribution of strain (plain section) assumption21 for flexure design 
which is applicable to shallow flexural members. In case of deep beams22, design standards 
recommend using non-linear distribution of strain or strut-and-tie method. The program checks 
beam dimensions and if a beam with the following clear span, ln, to overall depth, h, ratio is found

Eq. 2-9

a warning is issued alerting the user that additional deep beam design and detailing is required. For 
cantilevers, the warning is issued only if their clear span is larger than overall depth.

2.4 Special Considerations for One and Two-Way 
Joist Systems

2.4.1 Rib Dimensions

Rib dimensions will be considered valid if the rib width is at least 4 in. [100 mm], the depth is no 
more than 3-1/2 times the rib width, and the clear spacing between ribs does not exceed 30 in. [800 
mm]23. If rib dimensions do not meet these requirements (e.g. wide module joist systems) the code 
requires such ribs to be designed as beams24. The program treats the design of wide-spaced joists 
the same way as for valid slabs, regardless of code limitation. If the code limits are exceeded, the 
condition is flagged and the 10% increase of rib shear capacity is not used. The user is then 
responsible to validate the resulting design and reconcile the code requirements. 

2.4.2 Minimum Thickness for Joist Systems

The minimum slab thickness allowed for joist slabs is one-twelfth the clear rib spacing, or 1.5 in 
[40 mm] for ACI code25 and 50mm for CSA code26.

21. ACI 318-14, 22.2.1.2; ACI 318-11, 10.2.2; ACI 318-08, 10.2.2; ACI 318-05, 10.2.2; ACI 318-02, 
10.2.2; ACI 318-99, 10.2.2; CSA A23.3-14, 10.1.2; CSA A23.3-04, 10.1.2; CSA A23.3-94, 10.1.2

22. ACI 318-14, 9.9.1.2; ACI 318-11, 10.7.1; ACI 318-08, 10.7.1; ACI 318-05, 10.7.1; ACI 318-02, 10.7.1; 
ACI 318-99, 10.7.1; CSA A23.3-14; 10.7.1; CSA A23.3-04; 10.7.1; CSA A23.3-94, 10.7.1

23.ACI 318-14, 8.8.1.2, 8.8.1.4, 9.8.1.2, 9.8.1.4; ACI 318-11, 8.13.2, 8.13.3; ACI 318-08, 8.13.2, 8.13.3; 
ACI 318-05, 8.11.2, 8.11.3; ACI 318-02, 8.11.2, 8.11.3; ACI 318-99, 8.11.2, 8.11.3; CSA A23.3-14, 
10.4.1; CSA A23.3-04, 10.4.1; CSA A23.3-94, 10.4.1

24.ACI 318-14, 8.8.1.8, 9.8.1.8; ACI 318-11, 8.13.4; ACI 318-08, 8.13.4; ACI 318-05, 8.11.4; ACI 318-02, 
8.11.4; ACI 318-99, 8.11.4; CSA A23.3-14, 10.4.2; CSA A23.3-04, 10.4.2; CSA A23.3-94, 10.4.2

l
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2.4.3 Joist System Analysis and Design

For the purposes of analysis and design, the program replaces the ribbed slab with solid slabs of 
equivalent moment of inertia, weight, punching shear capacity, and one-way shear capacity.

The equivalent thickness based on system weight is used to compute the system self-weight. This 
thickness, hw, is given by

Eq. 2-10

where

Vmod = the volume of one joist module,
Amod = the plan area of one joist module.

Figure 2.4 Valid Rib Dimensions

The equivalent thickness based on moment of inertia is used to compute slab stiffness. The ribs 
spanning in the transverse direction are not considered in the stiffness computations. This 
thickness, hMI, is given by

Eq. 2-11

where

Irib = moment of inertia of one joist section between centerlines of ribs.
brib = the center-to-center distance of two ribs (clear rib spacing plus rib width).

The drop panel depth for two-way joist (waffle) slab systems is set equal to the rib depth. The 
equivalent drop depth based on moment of inertia, dMI, is given by

25.ACI 318-14, 8.8.2.1.1, 9.8.2.1.1; ACI 318-11, 8.13.5.2; ACI 318-08, 8.13.5.2; ACI 318-05, 8.11.5.2; ACI 
318-02, 8.11.5.2; ACI 318-99, 8.11.5.2

26.CSA A23.3-14, 10.4.1; CSA A23.3-04, 10.4.1; CSA A23.3-94, 10.4.1
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Eq. 2-12

where

hrib = rib depth below slab,
hMI = equivalent slab thickness based on moment of inertia.

A drop depth entered for a waffle slab system other than 0 will be added to dMI, thus extending 
below the ribs.

One–way shear capacity, Vc (increased by 10% for ACI code27), is calculated assuming the shear 
cross-section area consisting of ribs and the portion of slab above, decreased by concrete cover. 
For such section the equivalent shear width of single rib is calculated from the formula

Eq. 2-13

where

b = rib width,
d = distance from extreme compression fiber to tension reinforcement centroid.

The equivalent thickness based on shear area is used to compute the area of concrete section 
resisting punching shear transfer, Ac around drop panels in two-way joist (waffle) systems. The 
equivalent slab thickness, hV, used to compute Ac, is given by

Eq. 2-14

where

Arib = the entire rib area below the slab plus the slab thickness minus the distance to 
the reinforcement centroid, dreinf, within the rib width, i.e., the slab depth 
between the ribs is not considered as contributing to shear capacity,

brib = the center-to-center distance of two ribs (clear rib spacing plus rib width),
dreinf = the distance to reinforcement centroid from the slab top at the support

When calculating flexural capacity for negative bending moments, the distance between center of 
top reinforcement to the soffit of the rib is used as an effective depth, d, while assuming the width 
of compression zone as equal to the center-to-center distance of two ribs (brib). This assumption 
results in higher estimates of negative moment capacity since the space between ribs is void. The 
user may switch to a single rib design or investigation as a beam in order to consider rib width 
only in the compression zone.

27. ACI 318-14, 8.8.1.5, 9.8.1.5; ACI 318-11, 8.13.8; ACI 318-08, 8.13.8; ACI 318-05, 8.11.8; ACI 318-02, 
8.11.8; ACI 318-99, 8.11.8
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2.5 Material Properties

By entering the concrete density and compressive strength of the members, default values for the 
other concrete properties are determined. The slabs/beams and columns may have different 
concrete properties.

The density of concrete is used to determine the type of concrete, modulus of elasticity, and self-
weight.

The concrete type is determined in accordance with Table 2-1.

Table 2.1 Concrete Weight Classification

Once the compressive strength of concrete fc
′ is input, various parameters are set to their default 

values.

The modulus of elasticity is computed as28

Eq. 2-15

Type

ACI 318-14
ACI 318-11
ACI 318-08

ACI 318-05
ACI 318-02
ACI 318-99

wc wc
pcf kg/m3 pcf kg/m3

Normal 135 ≤ wc 2155 ≤ wc 130 ≤ wc 2000 ≤ wc
Sand-
Lightweight

115<wc<135 1840<wc<215
5

105<wc<130 1700<wc<200
0

All-
Lightweight

wc ≤ 115 wc ≤ 1840 wc ≤ 105 wc ≤ 1700

Type

CSA A23.3-14

CSA A23.3-04
CSA A23.3-94

c c
kg/m3 pcf kg/m3 pcf

Normal 2150 ≤ c 134.2 ≤ c 2000 ≤ c 124.8 ≤ c
Low 
Density

1850<
c<2150

115.5<
c<134.2

1700<
c<2000

106.1<
c<124.8

Semi-
low 
Density

c ≤ 1850 c ≤ 115.5 c ≤ 1700 c ≤ 106.1

28.ACI 318-14,19.2.2.1 (a); ACI 318-11, 8.5.1; ACI 318-08, 8.5.1; ACI 318-05, 8.5.1; ACI 318-02, 8.5.1; 
ACI 318-99, 8.5.1; CSA A23.3-14, 8.6.2.2; CSA CSA A23.3-04, 8.6.2.2; CSA A23.3-94, 8.6.2.2

 E w f33c c c
1.5
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where

wc = the unit weight of concrete.

For CSA A23.3 standard29

Eq. 2-16

where

γc = the density of concrete.

The square root of fc
′ is limited to 100 psi for the computation of shear strength provided by 

concrete, Vc, and development lengths.30

For CSA A23.3-14/04 standard the value of square root of fc
′ used to calculate factored shear 

resistance vr shall not exceed 8MPa.31

The modulus of rupture is used to determine the cracking moment when computing the effective 
moment of inertia in deflection calculations. For ACI 318 code, the default value of modulus of 
rupture, fr, is set equal to32

Eq. 2-17

and for the CSA A23.3 standard, the default value of modulus of rupture fr is33

Eq. 2-18

For two-way slabs analyzed in accordance with CSA A23.3-94 as well as for beams, one-way, and 
two-way slabs analyzed in accordance with CSA A23.3-14/04, the default value is reduced to its 
half value34, i.e.

Eq. 2-19

29. CSA A23.3-14, 8.6.2.2; CSA A23.3-04, 8.6.2.2; CSA A23.3-94, 8.6.2.2
30.ACI 318-14, 22.5.3.1, 22.6.3.1; ACI 318-11, 11.1.2; ACI 318-08, 11.1.2; ACI 318-05, 11.1.2; ACI 318-

05, 11.1.2; ACI 318-99, 11.1.2
31.CSA A23.3-14, 13.3.4.2; CSA A23.3-04, 13.3.4.2
32.ACI 318-14, 19.2.3.1; ACI 318-11, 9.5.2.3; ACI 318-08, 9.5.2.3; ACI 318-05, 9.5.2.3; ACI 318-02, 

9.5.2.3; ACI 318-99, 9.5.2.3;
33.CSA A23.3-14, 8.6.4; CSA A23.3-04, 8.6.4; CSA A23.3-94, 8.6.4
34.CSA A23.3-14, 9.8.2.3; CSA A23.3-04, 9.8.2.3; CSA A23.3-94, 13.3.6
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Factor λ reflecting the reduced mechanical properties of lightweight concrete is equal to35 1.00 for 
normal density concrete, 0.85 for sand-lightweight (structural semi-low-density) concrete, and 
0.75 for all-lightweight (structural low-density) concrete. Refer to Table 2-1 for determination of 
concrete type.

There is no limit imposed on fr. Entering a large value of fr will produce deflections based on gross 
properties (i.e. uncracked sections).

The default values for the longitudinal reinforcement yield strength, fy, and shear reinforcement 
yield strength, fyv, if applicable, are set equal to 60 ksi [413 MPa] for ACI and 400 MPa for CSA.

2.6 Equivalent Frame Method

The equivalent frame method, as described in the code36, is used by spSlab for both analysis and 
design. The code specifies procedures for the analysis and design of slab systems reinforced for 
flexure in more than one direction, with or without beams between the supports. A two-way slab37 
system, including the slab and its supporting beams, columns, and walls may be designed by either 
of the following procedures

• The Direct Design Method

• The Equivalent Frame Method

spSlab uses the Equivalent Frame Method of analysis which is based on extensive analytical and 
experimental studies conducted at the University of Illinois. Note also that there are no restrictions 
on the number of slab spans or on dead-to-live load ratios in this method of analysis.

The first step in the frame analysis is to divide the three-dimensional building into a series of two-
dimensional frames extending to the full height of the building. Horizontal members for each 
frame are formed by slab strips as shown in Fig. 2-5. For vertical loads, each story (floor and/or 
roof) may be analyzed separately with the supporting columns being considered fixed at their 
remote ends (Figure 2-6).

The required reinforcing and resulting deflections for an interior or exterior panel in a floor system 
shall be combined from the analysis of two equivalent frames in orthogonal directions in order to 
arrive at the final design. 

35. ACI 318-14, 19.2.4; ACI 318-11, 8.6; ACI 318-08, 8.6; ACI 318-05, 11.2.1.2; ACI 318-02, 11.2.1.2; 
ACI 318-99, 11.2.1.2; CSA A23.3-14, 8.6.5; CSA A23.3-04, 8.6.5; CSA A23.3-94, 8.6.5

36. ACI 318-14, 8.11; ACI 318-11, 13.7; ACI 318-08, 13.7; ACI 318-05, 13.7; ACI 318-02, 13.7; ACI 318-
99, 13.7; CSA A23.3-14, 13.8; CSA A23.3-04, 13.8; CSA A23.3-94, 13.9

37. Implies a slab supported by isolated supports which permits the slab to bend in two orthogonal direc-
tions.
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2.6.1 Stiffness Characteristics

The stiffness factors for the horizontal members (the slab beams) and the vertical members (the 
equivalent columns) are determined using segmental approach.

Figure 2.5 Design strips

2.6.2 Slab Beams

The moment of inertia of the slab beam elements between the faces of the columns (or column 
capitals) is based on the uncracked section of the concrete including beams or drop panels. The 
moment of inertia from the face of the column (or capital) to the centerline of the column (or 
capital) is considered finite and is dependent on the transverse dimensions of the panel and 
support. This reduced stiffness (as compared to the infinite stiffness assumed in previous codes) is 
intended to soften the slab at the joint to account for the flexibility of the slab away from the 
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support. This is consistent with provisions of the code.38 Figure 2-7 shows the changes in stiffness 
between a slab, and a drop panel, and a column (or capital).

Figure 2.6 Analytical model for vertical loads for a typical story

2.6.3 Columns

The computation of the column stiffness is more complicated as it utilizes the concept of an 
equivalent column. Theoretical slab studies have shown that the positive moment in a slab may 
increase under pattern loads, even if rigid columns are used, because of the flexibility of the slab 
away from the column. However, if a two-dimensional frame analysis is applied to a structure 
with rigid columns, pattern loads will have little effect. 

38. ACI 318-14, 8.11.3; ACI 318-11, 13.7.3; ACI 318-08, 13.7.3; ACI 318-05, 13.7.3; ACI 318-02, 13.7.3; 
ACI 318-99, 13.7.3; CSA A23.3-14, 13.8.2.3; CSA A23.3-04, 13.8.2.3; CSA A23.3-94, 13.9.2.3
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Figure 2.7 Sections for calculating slab-beam stiffness, Ksb

To account for this difference in behavior between slab structures and frames, the equivalent 
column torsional member, as shown in Figure 2-8, runs transverse to the direction in which the 
moments are being determined. The transverse slab beam can rotate even though the column may 
be infinitely stiff, thus permitting moment distribution between adjacent panels. It is seen that the 
stiffness of the equivalent column is affected by both the flexural stiffness of the columns and the 
torsional stiffness of the slabs or beams framing into the columns. Note that the method of 
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computation of column stiffness is in accordance with the requirements of the code39. Figure 2-10 
shows a schematic representation of the stiffness of typical columns.

Figure 2.8 continued

The column stiffness is based on the column height, lc, measured from mid-depth of the slab 
above, to the mid-depth of the slab below. spSlab calculates the stiffness of the column below the 
design slab, taking into account the design slab system at its top end. spSlab calculates the 
stiffness of the column above the design slab taking only the slab depth into account at its bottom 
end; column capitals, beams, or drops are ignored.

The computation of the torsional stiffness of the member requires several simplifying 
assumptions. The first step is to assume dimensions of the transverse torsional slab-beam 
members. Assumptions for dimensions of typical torsional members are shown in Figure 2-9.

39.ACI 318-14, 8.11.4; ACI 318-11, 13.7.4; ACI 318-08, 13.7.4; ACI 318-05, 13.7.4; ACI 318-02, 13.7.4; 
ACI 318-99, 13.7.4; CSA A23.3-14, 13.8; CSA A23.3-04, 13.8; CSA A23.3-94, 13.9
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The stiffness, Kt, of the torsional member is given by the following expression40

Eq. 2-20

where

 = denotes summation over left and right side torsional member,
Ecs = modulus of elasticity for slab concrete,
C = cross-sectional constant defined in Eq. 2-21
c2 = size of rectangular column or capital measured transverse to the direction in 

which moments are being determined,
lt = l2L and l2R, lengths of span transverse to l1, measured on each side of the 

column for ACI 318; for CSA A23.3 value of lt is taken as the smaller of l1a 
and l2a where l1a is the average l1 and l2a is the average l2 on each side of an 
interior column. In case of an exterior columns, l1a and l2a are taken 
respectively as l1 (if the column is exterior with respect to the direction of 
analysis) and l2 (if column is exterior in the transverse direction) of the 
adjacent span, i.e. cantilevers, if any, are neglected.

40. ACI 318-14, 8.11.5; ACI 318-11, 13.7.5; ACI 318-08, 13.7.5; ACI 318-05, 13.7.5; ACI 318-02, 13.7.5; 
ACI 318-99, 13.7.5; CSA A23.3-14, 13.8.2.8; CSA A23.3-04, 13.8.2.8; CSA A23.3-94, 13.9.2.8
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Figure 2.9 Equivalent column

The constant C is evaluated for the cross section by dividing it into separate rectangular parts and 
by carrying out the following summation41

Eq. 2-21

where

x = short overall dimension of the rectangular part of a cross section,
y = long overall dimension of the rectangular part of a cross section.

The program divides the section into rectangles in such a way that the value of constant C is 
maximum (see Figure 2-9).

Walls perpendicular to the direction analysis can be modeled as wide columns. If a column/wall 
runs full length of the total design strip42, the program modifies moment distribution factors to 

41. ACI 318-14, 8.10.5.2; ACI 318-11, 13.6.4.2; ACI 318-08, 13.6.4.2; ACI 318-05, 13.6.4.2; ACI 318-02, 
13.0; ACI 318-99, 13.0; CSA A23.3-14, 13.8.2.9; CSA A23.3-04, 13.8.2.9; CSA A23.3-94, 13.9.2.9

42. For walls running full width of the slab (c2 = l2), the program slightly adjusts the width of the wall to 
avoid singularity in the denominator of Eq. 2-20
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achieve uniform distribution of moments along the column and middle strips. If the width of the 
wall is less than 75% of the total design strip then no modification of distribution factors is 
applied. For column/wall widths between 75% and 100% of total strip widths, moment 
distribution factors are linearly interpolated between regular values and uniformly distributed 
values. 

When beams frame into the column in the direction of analysis, the value of Kt as computed in Eq. 
2-20 is multiplied by the ratio of the moment of inertia of the slab with the beam (Isb) to the 
moment of inertia of the slab without the beam (Is), as shown

Eq. 2-22

With reference to Figure 2-8, Is is computed from part A (slab without beam), whereas Isb is 
computed from both parts A and B (slab with beam).

K K
I
Ita t
sb

s
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Figure 2.10 Section of the attached torsional members
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Figure 2.11 Sections for calculating the stiffness (Kc) of the column below the design floor 
(lc-input, lc*-computed)

Having the column stiffness, Kc, and the stiffness of the attached torsional member, Kt, the 
stiffness of the equivalent column, Kec, is computed from the equation

Eq. 2-23

where

Kct = top column stiffness,
Kcb = bottom column stiffness,

Kta = torsional stiffness of the left ( ) and the right ( ) member.

2.7 Loading

All applied loads are input as unfactored loads. There are no limitations imposed on the ratio of 
dead to live loads in the Equivalent Frame Method. Results of gravity load and lateral load 
analyses may be combined, however, the effects of cracking and reinforcement on stiffness must 
be accounted for in the lateral load analysis.
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2.7.1 Self-Weight

The self weight of the system is automatically calculated and assigned to the reserved load 
selfweight load case, SELF, which is by default defined in all new data files. The weights of the 
slabs, drops, and longitudinal and transverse beams are considered in the selfweight computations. 
Only the concrete weight is considered, the reinforcement weight is ignored. The weight of 
longitudinal beams is ignored starting at the column centerline, for a length equal to one-half c1, 
the column dimension in the direction of analysis. This will produce slightly less self-weight than 
actually present for beams wider than c2, the column’s transverse dimension.

If load case SELF is removed then the program will ignore self weight in all ultimate load 
combinations as well as in internally defined service load combination used to calculate 
displacements.

2.7.2 Superimposed Loading

All superimposed vertical loading is considered to act over the entire transverse width of the slab. 
For slab systems with beams, loads supported directly by the beam (such as the weight of the 
beam stem or a wall supported directly by the beams) are also assumed to be distributed over the 
entire transverse width of the strip. An additional analysis may be required, with the beam section 
designed to carry these loads in addition to the portion of the slab moments assigned to the beam.

2.7.3 Lateral Loading

For lateral loads, each frame should be analyzed as a unit for the entire height of the building 
(Figure 2-11). Computer programs, such as spFrame, are available for performing such analyses. 
It should be realized that, for lateral load analysis, slab-beam elements may have a reduced 
stiffness due to cracking as well as other assumptions made for the effective slab width used for 
the lateral analysis. The moments obtained from such an analysis may then be input into the 
equivalent frame model using the program to determine the appropriate design moments under 
combined vertical and lateral loads.
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Figure 2.12 Analytical model for lateral loads

The program distributes the effect of the superimposed lateral load moments to the column strip 
and middle strip according to the moment distribution factors computed for gravity loads (see 
Table 2-2 through Table 2-4 later in this chapter).

2.7.4 Load Patterns

The analysis of floor systems requires the consideration of several loading configurations. For 
example, the two adjacent spans loaded may produce the maximum shear stress around a column, 
while the alternate spans loaded may produce the maximum flexural moments. To cover different 
loading scenarios the program generates live load case based on the following load patterns 
(Figure 2-12)

• Pattern No. l (All): All spans loaded with live load,

• Pattern No. 2 (Odd): Starting at span 1, alternate spans loaded with live load,

• Pattern No. 3 (Even): Starting at span 2, alternate spans loaded with live load,

• Pattern No. 3+N (SN): Two spans adjacent to support No. N loaded with live load.
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Figure 2.13 Live load patterns

The program reduces the magnitude of live load patterns No. 2 through No. (3+n) by a predefined 
ratio. For two-way systems, the default live load pattern ratio selected by the program equals 75% 
as permitted by the code43. The user has the ability to select different value for the pattern ratio 
within the range 0-100%. If 0% is selected then load patterning effects will be neglected. 
However, the pattern No. 1 with all spans loaded (as specified by the user) is always considered 
with full unreduced magnitude. 

2.7.5 Load Combinations

The program allows defining up to 50 load combinations. The user has full control over the 
combinations. The program contains predefined (built into the program) default primary load 

43. ACI 318-14, 6.4.3.3; ACI 318-11, 13.7.6.3; ACI 318-08, 13.7.6.3; ACI 318-05, 13.7.6.3; ACI 318-02, 
13.7.6.3; ACI 318-99, 13.7.6.3; CSA A23.3-14, 13.8.4; CSA A23.3-04, 13.8.4; CSA A23.3-94, 13.9.4
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combinations for the supported codes. These default combinations are created when starting a new 
project.

For the ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-02 codes, the default 
combinations of the Self-weight (SW), Dead (D), Live (L), Snow (S), Wind (W) and Earthquake 
(E) loads considered by the program are44

U1 = 1.4SW + 1.4D
U2 = 1.2SW + 1.2D + 1.6L + 0.5S
U3 = 1.2SW + 1.2D + 1.0L + 1.6S
U4 = 1.2SW + 1.2D + 1.6S + 0.8W
U5 = 1.2SW + 1.2D + 1.6S – 0.8W
U6 = 1.2SW + 1.2D + 1.0L + 0.5S + 1.6W
U7 = 1.2SW + 1.2D + 1.0L + 0.5S – 1.6W
U8 = 0.9SW + 0.9D + 1.6W
U9 = 0.9SW + 0.9D – 1.6W
U10 = 1.2SW + 1.2D + 1.0L + 0.2S + 1E
U11 = 1.2SW + 1.2D + 1.0L + 0.2S – 1E
U12 = 0.9SW + 0.9D + 1.0E
U13 = 0.9SW + 0.9D – 1.0E

For the ACI 318-99 code, the default combinations of the Self-weight (SW), Dead (D), Live (L), 
Wind (W) and Earthquake (E) loads considered by the program are45

U1 = 1.4SW + 1.4D + 1.7L
U2 = 0.75(1.4SW + 1.4D + 1.7L + 1.7W)
U3 = 0.75(1.4SW + 1.4D + 1.7L – 1.7W)
U4 = 0.75(1.4SW + 1.4D + 1.7W)
U5 = 0.75(1.4SW + 1.4D – 1.7W)
U6 = 0.9 SW + 0.9D + 1.3W
U7 = 0.9 SW + 0.9D – 1.3W
U8 = 0.75(1.4SW + 1.4D + 1.7L + 1.7*1.1E)
U9 = 0.75(1.4SW + 1.4D + 1.7L – 1.7*1.1E)
U10 = 0.75(1.4SW + 1.4D + 1.7*1.1E)
U11 = 0.75(1.4SW + 1.4D – 1.7*1.1E)
U12 = 0.9 SW + 0.9D + 1.43E
U13 = 0.9 SW + 0.9D – 1.43E

44. ACI 318-14, 5.3.1; ACI 318-11, 9.2; ACI 318-08, 9.2; ACI 318-05, 9.2; ACI 318-02, 9.2; (assuming W 
based on service-level wind load and E based on ultimate-level forces)

45. ACI 318-99, 9.2
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For the CSA A23.3-14 code load combinations are compliant with 2015 NBCC. The default 
combinations of the Self-weight (SW), Dead (D), Live (L), Snow (S), Wind (W) and Earthquake 
(E) loads considered by the program are46

U1 = 1.4SW + 1.4D
U2 = 1.25SW + 1.25D + 1.5L
U3 = 0.9SW + 0.9D + 1.5L
U4 = 1.25SW + 1.25D + 1.5L + 1.0S
U5 = 0.9SW + 0.9D + 1.5L + 1.0S
U6 = 1.25SW + 1.25D + 1.5L + 0.4W
U7 = 1.25SW + 1.25D + 1.5L – 0.4W
U8 = 0.9SW + 0.9D + 1.5L + 0.4W
U9 = 0.9SW + 0.9D + 1.5L – 0.4W
U10 = 1.25SW + 1.25D + 1.5S
U11 = 0.9SW + 0.9D + 1.5S
U12 = 1.25SW + 1.25D + 1.0L + 1.5S
U13 = 0.9SW + 0.9D + 1.0L + 1.5S
U14 = 1.25SW + 1.25D + 0.4W + 1.5S
U15 = 1.25SW + 1.25D – 0.4W + 1.5S
U16 = 0.9SW + 0.9D + 0.4W + 1.5S
U17 = 0.9SW + 0.9D – 0.4W + 1.5S
U18 = 1.25SW + 1.25D + 1.4W
U19 = 1.25SW + 1.25D – 1.4W
U20 = 0.9SW + 0.9D + 1.4W
U21 = 0.9SW + 0.9D – 1.4W
U22 = 1.25SW + 1.25D + 0.5L + 1.4W
U23 = 1.25SW + 1.25D + 0.5L – 1.4W
U24 = 0.9SW + 0.9D + 0.5L + 1.4W
U25 = 0.9SW + 0.9D + 0.5L - 1.4W
U26 = 1.25SW + 1.25D + 1.4W + 0.5S
U27 = 1.25SW + 1.25D – 1.4W + 0.5S
U28 = 0.9SW + 0.9D + 1.4W + 0.5S
U29 = 0.9SW + 0.9D – 1.4W + 0.5S
U30 = 1.0SW + 1.0D + 1.0E
U31 = 1.0SW + 1.0D – 1.0E
U32 = 1.0SW + 1.0D + 0.5L + 1.0E + 0.25S
U33 = 1.0SW + 1.0D + 0.5L – 1.0E + 0.25S

46. CSA A23.3-14, 8.3.2; CSA A23.3-04, 8.3.2; CSA A23.3-04, Annex C, Table C1; NBCC 2005 (Ref. [8]), 
Table 4.1.3.2
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For the CSA A23.3-04 code load combinations are compliant with 2005 NBCC. The default 
combinations of the Self-weight (SW), Dead (D), Live (L), Snow (S), Wind (W) and Earthquake 
(E) loads considered by the program are47

U1 = 1.4D
U2 = 1.25D + 1.5L
U3 = 0.9D + 1.5L
U4 = 1.25D + 1.5L + 0.5S
U5 = 0.9D + 1.5L + 0.5S
U6 = 1.25D + 1.5L + 0.4W
U7 = 1.25D + 1.5L – 0.4W
U8 = 0.9D + 1.5L + 0.4W
U9 = 0.9D + 1.5L – 0.4W
U10 = 1.25D + 1.5S
U11 = 0.9D + 1.5S
U12 = 1.25D + 0.5L + 1.5S
U13 = 0.9D + 0.5L + 1.5S
U14 = 1.25D + 0.4W + 1.5S
U15 = 1.25D – 0.4W + 1.5S
U16 = 0.9D + 0.4W + 1.5S
U17 = 0.9D – 0.4W + 1.5S
U18 = 1.25D + 1.4W
U19 = 1.25D – 1.4W
U20 = 0.9SW + 0.9D + 1.4W 
U21 = 0.9D – 1.4W
U22 = 1.25D + 0.5L + 1.4W
U23 = 1.25D + 0.5L – 1.4W + 0.5S
U24 = 0.9D + 0.5L + 1.4W
U25 = 0.9D + 0.5L - 1.4W
U26 = 1.25D + 1.4W + 0.5S
U27 = 1.25D – 1.4W + 0.5S
U28 = 0.9D + 1.4W + 0.5S
U29 = 0.9D – 1.4W + 0.5S
U30 = 1.0D + 1.0E
U31 = 1.0D – 1.0E
U32 = 1.0D + 0.5L + 1.0E + 0.25S
U33 = 1.0D + 0.5L – 1.0E + 0.25S

47. CSA A23.3-14, 8.3.2; CSA A23.3-04, 8.3.2; CSA A23.3-04, Annex C, Table C1; NBCC 2005 (Ref. [8]), 
Table 4.1.3.2
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For the CSA A23.3-94 code, the default combinations of the Self-weight (SW), Dead (D), Live 
(L), Wind (W), Earthquake (E), and Snow (S) loads considered by the program are48

U1 = 1.25SW + 1.25D + 1.5L
U2 = 1.25SW + 1.25D + 1.5L + 1.5S
U3 = 1.25SW + 1.25D + 0.7(1.5L + 1.5W)
U4 = 1.25SW + 1.25D + 0.7(1.5L – 1.5W)
U5 = 1.25SW + 1.25D + 0.7(1.5L + 1.5W+ 1.5S)
U6 = 1.25SW + 1.25D + 0.7(1.5L – 1.5W+ 1.5S)
U7 = 1.25SW + 1.25D + 1.5W
U8 = 1.25SW + 1.25D – 1.5W
U9 = 0.85SW + 0.85D + 1.5W
U10 = 0.85SW + 0.85D – 1.5W
U11 = 1.0SW + 1.0D + 0.5L + 1.0E
U12 = 1.0SW + 1.0D + 0.5L – 1.0E
U13 = 1.0SW + 1.0D + 0.5L + 1.0E + 0.5S
U14 = 1.0SW + 1.0D + 0.5L – 1.0E + 0.5S
U15 = 1.0SW + 1.0D + 1.0E
U16 = 1.0SW + 1.0D – 1.0E

2.8 Column and Middle Strip Widths

The code49 defines the width of the column strip on each side of the column centerline as being 
one-fourth of the smaller of either the transverse or the longitudinal span. These widths are printed 
as part of the design results.

The strip widths at a support are computed by (see Figure 2-13)

• column strip

Eq. 2-24

• middle strip

48. CSA A23.3-14, 8.3.2; CSA A23.3-94, 8.3.2 (assuming occupancies other than storage and assembly)
49. ACI 318-14, 8.4.1.5; ACI 318-11, 13.2.1; ACI 318-08, 13.2.1; ACI 318-05, 13.2.1; ACI 318-02, 13.2.1; 

ACI 318-99, 13.2.1; CSA A23.3-14, 2.2; CSA A23.3-04, 2.2; CSA A23.3-94, 13.1
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Eq. 2-25

Figure 2.14 Strips widths at support

The strip widths in the span are defined as (see Figure 2-14)

• column strip

Eq. 2-26
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• middle strip

Eq. 2-27

where

l1 = span length in the direction of analysis,
l2,l = the input transverse strip widths on the left of column centerline,
l2,r = the input transverse strip widths on the right of column centerline,
l2 = l2,l/2 + l2,r/2, the total input transverse strip width.

Figure 2.15 Strip widths in span

If a longitudinal slab band is defined (CSA A23.3-14/04 standard only) then the column strip 
width is automatically adjusted to be equal to the band width

Eq. 2-28

If a longitudinal beam exists then the adjusted column strip width, wcs, is calculated by subtracting 
the beam width, wbeam, from the width of the column strip

 w wlms cs2

 

/ //

w wcs band
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Eq. 2-29

If the user selects the BEAM T-SECTION DESIGN option in Solve Options, the beam width, wbeam, 
used by the program will include portion of the slab on each side of the beam equal to projection 
of the beam below the slab, but not greater than slab thickness50. Otherwise, only web width is 
used. If the beam width, wbeam, is greater than the column strip width, wcs, then the adjusted 
column strip width is set to zero and moment distribution factors are adjusted to apply all column 
strip moment to the beam. This may occur when modeling a slab band with a wide longitudinal 
beam for codes other than CSA A23.3-14/04. In case of CSA A23.3-14/04 standard, the dedicated 
LONGITUDINAL SLAB BAND option in General Information dialog window is available to model 
slab band systems explicitly.

By selecting USER SLAB STRIP WIDTH and USER DISTRIBUTION FACTORS options in Solve 
Options dialog window, the user has the ability to manually override strip widths and moment 
distribution factors calculated automatically by the program and requires engineering judgment.

Note: For exterior frames, the edge width should be specified to the edge of the slab from the 
column centerline. Entering edge width greater than l1/4 involves engineering judgment regarding 
two-way behavior of the system and the applicability of the equivalent frame method.

2.9 Strip Design Moments

For design purposes51, spSlab considers negative moments as those producing tension at the top 
of the slab and positive moments as those producing tension at the bottom of the slab. The 
negative design moment is taken at the face of the column below the slab, or at the face of the 
column capital, but in no case is it considered at a location greater than 0.175 of the longitudinal 
span length, l1, away from the center of the column.52 This imposes a limit on long narrow 
supports, in order to prevent undue reduction in the design moment. For slab systems with 
transverse beams, the face of a beam is not considered as the face of support. For end columns 
with capitals, the negative moments are taken at the midpoint of the capital extension.53 If 
a positive moment occurs at a support then its value at the face of the column above the slab is 
considered (or at the support centerline if there is no column above the slab). 

50.ACI 318-14, 8.4.1.8; ACI 318-11, 13.2.4; ACI 318-08, 13.2.4; ACI 318-05, 13.2.4; ACI 318-02, 13.2.4; 
ACI 318-99, 13.2.4; CSA A23.3-04 Figure N13.1.2.(a) in Ref. [12], CSA A23.3-94, 13.1

51. ACI and CSA provisions for the location of critical section for flexure referred to in this paragraph apply 
to two-way systems. Due to lack of similar provisions for one-way systems and beams in ACI and CSA 
standards, the program consistently applies the same rules (with the exception of 0.175l1 limitation) to 
one-way systems and beams.

52. ACI 318-14, 8.11.6.1; ACI 318-11, 13.7.7.1; ACI 318-08, 13.7.7.1; ACI 318-05, 13.7.7.1; ACI 318-02, 
13.7.7.1; ACI 318-99, 13.7.7.1; CSA A23.3-14, 13.8.5.1; CSA A23.3-04, 13.8.5.1; CSA A23.3-94, 
13.9.5.1

 w w wcs cs beam
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spSlab computes the amount of reinforcement for the moments on the left and the right side of the 
support. The negative design moment is the moment which requires the most area of 
reinforcement to be resisted. The location, left or right of the support, of the maximum moment 
may vary when systems differ on each side of the support (for example, a system with beams on 
one side only).

spSlab automatically calculates the values of strip moment distribution factors for column strips 
and longitudinal beams (if present). Portion of the total factor moment not assigned to a column 
strip or a beam is then proportionally assigned to the remaining middle strip.

Note: By checking USER DISTRIBUTION FACTORS option in Solve Options dialog window, the 
user has the ability to manually adjust strip moment distribution factors calculated automatically 
by the program.

2.9.1 ACI 318 and CSA A23.3-9454

The column strips are proportioned to resist the portions in percent of interior negative factored 
moments according to Table2-2.55

Table 2.2 Column Strip Percent of Interior Negative Factored Moments at Supports

The column strips are proportioned to resist the portions in percent of exterior negative factored 
moments according to Table 2-3.56

Table 2.3 Column Strip Percent of Exterior Negative Factored Moments at Supports

53. ACI 318-14, 8.11.6.2, 8.11.6.3; ACI 318-11, 13.7.7.2; ACI 318-08, 13.7.7.2; ACI 318-05, 13.7.7.2; ACI 
318-02, 13.7.7.2; ACI 318-99, 13.7.7.2; CSA A23.3-14, 13.8.5.2; CSA A23.3-04, 13.8.5.2; CSA A23.3-
94, 13.9.5.2

54.For CSA A23.3-94 standard, the program assumes by default values given by ACI code which fall within 
the ranges specified in CSA A23.3-94, 13.12.2

l2/l1 0.5 1.0 2.0
(f1 l2/l1) = 0 75 75 75

(f1 l2/l1) ≥ 1.0 90 75 45

55.ACI 318-14, 8.10.5.1; ACI 318-11, 13.6.4.1; ACI 318-08, 13.6.4.1; ACI 318-05, 13.6.4.1; ACI 318-02, 
13.6.4.1; ACI 318-99, 13.6.4.1; CSA A23.3-14, 13.9.5; CSA A23.3-04, 13.9.5; CSA A23.3-94, 13.9.5.1; 
CSA A23.3-94, 13.8.5.1

l2/l1 0.5 1.0 2.0

(f1 l2/l1) = 0
βt = 0 100 100 100

βt ≥ 2.5 75 75 75

(f1 l2/l1) ≥ 1.0
βt = 0 100 100 100

βt ≥ 2.5 90 75 45

56.ACI 318-14, 8.10.5.2, 8.10.5.3; ACI 318-11, 13.6.4.2; ACI 318-08, 13.6.4.2; ACI 318-05, 13.6.4.2; ACI 
318-02, 13.6.4.2; ACI 318-99, 13.6.4.2;
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The values α1 in Table 2-2 and Table 2-3 and βt in Table 2-3 are defined as

αf1 = ratio of flexural stiffness of the beam section to flexural stiffness of a width of 
slab bounded by centerlines of adjacent panels (if any) on each side of the 
beam in the direction of analysis. For flat plates, flat slabs, and waffle (f1 l2/
l1) = 0

βt = ratio of torsional stiffness of an edge beam section to flexural stiffness of a 
width of slab equal to the span length of the beam, center-to-center of 
supports.57 When no transverse beams are present, βt = 0, otherwise

Eq. 2-30

where

Ecb = modulus of elasticity of beam concrete,
Ecs = modulus of elasticity of slab concrete,
C = cross-sectional constant, see Eq. 2-21
Is = moment of inertia of the gross section of the slab about its centroidal axis.

For intermediate values of (l2/l1), (f1l2/l1) and βt the values in Table 2-2 and Table 2-3 are 
interpolated using equations Eq. 2-31 and Eq. 2-32.

Percentage of negative factored moment at interior support to be resisted by column strip

Eq. 2-31

Percentage of negative factored moment at exterior support to be resisted by column strip

Eq. 2-32

When a column width, c2, is equal to or greater than 75 percent of the tributary strip width l2, the 
distribution factor for negative column strip moment is linearly interpolated between the factor for 
regular support, and the factor equal 0.50 (moment uniformly distributed across l2). This extends 

the requirement of the design code58, by providing continuous linear transition between standard 
and uniform moment distributions, depending on the relative dimension of the support with 
respect to strip width. User may override software assumptions by selecting user defined 
distribution factors.

57. ACI 318-14, 8.10.5.2, 8.10.5.3; ACI 318-11, 13.6.4.2; ACI 318-08, 13.6.4.2; ACI 318-05, 13.6.4.2; ACI 
318-02, 13.0; ACI 318-99, 13.0; CSA A23.3-94, 13.0

58. ACI 318-14, 8.10.5.4; ACI 318-11, 13.6.4.3; ACI 318-08, 13.6.4.3; ACI 318-05, 13.6.4.3; ACI 318-02, 
13.6.4.3; ACI 318-99, 13.6.4.3
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When designing by the CSA A23.3-94 code, a portion of the total positive or interior negative 
moment equivalent to59

Eq. 2-33

is resisted by the beam. For exterior supports, the beam is proportioned to resist 100% of the 
negative moment.

That portion of the moment not resisted by the beam is resisted by the slab. The reinforcement 
required to resist this moment is distributed evenly across the slab.

For ACI designs the longitudinal beams are proportioned to resist 85 percent of the column strip 
moments if f1l2/l1 is equal to or greater than 1.0. For values of f1l2/l1 between 0 and 1.0, the 
beam is designed to resist a proportionate percentage of the column strip moment between 0 and 
85.60

The middle strips are proportioned to resist the portion of the total factored moments that is not 
resisted by the column strips.

The column strips are proportioned to resist the portions in percent of positive factored moments 
according to Table 2-4.61

For intermediate values of (l2/l1) and (f1l2/l1) the values in Table 2-4 are interpolated using Eq. 
2-34 follows

Eq. 2-34

Note: For flat plates, flat slabs, and waffle slabs, f1l2/l1 = 0.

2.9.2 CSA A23.3-14/04

For slabs without drop panels (with or without transverse beams) the following moment factors 
are used62

59. CSA A23.3-94, 13.13.2.1
60. ACI 318-14, 8.10.5.7; ACI 318-11, 13.6.5; ACI 318-08, 13.6.5; ACI 318-05, 13.6.5; ACI 318-02, 

13.6.5; ACI 318-99, 13.6.5

l2/l1 0.5 1.0 2.0
(f1l2/l1) = 0 60 60 60

(f1l2/l1) ≥ 1.0 90 75 45

61.ACI 318-14, 8.10.5.5; ACI 318-11, 13.6.4.4; ACI 318-08, 13.6.4.4; ACI 318-05, 13.6.4.4; ACI 318-02, 
13.6.4.4; ACI 318-99, 13.6.4.4
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• Negative moment at interior column, factor = 0.80

• Negative moment at exterior column, factor = 1.00

• Positive moment at all spans, factor = 0.60

For slabs with drop panels (with or without transverse beams) the following moment factors are 
used63

• Negative moment at interior column, factor = 0.825

• Negative moment at exterior column, factor = 1.00

• Positive moment at all spans, factor = 0.60

For slabs with longitudinal slab bands64

• Negative moment at interior column, factor = 0.90

• Negative moment at exterior column, factor = 1.00

• Positive moment at all spans, factor = 0.90

For slabs with transverse slab bands65

• Negative moment at interior column in width bb, factor from 0.05 to 0.15 range is selected 
so that the remaining moment is distributed evenly over the entire frame width (including 
bb width) and at least one-third of the total factored moment66 is applied to the band width 
bb.

• Negative moment at exterior column, factor = 1.00

• Positive moment at all spans where (l1/l2) ≥ 1.0, factor = 0.55

• Positive moment at all spans where (l1/l2) < 1.0, factor = 0.55 (l1/l2)

For slabs with beams between all the supports67, the positive and interior negative factored 
moments are distributed as follows

Eq. 2-35

Factored negative moments at exterior supports are assigned in 100% proportion to beams.

62.  CSA A23.3-14, 13.11.2.2; CSA A23.3-04, 13.11.2.2
63. CSA A23.3-14, 13.11.2.3; CSA A23.3-04, 13.11.2.3
64. CSA A23.3-14, 13.11.2.4; CSA A23.3-04, 13.11.2.4
65. CSA A23.3-14, 13.11.2.5; CSA A23.3-04, 13.11.2.5
66. CSA A23.3-14, 13.11.2.7; CSA A23.3-04, 13.11.2.7
67. CSA A23.3-14, 13.12.2; CSA A23.3-04, 13.12.2
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CSA A23.3-14/04 does not stipulate requirement for distributing moments in slab systems with 
beams between some (but not all) supports. For estimation of the moment resisted by the beams in 
this case, the program applies the ACI approach described in the previous section where 
longitudinal beams are proportioned to resist 85 percent of the column strip moments if f1l2/l1 is 
equal to or greater than 1.0. For values of f1l2/l1 between 0 and 1.0, the beam is designed to resist 
a proportionate percentage of the column strip moment between 0 and 85%. 

2.10 Moment Redistribution

Redistribution of negative moments applies to one-way and beam systems only. It can be engaged 
using the Input Redistribution option on the Solve Options tab in the General Information 
dialog box.

The program allows for redistribution of negative moments at supports. Only reduction in 
negative moments is considered. Increase of negative moments at the support is not taken into 
account even though it is allowed by the code68. Static equilibrium is maintained meaning that 
bending moments and shear forces along the span are adjusted in accordance with the reduction of 
moments applied at the supports. The following procedure is followed to obtain moment 
redistribution factors at the supports.

From elastic static analysis, the largest moments from all load combinations and load patterns are 
determined at support faces on both ends of each span except cantilevers. These moments are used 
to calculate the maximum percentage adjustment of moments, δ, allowed by the codes.

For ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-0269

Eq. 2-36

where εt is net tensile strain in extreme tension steel at nominal strength.

For ACI 318-9970

Eq. 2-37

68. ACI 318-14, 6.6.5.1; ACI 318-11, 8.4.1; ACI 318-08, 8.4.1; ACI 318-05, 8.4.1; ACI 318-02, 8.4.1; ACI 
318-99, 8.4.1; CSA A23.3-14, 9.2.4; CSA A23.3-04, 9.2.4; CSA A23.3-94, 9.2.4

69. ACI 318-14, 6.6.5.3; ACI 318-11, 8.4.1 and 8.4.3; ACI 318-08, 8.4.1 and 8.4.3; ACI 318-05, 8.4.1 and 
8.4.3 ; ACI 318-02, 8.4.1 and 8.4.3

70. ACI 318-99, 8.4.1 and 8.4.3

δ =
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where

ρ = tension reinforcement ratio,
ρ' = compression reinforcement ratio,
ρb = balanced reinforcement ratio.

For CSA A23.371

Eq. 2-38

where

c = distance from extreme compression fiber to neutral axis,
d = distance from extreme compression fiber to centroid of tension reinforcement.

In the investigation mode, program uses the area of provided reinforcement to obtain 
redistribution factors. In the design mode the required reinforcement area is used. Additionally,   
is limited to 20% and not to exceed the maximum values specified by the user. Negative moments 
at span ends are reduced by the amount of redistribution factors and new moment values are 
iteratively used to obtain new redistribution factors. This iterative procedure is repeated until the 
change in distribution factor is negligible (does not exceed 0.01%), but no more than 10 times.

2.11 Shear Analysis of Slabs

Shear analysis in spSlab takes into account one way shear and two-way shear. For two-way shear, 
the program considers contributions of factored shear force72, Vu, and fraction of unbalanced 

moment transferred by shear73, vMunbal. spSlab does not consider torsional stresses in the slab. If 
in the engineer’s judgment this may control, it must be computed manually.

spSlab checks one-way shear at a critical section located at a distance not less than the effective 
depth away from the face of the support74. If a concentrated load is applied closer than the 
effective depth away from the face of the support then critical section is located at the face of the 

71. CSA A23.3-14, 9.2.4; CSA A23.3-04, 9.2.4; CSA A23.3-94, 9.2.4
72. ACI 318-14, 8.4.4.2.3; ACI 318-11, 11.11.7.2; ACI 318-08, 11.11.7.2; ACI 318-05, 11.12.6.2; ACI 318-

02, 11.12.6.2; ACI 318-99, 11.12.6.2; CSA A23.3-14, 13.3.5.2; CSA A23.3-04, 13.3.5.2; CSA A23.3-94, 
13.4.5.2

73. ACI 318-14, 8.4.4.2.1; ACI 318-11, 11.11.7.1; ACI 318-08, 11.11.7.1; ACI 318-05, 11.12.6.1; ACI 318-
02, 11.12.6.1; ACI 318-99, 11.12.6.1; CSA A23.3-14, 13.4.5.3; CSA A23.3-04, 13.4.5.3; CSA A23.3-94, 
13.4.5.3

74. ACI 318-14, 7.4.3.2, 8.4.3.2, 9.4.3.2; ACI 318-11, 13.5.4, 11.1.3; ACI 318-08, 13.5.4, 11.1.3; ACI 318-
05, 13.5.4, 11.1.3; ACI 318-02, 13.5.4, 11.1.3; ACI 318-99, 13.5.4, 11.1.3; CSA A23.3-14, 13.3.6.1, 
11.3.2; CSA A23.3-04, 13.3.6.1, 11.3.2; CSA A23.3-94, 13.4.6.1; CSA A23.3-94, 13.4.6.1; 11.3.2

δ = 30 − 50 c
d
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support. Factored shear force at the critical section is obtained from the analysis of the equivalent 
frame75.

Figure 2.16 Critical section for two-way shear

Figure 2-15 shows the general two-way shear area76 used by spSlab. Note that the shaded area 
represents the general case and is modified for special considerations as explained below.

Beams are considered in the two-way shear as indicated in Figure 2-15 by areas B1, B2, B3, B4, 
B5, and B6. Ordinarily, transverse beams transfer unbalanced moment to the column through 
torsion along the beam and not through shear between the slab and column. However, the code 
leaves the transfer method to the engineer’s judgment concerning the point at which punching 
shear is no longer applicable and beam shear becomes the dominate element in shear transfer to 
the column. spSlab makes no such distinction and computes unbalanced moment transfer stress 
without regard to any beams framing into the column. When a beam is present, the depth of the 
beam increases the depth of the critical section where it intersects with the beam. The distances 
from the face of the support to the critical section will also be increased, i.e. effective depth of the 
beam will be used to calculate the distance instead of effective depth of the slab, if it results in a 
critical section that is still within the beam. Otherwise, distances to the critical section are not 
increased.

75. ACI 318-14, 8.11.1.1; ACI 318-11, 13.7.1; ACI 318-08, 13.7.1; ACI 318-05, 13.7.1; ACI 318-02, 13.7.1; 
ACI 318-99, 13.7.1; CSA A23.3-04, 13.8.1.1; CSA A23.3-94, 13.9.1.1

76.ACI 318-14, 22.6.4.1; ACI 318-11, 11.11.1.2; ACI 318-08, 11.11.1.2; ACI 318-05, 11.12.1.2; ACI 318-
02, 11.12.1.2; ACI 318-99, 11.12.1.2; CSA A23.3-14, 13.3.3; CSA A23.3-04, 13.3.3; CSA A23.3-94, 
13.4.3
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For circular supports (column or column capital), ACI code and CSA standard differ in their 
treatment and do not provide clear guidance towards the applicability of an equivalent rectangular 
section for checking punching shear around circular supports. Therefore, spSlab provides as a 
default option the calculation of properties of the critical section for punching shear based on 
circular critical shear perimeter. This option is possible given that both the soffit around the 
perimeter of circular support and the soffit around the perimeter of circular critical shear perimeter 
are flat & critical shear perimeter stays circular.

If circular critical shear perimeter is not achievable or possible, then, the program calculates 
properties of the critical section for punching shear based on an equivalent rectangular support 
with the same centroid and equal perimeter length77. The equivalent rectangular support is a 
square with side length equal to  D/40.785 D where D is the diameter of the circular support as 
shown in Figure 2-15.

Figure 2.17 Critical section for circular column

While this approach is widely used, it produces an equivalent section but not an equivalent shear 
perimeter. It is, therefore, left to the end-user discretion to judge the use of the circular shear 
perimeter as it produces more conservative results compared with the traditional equivalent square 
option. 

The critical section is considered closed if the concrete slab around a column extends to a distance 
greater than or equal to the specified threshold value. In spSlab, the user may define the distance 
extended beyond the column face in order to consider the section closed. If the critical section 
does not meet the distance requirement, it is considered open.

77. See Fig.13-38(b) and Fig. 13-57 in Ref. [16], and Fig. 10.5(f) in Ref. [25]
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ACI 318-08 code introduced the definition of the shear cap78 which, alternatively to column 
capital, can be used to increase the critical section around the column. spSlab users can use the 
capital geometry to model a shear cap and calculate the punching shear through the thickness of 
the slab itself (shear cap acting as capital). Other failure modes, such as punching within the 
perimeter of the shear cap, need to be verified by the user manually. The dimensions of the 
substitute capital have to be selected such that the resulting critical section is equivalent to critical 
section for a column with a shear cap. ACI code79 requires shear caps to extend beyond the face of 
the column by at least the distance equal to cap depth, and so depth/extension ratio should not 
exceed 1.0. For column capitals depth/extension ratio should not be less than 1.0. Therefore to 
model shear cap acting as capital, the substituted capital should have depth/extension ratio equal 
to 1.0.

2.11.1 Critical Section for Interior Supports of Interior Frames

The critical section (Figure 2-17) consists of four vertical surfaces through the slab, located at 
distances of d/2 beyond the support faces.

The critical section for interior supports of interior frames is always closed. A closed section will 
have all its faces defined in Figure 2-15 resisting shear as indicated by Eq. 2-39

Eq. 2-39

If beams frame80 into the column, then the critical section includes the dimensions of the beams 
(B1 through B6 in Figure 2-15).

78. ACI 318-14, 2.3; ACI 318-11, 2.2; ACI 318-08, 2.2
79. ACI 318-14, 8.2.5; ACI 318-11, 13.2.6; ACI 318-08, 13.2.6
80. A beam is considered as framing into the column if the beam is within a face of the column.

∑A = AC
i=1

8

i



METHOD OF SOLUTION

|   57   |

Figure 2.18 Interior supports of interior frames

2.11.2 Critical Section for Exterior Supports of Interior Frames

The critical section for exterior supports of interior frames (Figure 2-18) will be either closed (full 
A7 and A6 for the first column or A1 and A2 for the last column in Figure 2-15) or open, depending 
upon the length of the cantilever in relation to slab thickness. The critical section will be 
considered closed when the clear cantilever span, lc, is greater than or equal to the distance defined 
by the user beyond the column face. The default value of the distance is 4 h when an ACI code is 
selected81 and 5 d for the CSA standard82. The user can modify the default value to accommodate 
scenarios when larger distances are required, e.g. 10 h for slabs with openings83. If beams frame 
into the column then the critical section includes the contributions from the beam dimensions (B1 
through B6 in Figure 2-16).

81.Critical Sections near Holes and at Edges in Ref.[15], pp.672, Fig 13-59 (b) and (c)
82.CSA A23.3-04 Figure N13.3.3.4 (b) in Ref. [12]; CSA A23.3-94 Figure N13.4.3.4 (b) in Ref. [14]
83. ACI 318-14, 22.6.4.3; ACI 318-11, 11.11.6; ACI 318-08, 11.11.6; ACI 318-05, 11.12.5; ACI 318-05, 

11.12.5; ACI 318-05, 11.12.5; CSA A23.3-14, 13.3.3.4; CSA A23.3-04, 13.3.3.4; CSA A23.3-94, 
13.4.3.4
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Figure 2.19 Exterior supports of interior frames

2.11.3 Critical Section for Interior Supports of Exterior Frames

Figure 2-19 shows the critical section for shear for an interior support of an exterior frame. Note 
that the section is considered as U-shaped (A5 = 0, A8 = 0, B3 = 0, B4 = 0 in Figure 2-15) and it 
extends up to the edge of the exterior face of the support. If beams frame into the column, then the 
critical section includes the contribution from the beam dimensions (B1 through B6 in Figure 2-
15). If the exterior cantilever span, lc, is greater than or equal to the distance defined by the user 

beyond the column face (the default value is 4 h when an ACI code is selected81 and 5 d for the 
CSA standard82), the section is treated as closed, that is, the support is treated as an interior 
support of an interior frame.

2.11.4 Critical Section for Exterior Supports of Exterior Frames

The critical section for an exterior support of an exterior frame will typically be L-shaped (A5 = 0, 
A6 = 0, A7 = 0, A8 = 0, B1 = 0, B3 = 0, and B4 = 0 in Figure 2-15).

If the cantilever span, lc, (in the direction of analysis) is greater than or equal to the distance 
defined by the user beyond the column face (the default value is 4 h when an ACI code is 
selected81 and 5 d for the CSA standard82), then the section is treated as a U-shaped interior 
support. If, in addition, the cantilever span in transverse direction is greater than or equal to the 
distance defined by the user beyond the column face, the section is treated as closed. If beams 
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frame into the column, then the critical section includes the contributions from the beam 
dimensions.

Figure 2.20 Interior supports of exterior frames

2.11.5 Computation of Allowable Shear Stress at Critical Section

One-way shear strength of slabs is limited84 to λ f2 c
′ . Two-way shear strength of slabs is 

affected by concrete strength, relationship between size of loaded area and slab thickness, loaded 
area aspect ratio, and shear-to-moment ratio at slab-column connections.

These variables are taken into account in the allowable shear stress, vc, computed at distances of d/
2 around the columns and drops (if applicable). For the ACI 318 code, vc is taken as the smallest 

of the 3 quantities85

Eq. 2-40

Eq. 2-41

Eq. 2-42

84. ACI 318-14, 22.5.5.1; ACI 318-11, 11.2.1.1;ACI 318-08, 11.2.1.1; ACI 318-05, 11.3.1.1; ACI 318-02, 
11.3.1.1; ACI 318-99, 11.3.1.1

85. ACI 318-14, 22.6.5.2, 22.6.5.3; ACI 318-11, 11.11.2.1; ACI 318-08, 11.11.2.1; ACI 318-05, 11.12.2.1; 
ACI 318-02, 11.12.2.1; ACI 318-99, 11.12.2.1
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where

βc = the ratio of the long to the short side of the column.
αs = a constant dependent on the column location, (40 for an interior 4-sided 

effective critical area, 30 for an exterior 3-sided critical area, 20 for a corner 2-
sided effective critical area.)

d = distance from the slab bottom to centroid of the slab tension reinforcement at 
support (average value is used if d changes along critical section perimeter)

b0 = the perimeter of the critical section
 = factor86 reflecting the reduced mechanical properties of lightweight concrete 

equal to 0.75 for all-lightweight concrete, 0.85 for sand-lightweight concrete 
and 1.0 for normal weight concrete. Refer to Table 2-1 for determination of 
concrete type.

For the CSA A23.387, the allowable shear stresses are calculated as the minimum of the following 
metric equations

Eq. 2-43

Eq. 2-44

Eq. 2-45

where

 = 0.19 for CSA A23.3-14/04 and 0.20 for CSA A23.3-94
αs = a constant dependent on the column location, (4 for an interior 4-sided 

effective critical area, 3 for an edge column, 2 for a corner column)
d = distance from the slab bottom to centroid of the slab tension reinforcement at 

support (average value is used if d changes along critical section perimeter)
φc = resistance factor for concrete88 equal to 0.60 for CSA A23.3-94 and for CSA 

A23.3-14/04 it is equal to 0.65 for regular and 0.70 for precast concrete
 = factor89 reflecting the reduced mechanical properties of lightweight concrete 

equal to 0.75 for structural low-density concrete, 0.85 structural semi-low-

86. ACI 318-14, 22.6.5.2, 22.6.5.3; ACI 318-11, 11.11.2.1; ACI 318-08, 11.11.2.1; ACI 318-05, 11.2.1.2; 
ACI 318-02, 11.2.1.2; ACI 318-99, 11.2.1.2

87. CSA A23.3-14, 13.3.4; CSA A23.3-04, 13.3.4; CSA A23.3-94, 13.4.4
88. CSA A23.3-14 8.4.2, 16.1.3; CSA A23.3-04 8.4.2, 16.1.3; CSA A23.3-94 8.4.2 
89. CSA A23.3-14, 8.6.5; CSA A23.3-04, 8.6.5; CSA A23.3-94, 8.6.5
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density concrete and 1.0 for normal density concrete. Refer to Table 2-1 for 
determination of concrete type.

≤ 8 MPa.

When the value of d is greater than 300mm, allowable stress vc obtained from the above three 

equations shall be multiplied by 1300/(1000+d) as required by CSA A23.3-14/04 code90.

The allowable shear stress around drops when waffle slabs are used is computed as

Eq. 2-46

For waffle slab systems with valid ribs defined earlier in this chapter, the allowable shear stress is 
increased by 10% for ACI designs.91 

2.11.6 Computation of Factored Shear Force at Critical Section

The factored shear force Vu in the critical section, is computed as the reaction at the centroid of the 
critical section (e.g., column centerline for interior columns) minus the self-weight and any 
superimposed surface dead and live load acting within the critical section. If the section is 
considered open, two 45 degree lines are drawn from the column corners to the nearest slab edge 
(lines AF and DE in Figure 2-19) and the self-weight and superimposed surface dead and live 
loads acting on the area ADEF are omitted from Vu.

2.11.7 Computation of Unbalanced Moment at Critical Section

The factored unbalanced moment used for shear transfer, Munbal, is computed as the sum of the 
joint moments to the left and right. Moment of the vertical reaction with respect to the centroid of 
the critical section is also taken into account by

Eq. 2-47

90. CSA A23.3-14, 13.3.4.3; CSA A23.3-04, 13.3.4.3
91. ACI 318-14, 8.8.1.5, 9.8.1.5; ACI 318-11, 8.13.8; ACI 318-08, 8.13.8; ACI 318-05, 8.11.8; ACI 318-02, 

8.11.8; ACI 318-99, 8.11.8

fc
′

v =

2λ f for ACI,

0.20 ϕ λ f for CSA A23.3-94,

0.19 ϕ λ f for CSA A23.3-04.

c

c
′

c c
′

c c
′
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where

Mu,left = factored bending moment at the joint on the left hand side of the joint,
Mu,right = factored bending moment at the joint on the right hand side of the joint,
Vu = factored shear force in the critical section described above,
cg = location of the centroid of the critical section with respect to the column 

centerline (positive if the centroid is to the right in longitudinal direction with 
respect to the column centerline). 

2.11.8 Computation of Shear Stresses at Critical Section

The punching shear stress computed by the program is based on the following92

Eq. 2-48

where

Vu = factored shear force in the critical section described above,
Ac = area of concrete, including beam if any, resisting shear transfer. 

Under conditions of combined shear, Vu, and unbalanced moment, Munbal, γvMunbal is assumed to 
be transferred by eccentricity of shear about the centroidal axis of the critical section. The shear 
stresses computed by the program for this condition correspond to93

Eq. 2-49

Eq. 2-50

92. ACI 318-14, 8.4.4.2.3; ACI 318-11, 11.11.7.2; ACI 318-08; 11.11.7.2; ACI 318-05, 11.12.6.2; ACI 318-
02, 11.12.6.2; ACI 318-99, 11.12.6.2; CSA A23.3-14, 13.3.5; CSA A23.3-04, 13.3.5; CSA A23.3-94, 
13.4.5

93. ACI 318-14, R8.4.4.2.3; ACI 318-11, R11.11.7.2; ACI 318-08, R11.11.7.2; ACI 318-05, R11.12.6.2; 
ACI 318-02, R11.12.6.2; ACI 318-99, R11.12.6.2; CSA A23.3-14, 13.3.5.5; CSA A23.3-04, 13.3.5.5; 
CSA A23.3-94, 13.4.5.5; Ref. [24]

v
V
Au
u

c


v
V
A

γ M c
JAB

u

c

v unbal AB

c
 

γ
v

V
A

M c
JCD

u

c

v unbal CD

c
 



METHOD OF SOLUTION

|   63   |

where

Munbal = factored unbalanced moment transferred directly from slab to column, as 
described above,

γv = (1 - γf) Eq 2-51
is a fraction of unbalanced moment considered transferred by the eccentricity 
of shear about the centroid of the assumed critical section,94 

c = distance from centroid of critical section to the face of section where stress is 
being computed,

Jc = property of the assumed critical section analogous to polar moment of inertia.

Factor γf in Eq. 2-51 is calculated as95

Eq. 2-52

where

b1 = width of critical section in the direction of analysis,
b2 = width of the critical section in the transverse direction.

If an ACI 318 standard is selected then the program provides an option to use an increased value96 
of γf. For edge and corner columns with unbalanced moment about an axis parallel to the edge, the 
value can be increased to 1.0 if the factored shear force at the support doesn’t exceed 0.75Vc for 
edge columns and 0.5Vc for corner columns. For ACI 318-99, ACI 318-02, and ACI 318-05, 
condition that reinforcement ratio in the effective slab width doesn’t exceed 0.375b must also be 
satisfied to apply the increase. For interior columns and for edge columns with unbalanced 
moment perpendicular to the edge, f can be increased 25% but the final value of f cannot exceed 
1.0. The increase can be applied if the shear doesn’t exceed 0.4Vc. Also, the net tensile strain in 
the effective slab has to exceed 0.010 for the ACI 318-08, ACI 318-11, and ACI 318-14. For 
earlier ACI 318 editions, the condition that reinforcement ratio does not exceed 0.375b applies.

spSlab calculates vu as the absolute maximum of vAB and vCD. Local effects of concentrated loads 
are not computed by spSlab and must be calculated manually.

94. ACI 318-14, 8.4.4.2.1, 8.4.4.2.2; ACI 318-11, 11.11.7.1; ACI 318-08, 11.11.7.1; ACI 318-05, 11.12.6.1; 
ACI 318-02, 11.12.6.1; ACI 318-99, 11.12.6.1; CSA A23.3-04, Eq. 13-8; CSA A23.3-94, Eq. 13-8

95.ACI 318-14, 8.4.2.3.2; ACI 318-11, 13.5.3.2; ACI 318-08, 13.5.3.2; ACI 318-05, 13.5.3.2; ACI 318-02, 
13.5.3.2; ACI 318-99, 13.5.3.2; CSA A23.3-04, Eq. 13-8; CSA A23.3-94, Eq. 13-7

96. ACI 318-14, 8.4.2.3.4; ACI 318-11, 13.5.3.3; ACI 318-08, 13.5.3.3; ACI 318-05, 13.5.3.3; ACI 318-02, 
13.5.3.3; ACI 318-99, 13.5.3.3;
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b b
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2.11.9 Shear Resistance at Corner Columns

For the CSA A23.3 code in design mode, the program performs one-way shear resistance check in 
the vicinity of corner columns. A corner column is determined in spSlab as the exterior support 
along an exterior left or exterior right equivalent frame. For slabs with edge beams or drop panels 
a supplementary check including the contribution of these components should be performed 
manually.

For the CSA A23.3-94 edition, a critical shear section is located d/2 from the column corner. The 
minimum length section is selected using an optimization algorithm which analyzes sections at 
different angles. The extension to the cantilevered portion is considered by a length not to exceed 
effective slab thickness d. 

For the CSA A23.3-14/04 edition, a critical shear section is located not further than d/2 from the 
edge of the column or column capital. The extension to the cantilevered portion is considered by a 
length not to exceed effective slab thickness d. The factored shear resistance is calculated as 
follows97

Eq. 2-53

where

β = factor accounting for shear resistance of cracked concrete98

2.11.10 Shear Resistance in Slab Bands

When performing two-way shear analysis for models with non-continuous longitudinal slab bands 
a non-standard partial drop panel is anticipated to close the slab band and the calculations are 
performed as follows. Punching shear around the column is checked using effective depth of the 
slab band on one side of the column and the depth of the extension drop panel on the other side of 
the column. On each four sides of the column the critical section is located ½ of the respective 
depth from the face of the column. Punching shear calculation around the drop panel/slab band 
assumes that the plane of critical section, which cuts perpendicularly through slab band, is located 
½d of the slab band from the face of column. For three remaining column faces critical section is 
located ½d of the slab measured from the respective edges of drop panel or slab band.

97. CSA A23.3-14, 13.3.6.2; CSA A23.3-04, 13.3.6.2
98. CSA A23.3-14, 11.3.6.2 and 11.3.6.3; CSA A23.3-04, 11.3.6.2 and 11.3.6.3

 v βλφ fc c c
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2.12 One-Way Shear Analysis of Longitudinal Beams 
and Slabs

When longitudinal beams are present in a span, the program computes the shear reinforcement 
requirements for the beams. Table “Longitudinal Beam Shear Reinforcement Required” in the 
program output provides values of Vu, Vc, and Av/s for selected segment locations of each span. 
Segment lengths are chosen not to exceed the beam section depth. The beginning of first segment 
and the end of last segment correspond to the locations of critical sections on the left and right 
support respectively. The critical sections are located at a distance d, the effective beam depth, 
away from the column face at both the left and the right ends of the beam. However, if 
concentrated loads are present within distance d from the column face, critical section is selected 
at the column face. 

Vu is computed from the load acting over the entire width of the design strip. The program makes 
no distinction between shallow beams (f1l2/l1 < 1) and deeper beams (f1l2/l1 > 1).

2.12.1 Shear Calculations for ACI 318 and CSA A23.3-94

Shear strength provided by concrete, Vc, is computed by99

where

c = resistance factor for concrete100 equal to 0.60.

In CSA A23.3-94 design, for beams without minimum stirrup reinforcement and greater than 
300 mm deep, Vc is calculated from the following equation101

99. ACI 318-14, 22.5.5.1; ACI 318-11, 11.2.1.1; ACI 318-08, 11.2.1.1; ACI 318-05, 11.3.1.1; ACI 318-02, 
11.3.1.1; ACI 318-99, 11.3.1.1; ACI 318M-08, 11.2.1.1; ACI 318M-05, 11.3.1.1; ACI 318M-02, 
11.3.1.1; ACI 318M-99, 11.3.1.1; CSA A23.3-94, 11.3.5.1

100. CSA A23.3-94, 8.4.2
101. CSA A23.3-94, 11.3.5.2

λ f b d for ACI

λ f b d
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ϕ λ f b d for
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0.17 for ACI 318M-11/08/05,
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Eq. 2-55

When V > φV / 2u c , the beam must be provided with at least a minimum shear reinforcement of102

Eq2-56

where

Av = area of all stirrup legs,
s = stirrups spacing,
bw = longitudinal beam width,
fyt = yield strength of the shear reinforcement.

In the investigation mode, if the ACI-318 spacing requirement for shear reinforcement103 or 
minimum shear reinforcement requirement are not met, the shear strength of the section is taken as 
one-half of the shear strength provided by concrete.

When V > φVu c, shear reinforcement must be provided so that

Eq. 2-57

102. ACI 318-14, 9.6.3.3; ACI 318-11, 11.4.6.3; ACI 318-08, 11.4.6.3; ACI 318-05, 11.5.6.3; ACI 318-02, 
11.5.5.2; ACI 318-99, 11.5.5.2; ACI 318M-08, 11.4.6.3; ACI 318M-05, 11.5.6.3; ACI 318M-02, 
11.5.5.2; ACI 318M-99, 11.5.5.2; CSA A23.3-94, 11.2.8.4

103. ACI 318-14, 9.7.6.2.2, 9.7.6.2.3; ACI 318-11, 11.4.5; ACI 318-08, 11.4.5; ACI 318-05, 11.5.5; ACI 
318-02, 11.5.4; ACI 318-99, 11.5.4
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where

Vu = factored shear force at the section being considered
Vs = shear strength provided by shear reinforcement
d = effective depth of the beam at the same location
 = strength reduction factor for shear calculations104 equal to 0.85 for ACI 318-

99 and equal to 0.75 for ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, 
and ACI 318-02

s = resistance factor for reinforcement105 equal to 0.85

The capacity of shear reinforcement Vs is limited to V = f b d8s,max c
′
w (V = λϕ f b d0.8s,max c c

′
w  

for CSA A23.3-94). When Vu exceeds Vc+Vs,max (Vc+Vs,max for CSA A23.3-94), the beam 

section dimensions must be increased or a higher concrete strength must be provided.106 

When V ≤ φ10 f b du c
′
w , the spacing is computed as

Eq. 2-58

where

Asb = stirrup bar area (one leg)
n = number of stirrup legs

The maximum stirrup spacing for ACI codes107 must not exceed d/2 or 24 in when V ≤ f b d4s c
′
w . 

V ≤ f b d0.33s c
′
w






. When V > f b d4s c

′
w , the maximum stirrup spacing must be reduced by half, 

to d/4 or 12 in. For the CSA A23.3-94 standard108, maximum spacing must not exceed the smaller 

of 0.7 d and 600 mm when V < λϕ f b d0.1u c c
′
w  or the smaller of 0.35 d and 300 mm when 

V ≥ λϕ f b d0.1u c c
′
w .

104. ACI 318-14, 21.2.1; ACI 318-11, 9.3.2.3; ACI 318-08, 9.3.2.3; ACI 318-05, 9.3.2.3; ACI 318-02, 
9.3.2.3; ACI 318-99, 9.3.2.3

105. CSA A23.3-94, 8.4.3
106. ACI 318-14, 22.5.1.2; ACI 318-11, 11.4.7.9; ACI 318-08, 11.4.7.9; ACI 318-05, 11.5.7.9; ACI 318-02, 

11.5.6.9; ACI 318-99, 11.5.6.9; CSA A23.3-94, 11.3.4
107. ACI 318-14, 9.7.6.2.2, 9.7.6.2.3; ACI 318-11, 11.4.5; ACI 318-08, 11.4.5; ACI 318-05, 11.5.5; ACI 

318-02, 11.5.4; ACI 318-99, 11.5.4; CSA A23.3-94, 11.2.11
108. CSA A23-3-94, 11.2.11

s n A1 ( )A
s
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When V > f b d8s c
′
w  V ≤ f b d0.66s c

′
w






 for ACI codes and V > λ ϕ f b d0.8s c c

′
w  for CSA A23.3-

94 code, the beam section dimensions must be increased or a higher concrete strength must be 
provided109.

The minimum shear reinforcement requirement is waived110 for joist construction and for beams 
satisfying the following criteria

For ACI 318-14, ACI 318-11 and ACI 318-08

• Beams with depth not exceeding 10 in. [250 mm].

• Beams integral with slabs (assumed by the program for all beams in two-way systems and 
beams within one-way slabs with overall width larger than effective beam flange width), 
with beam depth not exceeding 24 in. [600 mm] and not greater than the larger of 2.5 
times flange thickness and 0.5 times web width.

For ACI 318-05/02/99

• Beams with depth not exceeding the largest of 10 in. [250 mm], 2.5 times flange thick-
ness, and half of web width (rectangular beams are assumed by the program to have flange 
thickness equal to zero and web width equal to beam width).

For CSA A23.3-94

• Beams with depth not exceeding 250 mm.

• Beams integral with slabs (assumed by the program for all beams in two-way systems and 
beams within one-way slabs with overall width larger than effective beam flange width), 
with beam depth not exceeding the larger of 600 mm and 0.5 times web width.

2.12.2 Shear Calculations for CSA A23.3-14/04

For CSA A23.3-04 code, the program calculates shear strength Vc provided by concrete from the 

following equation111

Eq. 2-59

109. ACI 318-14, 22.5.1.2; ACI 318-11, 11.4.7.9; ACI 318-08, 11.4.7.9; ACI 318-08, ACI 318-05, 11.5.7.9; 
ACI 318-02, 11.5.6.9; ACI 318-99, 11.5.6.9, CSA A23.3-94, 11.3.4

110. ACI 318-14, 7.6.3.1, 9.6.3.1; ACI 318-11, 11.4.6.1; ACI 318-08, 11.4.6.1; ACI 318-05, 11.5.6.1; ACI 
318-02, 11.5.5.1; ACI 318-99, 11.5.5.1; ACI 318M-08, 11.4.6.1; ACI 318M-05, 11.5.6.1; ACI 318M-02, 
11.5.5.1; ACI 318M-99, 11.5.5.1; CSA A23.3-94, 11.2.8.1

111. CSA A23.3-14, 11.3.4; CSA A23.3-04, 11.3.4

V φ λβ f b dc c c w v 
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where

c = resistance factor for concrete equal to 0.65 for regular and 0.70 for precast 
concrete

λ = factor to account for low-density concrete
b w = beam web width
d v = effective shear depth equal to greater of 0.9d or 0.72h
β = factor accounting for shear resistance of cracked concrete

< 8 MPa.

When V > Vu c, the beam must be provided with at least minimum shear reinforcement112. 
Additionally minimum shear reinforcement is required for beam sections with overall thickness 
exceeding 750mm. Minimum area of shear reinforcement is calculated from the following 
formula113

Eq. 2-60

Shear strength provided by shear reinforcement, Vs, is calculated from the following equation114

Eq. 2-61

where

s = resistance factor for reinforcement steel115 equal to 0.85
Av = area of shear reinforcement within distance s
f y = yield strength of reinforcement
d v = effective shear depth equal greater of 0.9d or 0.72h
s = spacing of transverse reinforcement
θ = the angle of inclination of diagonal compressive stresses.

Spacing of transverse reinforcement, s, must not exceed the smaller116 of 0.7 d and 600 mm when 

V ≤ λϕ f b d0.125u c c
′
w  or the smaller117 of 0.35 d and 300 mm when V > λϕ f b d0.125u c c

′
w .

112. CSA A23.3-14, 11.2.8.1; CSA A23.3-04, 11.2.8.1
113. CSA A23.3-14, 11.2.8.2; CSA A23.3-04, 11.2.8.2
114. CSA A23.3-14, 11.3.5.1; CSA A23.3-04, 11.3.5.1
115. CSA A23.3-14, 8.4.3(a); CSA A23.3-04, 8.4.3(a)
116. CSA A23.3-14, 11.3.8.1; CSA A23.3-04, 11.3.8.1
117. CSA A23.3-14, 11.3.8.3; CSA A23.3-04, 11.3.8.3

fc
′

A f
b s
f

0.06v c
w

y
 

V
φA f d θ

s

cot( )
s

s v y v




METHOD OF SOLUTION

|   70   |

When V > λ β f b d0.25u c
′
w v, the beam section dimensions must be increased or a higher concrete 

strength must be provided118.

The program recognizes special member types and assumes values of β = 0.21 and θ = 42deg in 
the following cases119

• Slabs (including slab bands for CSA code) having thickness not exceeding 350 mm.

• Beams having thickness not exceeding 250 mm.

• Concrete joist construction.

• Beams cast monolithically with the slab and having the depth below the slab not exceed-
ing one-half of the width or 350mm.

For other general cases the program utilizes the so called simplified method. The value of θ is 
assumed as 35deg. For sections having or requiring at least minimum transverse reinforcement 
β = 0.18 is assumed. For sections with no transverse reinforcement the value of β is calculated as 
follows120

Eq. 2-62

2.12.3 Shear Distribution

When no ribs are present, one way shear is proportioned to the slab and beam according to the 
following ratios

Eq. 2-63

When ribs are present (joist systems), one way shear is proportioned to the slab and beam 
according to the following ratios of cross-section areas

Eq. 2-64

Per requirement121 of CSA A23.3-14/04, the program allows distributing one-way shear in the 
slab between column and middle strips using the distribution factors which are proportional to the 
factors used for negative moment distribution. The fraction of the shear transferred to the beam 
remains unchanged irrespective of the use of this feature. This functionality is also provided for 
other design codes, to be selected at engineer’s discretion.

118. CSA A23.3-94, 11.3.3
119. CSA A23.3-14, 11.3.6.2; CSA A23.3-04, 11.3.6.2
120. CSA A23.3-14, 11.3.6.3(b); CSA A23.3-04, 11.3.6.3(b)
121. CSA A23.3-14, 13.3.6.1; CSA A23.3-04, 13.3.6.1

β = 230
1000 + dv

α l / l , 1 − α l / lf1 2 1 f1 2 1
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2.12.4 One-Way Shear in Slab Bands (CSA A23.3-14/04)

One-way shear calculations in slab bands are done similar to shear in two-way slabs, except the 
column strip is substituted by the band strip. Shear forces are distributed between the band and the 
middle strip proportionally to negative moment distribution factors. Transverse reinforcement is 
not considered.

2.12.5 Shear in Drop Panels

When calculating one-way shear capacity for two-way solid and waffle slabs, the contribution of 
the drop panel cross-section can be optionally selected. For such slabs, the shear capacity is 
calculated in three regions, with increased Vc values in support (drop panel) locations. In case 
shear is distributed into column and middle strips, drop panel contribution is divided according to 
the share of drop panel cross-section area in each strip.

2.13 Torsion and Shear

Torsion analysis can be engaged for beam and one way systems using the Torsion Analysis and 
Design check box located on the Solve Options tab in the Input | General Information dialog 
box.

As far as torsional analysis is concerned, it is assumed that columns provide perfectly rigid 
supports so there is no transfer of torsional moments between spans. Within a span, torsional 
moments are considered only if a longitudinal beam is present. Torsion can be induced by 
concentrated and redistributed torsional loads and also, in the case of a beam with unsymmetrical 
cross sections, by self weight and area loads. A T-section with different flange widths is an 
example of a cross section which is not symmetrical. It can be obtained if a beam and a slab with 
different left and right widths are combined in the same span. However, in order for a flange to be 
considered in the torsional analysis its thickness has to be greater than twice the cover. If a flange 
is wider than the effective width then only the effective width is taken into account.

The design for torsion is based on a thin-walled tube, space truss analogy. For the Canadian code 
the simplified method is used. The program allows both equilibrium and compatibility torsion 
conditions. In the equilibrium mode, which is assumed by default, unreduced total value of the 
torsional design moment is used in the design. In the compatibility mode122, factored torsional 
moments that exceed cracking moment Ter (0.67 Ter for CSA) are reduced to the value of Ter (0.67 

122. ACI 318-14, 22.7.5.1; ACI 318-11, 11.5.2.2; ACI 318-08, 11.6.2.2; ACI 318-05, 11.6.2.2; ACI 318-02, 
11.6.2.2; ACI 318-99, 11.6.2.2; CSA A23.3-14, 11.2.9.2; CSA A23.3-04, 11.2.9.2; CSA A23.3-94, 
11.2.9.2
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Ter for CSA). However, it is user’s responsibility to determine which mode is appropriate and the 
program does not perform any redistribution of internal forces if compatibility torsion is selected. 

If torsion analysis is engaged then both torsion and shear actions contribute to the amount of 
required transverse (stirrup) reinforcement. However, additional longitudinal bars distributed 
along the perimeter of a cross-section are also required to provide torsional capacity.

For torsion design a span is divided into segments in the same way as for shear design. Governing 
values within a segment are used to design the whole segment. For stirrups, the governing values 
of torsional moment and shear force (acting simultaneously) will be these that produce the highest 
intensity of required stirrup area. On the other hand, the required area of longitudinal bars depends 
only on the torsional moment so the highest absolute value of torsional moment will govern. Since 
stirrup area depends both on shear and torsion whereas longitudinal bar area depends only on 
torsion, the governing values for stirrups and longitudinal bars can occur at different locations 
within a segment and for different load combinations. Governing values along with their location 
and associated load combination are provided in the design results report.

Effect of torsion within a segment will be neglected if the factored torsional moment, Tu, at every 
segment location is less than one fourth of the torsion cracking moment, Ter, which equals

for ACI code123

Eq. 2-65

for CSA A23.3-94 code124 

Eq. 2-66

for CSA A23.3-14/04 code125

Eq. 2-67

Acp denotes the area enclosed by outside perimeter of concrete section and pcp is equal to the 
outside perimeter of concrete section.

123. ACI 318-08, R11.5.1; ACI 318-05, R11.6.1; ACI 318-02, R11.6.1; ACI 318-99, R11.6.1;
124. CSA A23.3-94, 11.2.9.1
125. CSA A23.3-04, 11.2.9.1
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To be adequate for torsion design, a section has to be proportioned in such a way that combined 
shear stress due to shear and torsion does not exceed the limit value specified by the code. In ACI 
code this condition reads as126

Eq. 2-68

The simplified method of CSA A23.3-94 standard defines this relation as127

Eq. 2-69

Similar requirement for CSA A23.3-04 reads as follows128

Eq. 2-70

In above relations, Aoh is the area enclosed by centerline of the outermost closed transverse 
reinforcement and ph is the perimeter of that area. By default, flanges do not contribute to Aoh and 
ph. For sections with flanges, flanges will only be taken into account for Aoh and ph if the option 
to include stirrups in flanges is engaged in the torsion design. In the program output, the combined 
stress (left hand side of the above inequalities) is denoted as vf and the limit value as ϕsvt.

The required intensity of stirrup area to provide required torsional capacity is calculated from the 
following formula129

Eq. 2-71

126. ACI 318-14, 22.7.7.1; ACI 318-11, 11.5.3.1; ACI 318-08, 11.5.3.1; ACI 318-05, 11.6.3.1; ACI 318-02, 
11.6.3.1; ACI 318-99, 11.6.3.1;

127. CSA A23.3-94, 11.3.9.8
128. CSA A23.3-14, 11.3.10.4(b); CSA A23.3-04, 11.3.10.4(b)
129. ACI 318-14, 22.7.6.1; ACI 318-11, 11.5.3.6; ACI 318-08, 11.5.3.6; ACI 318-05, 11.6.3.6; ACI 318-02, 

11.6.3.6; ACI 318-99, 11.6.3.6; CSA A23.3-14, 11.3.10.3; CSA A23.3-04, 11.3.10.3; CSA A23.3-94, 
11.3.9.4
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where the gross area enclosed by the shear path130, Ao, is taken as 0.85Aoh. At /s is the quantity per 

stirrup leg. Concrete shear and torsion strength reduction factor131, , for ACI-318 codes is equal 
to 0.75 for the 99 edition and 0.75 for later editions. 

The total requirement for stirrup intensity combining shear and torsion equals132

Eq. 2-72

This value cannot be taken less than minimum stirrup area required by the codes. The minimum 
code requirements can be written in the following form133

Eq. 2-73

In addition to stirrup spacing requirement defined for shear, program imposes one more torsion 
specific requirement for all ACI codes134 which limits the spacing to the smallest of p / 8h , and 
12 in [300 mm]. Based on the total required stirrup area intensity and spacing requirements, the 
program attempts to select stirrups taking also into account that if stirrups with more than two legs 
have to be used then the area of an outer leg must not be less than At.

2.13.1 Additional Longitudinal Reinforcement for ACI 318 and CSA 
A23.3-94

The area of additional longitudinal reinforcement, Aℓ, is calculated from135

130. CSA A23.3-14, 11.3.10.3; CSA A23.3-04, 11.3.10.3; CSA A23.3-94, 11.3.9.7
131. ACI 318-14, 21.2.1; ACI 318-11, 9.3.2.3; ACI 318-08, 9.3.2.3; ACI 318-05, 9.3.2.3; ACI 318-02, 

9.3.2.3; ACI 318-99, 9.3.2.3
132. ACI 318-14, R9.5.4.3; ACI 318-11, R11.5.2.8; ACI 318-08, R11.5.3.8; ACI 318-05, R11.6.3.8; ACI 

318-02, R11.6.3.8; ACI 318-99, R11.6.3.8
133. ACI 318-14, 9.6.4.2; ACI 318-11, 11.5.5.2; ACI 318-08, 11.5.5.2; ACI 318-05, 11.6.5.2; ACI 318-02, 

11.6.5.2; ACI 318-99, 11.6.5.2; ACI 318M-11, 11.5.5.2; ACI 318M-08, 11.5.5.2; ACI 318M-05, 11.6.5.2; 
ACI 318M-02, 11.6.5.2; ACI 318M-99, 11.6.5.2; CSA A23.3-14, 11.2.8.2; CSA A23.3-04, 11.2.8.2; CSA 
A23.3-94, 11.2.8.4

134. ACI 318-14, 9.7.6.3.3; ACI 318-11, 11.5.6.1; ACI 318-08, 11.5.6.1; ACI 318-05, 11.6.6.1; ACI 318-02, 
11.6.6.1; ACI 318-99, 11.6.6.1
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Eq. 2-74

For ACI code it is also checked against the following minimum value136

Eq. 2-75

where At / s is calculated from Eq. 2-56 but is not taken less than 25bw / fyt. Longitudinal bars are 
selected in such a way that their area is not less than Aℓ > Aℓ,min and that number of longitudinal 
bars in a section is enough to provide a bar in every corner of a stirrup and preserve spacing 
between bars not higher than 12 in [300 mm]. Also, bar sizes are selected not to have diameter less 
than No. 3 bar and not less than 1/24 of stirrup spacing for ACI codes137 and 1/16 for CSA 
standard138.

2.13.2 Additional Longitudinal Reinforcement for CSA A23.3-14/04

The additional longitudinal reinforcement, Aℓ, will only be calculated for CSA A23.3-14/04 if 
option COMBINED M-V-T REINF. DESIGN is unchecked in the Solve Options dialog window. If 
this option is checked (default setting) then no additional longitudinal reinforcement is calculated 
because the regular top and bottom reinforcement will automatically be proportioned to resist 
combined action of flexure, shear and torsion.

Proportioning of longitudinal reinforcement for sections subjected to combined shear and torsion 
in flexural regions is based on the requirement that the resistance of the longitudinal reinforcement 
has to be greater or equal to the axial force that can be developed in this reinforcement. In sections 
with no axial action (Nf = 0 and Vp = 0) that force is equal to139

• flexural tension side 

 and 

135. ACI 318-14, 22.7.6.1; ACI 318-11, 11.5.3.7; ACI 318-08, 11.5.3.7; ACI 318-05, 11.6.3.7; ACI 318-02, 
11.6.3.7; ACI 318-99, 11.6.3.7; CSA A23.3-94, 11.3.9.5

136. ACI 318-14, 9.6.4.3, 9.7.5.1; ACI 318-11, 11.5.5.3; ACI 318-08, 11.5.5.3; ACI 318-05, 11.6.5.3; ACI 
318-02, 11.6.5.3; ACI 318-99, 11.6.5.3

137. ACI 318-14, 9.7.5.1, 9.7.5.2; ACI 318-11, 11.5.6.2; ACI 318-08, 11.5.6.2; ACI 318-05, 11.6.6.2; ACI 
318-02, 11.6.6.2; ACI 318-99, 11.6.6.2

138. CSA A23.3-14, 11.2.7; CSA A23.3-04, 11.2.7; CSA A23.3-94, 11.2.7
139. CSA A23.3-14, 11.3.9.2, 11.3.9.3, 11.3.10.6; CSA A23.3-04, 11.3.9.2, 11.3.9.3, 11.3.10.6
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Eq. 2-76

• flexural compression side

 and 

Eq. 2-77

These forces can be decomposed140 into flexure and shear components. The flexure components, 
Flt,flexure and Flc,flexure, account for the action of the bending moment, Mf, whereas the shear 
components, Flt,shear and Flc,shear, account for the action of the shear force, Vf, and the torsional 
moment, Tf. The amounts of reinforcement needed to resist the flexure components are calculated 
separately in the flexure design procedure. The total amount of the additional longitudinal 
reinforcement, Aℓ, needed to resist shear and torsion will be determined as follows

Eq. 2-78

If only torsion is present (Vf = 0 and Vs = 0), then (assuming141 θ = 35°) Aℓ would reduce to

Eq. 2-79

which is comparable (and conservative) to the additional amount of longitudinal reinforcement 
due to torsion required in accordance with the previous edition of the CSA A23.3 standard142. 

2.13.3 Investigation Mode

In the investigation mode when transverse and longitudinal reinforcement is input by the user, the 
program checks the combined shear and torsional capacity of the system in terms of required and 
provided reinforcement area. In other words, the provided area of reinforcement is compared to 

140. See Eq. 7-42, pp 294 in Ref. [7]
141. CSA A23.3-14, 11.3.6.3; CSA A23.3-04, 11.3.6.3
142. CSA A23.3-94, 11.3.9.5
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the area of reinforcement required to resist applied loads. This is a different approach than for 
flexure and shear actions without coupling where design forces are directly compared to capacity. 
In the case where torsion and shear stirrup requirements are combined, the approach of comparing 
total reinforcement area is more convenient since it does not require dividing stirrup area into a 
part that resists torsion only and a part that resists shear only. For consistency, additional 
longitudinal reinforcement required for torsion and shear is also checked in terms of provided and 
required area. Other requirements, e.g. bar or stirrup spacing, number of longitudinal bars, area of 
stirrup outer leg, and combined stresses in concrete due to shear and torsion are checked also. 
Exceeded capacity and other conditions are flagged in the Design Results section of the report.

2.14 Area of Reinforcement

The program calculates the required area of reinforcement (top and bottom) based on the values of 
bending moment envelope within the clear span. For rectangular sections with no compression 
reinforcement, the design flexural strength of the column strip, middle strip and beam must equal 
the factored design moment

Eq. 2-80

The reinforcement can therefore be computed from

Eq. 2-81

For CSA A23.3

Eq. 2-82

The effective depth of the section is taken as the overall section depth minus the distance from the 
extreme tension fiber to the tension reinforcement centroid. The column strip depth may include 
all or part of the drop panel depth. The drop depth will not be included in the effective depth of the 
column strip when the drop does not extend at least one-sixth the center-to-center span length in 
all directions, or when the drop depth below the slab is less than one-quarter the slab depth. If the 
drop extends at least one-sixth the center-to-center span length and the drop depth is greater than 
one-quarter the distance from the edge of the drop panel to the face of the column or column 
capital, the excess depth will not be included in the column strip effective depth. If the drop width 
is less than the column strip width, the drop width will be used in the computation of the required 
reinforcement.
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When computing negative slab reinforcement and additional reinforcement for negative 
unbalanced moments over the supports, the contribution of the depth of transverse beam can be 
optionally selected. The contribution of transverse beam will be considered, if it extends beyond 
the critical section and if its depth exceeds the depth of the drop panel. The increase of the slab 
thickness is limited to ¼ of the extent of the transverse beam beyond the face of support, identical 
to design depth limitations for drop panels. If transverse beam depth exceeds the limit, excess 
depth is disregarded in the reinforcement calculations.

For two-way slabs with beams, an option exists when designing reinforcement for positive 
bending moments, to include a portion of slab as beam flanges143

 (T-Section). The width of the column strip is then decreased accordingly. The extent of the flanges 
on each side is limited to four times slab thickness and not more that the projection of the beam 
under the slab. When this option is not selected, beam geometry is treated as rectangular. When 
calculating required reinforcement for negative bending moments the geometry of the beam is 
treated as rectangular, having beam width equal to web width. However, when a T-Section is 
selected, reinforcing bar design is performed assuming that they are distributed across the beam 
width including the flanges.

For the ACI 318-99 code the strength reduction factor for flexure calculations is specified as 
=0.90.144 For the ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-02 codes the 
strength reduction factor for tension-controlled sections (εt > 0.005) is equal =0.90. For 
transition sections (fy / Es < εt < 0.005) the strength reduction factor can be linearly interpolated by 

the formula145

Eq. 2-83

ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-02 codes specify the strength 
reduction factor for compression controlled sections (t < fy Es) as equal =0.65. The reduction 
factors for transition or compression controlled sections have application primarily in 
investigation mode of the program. In design mode the program performs the calculations 
assuming a tension controlled section (t ≥ 0.005) or a section with compressive reinforcement (if 
enabled).

The ACI 318-99 code146 requires keeping the steel ratio below the maximum value, max, equal to 

75% of steel ratio producing balanced strain condition, b, where147

143. See footnote 50
144. ACI 318-99, 9.3.2
145. ACI 318-14, 21.2.1; ACI 318-11, 9.3.2; ACI 318-08, 9.3.2; ACI 318-05, 9.3.2; ACI 318-02, 9.3.2
146. ACI 318-99, 10.3.3
147. ACI 318-99, 8.4.3
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Eq. 2-84

with

β1 =

For CSA code the value of max equals b and is calculated as follows148

Eq. 2-85

where

a1 =

β1 =

The ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, and ACI 318-02 codes control the 
amount of reinforcement by limiting the value of net tensile strain (t ≥ 0.004)149. The program 
satisfies this condition by assuming a tensioned controlled section with t ≥ 0.005. From this 
assumption the equivalent maximum reinforcement ratio for rectangular section can be written as

Eq. 2-86

If the calculated reinforcement exceeds the maximum allowed, a message will appear in the 
output. In such cases, it is recommended that the engineer review the slab thickness to ensure a 
more satisfactory design. If compression reinforcement calculations are enabled, the program will 
attempt to add compression reinforcement to the section. The program is capable to design 
compressive reinforcement for any design strip (column, middle, and beam) including also 
unbalanced moment strip150.

148. CSA A23.3-14, 10.5.2; CSA A23.3-04, 10.5.2; CSA A23.3-94, 10.5.2; Eq. 4-24, pp 110 in Ref. [16]
149. ACI 318-14, 7.3.3.1, 8.3.3.1, 9.3.3.1; ACI 318-11, 10.3.5; ACI 318-08, 10.3.5; ACI 318-05, 10.3.5; 

ACI 318-02, 10.3.5
150. ACI 318-14, 8.4.2.3.2, 8.4.2.3.3; ACI 318-11, 13.5.3.2; ACI 318-08, 13.5.3.2; ACI 318-05, 13.5.3.2; 

ACI 318-02, 13.5.3.2; ACI 318-99, 13.5.3.2; CSA A23.3-14, 13.3.5.3; CSA A23.3-04, 13.3.5.3; CSA 
A23.3-94, 13.11.2
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The amount of reinforcement provided will not be less than the code prescribed minimum. For the 
ACI 318 code, the minimum ratio of reinforcement area to the gross sectional area of the slab strip 
using Grade 60 reinforcement is taken as 0.0018. When reinforcement yield strength exceeds 60 
ksi, the minimum ratio is set to 0.0015×60 / fy. For reinforcement with yield strength less than 60 
ksi, the minimum ratio is set to 0.0020. In no case will this ratio be less than 0.0014 (See Table 2-
5)151. The CSA Standard requires a minimum ratio of slab reinforcement area to gross sectional 
area of the slab strip equal to 0.002 for all grades of reinforcement152.

Table 2.4 Minimum Ratios of Reinforcement to Gross Concrete Area

According to ACI code for beams and positive moment regions of joist slabs, minimum 
reinforcement provided will not be less than153

Eq. 2-87

and not less than 200bwd/fy where bw is the web width of the section. For statically determinate 
sections with flange in tension, bw is replaced by the smaller of 2bw and the width of the flange.

Similar equation prescribed by CSA A23.3 code has the form154

Eq. 2-88

where bt is the width of the tension zone of the section. Additionally, for T-sections having flange 
in tension the CSA code limits value of bt to 1.5bw for single sided flanges and to 2.5bw for double 
sided flanges.

When designing reinforcement for longitudinal slab bands according to CSA code, program 
assumes identical minimum steel requirements as for beams.

151.ACI 318-14, 7.6.1.1, 8.6.1.1; ACI 318-11, 7.12.2.1; ACI 318-08, 7.12.2.1; ACI 318-05, 7.12.2.1; ACI 
318-02, 7.12.2.1; ACI 318-99, 7.12.2.1

fy (ksi) As/Ag
< 60 0.0020

≥ 60

152.CSA A23.3-14, 7.8.1; CSA A23.3-04, 7.8.1; CSA A23.3-94, 7.8.1
153. ACI 318-14, 9.6.1.1, 9.6.1.2; ACI 318-11, 10.5.1; ACI 318-08, 10.5.1; ACI 318-05, 10.5.1; ACI 318-

02, 10.5.1; ACI 318-99, 10.5.1
154. CSA A23.3-14, 10.5.1.2(b); CSA A23.3-04, 10.5.1.2(b); CSA A23.3-94, 10.5.1.2(b)
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2.14.1 Design for Combined Flexure, Shear, and Torsion

CSA A23.3-14/04 requires, in proportioning of longitudinal reinforcement, to include additional 
tension forces caused by shear and torsion155. To achieve this, the program calculates forces 
developed in the longitudinal reinforcement due to flexure, shear, and torsion. 

On the flexural tension side the force in longitudinal reinforcement is equal to156

Eq. 2-89

On the flexural compression side the force in longitudinal reinforcement is equal to157

Eq. 2-90

but not less than zero.

For these forces, longitudinal reinforcement area is calculated from the following equations158

Eq. 2-91

Eq. 2-92

Taking into account both positive and negative bending moments (resulting from all load 
combinations and load patterns) and checking against area of steel required for flexure only, the 
final areas of top and bottom reinforcement can be calculated from

Eq. 2-93

Eq. 2-94

155. CSA A23.3-14, 11.3.9; CSA A23.3-04, 11.3.9
156. CSA A23.3-14, 11.3.9.2 and 11.3.10.6; CSA A23.3-04, 11.3.9.2 and 11.3.10.6
157. CSA A23.3-14, 11.3.9.3 and 11.3.10.6; CSA A23.3-04, 11.3.9.3 and 11.3.10.6
158. CSA A23.3-14, 11.3.9.1; CSA A23.3-04, 11.3.9.1
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2.15 Reinforcement Selection

According to ACI-318 code159, the default minimum clear spacing of reinforcement for both slabs 
and beams is taken as the larger of the two prescribed minima of one bar diameter, db, or 1 in. 

According to CSA code160, the default minimum clear spacing of reinforcement for both slabs and 
beams is taken as the larger of the two prescribed minima of 1.4 times the bar diameter, db, or 1.2 
in (30mm). The user may select a clear spacing greater than the default value to take into account 
tolerances for reinforcement placement161 and other project specific considerations. 

For two-way systems, the maximum spacing of reinforcement is kept at two times the slab 
thickness for the ACI code162 and three times the slab thickness for the CSA code163, but no more 
than 18 in. or 500 mm respectively. For joist systems the limit is increased to 5 times the slab 
thickness164. When calculating negative support reinforcement for the CSA code165, the program 
assumes that banded reinforcement over supports is spaced at a maximum of 1.5 hs and no more 
than 250 mm.

For one-way slabs, the maximum spacing is limited to166 the smaller of three times the slab 
thickness and 18 in. [500 mm]. Additionally, the maximum spacing of reinforcement, s, in beams 
and one-way slabs is selected so that the following crack control requirements of the ACI and the 
CSA codes167 are met

159. ACI 318-14, 25.2.1; ACI 318-11, 7.6.1; ACI 318-08, 7.6.1; ACI 318-05, 7.6.1; ACI 318-02, 7.6.1; ACI 
318-99, 7.6.1

160. CSA A23.3-14, Annex A, 6.6.5.2; CSA A23.3-04, Annex A, 6.6.5.2; CSA A23.3-94, Annex A, 
A12.5.2

161. See ACI 317-06 (Ref. [7])
162. ACI 318-14, 8.7.2.2; ACI 318-11, 13.3.2; ACI 318-08, 13.3.2; ACI 318-05, 13.3.2; ACI 318-02, 

13.3.2; ACI 318-99, 13.3.2
163. CSA A23.3-14, 13.10.4; CSA A23.3-04, 13.10.4; CSA A23.3-94, 13.11.3(b)
164. ACI 318-14, 7.7.6.2.1, 8.7.2.2; ACI 318-11, 7.12.2.2; ACI 318-08, 7.12.2.2; ACI 318-05, 7.12.2.2; ACI 

318-02, 7.12.2.2; ACI 318-99, 7.12.2.2; CSA A23.3-14, 7.8.3; CSA A23.3-04, 7.8.3; CSA A23.3-94, 
7.8.3

165. CSA A23.3-14, 13.10.4; CSA A23.3-04, 13.10.4; CSA A23.3-94, 13.11.3(a)
166. ACI 318-14, 7.7.2.3, 8.7.2.2; ACI 318-11, 7.6.5; ACI 318-08, 7.6.5; ACI 318-05, 7.6.5; ACI 318-02, 

7.6.5, ACI 318-99, 7.6.5; CSA A23.3-14, 7.4.1.2; CSA A23.3-04, 7.4.1.2; CSA A23.3-94, 7.4.1.2
167. ACI 318-14, 24.3.2, 24.3.3; ACI 318-11, 10.6.4; ACI 318-08, 10.6.4; ACI 318-05, 10.6.4; ACI 318-02, 

10.6.4; ACI 318-99, 10.6.4; CSA A23.3-14, 10.6.1; CSA A23.3-04, 10.6.1; CSA A23.3-94, 10.6.1
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Eq. 2-95

where

cc = least distance from the surface of bar to the tension face,
dc = distance from extreme tension fiber to center of the closest longitudinal bar
A = effective tension area of concrete surrounding the flexural tension 

reinforcement and extending from the extreme tension fiber to the centroid of 
the flexural tension reinforcement and an equal distance past that centroid, 
divided by the number of bars or wires

zmax = 30 000 N/mm for interior exposure or 25 000 N/mm for exterior exposure, 
multiplied by a factor of 1.2 for epoxy-coated reinforcement

An iterative process is performed to determine the number of bars and bar size. The initial number 
of bars is determined by dividing the total reinforcement area required, As, by the area of one bar, 
Asb, of the input minimum bar size. Next, the spacing is determined. If the minimum spacing 
limitations are violated, the bar size is increased and the iterative process is repeated until all bars 
sizes have been checked. If the maximum spacing limitations are not met, the number of bars 
required to satisfy these limitations is computed and the iteration process terminates.

Figure 2.21 Width due to stirrup bend

For beams, layered reinforcement is provided if sufficient beam width is not available. The clear 
distance between layers is assumed 1.0 in [30 mm] but the user can change this value. By default, 
the program assumes a 1.5 in [40 mm] side cover to stirrup for width calculations and this value 
can also be changed by the user. The program also assumes that the longitudinal bar makes contact 
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at the middle of the stirrup bend where the minimum inside diameter of the bend is four times 
stirrup diameter168. Therefore, an additional width is added to the cover for longitudinal bars less 
than size #14 (#45 for CAN/CSA-G30.18) (Figure 2-21). This additional width due to the bend, 
wbend, is equal to

Eq. 2-96

where

db =  diameter of the longitudinal bar
r =  inside radius of bend for stirrup

Figure 2.22 Detail reinforcement in longitudinal beams

Bar-length computations are performed for two-way slabs and longitudinal beams. For top 
reinforcement at the supports, the length for long bars is given by

Eq. 2-97

and the length for short bars is given by

168. ACI 318-14, 25.3.2; ACI 318-11, 7.2.2; ACI 318-08, 7.2.2; ACI 318-05, 7.2.2; ACI 318-02, 7.2.2; ACI 
318-99, 7.2.2; CSA A23.3-04, 7.1.1 and Table 16 in Annex A; CSA A23.3-94, 7.1.1 and Table 16 in 
Annex A
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Eq. 2-98

where

max(l50%) = maximum distance to the points of 50% demand,
max(lpi) = maximum distance to the points of inflection (P.I.),
ld = bar development length169,
d = effective depth,
db = bar diameter,
ln = clear span length,
lfos = distance to the face of support (column),
lcr = minimum code prescribed extension.

These bar lengths are then compared and adjusted if necessary to meet the minimum extension 
requirements for reinforcement specified by the code.170 Additionally the program may select 
continuous top bars in those spans where steel is required by calculation in mid-span at top.

If the computed bar lengths overlap, it is recommended that such reinforcement be run 
continuously. The printed bar lengths do not include hooks or portions of bars bent down into 
spandrel beams or other bar-bend configurations. If a bar starts (or ends) at a column support the 
length of the bar is measured from (or to) the center line of the column. The selection of bar 
lengths for positive reinforcement for flat plates, flat slabs, and beam-supported slabs, is based 
strictly on the minimum values of the code.

The development length depends on the following factors: concrete cover, minimum transverse 
reinforcement, special transverse reinforcement, layer location bar size and bar clear spacing. The 
development length is calculated from the general expression171 below, but not less 172 than 12 in 
[300 mm]

169. Chapter 25 in ACI 318-14; Chapter 12 in ACI 318-11, ACI 318-08, ACI 318-05, ACI 318-02, and ACI 
318-99; CSA A23.3-14, Clause 12.2; CSA A23.3-04, Clause 12.2; CSA A23.3-94, Clause 12.2

170. Figure 8.7.4.3a in ACI 318-14; Figure 13.3.8 in ACI 318-11, ACI 318-08, ACI 318-05, ACI 318-02, 
and ACI 318-99; CSA A23.3-14, Figure 13.1; CSA A23.3-04, Figure 13.1; CSA A23.3-94, Figure 13.1

171. ACI 318-14, 25.4.2.3; ACI 318-11, 12.2.3; ACI 318-08, 12.2.3; ACI 318-05, 12.2.3; ACI 318-02, 
12.2.3; ACI 318-99, 12.2.3; ACI 318M-11,12.2.3; ACI 318M-08, 12.2.3; ACI 318M-05, 12.2.3; ACI 
318M-02, 12.2.3; ACI 318M-99, 12.2.3; CSA A23.3-14, 12.2.2; CSA A23.3-04, 12.2.2; CSA A23.3-94, 
12.2.2

172. ACI 318-14, 25.4.2.1; ACI 318-11, 12.2.1; ACI 318-08, 12.2.1; ACI 318-05, 12.2.1; ACI 318-02, 
12.2.1; ACI 318-99, 12.2.1; CSA A23.3-14, 12.2.1; CSA A23.3-04, 12.2.1; CSA A23.3-94, 12.2.1
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Eq. 2-99

where
t = reinforcement location factor equal to 1.3 if more than 12 in [300 mm] of fresh 

concrete is cast in the member below the development length or splice, or 
equal to 1.0 otherwise,

e = coating factor equal to 1.0 for uncoated reinforcement; for epoxy coated 
reinforcement with covers less than 3db or clear spacing less than 6db the 
factor is equal to 1.5 and for all other epoxy coated bars it equals 1.2,

s = reinforcement size factor equal to 1.0 for bars #7 [22] and larger or equal to 0.8 
for bars #6 [19] and smaller if ACI 318 [ACI 318M] is selected; for CSA 
A23.3 the factor is equal to 1.0 for bars 25M and larger or equal to 0.8 for bars 
20M and smaller,

λ = lightweight aggregate concrete factor equal to 1.0 for normal concrete and:
0.75 for lightweight concrete per ACI 318-14, ACI 318-11 and ACI 318-08
1.3 for lightweight concrete per ACI 318-05/02/99
1.3 for low density concrete per CSA A23.3-14/04/94
1.2 for semi low density concrete per CSA A23.3-14/04/94

Ktr = transverse reinforcement index conservatively assumed zero,
cb = smaller of the distance form bar surface to the closest concrete surface and 

one-half (two thirds for CSA173) center-to-center bar spacing.174

Additionally, the product of te is not taken greater than 1.7 and the development length, ld, is 

reduced175 by the factor of As,req to As,prov where the provided area of flexural reinforcement, 
As,prov, exceeds the area required by analysis, As,req.

The final calculated or minimum development length for each bar is tabulated in the design results 
section of the program results report. In two-way slab systems without beams, the development 
length presented is often controlled by the minimum development length. 

Where flexural reinforcement is terminated in a tension zone, spSlab and spBeam provide a 
warning to require an extension of the bar beyond what is required for flexure. For ACI code, the 

173. Denoted as dcs in CSA A23.3-14, 3.2; CSA A23.3-04, 2.3 and CSA A23.3-94, 12.0
174. ACI 318-05, 2.1; ACI 318-02, 12.2.4; ACI 318-99, 12.2.4
175. ACI 318-14, 25.4.10.1; ACI 318-11, 12.2.5; ACI 318-08, 12.2.5; ACI 318-05, 12.2.5; ACI 318-02, 

12.2.5; ACI 318-99, 12.2.5; CSA A23.3-14, 12.2.5; CSA A23.3-04, 12.2.5; CSA A23.3-94, 12.2.5
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shear capacity at the cutoff point for each bar is evaluated for satisfying the shear demand does not 
exceed permissible shear limit in 12.10.5.1.  Final bar length shall be extended beyond the 
minimum reported to meet one of the three conditions outlined in 12.10.5

2.16 Concentration and Additional Reinforcement

spSlab computes the fraction of the unbalanced moment, f Mu, that must be transferred by flexure 
within an effective slab width (a band) equal to the column width plus one and one-half the slab or 
drop panel depth (1.5h) on either side of the column where176

Eq. 2-100

The amount of reinforcement required to resist this moment is computed. The amount of 
reinforcement already provided for flexure is then computed from the bar schedule (i.e. the 
number of bars that fall within the effective slab width multiplied by the area of each bar). 
Depending on load conditions, additional negative or positive reinforcement may be required. If 
the reinforcement area provided for flexure is greater than or equal to the reinforcement 
requirements to resist moment transfer by flexure, no additional reinforcement is provided, and 
the number of additional bars will be set to 0. If the amount of reinforcement provided for flexure 
is less than that required for moment transfer by flexure, additional reinforcement is required. The 
additional reinforcement is the difference between that required for unbalanced moment transfer 
by flexure and that provided for design bending moment in the slab, and it is selected based on the 
bar size already provided at the support.

For ACI codes the value of f on selected supports can be automatically adjusted to the maximum 
permitted value. The corresponding value of v = 1 – f is adjusted accordingly. This option allows 
relaxing stress levels for two-way shear around the columns by transferring increased part of the 
unbalanced moment through flexure. The adjustment is performed independently for each load 
case and pattern. If for given load case the corresponding two-way shear Vu exceeds the 
appropriate limits 0.75Vc at an edge support, 0.5Vc at a corner support, or 0.4Vc at an interior 
support, adjustment of both factors is not performed. When the adjustment of f and v factors is 
selected, the reinforcement calculated within the transfer width should be limited according to the 
code to reinforcement ratio  < 0 .375b, as stipulated in ACI 318-99/02/05177, or limitation of net 

176. ACI 318-14, 8.4.2.3.2, 8.4.2.3.3; ACI 318-11, 13.5.3.2; ACI 318-08, 13.5.3.2; ACI 318-05, 13.5.3.2; 
ACI 318-02, 13.5.3.2; ACI 318-99, 13.5.3.2; CSA A23.3-14, 13.3.5.3; CSA A23.3-04, 13.3.5.3; CSA 
A23.3-94, 13.11.2 and 13.4.5.3

177. ACI 318-14, 8.4.2.3.4; ACI 318-11, 13.5.3.3; ACI 318-05, 13.5.3.3; ACI 318-02, 13.5.3.3; ACI 318-
99, 13.5.3.3
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tensile strain t > 0.010, as required by ACI 318-14, ACI 318-11 and ACI 318-08178. Violation of 
this requirement is reported by the software as exceeding maximum allowable reinforcement 
indicating that the option to adjust the factor f should be turned off by the user at the support 
where the violation occurs.

It should be noted that the ACI code179 requires either concentration of reinforcement over the 
column by closer spacing, or additional reinforcement, to resist the transfer moment within the 
effective slab width. spSlab satisfies this requirement by providing additional reinforcement 
without concentrating existing reinforcement.

When computing additional reinforcement for the transfer of negative and positive unbalanced 
moments over the supports through flexure in systems with longitudinal beams, the contribution 
of the longitudinal beam cross-section can be optionally selected. If selected, this contribution will 
be considered. For CSA designs this functionality extends also to design of banded reinforcement 
in bb strip.

The CSA A23.3 code requires at least one-third of the total negative reinforcement for the entire 
design strip at interior supports to be concentrated in the band width, bb, extending 1.5 hs from the 

sides of the columns180. The program fulfills this requirement by concentrating a portion of 
reinforcement assigned to the design strip that includes width bb. This strip will typically be the 
column strip. However, if longitudinal slab bands or slab-band-like beams wider than band width 
bb are present, then reinforcement assigned to these elements is concentrated. At exterior supports, 

the total negative reinforcement is placed in the bb band width181 or if a beam narrower than bb is 

present, then the total reinforcement is placed within the beam width182. The reinforcement in the 
bb and the remaining portions of the design strip is also checked for compliance with spacing and 
minimum reinforcement requirements.

2.17 Structural Integrity Reinforcement

Enhancing redundancy and ductility is necessary in the event of damage to a major supporting 
element resulting from an abnormal shock or blast loading event.

178. ACI 318-14, 8.4.2.3.4; ACI 318-11, 13.5.3.3; ACI 318-08, 13.5.3.3
179. ACI 318-14, 8.4.2.3.5; ACI 318-11, 13.5.3.4; ACI 318-08, 13.5.3.4; ACI 318-05, 13.5.3.4; ACI 318-

02, 13.5.3.4; ACI 318-99, 13.5.3.4
180. CSA A23.3-14, 13.11.2.7; CSA A23.3-04, 13.11.2.7; CSA A23.3-94, 13.12.2.1 
181. CSA A23.3-14, 13.10.3; CSA A23.3-04, 13.10.3; CSA A23.3-94, 13.12.2.2, 13.13.4.2
182. CSA A23.3-04, 13.12.2.2; CSA A23.3-04, 13.12.2.2; CSA A23.3-94, 13.13.2.2
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Minor changes in reinforcement detailing typically result in substantial enhancement in the overall 
integrity of a structure by confining the resulting damage to a small area and improving the 
resistance to progressive collapse.

The ACI code requires all bottom bars in the column strip to extend continuously (or with splices) 
in the entire span and at least two of these bars to pass within the column core and to be anchored 
at exterior supports183. In continuous beams, including longitudinal beams in two-way slab 
systems, spSlab and spBeam produce, in design mode, reinforcement that satisfies ACI 
requirements for structural integrity. In perimeter (exterior) beams, at least one sixth of the 
negative tension reinforcement and not less that two bars are continuous184. Also, at least one 
fourth of the positive tension reinforcement and not less than two bars are continuous in all 
beams185.

For the CSA code, the program performs calculation of the amount of integrity reinforcement at 
slab column connections in design mode. The integrity reinforcement is required for slabs without 
beams. Integrity reinforcement is not required if there are beams containing shear reinforcement in 
all spans framing into the column. Otherwise, the sum of all bottom reinforcement connecting the 
slab to the column on all faces of the periphery should consist of at least two bars and meet the 
condition186

Eq. 2-101

where Vse is the larger of shear force transmitted to column or column capital due to specified 
(unfactored) loads and shear force corresponding to twice the self-weight of the slab.

2.18 Corner Reinforcement

The program performs calculation of the amount of reinforcement in exterior corners of slabs with 
stiff edge beams ( greater than 1.0)187. This reinforcement is required within a region equal to 1/
5 of the shorter span. The amount of corner reinforcement is calculated from the moment per unit 

183.ACI 318-14, 8.7.4.2.1, 8.7.4.2.2; ACI 318-11, 13.3.8.5; ACI 318-08, 13.3.8.5; ACI 318-05, 13.3.8.5; 
ACI 318-02, 13.3.8.5; ACI 318-99, 13.3.8.5

184.ACI 318-14, 9.7.7.1(a); ACI 318-11, 7.13.2.2(a); ACI 318-08, 7.13.2.2(a); ACI 318-05, 7.13.2.2(a); 
ACI 318-02, 7.13.2.2(a); ACI 318-99, 7.13.2.2

185.ACI 318-14, 9.7.7.1(b); ACI 318-11, 7.13.2.2(b) and 7.13.2.4; ACI 318-08, 7.13.2.2(b) and 7.13.2.4; 
ACI 318-05, 7.13.2.2(b) and 7.13.2.4; ACI 318-02, 7.13.2.2(b) and 7.13.2.4; ACI 318-99, 7.13.2.2 and 
7.13.2.3

186.CSA A23.3-14, 13.10.6.1 and 13.10.6.2; CSA A23.3-04, 13.10.6.1 and 13.10.6.2; CSA A23.3-94, 
13.11.5.1 and 13.11.5.2

187. ACI 318-14, 8.7.3.1; ACI 318-11, 13.3.6; ACI 318-08, 13.3.6; ACI 318-05, 13.3.6; ACI 318-02, 
13.3.6; ACI 318-99, 13.3.6; CSA A23.3-14, 13.12.5; CSA A23.3-04, 13.12.5; CSA A23.3-94, 13.13.5
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width intensity corresponding to the maximum positive moment in span. The code allows the 
corner reinforcement to be placed at top and bottom of the slab in bands parallel to the sides of the 
slab edges.

2.19 Deflections

2.19.1 Instantaneous Deflections

Instantaneous deflections are obtained directly by the program from elastic analysis of the defined 
system for three load levels. The first corresponds to dead load only, the second corresponds to 
dead load plus sustained part of live load only, and the third corresponds to dead load plus live 
load on all spans (total deflection). The deflection occurring when the live load is applied can be 
computed as the total load deflection (due to the dead and the live load ) minus the dead load only 
deflection188. Depending on the option selected by the user, the program will calculate flexural 
stiffness of the members based on either gross moment of inertia or the effective moment of inertia 
which takes cracking into account.

The program results section provides detailed summary of the frame section properties, frame 
effective section properties, column and middle strip properties at midpsan, and a summary of 
extreme deflection values for each load level along the span.

2.19.2 Cracking

When calculating the deflections for effective (cracked) section properties, the frame solution is 
obtained for three load levels: dead load, dead load plus sustained part of live load, and dead load 
plus full live load on all spans. Flexural stiffness is assumed corresponding to the load level.

A reduction in the flexural stiffness caused by cracking leads to an increase in deflections. Several 
methods of deflection analyses taking cracking into account are reviewed in Ref. [22]. The 
program uses the approach based on the effective moment of inertia as permitted by the code.189

The effective moment of inertia, Ie, developed by Branson (Ref. [17]) and incorporated into the 
code equals

188. Example 9-5 Calculation of Immediate Deflections in Ref. [15], pp. 443, Step 5
189.ACI 318-14, 19.2.3.1, 24.2.3.5; ACI 318-11, 9.5.2.3; ACI 318-08, 9.5.2.3; ACI 318-05, 9.5.2.3; ACI 

318-02, 9.5.2.3; ACI 318-99, 9.5.2.3; CSA A23.3-14, 9.8.2.3; CSA A23.3-04, 9.8.2.3; CSA A23.3-94, 
9.8.2.3

ΔLive ΔTotal ΔDead 
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Eq. 2-102

where

Ig = moment of inertia of the gross uncracked concrete section,
Icr = moment of inertia of the cracked transformed concrete section190

Mcr = cracking moment
Mmax = maximum bending moment at the load level for which the deflection is 

computed.

To calculate Ie for two-way slabs, the values of all terms for the full width of the equivalent frame 
are used in Eq. 2-102. This approach averages the effects of cracking in the column and middle 
strips.

The value of Ie at midspan for a simple span and at support for a cantilever is taken191 to calculate 
flexural stiffness of a member. For other conditions, an averaged effective moment of inertia, 
Ie,avg is used. For spans with both ends continuous, Iframe is given by192

Eq. 2-103

where

 = effective moment of inertia for the positive moment region,
 = effective moment of inertia for the negative moment region at the left support,
 = effective moment of inertia for the negative moment region at the right 

support.

For spans with one end continuous the value of Iframe is given by193

Eq. 2-104

190.See formulas for various cross sections in Table 10-2 in Ref. [18]
191. ACI 318-14, 24.2.3.6, 24.2.3.7; ACI 318-11, 9.5.2.4; ACI 318-08, 9.5.2.4; ACI 318-05, 9.5.2.4; ACI 

318-02, 9.5.2.4; ACI 318-99, 9.5.2.4
192. ACI 435R-95 (Ref. [19]), 2.5.1, Eq. (2.15a); CSA A23.3-14, 9.8.2.4(a); CSA A23.3-04, 9.8.2.4(a); 

CSA A23.3-94, 9.8.2.4, Eq. 9.3
193. ACI 435R-95 (Ref. [19]), 2.5.1, Eq. (2.15b); CSA A23.3-14, 9.8.2.4(b); CSA A23.3-04, 9.8.2.4(b); 

CSA A23.3-94, 9.8.2.4, Eq. 9.4
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where

 = effective moment of inertia for the positive moment region,
 = effective moment of inertia for the negative moment region at the continuous 

end.

2.19.3 Long-Term Deflections

The program estimates additional long-term deflection resulting from creep and shrinkage, cs, by 

multiplying the immediate deflection due to sustained load, sust, by the factor, , equal to194

Eq. 2-105

where

 = time dependent factor with the maximum value of 2.0 (the actual value is 
interpolated from the values and the chart given in the code195 based on the 
load duration specified by the user in the input)

’ = ratio of compressive reinforcement at midspan for simple and continuous 
spans and at support for cantilevers.

Deflection due to the sustained load, sust, is the deflection induced by the dead load (including 
self weight), plus sustained portion of the live load. 

And long-term deflection resulting from creep and shrinkage equals

Eq. 2-106

The program calculates incremental deflection which occurs after partitions are installed in two 
ways. In the first approach, it is assumed that the live load has been applied before installing the 
partitions and the incremental deflection equals196

Eq. 2-107

In the second approach, the assumption is that the full live load, including the sustained portion of 
the live load, has been applied after the partitions are installed which results in the incremental 
deflection equal to197

194. ACI 318-14, 24.2.4.1.1, 24.2.4.1.2, 24.2.4.1.3; ACI 318-11, 9.5.2.5; ACI 318-08, 9.5.2.5; ACI 318-05, 
9.5.2.5; ACI 318-02, 9.5.2.5; ACI 318-99, 9.5.2.5; CSA A23.3-14, 9.8.2.5; CSA A23.3-04, 9.8.2.5; CSA 
A23.3-94, 9.8.2.5A23.3

195. Fig. R24.2.4.1; Fig. R9.5.2.5 in ACI 318-11, ACI 318-08; ACI 318-05; ACI 318-02, and ACI 318-99; 
Fig. N9.8.2.6 in CSA A23.3-04 and CSA A23.3-94

196. CSA A23.3-04 N9.8.2.5, CSA A23.3-94 N9.8.2.5
197. See Example 10.1 in Ref. [18]
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Eq. 2-108

The total long-term deflection (total)lt is also calculated as198

Eq. 2-109

2.19.4 Deflections of two-way systems

Calculation of deflections of reinforced concrete two-way slabs is complicated by a large number 
of significant parameters such as: the aspect ratio of the panels, the vertical and torsional 
deflection of supporting beams, the stiffening effect of drop panels and column capitals, cracking, 
and the time-dependent nature of the material response. Based on studies (Ref. [20]-[22]), an 
approximate method consistent with the equivalent frame method was developed (Ref. [23]) to 
estimate the column and middle strip deflections.

Under vertical loads, Reference 20 indicates that the midspan deflection of an equivalent frame 
can be considered as the sum of three parts: that of the panel assumed to be fixed at both ends of 
its span, Δf,ref  and those due to the known rotation at the two support lines, Δθ,L and Δ

θ,r
. 

Calculation of midspan deflection of the column strip or the middle strip under fixed-end 
conditions is based on M/EI ratio of the strip to that of the full-width panel

Eq. 2-110

The ratio (Mstrip/Mframe) can be considered as a lateral distribution factor, LDF. 

For ACI and CSA A23.3-94 codes the lateral distribution factor, LDF, at an exterior negative 
moment region is

Eq. 211

The LDF at an interior negative moment region is

Eq. 2-112

The LDF at a positive moment region is

Eq. 2-113

198. CSA A23.3-04 N9.8.2.5; CSA A23.3-94 N9.8.2.5
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where

f1 = the ratio of flexure stiffness of a beam section to the flexural stiffness of a 
width of slab bounded laterally by centerlines of adjacent panels on either side 
of the beam,

t = ratio of torsional stiffness of an edge beam section to the flexural stiffness of a 
width of slab equal to the span length of the beam, center-to-center of the 
supports (see Eq. 2-30).

For CSA A23.3-14/04 code lateral distribution factors are based on tabulated values presented 
earlier in the chapter.

When f1l2/l1 is greater than 1.0, f1l2/l1 will be set equal to 1.0.

The column and middle strip LDF’s can be computed by

Eq. 2-114

Eq. 2-115

where

LDFneg,l = LDF for the negative moment region at the left end of the span
LDFneg,r = LDF for the negative moment region at the right end of the span

The total midspan deflection for the column or middle strip is the sum of three parts

Eq. 2-116

where

 = midspan deflection due to rotation of left and right supports, respectively.

The above procedure was implemented starting in v5.00 to follow the reference recommendations 
exactly and eliminate overestimation of the column strip deflection and underestimation of the 
middle strip deflection especially for the exterior span. 

The deflections should be used in conjunction with the deflections obtained from an analysis in the 
transverse direction. For square panels (l1 = l2), the mid-panel deflection is obtained from the 
following equation as shown in Figure 2-22

Eq. 2-117

For rectangular panels, (l1  l2), the mid panel deflection is obtained from
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Eq. 2-118

Figure 2.23 Deflection computation for a square panel

2.20 Material Quantities

The program computes concrete and reinforcing steel quantities. The quantity of concrete is based 
on an average of the slab, drop, and beam sizes. The total quantity of reinforcing steel computed 
by the program corresponds to the actual bar sizes and lengths required by design. No allowance 
is made for bar hooks, anchorage embedment, and so forth. It should be noted that the quantity of 
reinforcement printed by the program pertains to bending in one direction only. In practice, the 
total amount of reinforcement for the structure should also include the quantities obtained for the 
appropriate transverse equivalent frames. 

( ) ( )
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3.1 spSlab/spBeam Interface

The spSlab/spBeam Interface will appear after the program is started as shown below. The 
spSlab/spBeam Interface consists of a Control Menu, Title Bar, Menu Bar, Toolbar, and a 
Status Bar. The program name and current data file name is shown in the Title Bar. All the 
menu commands can be accessed from the Menu Bar and some frequently used commands 
also can be accessed from the buttons in the Toolbar. The four view windows show the 
geometry of a floor system and the loads on it. Plan view, side view, elevated view and 
isometric view are available. The Status Bar shows the current state of the program.

Control Menu

The Control menu is located in the upper-left corner of the window and includes commands 
for sizing, moving, enlarging, restoring, and closing the window, as well as switching to other 
applications. To access the Control menu using the mouse, click the left mouse button on the 
spSlab/spBeam logo; using the keyboard, press ALT+‘ ‘(space).

Title Bar

The Title Bar displays the program name, and following the hyphen, displays the name of the 
current data file you are using. If the data you are currently working on has not been saved into 
a file, the word spSlab1 (spBeam1 for spBeam) is displayed in the Title Bar. If you start a new 
data file by clicking the New button on the most left of the Toolbar, the next data file is named 
as spSlab2 (spBeam2 for spBeam), and so on.
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Menu Bar

Located directly below the Title Bar is the menu line. spSlab commands are listed in the pop-
up menus located in the Menu Bar. These menu commands allow you to perform functions 
that create, view, and ultimately design the floor system.

In the spSlab program there are seven main pull-down menus: File, Input, Solve, View, 
Options, Windows, and Help. To access a menu item using the mouse, place the arrow cursor 
on the menu item you want and click the left mouse button. Each menu item can also be 
selected with the keyboard keys by simultaneously pressing the ALT key and the underlined 
letter of the menu you want to open. For example, to open the File menu, press ALT + F. To 
close a menu without selecting a command, move the cursor to any blank area on the screen 
and click the left mouse button. Press ESC key to close a menu using the keyboard keys.

To select a command from a menu with the mouse, place the arrow on the item you want, and 
click the left mouse button. In some cases, you will be told to double click on a selection, that 
is, press the mouse button twice, quickly. Anytime you have to wait, for example, when 
loading the program or designing the system, the mouse cursor becomes an hourglass cursor. 
It will return to its original state when the task is completed.

To select a command from a menu using the keyboard, use the down arrow key to highlight 
your choice and press ENTER key or press the keyboard key of the command’s underlined 
letter. The space bar is also equivalent to pressing the left mouse button.

Special instructions for inputting with the keyboard keys are given wherever necessary.

Toolbar

Located directly below the Menu Bar is the tool bar. Some frequently used buttons can be 
found in the Toolbar. A description of the corresponding button is shown in the status bar (on 
the bottom of the window) when the mouse cursor is moving over this button. In addition to 
the description in the Status Bar, a brief tip is shown in a light yellow colored pop-up window 
close to the corresponding button when a mouse cursor is hanging over the button for a short 
period of time. Exactly the same functions or features can be accessed from either the menu 
items or Toolbar buttons. 

The Toolbar can be changed from docking status to floating status by single clicking the left 
mouse button on the tool bar and dragging it away from the docking position to any other 
positions on the screen. A floating tool bar can be resized by clicking and dragging its borders. 

To restore the Toolbar to the docking status, single click the left mouse button on the tool bar 
and drag it to the location that is directly below the menu line and release the mouse button.
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View Windows

A total of 10 view windows can be used to show Plan, Elevated, Side and Isometric views of 
the geometry, as well as Loads, Shear and Moment, Moment Capacity, Shear Capacity, 
Deflection, and Reinforcement.

Status Bar

Status Bar is always on the bottom of the main window. The Status Bar shows the current 
status of the data file and the coordinate values of the mouse cursor position. Depending on the 
active view window, different information of the mouse cursor will appear in the Status Bar.

3.2 File Menu

The File menu is used for saving or retrieving data, printing, and exiting. The File menu contains the 
following commands: New, Open, Close, Save, Save As, Classic Results, Print Preview, Print 
Setup, Recent Files and Exit. 

New

The New command clears any data input and returns to 
the default values. Thus, you are able to create a new 
data file. However, before you can begin a new data 
file, spSlab will ask whether you want to save the 
current data. Answering Yes will save the old data and 
begin a new data file. Answering No will discard any 
changes to the data and begin a new data file. 
Answering Cancel will return you to spSlab so that you can continue to work with the current 
data.

Open

The Open command allows you to load an existing spSlab data file. The dialog box that 
appears shows you a listing of all the files with the extension contained in the default data 
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directory or in the current directory (if a default data directory was not specified). This box 
also enables you to change the current drive and directory. If you are currently working on a 
data file and select the Open command, spSlab will ask whether you want to save the current 
data. Answering Yes will save the old data and display the Open dialog box. Answering No
will discard any changes to the data and display the Open dialog box. Answering Cancel will 
return you to spSlab so that you can continue to work with the current data.

Close

The Close command allows you to close the current spSlab data file. If you are currently 
working on a data file and select the Open command, spSlab will ask whether you want to 
save the current data. Answering Yes will save the old data and display the Open dialog box. 
Answering No will discard any changes to the data and display the Open dialog box. 
Answering Cancel will return you to spSlab so that you can continue to work with the current 
data.

Save

The Save command saves the changes you’ve made to the current data under that same 
filename. The new data overwrites the old data, and you cannot retrieve the old data. It is a 
good practice to periodically save while inputting data. If a data file is untitled, the Save As 
dialog box will appear.

Save As

The Save As command allows you to name or rename a data file. Use Save As when you want 
to save both the original data and any changes you’ve currently made to the data. The original 
data remains under the old filename. If a file of the same name exists, the program will ask if 
you would like to overwrite the file.
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Classic Results

The Classic Results command allows you to execute the classical Results Report module to 
view and print the input and output data after a successful run has been performed.

Print Preview

The Print Preview command allows you to preview and print the current view window (floor 
system geometry in the plan, elevated, and isometric views, prints the shear and moment 
diagrams, and prints the deflected shapes). To obtain a view window you must first perform 
the design, then select what you want to view from the View menu. You may have more than 
one view windows opened. The current view window is the one activated and on top of the 
others on your screen. Selecting this command closes the spSlab main window and opens the 
print preview window as shown below. On the print preview window, press the Zoom In or 
Zoom Out buttons or simply click the left mouse button on the preview window to magnify or 
reduce the size of the preview paper. Press the Next Page button if more than one page needs 
to be printed. Press the Print button to print the view. The printer could be a local printer, 
which is connected to your computer directly, or a network printer. Press the Close button to 
close the preview window and go back to spSlab.
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Print Setup… 

The Print Setup command brings up the Windows print setup box which allows the user to 
select the printer to send the output to, and to change the settings of the printer.

Recent Files

This list contains the data files that are used recently and can be accessed quickly from the 
menu by a single click. The most recently used one is on the top of the list. Up to four files can 
be listed. 

Exit

The Exit command ends the spSlab session and returns you to Windows. If you have made any 
changes to your data and have not saved them, spSlab will first ask whether you want to save 
or abandon any changes you’ve made before you exit. 
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3.3 Input Menu

The Input Menu allows you to enter and modify data for the floor system. The Input Menu
contains the following commands: Data Input Wizard, General Information, Material 
Properties, Spans, Supports, Reinforcement Criteria, Reinforcing Bars, Load Cases, 
Load Combinations, Span Loads, Support Loads and Displacements, and Lateral 
Effects. 

Data Input Wizard

The Data Input Wizard command is designed to make the inputting process easier. By 
selecting Data Input Wizard, a logical sequence of dialog boxes will automatically be 
displayed allowing you to enter data for your floor system.

General Information

The General Information consists of three tabs: General Information, Solve Options, and 
Span Control. 

The General Information tab will allow you to enter the project name, frame name, engineer 
name, design code, reinforcement database, run mode, and number of supports. You must 
always use the General Information tab before doing any further inputting since it affects the 
availability of other commands in this menu.

The Span Control tab provides commands for span manipulation such as inserting new spans, 
copying spans, moving spans, and deleting spans.
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The Solve Options command allows you to specify design options, punching shear options, 
and deflection calculations options. Please note that design options for two-way systems are 
different from beams/one-way slab systems. To take effect, this command must be used prior 
to Execute. 

Material Properties

The Material Properties command enables you to input material property requirements for 
concrete and reinforcement. Concrete density, compressive strength, Young’s modulus, 
rapture modulus, as well as the longitudinal and shear reinforcement yield levels, are required.

Spans

The Spans menu allows you to input geometric dimensions for slabs, longitudinal beams, and 
ribs.

Supports

The Supports menu allows you to input geometric dimensions for columns, drop panels, 
column capitals, and transverse beams. The percentage of the actual column joint stiffness to 
be used in the analysis to determine the joint moments and shears can be modified on the 
Columns tab. The Drop Panels tab is available if two-way system is selected and the 
Moment Redistribution tab is available only for beams/one-way slab systems if moment 
redistribution is engaged in the General Information window.

Reinforcement Criteria

The Reinforcement Criteria menu allows you to specify the distance to reinforcement, 
reinforcement bar sizes, bar spacing, and reinforcing ratio for both slabs and beams. For beams 
it also allows you to specify criteria for stirrups, side cover and distance between layers of 
reinforcement if more than one layer is needed.

Reinforcement Bars

For two-way floor systems, the Reinforcement Bars menu allows you to specify the 
longitudinal reinforcement arrangement information for column strip, middle strip, and beam, 
as well as shear reinforcing information for beams. 

For beams/one-way slab systems, flexural bars, stirrups, and torsional longitudinal 
reinforcement can be specified. The Reinforcement Bars menu is disabled if Run Mode of 
Design is selected from the General Information dialog box. Select the Run Mode of 
Investigation from the General Information dialog box to enable it.

Load Cases

The Load Cases menu allows you to specify load cases. Up to six load cases can be added and 
only one live load case is allowed.



spSlab/spBeam INTERFACE

|   105   |

Load Combinations

The Load Combinations menu allows you to specify load combinations as shown.Up to fifty 
load combinations can be added.

Span Loads

The Span Loads menu allows you to enter superimposed area loads, line loads, point loads, 
and moments.
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Support Loads and Displacements

The Support Loads and Displacements menu allows you to enter prescribed displacements 
and rotations of supports as well as concentrated loads applied directly at support locations.

Lateral Effects

The Lateral Effects menu allows you to enter the lateral loads as moments acting on the two 
ends of each span. 
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3.4 Solve Menu

The Solve Menu contains the Execute, Results and Reporter commands.

Execute

The Execute command executes the solver portion of spSlab. if some data is still required 
when this command is executed, spSlab will respond with an “Invalid Model!” error message. 
The missing data must be completed before execution. A status window pops up and shows 
the status during the execution. If the execution is not successful, an error message will be 
shown and the execution is terminated.
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Results… 

The Results command allows you to execute the spResults module to view the input and 
output data after a successful run has been performed. 

Reporter… 

The Reporter command allows you to execute the spReporter module to generate, view and 
print reports after a successful run has been performed.

3.5 View Menu

The View menu commands enable you to 
modify the floor system’s appearance on the 
screen to suit your viewing needs and enable 
you to view the result diagrams. The View 
menu contains the following commands: 
Zoom, Pan, Restore, Plan View, Elevated 
View, Side View, Isometric View, Change 
View Angles ,  View Options ,  Loads , 
Internal Forces, Moment Capacity, Shear 
Capacity, Reinforcement, Deflection and 
Duplicate Active View. 

Zoom

The Zoom menu contains a cascade sub-menu, which enables you to zoom in and out on any 
portion of your floor system. Select Window from the sub-menu and use the mouse to specify 
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a zooming region; the program will enlarge the portion you select. Select the In(2x) or 
Out(0.5x) to enlarge or reduce the model by two times, respectively.

Pan

The Pan command allows you to move your model on the plane of the screen. You may move 
the model in any direction. The mouse cursor is changed to a palm shape once the Pan
command is selected. Press and hold the left mouse button on the view window and drag to the 
new location. After the mouse button is released, the model is moved in the same distance and 
direction as the mouse cursor from the original position.

Restore

The Restore command will redraw the floor system in full size. If you have altered your 
screen view using the Zoom command, select Restore to restore the figure’s original 
proportions.

Plan View

Select Plan View command to show the plan view window.

Elevated View

Select Elevated View command to show the elevated view window.

Side View

Select Side View command to show the side view window.

Isometric View

Select Isometric View command to show the isometric view window.

Change View Angles

The Change View Angle command allows you to modify the angle at which the floor system 
is displayed in the Isometric View. The default angles are set at -45 about the X axis and 45 
about the Z axis. A more convenient way to change the view angle is to use the keyboard short 
cut CTRL + ARROW KEYS. To rotate around Z axis, press CTRL +  or CTRL + . To 
rotate around X axis, press CTRL +  or CTRL + . 
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View Options

The View Options command allows you to view selected members of the 
floor system in the view windows. Clicking the left mouse button on the 
check boxes next to the items in the dialog box, or tabbing to the member 
type and pressing the space bar will toggle the selection. spSlab will draw 
any members that contain a  in the box. 

Loads

Select Loads command to show the load view window.

Internal Forces

Select Internal Forces command to show the shear, 
moment, and torsion (for beams/one-way slab systems 
only) diagram view window. The analysis and/or design 
must be performed before selecting this command. 
Otherwise “Problem Not Solved” message will be shown 
instead. 

Moment Capacity

Select Moment Capacity command to show the moment capacity diagram view window. The 
analysis and/or design must be performed before selecting this command. Otherwise “Problem 
Not Solved” message will be shown instead.

Shear Capacity

Select Shear Capacity command to show the shear capacity diagram view window. The 
analysis and/or design must be performed before selecting this command. Otherwise “Problem 
Not Solved” message will be shown instead.

Reinforcement

Select Reinforcement command to show the reinforcement view window. The analysis and/or 
design must be performed before selecting this command. Otherwise “Problem Not Solved” 
message will be shown instead.

Deflection

Select Deflection command to show the deflection diagram view window. The analysis and/or 
design must be performed before selecting this command. Otherwise “Problem Not Solved” 
message will be shown instead.

Duplicate Active View

Select Duplicate Active View to make a copy of the current active view window.
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3.6 Options Menu

The Options menu allows you to change the 
startup options of the spSlab program to suit your 
needs. The Options menu contains the following 
commands: Colors, Fonts, Startup Defaults, 
Reinforcement Database, Toolbar, and Status 
Bar. 

Colors

The Colors command allows you to change the background color, member color, load color, 
text color, diagram color, etc. You may save the new colors as default setting, which will be 
used when spSlab is executed in the future. 

Fonts

The Fonts command allows you to select properties of the font that will be used in the on 
screen-graphical window, graphical print as well as in classic text result window and output. 
Please note that for the Classical text output only non-proportional (fixed width) fonts can be 
used
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Startup Defaults

The Startup Defaults command allows you to 
enter engineer name, change the default design 
code, reinforcement database, and the data 
directory which is where the program looks for data 
when it is executed.

Note: Default values of various design parameters 
(e.g. minimum and maximum bar spacing and reinforcement ratio, Young modulus, rupture 
modulus, etc.) assumed by the program depend on the design code selected in this dialog box. 
Subsequent change of the design code in the General Information dialog box does not reset 
values of these parameters to the default values corresponding to the newly selected code. It 
may, however, convert these values to different units if the code change is accompanied by a 
change of units. 

Reinforcement Database

The Rebar Database command allows you to view the 
pre-defined reinforcement information and define your 
own database. The user-defined database can be 
selected from the General Information dialog box. 

Toolbar

Check the Toolbar command with a  sign to show the 
Toolbar. Select the command again to clear the  sign 
to hide the Toolbar. The Toolbar is shown by default.
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Status Bar

Check the Status Bar command with a  sign to show the Status Bar. Select the command 
again to clear the  sign to hide the Status Bar. The Status Bar is shown by default.

3.7 Window Menu

The Window menu enables you to arrange view windows shown on screen. The Window
menu contains the following commands: Cascade, Tile Horizontal and Tile Vertical. 

Cascade

The Cascade command displays all the open windows in the same size, arranging them on top 
of each other so that the title bar of each is visible. The current active view widow will be on 
the top after the execution of the Cascade command.

Tile Horizontal

The Tile Horizontal command arranges all open windows horizontally so that no window 
overlaps another. The current active view widow will be on the most left or on the upper-left 
corner of the screen after the execution of the Tile Horizontal command.

Tile Vertical

The Tile Vertical command arranges all open windows vertically so that no window overlaps 
another. The current active view widow will be on the most left or on the upper-left corner of 
the screen after the execution of the Tile Vertical command.

Window List

The remaining menu items are in a list of the windows that are available for viewing. Selecting 
any window from this menu will bring up or restore the window to its previous size and 
position if it was minimized.
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3.8 Help Menu

The Help menu includes commands that enable you to obtain 
online help for the program and show the copyright and registration 
information about your software.

spSlab/spBeam Info

Opens information page for the current version of spSlab being 
used in the default browser. Internet connection is required.

Submit a Question

Opens the StructurePoint Submit a Question page in the default 
browser. Internet connection is required.

Manual

Opens spSlab/spBeam Manual in the default browser. Internet connection required.

Help

Uses the default browser to open spSlab/spBeam help. It provides access to all available help 
topics. Click on any topic and a help screen will appear with information about that item. 
Internet connection is required.

Tutorial Videos

Uses the default browser to open a page containing spSlab/spBeam tutorial videos. Internet 
connection is required.

Design Examples

Uses the default browser to open a page containing design examples for StructurePoint 
software. Internet connection is required.

Check for Updates

Checks if a newer version of spSlab is available. Internet connection is required.

Release Notes

Uses the default browser to open a page containing release notes for the version of spSlab 
being used. Internet connection is required.
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About spSlab

Shows the version number of the program, the licensing information, and the copyright 
information. In the case of a trial license, the expiration date is given as well as the locking 
code which is needed to obtain a standalone license.

3.9 Control Menu

All the view windows have one pull-down menu located in the upper left hand corner of the 
open window. This is the Control Menu. To access the Control Menu, press CTRL + F6 to 
cycle through the windows and press ALT + – (hyphen), to open the Control Menu of the 
desired window. The following is a list and a brief description of the commands in this menu.

Restore

The Restore command will restore a window or an icon to its previous size and position. This 
menu item is available when the window is iconized or maximized.
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Move

The Move command moves the window to a new location. Select Move and use the ARROW 
KEYS to move the window in the desired direction and select ENTER to accept the new 
location.

Size

The Size command resizes a window. Select Size and use the ARROW KEYS to move the 
border of the window in the desired direction and select ENTER to accept the new size.

Minimize

The Minimize command reduces a window to an icon and positions it at the bottom of the 
screen.

Maximize

The Maximize command enlarges a window to fit your entire screen.

Close

The Close command is used to close a window and return it to an icon and the bottom of the 
screen.

Next

The Next command switches among open windows and icons.

3.10 Program Toolbar

Close the current data file if there is one and start a new data file. The equivalent menu 
command is File/New.

Open an existing data file on hard disk. The equivalent menu command is File/Open.

Save the current data file to hard disk. The equivalent menu command is File/Save. If you 
have not changed the default file name (spSlab1, spSlab2, etc.), the equivalent menu 
command is File/Save As.

Copy Bitmap to clipboard. The bitmap then can be pasted to a word processing or 
presentation software such as Microsoft Word or Microsoft PowerPoint.

Copy Metafile to clipboard. The metafile then can be pasted to a word processing or 
presentation software such as Microsoft Word or Microsoft PowerPoint.
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Open the Data Input Wizard. The Data Input Wizard will guide you to enter the necessary 
input to your project. The equivalent menu command is Input/Data Input Wizard.

Enter general information. The equivalent menu command is Input/ General 
Information.

Enter material properties. The equivalent menu command is Input/Material Properties.

Enter span geometry information for slabs, longitudinal beams, and ribs. The equivalent 
menu command is Input/Spans.

Enter support information for columns, drop panels, column capitals, and transverse 
beams. The equivalent menu command is Input/Support. 
Enter reinforcement criteria for slab and ribs, and beams. The equivalent menu command 
is Input/Reinforcement Criteria.

Enter reinforcing bar information for column strips, middle strips, beams, and beam 
stirrups. This button is disabled if Design run mode is selected from the General 
Information dialog box. The equivalent menu command is Input/Bars.

Enter load cases. The equivalent menu command is Input/Load Cases.

Enter load combinations. The equivalent menu command is Input/Load Combinations.

Enter span loads. The equivalent menu command is Input/Span Loads.

Enter support loads and displacements. The equivalent menu command is Input/Support 
Loads and Displacements.

Enter lateral effects. The equivalent menu command is Input/Lateral Effects.

View plan geometry. The equivalent menu command is View/Plan View.

View elevated geometry. The equivalent menu command is View/Elevated View.

View side geometry. The equivalent menu command is View/Side View.

View isometric geometry. The equivalent menu command is View/Isometric View.

Execute the analysis and/or design. The equivalent menu command is Solve/Execute.

Print preview window. the equivalent menu command is File/Print Preview.

View loads. The equivalent menu command is View/Loads.

View internal forces within the whole system or a single span. The equivalent menu 
command is View/Internal Forces. 

View moment capacity of the whole geometry or a single span. The equivalent menu 
command is View/Moment Capacity.

View shear capacity of the whole geometry or a single span. The equivalent menu 
command is View/Shear Capacity.

View deflection of the whole geometry or a single span. The equivalent menu command is 
View/Deflection.
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View flexure reinforcement for beam strip, middle strips, and column strips. View shear 
reinforcement for beam strips. The equivalent menu command is View/Reinforcement.
Zoom in view window to magnify the system. The equivalent menu command is View/
Zoom/In(2x).
Zoom out view window to reduce the system. The equivalent menu command is View/
Zoom/Out(0.5x).
Zoom any part of a view window. The equivalent menu command is View/Zoom/
Window.

Move the model in the screen plane. The equivalent menu command is View/Pan.

Restore a view window. The equivalent menu command is View/Redraw.

View results. The equivalent menu command is File/Results.

View report. The equivalent menu command is File/Reporter.
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4.1 Introduction

In this chapter, the sections follow the order in which commands and options appear beginning 
with those found under the File menu and ending with those under the Help menu.

Many of the commands and options that appear under these menus are also accessible by other 
methods. Consequently, these other methods are also explained. 

4.2 Creating New File

When spSlab/spBeam is loaded, the program is ready to begin receiving input for a new project. 
Until you save the file, the data will not have a filename associated with it, and the title bar will 
display the word spSlab1 or spBeam1 as illustrated here: 

• From the File menu, choose New. This clears the screen in preparation for a new project 
or data entry file and returns the program to its default settings. 

• If existing data on an open project has been changed prior to executing the New command, 
the program will display the following message box inquiring whether you wish to save 
the data on the open project or data file before creating a new file:

4.3 Opening File

spSlab allows you to open data files that were saved at an earlier time including files from 
previous versions of spSlab and spBeam as well as pcaSlab, pcaBeam, or ADOSS.  Note that the 
extension name of an ADOSS .ADS and the extention name of a pcaBeam v1.01 file is .BMS. 
Both pcaSlab and pcaBeam v1.5x use files with the .SLB extension.

• From the File menu, choose Open and a dialog box will appear.
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• All files with the .SLB extension contained in the current drive and directory are displayed 
in the FILE NAME list box. To view files with a different extension, use the file type drop-
down menu to choose a different file extension.

• To open a file that exists in another drive or directory, select the drive or directory you 
want from the LOOK IN drop-down list.

• From the FILE NAME list box, select the file to be opened, or simply type its name in the 
text box. 

• Choose the OK button.

• Alternatively, an input file can be opened by spSlab if the file is drag-and-dropped onto 
the program window or if the file pathname is provided as a command line parameter 
when invoking spSlab from the command prompt.

Figure 4-1 Open Dialog Box

4.4 Saving File

spSlab files are saved in a binary format with .SLB extensions. 

4.4.1 Save the data with the same file name

• At any time while editing a data file that has previously been saved under a file name, 
choose File and Save to save the changes under the same file name, overwriting the old 
file. From the File menu, select the Save command before giving the data file a name dis-
plays the Save As dialog box.
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4.4.2 Change the format or rename the file

• From the File menu, select Save As, and a dialog box will appear.

• All files with. SLB extensions contained in the current drive and directory are displayed in 
the File Name list box.

• To save the file to a drive or directory other than the default, select a different drive or 
directory from the Save In drop-down list.

• Choose OK button

Figure 4-2 Save As Dialog Box

4.5 Most Recently Used Files (MRU)

Figure 4-3 Most Recently Used File List (MRU)
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The Most Recently Used Files (MRU) list shows the four data files that were opened most 
recently. Selecting a data file from this list makes it easier and faster to open the file. The list is 
empty when the program is executed for the first time.

4.6 Specifying Model Data (Menu Input)

4.6.1 Data Input Wizard

The Data Input Wizard is designed to make the inputting process easier. By selecting the Data 
Input Wizard from Input menu or selecting  from the tool bar, a logical sequence of dialog 
boxes will automatically be displayed allowing you to enter data for your floor system.

4.7 Defining General Information

The General Information command allows you to enter labels, design code, reinforcement 
database, run mode, and the frame information needed by spSlab to proceed with the input 
process. You must choose this command before doing any further inputting since this command 
affects the availability of the commands in the Input menu.

To enter general information:

• Select the General Information command from the Input menu or click the  button 
from the tool bar. The dialog box of Figure 4-4 will appear.

• Enter the project name, frame name, and engineer name in the Label frame box.

• Select the building standard you want your floor system to be designed to (ACI 318-14, 
ACI318M-14, ACI 318-11, ACI 318M-11, ACI 318-08, ACI 318M-08, ACI 318-05, 
ACI 318M-05, ACI 318-02, ACI 318M-02, ACI 318-99, ACI 318M-99, CSA A23.3-14, 
CSA A23.3-14E, CSA A23.3-04, CSA A23.3-04E, CSA A23.3-94, CSA A23.3-94E) 
from the Option frame box.
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a)  b) 

Figure 4-4 General Information dialog box (a) two-way system (b) beam and one-way 
system

• Select the DESIGN or INVESTIGATION from the RUN MODE frame box.

• In the FRAME box, enter the Number of supports of the frame. The default number of sup-
ports is 2. The minimum and maximum number of spans is 1 and 20 spans, respectively. 
Therefore the minimum number of supports is 2 and the maximum number of supports is 
21.

• Check the LEFT CANTILEVER and/or RIGHT CANTILEVER check boxes if left cantilever and/
or right cantilever exist in the frame respectively.

• In the FLOOR SYSTEM frame box, select TWO-WAY or BEAMS/ONE-WAY slab option.

• Select NONE, LONGITUDINAL, or TRANSVERSE in SLAB BAND box if a two-way floor sys-
tem is selected for the CSA A23.3-14/04 design code.

• Check the DISTANCE LOCATION AS RATIO OF SPAN if the locations of loads need to be 
entered as a ratio of the length of a span.

• Press OK button to exit the dialog box and allow spSlab to use the new data. If using the 
Auto Input, click the NEXT button to the next dialog box.

4.7.1 Defining Solve Option

The Solve Options command allows you to select options and specify parameters that affect the 
analysis and design results. Changing these settings involves engineering judgment and it has to 
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be done cautiously. To take effect, this command must be used prior to the Execute command. The 
set of parameters is different for two-way and one-way systems.

4.7.1.1 Two-way systems

To specify solve options for two-way systems:

• Enter the live load pattern ratio.

• Check COMPRESSION REINFORCEMENT checkbox if it is to be considered when needed.

• Check USER SLAB STRIP WIDTH to enable manual input of column strip width. The default 
values are calculated according to design code selected. The validity of the assumptions 
when entering user defined values are to be decided by the Designer.

• Check USER DISTRIBUTION FACTORS to enable manual input of moment distribution fac-
tors. The default values are calculated according to design code selected. The validity of 
the assumptions when entering user defined values are to be decided by the Designer.

• Check DECREMENTAL REINFORCEMENT DESIGN to use alternative reinforcement design 
algorithm.

• Check COMBINED M-V-T REINF. DESIGN to proportion longitudinal reinforcement for 
combined action of flexure, shear, and torsion. This option is available only when CSA 
A23.3-14 or CSA A23.3-04 are selected.

• Check ONE-WAY SHEAR IN DROP PANELS to include drop panel cross-section in slab one-
way shear capacity calculations in support locations.

• Check DISTRIBUTE SHEAR TO SLAB STRIPS to distribute slab one-way shear between col-
umn and middle strips in proportion to moment distribution factors.

• Check BEAM T-SECTION DESIGN to include portions of slab as flanges in beam cross-sec-
tion for reinforcement design.

• Check LONG. BM. SUPT. DESIGN to include cross-section of longitudinal beam in rein-
forcement design for unbalanced moments over supports. This feature can be useful for 
slabs having wide longitudinal beams. When used together with USER DISTRIBUTION FAC-
TORS, it can produce solutions consistent with the solutions for models with longitudinal 
slab bands for CSA A23.3-14/04 code.

• Check TRANS. BM. SUPT. DESIGN to include cross-section of transverse beam in reinforce-
ment design for negative moments and unbalanced moments over supports. This feature is 
useful for slabs having wide transverse beams. When used together with USER DISTRIBU-
TION FACTORS, it can produce solutions consistent with the solutions for systems with 
transverse slab bands for CSA A23.3-14/04 code.
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• Enter the multiplier that defines the distance between a column face and a free edge of a 
slab, within which a segment of punching shear critical section is to be ignored.

• Select whether circular critical section around circular supports is to be used or traditional 
equivalent rectangular critical section.

• Choose if GROSS (UNCRACKED) or EFFECTIVE (CRACKED) sections are to be considered in 
the deflection calculations.

• Choose if in the case of a section with flanges in the negative moment region, only the 
web (RECTANGULAR SECTION) or the whole section (T-SECTION) is to be used to calculate 
the gross moment of inertia (Ig) and the cracking moment.

• Check CALCULATE LONG-TERM DEFLECTIONS checkbox if you want the program to calcu-
late long-term deflections. Provide the duration of load in months and the percentage of 
the live load which is considered as sustained load.

ACI

a)  b) 
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CSA

c)  d) 

Figure 4-5 Solve Option (a, d) two-way system (b,c) beam and one-way system

4.7.1.2 One way/beam systems

To specify solve options for beams/one-way slab systems:

• Enter the live load pattern ratio. The default value for beams/one-way slab systems is 
100%.

• Check COMPRESSION REINFORCEMENT checkbox if it is to be considered when needed.

• Check DECREMENTAL REINFORCEMENT DESIGN to use alternative reinforcement design 
algorithm.

• Check COMBINED M-V-T REINF. DESIGN to proportion longitudinal reinforcement for 
combined action of flexure, shear, and torsion. This option is available only when CSA 
A23.3-14 or CSA A23.3-04 are selected.

• Check EFFECTIVE FLANGE WIDTH if instead of the full flange width only the effective 
flange width is to be considered in the flexural design.

• Check RIGID BEAM-COLUMN JOINT to consider beam-column joint as rigid.

• Check TORSION ANALYSIS AND DESIGN if they are to be included in the solution. This 
option has to be checked for the TORSION TYPE and STIRRUPS IN FLANGES options to be 
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enabled. Also torsional loads will only be available in the TYPE combo box of the SPAN 
LOADS dialog box if this option is checked.

• Check MOMENT REDISTRIBUTION checkbox if it is to be considered in the analysis. This 
option has to be checked for the MOMENT REDISTRIBUTION tab to be available in the SUP-
PORT DATA dialog box.

• If TORSION ANALYSIS AND DESIGN is checked then select if EQUILIBRIUM or COMPATIBIL-
ITY torsion is to be considered and if for sections with flanges STIRRUPS IN FLANGES can 
be considered.

• Choose if GROSS (UNCRACKED) or EFFECTIVE (CRACKED) sections are to be considered in 
the deflection calculations.

• Choose if in the case of a section with flanges in the negative moment region, only the 
web (RECTANGULAR SECTION) or the whole section (T-SECTION) is to be used to calculate 
the gross moment of inertia (Ig) and the cracking moment.

• Check CALCULATE LONG-TERM DEFLECTIONS checkbox if you want the program to calcu-
late long-term deflections. Provide the duration of load in months and the percentage of 
the live load which is considered as sustained load.

4.7.2 Using Span Control

The Span Control tab allows you to perform different operations on the spans that your system 
consists of. These operations include inserting new spans with default parameters, creating new 
spans by copying existing spans, moving spans to change span sequence, and deleting spans. The 
result of an operation depends on the span selected as well an on the selected support. Spans can 
be selected using the Span Control List and columns using the Support Selection radio buttons.

Figure 4-6 Span control tab
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Additionally before the Span Control window is closed all changes made to the spans can be 
revoked using the RESET ALL button. The RESTORE button can be used to bring back a span 
removed using the DELETE button.

To insert a new span with default dimensions:

• In the SPAN CONTROL LIST select the span next to which you want to insert a new span.

• Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the newly created span will be 
inserted.

• Press INSERT BEFORE button to insert the new span left to the selected span or INSERT 
AFTER button to insert the new span on the right side of the currently selected span.

• Examples of the insert operations are presented in Figure 4-7. Assuming that Span 2 is 
always selected the resulting systems will depend on whether INSERT AFTER or INSERT 
BEFORE was used and whether LEFT COLUMN or RIGHT COLUMN was selected. Newly 
inserted span and column are denoted with an “x”.

To copy a span:

• In the SPAN CONTROL LIST select the span you want to copy.

• Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the copied span will be copied 
with the span.

• Press INSERT BEFORE button to place the copied span left to the selected span or INSERT 
AFTER button to place the copied span on the right side of the currently selected span.

• Examples of the insert operations are presented in Figure 4-8. Assuming that Span 2 is 
always selected the resulting systems will depend on whether COPY AFTER or COPY 
BEFORE was used and whether LEFT COLUMN or RIGHT COLUMN was selected. Newly 
created span and column are denoted with the prime sign.
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Figure 4-7 Inserting a new span using Span Control

To move a span:

• In the SPAN CONTROL LIST select the span you want to move.

• Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the moved span will be moved 
with the span.

• Press MOVE BEFORE button to move the span to the left or MOVE AFTER button to move 
the span to the right side.
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Figure 4-8 Copying a span using Span Control

Examples of the move operations are presented in Figure 4-9. Assuming that Span 2 is always 
selected the resulting systems will depend on whether MOVE AFTER or MOVE BEFORE was used 
and whether LEFT COLUMN or RIGHT COLUMN was selected.

Figure 4-9 Moving a span using Span Control
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To delete a span:

• In the SPAN CONTROL LIST select the span you want to delete.

• Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the deleted span will be 
removed with the span.

• Press the DELETE button to delete the selected span.

Examples of the delete operations are presented in Figure 4-10. Assuming that Span 2 is always 
selected the resulting systems will depend on whether LEFT COLUMN or RIGHT COLUMN was 
selected.

Figure 4-10 Deleting a span using Span Control

4.7.3 Defining Material Properties

The Material Properties command from the Input menu allows you to input material properties 
of the concrete and the reinforcement. There are two tabs in this dialog box. One is for concrete 
and the other is for reinforcing steel. This command must be executed in order to perform a design 
of the floor system. Use the tab key to get to each edit box then type in your values, or use your 
mouse and click directly on the desired tab and box, then type in your values. Refer to "Material 
Properties" for a detailed explanation of the default values.

To define material properties:

• Select the Material Properties command from the Input menu or click the  button on 
the tool bar. The dialog box of Figure 4-11 will appear.
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Figure 4-11 Concrete Properties dialog box

• Click the Concrete tab and enter the concrete density for the following members: Slabs, 
Beams, and Columns. 

• Enter the concrete compressive strength. By entering a value for the compressive strength, 
values for Young’s modulus and rupture modulus will automatically be computed for the 
slabs, beams, and columns. Young’s modulus and rupture modulus will automatically be 
shown in the corresponding text boxes.

• If you have values for the rupture modulus, fr, enter the values in the text boxes for the 

slabs, beams, and columns. Default values are computed based on . These values will be 
used for deflection analysis. A large value for the rupture modulus will produce a deflec-
tion analysis based on gross, non-cracked, sections. The CSA A23.3 standard requires199

that for the calculation of deflections half the value of rupture modulus be used. spSlab 
defaults to this value of the rupture modulus for the slab (both one-way and two-way) and 
beam concrete in CSA A23.3-14/04 design runs and for two-way slabs in CSA A23.3-94 
design runs. For beams and one-way slabs per CSA A23.3-94, however, the full value of 
rapture modulus has to be used and the program will provide it as default in this case. It is 
strongly recommended, however, that the user verifies what value of fr is actually entered 
in the program since the default value can be inadvertently overwritten or carried over 
from a previous run.

• If precast concrete is used, check PRECAST CONCRETE checkbox.

• Click the Reinforcing Steel tab as shown in Figure 4-12.

199. CSA A23.3-14, 9.8.2.3; CSA A23.3-04, 9.8.2.3; CSA A23.3-94, 13.3.6

fc
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Figure 4-12 Reinforcing Steel Properties dialog box

• Enter the yield stress of flexure steel. 

• Enter the yield stress of stirrups.

• Enter the Young’s modulus for flexural steel and stirrups.

• Select whether the main reinforcement is epoxy-coated by clicking the left mouse button 
on the box or tabbing to the box and pressing the SPACE BAR. This selection affects 
development lengths.

• Press OK button to exit the dialog box so that spSlab will use these material properties. If 
using the Auto Input, click the NEXT button to the next dialog box.

4.7.4 Defining Slabs/Flanges

The Spans command from the Input menu is available for all floor systems. Span numbers, which 
are determined from the number of supports entered in the General Information box, are 
automatically filled into the Span drop-down list in the Span Data dialog box. 

To input slab geometry:

1. Select the Spans command from the Input menu or click the  button on the tool bar. 
Click the left mouse button on the Slabs tab. The dialog box of Figure 4-13 will appear.

2. Select the number of the span, for which dimensions will be entered, from the Span drop-
down list.
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Figure 4-13 Defining the slabs dialog box

3. Select the span location from the Location drop-down list. Three types of locations are 
available: Interior, Exterior Left, and Exterior Right. The "left" and "right" are defined as 
you look along the direction of analysis. If a span has design strips on both sides it should 
be an "Interior" span. If a span has only a left design strip, it should be an "Exterior Right" 
span. If a span has only a right design strip, it should be an "Exterior Left" span.

4. Enter the slab thickness of the span. 
5. Enter the span length from column centerline to column centerline or edge to column 

centerline for the two cantilever spans in the Length edit box. If the program detects a 
cantilever span length less than one-half the column dimension in the direction of analysis, 
an error message will pop up when the frame is analyzed. If a partial load is affected by 
the span length, a message warns the user of this condition.

6. Enter the span design width in the transverse direction of analysis on the left and right side 
of the column (see Figure 4-14). These distances are usually one-half the distance to the 
next transverse column or edge of the slab for exterior spans. The left and right 
designations are arbitrary. Both interior and exterior spans may be used in a design strip. 
An exterior width will automatically be designated by spSlab by entering a width value 
less than or equal to the transverse column dimension. Exterior sides do not contribute to 
the attached torsional stiffness, although they do contribute to loading. spSlab will use the 
total width entered for weight and superimposed loading but will use code allowed 
dimensions for flange width and stiffness computations.
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Figure 4-14 Required Slab Dimensions

7. Press the MODIFY button to update the slab geometry.
8. Repeat steps 2 through 7 until all the spans have been updated. You can use the COPY

button as a shortcut.
9. Press OK button to exit the dialog box and allow spSlab to use the updated slab geometry.

4.7.5 Defining Longitudinal Beams

Longitudinal beam dimensions are required for the beam-supported slab. Span numbers, which 
are determined from the number of supports entered in the General Information box, are 
automatically filled into the Span drop-down list. 

To input longitudinal beam geometry:

1. Select the Spans command from the Input menu or click the  button on the tool bar. 
Select Longitudinal Beams tab from the Span Data dialog box. The dialog box of Figure 
4-15 will appear.

2. Select the span number from the Span drop-down list.
3. Enter the width of the longitudinal beam (Figure 4-16).
4. Enter the depth of the longitudinal beam which is taken from the top of the slab to the 

bottom of the beam (Figure 4-16).
5. If required, enter the offset which is measured from the joint centerline, positive to the 

right, and negative to the left of the joint (Figure 4-16)
6. Press the MODIFY button to update the longitudinal beam geometry.
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Figure 4-15 Longitudinal Beam Geometry dialog box

7. Repeat steps 2 through 6 until all the beams have been updated. You can use the COPY
button as a shortcut.

8. Press OK button to exit the dialog box so that spSlab will use the new beam geometry.

Figure 4-16 Required Longitudinal Beam Dimensions

4.7.6 Defining Ribs

For joist systems, you must define the rib geometry. The ribs are assumed to be the same 
throughout the strip.
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To enter rib geometry:

• Select the Spans command from the Input menu or click the  button on the tool bar. 
Click the left mouse button on the Ribs tab. The dialog box of Figure 4-17 will appear.

Figure 4-17 Ribs Geometry dialog box

• Select the span number from the Span drop-down list.

• Enter the spacing between ribs at the bottom for clear rib spacing (see Figure 4-18).

Figure 4-18 Required Rib Dimensions
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• Enter the width at the bottom for rib width (see Figure 4-18).

• Enter the depth of the rib below the slab for Rib depth (see Figure 4-18).

• Press OK button to exit the dialog box so that spSlab can use the rib geometry.

4.7.7 Defining Longitudinal Slab Bands

This command is only available for two way floor systems when Slab Bands | Longitudinal
option is selected under the General Information dialog box, (CSA A23.3-14/04 only).

The Longitudinal Slab Bands property page (Figure 4-19) allows inputting the width, depth, and 
offset (eccentricity) of longitudinal slab bands in each span. The procedure is identical to the 
described earlier input of dimensions of longitudinal beams. It is not required to input bands for 
every span. Spans where slab bands are not defined are modeled similar to regular two-way 
systems. Longitudinal slab bands can also be extended to adjacent spans using drop panels.

To input geometry for longitudinal slab band:

1. Select the Spans command from the Input menu or click the  button on the tool bar. 
Click the left mouse button on the Longitudinal Bands tab. The dialog box of Figure 4-19 
will appear.

2. Select the span number from the Span drop-down list.
3. Enter the width of the longitudinal slab band.
4. Enter the depth of the longitudinal slab band from the top of the slab.
5. If required, enter the offset which is measured from the joint centerline, positive to the 

right, and negative to the left of the joint (See Figure 4-15)
6. Press the MODIFY button to update the longitudinal slab band geometry.
7. Repeat steps 2 through 6 until all the slab bands have been updated. You can use the COPY

button as a shortcut.
8. Press OK button to exit the dialog box longitudinal slab bands can either be continuous (at 

every span) or be discontinuous (at a single span or in successive spans). However, 
discontinuous Longitudinal bands are required to be capped by a half drop panel at the 
discontinued support.
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Figure 4-19 Longitudinal Slab Bands Geometry dialog box

4.7.8 User Defined Column Strip Widths

User has the ability to manually adjust column strip widths if the two-way floor system option is 
selected in Solve Options. In this case the Slab/Flanges property page (Figure 4-20) will contain 
additional field for inputting column strip width. The values of middle and beam strip widths are 
recalculated internally.

To manually adjust column strip widths:

• Enable check box User Slab Strip Width under Solve Options dialog window.

• Follow the procedure described in section Defining Slabs/Flanges.

• Enter additional values of column strip width for each span.
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Figure 4-20 User Defined Column Strip Widths

4.7.9 User Defined Moment Distribution Factors

User has the ability to manually adjust moment distribution factors if the two-way floor system 
option is selected in Solve Options. In such case the Moment Distribution property page (Figure 
4-21) will become available under Span Data dialog window. This dialog contains fields for 
inputting distribution factors in column and beam strips. The distribution factors for middle strip 
are recalculated internally.

To input Moment Distribution Factors:

1. Enable check box User Distribution Factors under Solve Options dialog window.

2. Select the Spans command from the Input menu or click the  button on the tool bar. 
Click the left mouse button on the Moment Distribution tab. The dialog box of Figure 4-
22 will appear.

3. Select the number of the span, for which values will be entered, from the Span drop-down 
list.

4. Enter moment distribution values in edit boxes.
5. Press the MODIFY button to update the slab geometry.
6. Repeat steps 2 through 5 until all the spans have been updated. You can use the COPY

button as a shortcut.
7. Press OK button to exit the dialog box.
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Figure 4-21 User Defined Moment Distribution Factors

4.7.10 Defining Columns

Column data is optional. If no column is specified at the joints the joint is assumed hinged. You 
will be allowed to enter column dimensions above and below.

To input column/capital geometry:

1. Select the Supports command from the Input menu or click the  button on the tool bar. 
The dialog box of Figure 4-22 will appear. Click on the Columns tab.

2. Enter stiffness share of the column which determines the percentage of the column 
stiffness used in the analysis. When the percentage lies between zero and 100%, the joint 
stiffness contribution by the column is multiplied by that percentage. Zero stiffness share 
indicates a pin support. Value of 999 indicates a support with fully fixed rotation. The 
default value is 100%, i.e. the actual column stiffness.

3. Enter the column height above, which is the distance from the top of the design floor to the 
top of the floor above (see Figure 4-23). spSlab obtains the clear column height above by 
subtracting the average slab depth from the height given. Only the slab is considered for 
the floor system above. A zero dimension for the column heights above and below will 
create a pin condition.
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Figure 4-22 Column Geometry dialog box

4. Enter the column height below, which is the distance from the design floor to the top of the 
floor below (see Figure 4-23). To obtain a clear column height below, the slab/drop/beam 
depth is subtracted from the height given. A zero dimension for the column heights above 
and below will create a pin condition.

Figure 4-23 Required Column Dimensions

5. Enter a value for c1, the column dimension in the direction of analysis (see Figure 4-23).
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6. Enter a value for c2, the column dimension perpendicular to the direction of analysis (see 
Figure 4-23). Round columns are specified with a zero input for c2; c1 is then taken as the 
diameter.

7. Select whether spSlab should compute punching shear around column and then ensure the 
preferred solve option for punching shear perimeter is selected in general information 
window.

8. Select whether spSlab should compute increased value of f factor and corresponding 
decreased v factor (for ACI code only).

9. Press the MODIFY button to update the column geometry.
10. Repeat steps 2 through 9 until all the columns and capitals have been updated. You can use 

the COPY button as a shortcut.
11. Press OK button to exit the dialog box so that spSlab will use the new data.

4.7.11 Defining Drop Panels

Drops are available for the flat slab or waffle slab systems and can be defined at all the support 
locations. The drop length and width dimensions are computed by spSlab, based on slab span 
dimensions, when the "Standard" is selected in the Type drop-down list.

To input drop geometry:

1. Select the Supports command from the Input Menu or click the  button then click on 
the Drop Panels tab. The dialog box of Figure 4-24 will appear.

2. Select whether spSlab should compute the drop dimensions or the dimensions will be user 
specified. If spSlab is to compute the dimensions, the "Standard" option should be selected 
from the Type drop-down list and then only the drop depth will be available. When the 
"Standard drop" option is selected spSlab will calculate drop panel dimensions in 
accordance with ACI 318 Clause 13.3.7. Similar requirements contained in previous 
editions of the CSA A23.3 Standard have been removed from the 1994 edition. As a 
result, the ACI minimum specifications for drop panels are also used in CSA A23.3 runs 
when the "Standard Drops" option is selected. If you would like to specify drop 
dimensions other than those computed by spSlab, you must select "User-defined" from the 
Type drop-down list.
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Figure 4-24 Drop Panel Geometry dialog box

3. Enter the dimension in the direction of analysis from the column centerline to the edge of 
the drop left of the column (see Figure 4-25). If this is a standard drop, this dimension will 
not be available and the length left is set equal to the slab span length left/6 for interior 
columns or the left cantilever length for the first column.

4. Enter the width dimension in the transverse direction (see Figure 4-25). If this is a 
standard drop, this dimension will not be available and the width is set equal to slab width/
3.

5. In order for spSlab to recognize drops, drop depths are required for the flat slab systems 
even if Standard Drop is selected. Enter the depth of the drop from the span with the 
smaller slab depth (see Figure 4-25). For waffle slab systems, the depth is automatically 
assumed to be equal to the rib depth below the slab and is not displayed. A value entered 
will be considered to exist below the rib depth during calculations.

6. Select whether spSlab should compute punching shear around drop panel.
7. Press the MODIFY button to update the drop geometry.
8. Repeat steps 2 through 6 until all the drop dimensions have been updated. You can use the 

COPY button as a shortcut.
9. Press OK button to exit the dialog box so that spSlab will use the new drop geometry
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Figure 4-25 Required Drop Panel Dimensions

4.7.12 Defining Column Capitals

To input column capital geometry:

• Select the Supports command from the Input menu or click the  button on the tool bar. 
Click left mouse button on the Column Capitals tab to activate it. The dialog box of Fig-
ure 4-26 will appear.
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Figure 4-26 Capital Dimensions

• Select the support number from the Support drop-down list.

• Enter the capital depth which is the distance from the bottom of the soffit (slab, drop, or 
beam), to the bottom of the capital. 

• Enter the capital side slope which is the rate of depth to extension of the capital and it must 
be greater than 1 and smaller than 50 (see Figure 4-27). 

• For circular column capitals, ensure the preferred solve option for punching shear perime-
ter is selected.
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Figure 4-27 Required Capital Dimensions

4.7.13 Defining Transverse Beams

This command is only available for two way floor systems when Slab Bands | Transverse option 
is selected under the General Information dialog box, (CSA A23.3-14/04 only).

The Transverse Beam command allows you to input the width, depth, and offset (eccentricity) of 
transverse beams at each column. This command is optional.

To input transverse beam geometry:

1. Select the Support command from the Input menu. Select Transverse Beams tab from 
the Support Data dialog box. The dialog box of Figure 4-28 will appear.

2. Enter the width of the transverse beam (see Figure 4-29)
3. Enter the depth of the transverse beam which is taken from the top of the slab to the 

bottom of the beam (see Figure 4-29)
4. If required, enter the offset, which is measured from the joint centerline, positive to the 

right, and negative to the left of the joint (See Figure4-29).
5. Press the MODIFY button to update the transverse beam dimensions.
6. Repeat steps 2 through 5 until all the beams have been updated. You can use the COPY

button as a shortcut (see "Entering the Structure Geometry" earlier in this chapter for help 
on the COPY button).
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Figure 4-28 Transverse Beam Geometry dialog box

7. Press OK button to exit the dialog box so that spSlab will use the new beam geometry.

Figure 4-29 Required Transverse Beam Dimensions

4.7.14 Defining Transverse Slab Bands

The Transverse Slab Bands property page (Figure 4-30) allows inputting the width, depth, and 
offset (eccentricity) of transverse bands at each column. It is not required to input bands for every 
support. Supports where slab bands are not defined are modeled similar to regular two-way 
systems.
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Figure 4-30 Transverse Slab Band Geometry dialog box

To input transverse slab band geometry:

1. Select the Support command from the Input menu. Select Transverse Slab Bands tab 
from the Support Data dialog box. The dialog box of Figure 4-30 will appear.

2. Enter the width of the transverse slab band (see Figure 4-30)
3. Enter the depth of the transverse slab band which is taken from the top of the slab to the 

bottom of the slab band (see Figure 4-30).
4. If required, enter the offset, which is measured from the joint centerline, positive to the 

right, and negative to the left of the joint (See Figure 4-30).
5. Press the MODIFY button to update the transverse slab band dimensions.
6. Repeat steps 2 through 5 until all the beams have been updated. You can use the COPY

button as a shortcut (see "Entering the Structure Geometry" earlier in this chapter for help 
on the COPY button).

7. Press OK button to exit the dialog box so that spSlab will use the new band geometry.

4.7.15 Defining Boundary Conditions

By default spSlab assumes that column-slab/beam joints can only rotate and that they do not 
undergo any translational displacements. Rotation of a joint is affected by the stiffness of elements 
it connects i.e. slabs/beams, transverse beams, and columns. Columns are assumed by default to 
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be fixed at their far ends as shown in Figure 2-6. These default assumptions can be altered using 
the Boundary Conditions command.

Figure 4-31 Boundary Conditions dialog box

By specifying vertical spring support constant with Kz value other than 0, you can allow the joint 
to displace vertically. This movement is then controlled by the stiffness of the spring Kz in 
addition to the stiffness of the column below. The column above is assumed not to constrain the 
vertical movement of the joint. Additional rotational spring support can be applied to the joint by 
specifying the value of Kry. Also the far end column conditions can be selected as either fixed or 
pinned as shown in Figure 4-32(b). All elements controlling the displacements of a joint are 
shown in Figure 4-32(a).

a)  b)

Figure 4-32 (a) Elements controlling joint displacement (b) Far End Column Boundary 
Conditions
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To input boundary conditions:

1. Select the Support command from the Input menu. Select Boundary Conditions tab 
from the Support Data dialog box. The dialog box of Figure 4-31 will appear.

2. Select support number
3. Enter value of Kz to allow vertical displacement of the support and to add translational 

spring support (see Figure 4-32(a))
4. Enter value of Kry to add rotational spring support (see Figure 4-32(a))

5. Select far end support conditions for the column above and below the joint (see Figure 4-
32(b))

6. Press the MODIFY button to update the boundary conditions.
7. Repeat steps 2 through 5 until all the joints have been updated. You can use the COPY

button as a shortcut (see "Entering the Structure Geometry" earlier in this chapter for help 
on the COPY button).

8. Press OK button to exit the dialog box so that the program will use the new boundary 
conditions.

4.7.16 Defining Moment Redistribution Factors

This command is only available for one-way/beam slab systems when MOMENT REDISTRIBUTION
option is checked in the General Information | Solve Options Tab

To input moment redistribution factors:

1. Select the Support command from the Input menu. Select Moment Redistribution tab 
from the Support Data dialog box. The dialog box of Figure 4-33 will appear.

2. Select support number
3. Enter the maximum value of the redistribution factors you want to allow on the left and 

the right side of the support. Please note that actual value used is determined by the 
program when the problem is being solved and that the check against the code specified 
limit is also performed.

4. Press the MODIFY button to update the redistribution factor limits.
5. Repeat steps 2 through 5 until all the supports have been updated. Please note that 

supports connecting to cantilevers will not be available since moment redistribution is not 
allowed there. You can use the 

6. COPY button as a shortcut (see "Entering the Structure Geometry" earlier in this chapter 
for help on the COPY button).

7. Press OK button to exit the dialog box so that spSlab will use the new moment 
redistribution limits.
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Figure 4-33 Moment Redistribution dialog box

4.7.17 Defining Reinforcement Criteria for Slabs and Ribs

In order for spSlab to select the reinforcement, you must define the slab and rib reinforcement, bar 
sizes, location, and minimum spacing dimensions. See "Area of Reinforcement" and 
"Reinforcement Selection" in Method of Solution for a discussion of the reinforcement 
computations. 

To define reinforcement Criteria for Slabs and Ribs:

• Select the Reinforcement Criteria command from the Input menu or click the  button 
on the tool bar. Select Slabs and Ribs tab by clicking the left mouse button on the tab title. 
The dialog boxes of Figure 4-34 will appear.

• For slabs and ribs, enter the clear covers for top and bottom reinforcing bars. For the top 
reinforcement, this distance is from the top of the slab to the top of the top bars. For the 
bottom reinforcement, this distance is from the bottom of the slab to the bottom of the bot-
tom bars (see Figure 4-35). The default value is 1.5 in. [40mm] for both input items.

• Enter the minimum bar size to start the iteration for determining flexural reinforcement.

• Enter the maximum bar size. This number will be used as a stop in the iteration for deter-
mining flexural bars in beams.
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Figure 4-34 Slab and Rib Reinforcement dialog boxes

• Enter minimum bar spacing for slab and rib flexural reinforcement. This number should 
be based on aggregate size or detailing considerations. Default spacing is 6 in. [150mm] 
for slabs and ribs.

• Enter maximum bar spacing for slab and rib flexural reinforcement. Default spacing is 18 
in. [500 mm] for slabs and ribs.

• Enter minimum Reinforcement Ratio for slab and rib flexural reinforcement. Default ratio 
is 0.14% [0.20%] for slabs and ribs. If the user specified value is smaller than 0.14%, 
0.14% is used by spSlab. If the user specified value is greater than 0.14%, the specified 
value is used by spSlab.

Figure 4-35 Clear Cover to Reinforcement
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• Enter maximum Reinforcement Ratio for slab and rib flexural reinforcement. Default ratio 
is 5% for slabs and ribs.

• If the top bars have more than 12 in. [300 mm] of concrete below them, check the corre-
sponding check box.

• Press OK button to exit the dialog box and allow spSlab to use the new data.

4.7.18 Defining Reinforcement Criteria for Beams

In order for spSlab to select the reinforcement, you must define the beam reinforcement, bar sizes, 
location, and minimum spacing dimensions. See "Area of Reinforcement" and "Reinforcement 
Selection" in the Method of Solution for a discussion of the reinforcement computations. 

To define reinforcement criteria for beams:

• Select the Reinforcement Criteria command from the Input menu or click the  button 
on the tool bar. Select Beams tab by clicking the left mouse button on the tab title. The 
dialog boxes of Figure 4-36 will appear.

• Enter the covers for top and bottom reinforcing bars for beams. For the top reinforcement, 
this distance is from the top of the beam to the top of the top bars; and for the bottom rein-
forcement, this distance is from the bottom of the beam to the bottom of the bottom bars 
(see Figure 4-37). The default value is 1.5 in. [40mm] for both input items.

• Enter the side cover which is measured from the side face of a beam to the face of the stir-
rup (see Figure 2-20). The default value is 1.5 in [40 mm].

• Enter the minimum bar size for top and bottom bars and stirrups to start the iteration for 
determining flexural reinforcement.

• Enter the maximum bar size for top and bottom bars and stirrups. This number will be 
used as a stop in the iteration for determining flexural bars in beams.

• Enter the minimum bar spacing for beam flexural reinforcement and stirrups. This number 
should be based on aggregate size or detailing considerations. The default minimum rein-
forcement bar spacing is 1 in. [25 mm] and the default stirrup spacing is 6 in. [150 mm]
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Figure 4-36 Beam reinforcement dialog boxes

• Enter the maximum bar spacing for beam flexural reinforcement and stirrups. The default 
maximum reinforcement spacing is 18 in. [500 mm] and the default maximum stirrup 
spacing is 18 in. [450 mm]

• Enter the minimum Reinforcement Ratio for beam flexural reinforcement. Default ratio is 
0.14% [0.20%] for beams. If the user specified value is smaller than 0.14%, 0.14% is used 
by spSlab. If the user specified value is greater than 0.14%, the specified value is used by 
spSlab.

Figure 4-37 Clear Cover to Reinforcement

• Enter the maximum Reinforcement Ratio for beam flexural reinforcement. Default ratio is 
5% for beams.
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• Enter the clear distance between bar layers to use if the program needs to distribute flex-
ural bars in multiple layers. Default distance is 1 in. [30 mm] for beams.

• Enter the distance from face of support (FOS) to first stirrup. The default value is 3.0 in 
[75 mm].

• If the top bars have more than 12 in. [300 mm] of concrete below them, check the corre-
sponding check box.

• Press OK button to exit the dialog box and allow spSlab to use the new data.

4.7.19 Defining Column Strip Bars for Two-Way Slab Systems

The reinforcing bar size, number of bars, bar length, etc. can be defined by users if the Run Mode 
of Investigation and two-way floor system are selected in the General Information dialog box. 
This menu item is not available if Run Mode of Design is selected in the General Information 
dialog box.

To define column strip bars:

1. Select Reinforcing Bars from the Input menu or click the  button on the tool bar. Select 
the Column Strip Bars tab by clicking the tab title or use the tab key on the keyboard to 
toggle to the tab title then select the Column Strip Bars tab using the arrow keys. The 
dialog boxes of Figure 4-38 will appear.

Figure 4-38 Defining Column Strip Bars
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2. Select the span for which reinforcing bars will be defined from the Span list box on the 
upper left corner. The length of the selected span will be shown right above the ADD
button.

3. Select bar size from the Bar Size drop-down list. 
4. Define the number of reinforcing bars in the selected span by entering the number in the 

Number of Bars input box.
5. Define the length of the reinforcing bars by entering the length in the Length input box. 

The unit of the length is foot [m].
6. Define the types of the reinforcing bars in the selected span by selecting from the Type

drop-down list, which is right below the Bar Size drop-down list. Five types are available: 
Top Left, Top Right, Top Continuous, Bottom Continuous and Bottom Discontinuous. 

7. Define the cover by entering the number in the Cover input box. The unit of cover is inch 
[mm].

8. Press ADD button to add the new data into the list box below the buttons.
9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use the SPAN 

COPY button below the Span list to simply copy the data of one span to other spans.
10. If the reinforcing data of a span needs to be modified, select the data from the data list box 

on the lower part of the dialog box then modify the data as mentioned above. Press 
MODIFY button when finished to update the corresponding data in the data list box.

11. To delete the reinforcing data for a span, select the data of the span from the data list box 
then press the DELETE button.

12. Press OK button to exit the dialog box so that spSlab will use these reinforcing bar 
properties.

4.7.20 Defining Middle Strip Bars for Two-Way Slab Systems

The reinforcing bar size, number of bars, bar length, etc., can be defined by users if the Run Mode 
of Investigation and two-way floor system are selected in the General Information dialog box. 
This menu item is not available if Run Mode of Design is selected in the General Information
dialog box.

To define middle strip bars:

1. Select Reinforcing Bars from the Input menu or click the  button on the tool bar. Select 
the Middle Strip Bars tab by clicking the tab title or use the tab key on the keyboard to 
toggle to the tab title then select the Middle Strip Bars tab using the arrow keys. The 
dialog boxes of Figure 4-39 will appear.
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Figure 4-39 Defining Middle Strip Bars

2. Select the span for which reinforcing bars will be defined from the Span list box on the 
upper left corner. The length of the selected span will be shown right above the ADD
button.

3. Select bar size from the Bar Size drop-down list.
4. Define the number of reinforcing bars in the selected span by entering the number in the 

Number of Bars input box.
5. Define the length of the reinforcing bars by entering the length in the Length input box. 

The unit of the length is foot [m].
6. Define the Types of the reinforcing bars in the selected span by selecting from the drop-

down list, which is right below the Bar Size drop-down list. Five types are available: Top 
Left, Top Right, Top Continuous, Bottom Continuous and Bottom Discontinuous. 

7. Define the cover by entering the number in the Cover input box. The unit of cover is inch 
[mm].

8. Press ADD button to add the new data into the list box below the buttons.
9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use the SPAN 

COPY button below the Span list to simply copy the data of one span to other spans.
10. If the reinforcing data of a span needs to be modified, select the data from the data list box 

on the lower part of the dialog box then modify the data as mentioned above. Press 
MODIFY button when finished to update the corresponding data in the data list.

11. To delete the reinforcing data for a span, select the data of the span from the data list box 
then press the DELETE button.
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12. Press OK button to exit the dialog box so that spSlab will use these reinforcing bar 
properties. 

4.7.21 Defining Beam Bars for Two-Way Slab Systems

The reinforcing bar size, number of bars, bar length, etc. can be defined by users if the Run Mode 
of Investigation and two-way floor system are selected in the General Information dialog box. 
This menu item is not available if Run Mode of Design is selected in the General Information
dialog box.

To define beam bars:

1. Select Reinforcing Bars from the Input menu or click the  button from the tool bar. 
Select the Beam Bars tab by clicking the tab title or use the tab key on the keyboard to 
toggle to the tab title then select the Beam Bars tab using the arrow keys. The dialog box 
of Figure 4-40 will appear.

Figure 4-40 Defining Beam Bars

2. Select the span for which reinforcing bars will be defined from the Span list box on the 
upper left corner. The length of the selected span will be shown right above the ADD
button.

3. Select bar size from the Bar Size drop-down list. 
4. Define the number of reinforcing bars in the selected span by entering the number in the 

Number of Bars input box.
5. Define the length of the reinforcing bars by entering the length in the Length input box. 

The unit of the length is foot [m].
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6. Define the types of the reinforcing bars in the selected span by selecting from the Type
drop-down list, which is right below the Bar Size drop-down list. Five types are available: 
Top Left, Top Right, Top Continuous, Bottom Continuous and Bottom Discontinuous. 

7. Define the cover by entering the number in the Cover input box. The unit of cover is inch 
[mm].

8. Press ADD button to add the new data into the list box below the buttons.
9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use the SPAN 

COPY button below the Span list to simply copy the data of one span to other spans.
10. If the reinforcing data of a span needs to be modified, select the data from the data list box 

on the lower part of the dialog box then modify the data as mentioned above. Press 
MODIFY button when finished to update the corresponding data in the data list.

11. To delete the reinforcing data for a span, select the data of the span from the data list box 
then press the DELETE button.

Press OK button to exit the dialog box so that spSlab will use these reinforcing bar properties.

4.7.22 Defining Beam Stirrups for Two-Way Slab Systems

The stirrup size, number of stirrups, etc. can be defined by users if the Run Mode of Investigation 
and two-way floor system are selected in the General Information dialog box. This menu item is 
not available if Run Mode of Design is selected in the General Information dialog box.

To define beam stirrups:

1. Select Reinforcing Bars from the Input menu or click the  button from the tool bar. 
Select the Beam Stirrups tab by clicking the tab title or use the tab key on the keyboard to 
toggle to the tab title then select the Beam Stirrups tab using the arrow keys. The dialog 
boxes of Figure 4-41 will appear.
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Figure 4-41 Defining Beam Stirrups

2. Select the span for which stirrups will be defined from the Span list box on the upper left 
corner. The length of the selected span will be shown right above the ADD button.

3. Enter the amount of stirrups of the selected span in the Count input box. (see Note)
4. Select stirrup size from the Size drop-down list. 
5. Enter the spacing of the stirrups of the selected span in the Spacing input box. The unit of 

spacing is inch [mm].
6. Enter the number of legs in the Leg input box.
7. For first stirrup set modify the default location of first stirrup if required.
8. Press ADD button to add the new data into the list box below the buttons.
9. Repeat steps 2 to 8 to define stirrups for all the spans. You may use the Span COPY button 

below the Span list to simply copy the data of one span to other spans.
10. In order to mirror stirrup set or sets at the end of the span use APPEND button.
11. If the stirrup data of a span needs to be modified, select the data from the data list box on 

the lower part of the dialog box then modify the data as mentioned above. Press MODIFY
button when finished to update the corresponding data in the data list.

12. To delete the stirrup data for a span, select the data of the span from the data list box then 
press the DELETE button.

13. Press OK button to exit the dialog box so that spSlab will use these reinforcing bar 
properties.
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Note: If stirrups do not apply in a part of a span, the Count should be set to 0 (zero) and the 
Spacing should be the length of the part of the span where no stirrups are defined. For example, 
the following configuration shows stirrups in the left and right ends of a span with an empty space 
(46.0 in. long, no stirrups) in the middle part of the span.

4.7.23 Defining Flexure Bars for Beams and One-Way Slab Systems

The reinforcing bar size, number of bars, bar length, etc. for one-way beam systems can be defined 
by users if the Run Mode of Investigation and beams/one-way slab floor system are selected in the 
General Information dialog box. This menu item is not available if Run Mode of Design is 
selected in the General Information dialog box.

Figure 4-42 Defining Flexure Bars for Beams/One-Way slab Systems

To define flexure bars for beam in beams/one-way slab systems follow the steps described in 
section Defining Beam Bars.

4.7.24 Defining Stirrups for Beams and One-Way Slab Systems

The stirrup size, number of stirrups, etc. for beams/one-way slab systems can be defined by users 
if the Run Mode of Investigation and beams/one-way slab floor system are selected in the General 
Information dialog box. This menu item is not available if Run Mode of Design is selected in the 
General Information dialog box.

Count Bar Size Spacing Legs
32 #5 4.50 2
0 #5 46.0 2
32 #5 4.50 2
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Figure 4-43 Defining Beams Stirrups in Beam/One-Way Slab Systems

To define beam stirrups in beams/one-way slab systems follow the steps described in section 
Defining Beam Stirrups.

4.7.25 Defining Torsional Longitudinal Bars for Beams

The torsional longitudinal reinforcement bars are distributed along the perimeter of the section in 
addition to the flexure bars. They can be defined by users if the Run Mode of Investigation, 
beams/one-way slab floor system, and torsional analysis and design are selected in the General 
Information dialog box. This menu item is not available if Run Mode of Design is selected in the 
General Information dialog box.

To define torsional longitudinal bars for beams in beams/one-way slab systems:

1. Select Reinforcing Bars from the Input menu or click the  button from the tool bar. 
Select the Torsion Bars tab by clicking the tab title or use the tab key on the keyboard to 
toggle to the tab title then select the Torsion Bars tab using the arrow keys. The dialog 
box of Figure 4-44 will appear.
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Figure 4-44 Defining Torsion Bars for Beams in Beams/One-Way Slab Systems

2. Select the span for which reinforcing bars will be defined from the Span list box on the 
upper left corner. The length of the selected span will be shown right above the ADD
button.

3. Select bar size from the Bar Size drop-down list. 
4. Define the type of the reinforcing bars in the selected span by selecting from the Type

drop-down list, which is right below the Bar Size drop-down list. Two types are available: 
Continuous and Discontinuous. 

5. Define the number of reinforcing bars in the selected span by entering the number in the 
Number of Bars input box.

6. Define the cover by entering the number in the Cover input box. The unit of cover is inch 
[mm].

7. For discontinued bars, define the length and the starting point of the reinforcing bars by 
entering the values in the Start and Length input boxes. The unit of both is foot [m].

8. Press ADD button to add the new data into the list box below the buttons.
9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use the SPAN 

COPY button below the Span list to simply copy the data of one span to other spans.
10. If the reinforcing data of a span needs to be modified, select the data from the data list box 

on the lower part of the dialog box then modify the data as mentioned above. Press 
MODIFY button when finished to update the corresponding data in the data list.

11. To delete the reinforcing data for a span, select the data of the span from the data list box 
then press the DELETE button.
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12. Press OK button to exit the dialog box so that spSlab will use these reinforcing bar 
properties.

4.7.26 Defining Load Cases

Up to 6 load cases of dead load, live load or lateral load can be defined in the Load Cases dialog 
box. The default five load case labels (types) are SELF (dead load), Dead (dead load), Live (live 
load), Wind (wind load), and EQ (seismic load).

To define load cases:

1. Select Load Cases command from the Input menu or click the  button on the tool bar. 
Dialog box as in Figure 4-45 will appear.

2. Enter a name for the new load case in the Label edit box. The name could be any character 
string defined by the user.

3. Select the type of the new load case from the Type drop-down list. The available types are 
Dead Load, Live Load and Lateral Load.

Figure 4-45 Defining Load Cases

4. Press ADD button to add the new load case into the load case list box on the lower part of 
the dialog box.

5. Repeat steps 2 to 4 to define all the load cases. The maximum number of load cases is 6. 
Once the maximum number is reached, the ADD button will be disabled.

6. To enter reserved load case SELF press the SELFWEIGHT button.
7. To modify an existing load case, select the load case from the load case list box then 

change the label or type the selected load case as mentioned above and press the MODIFY
button.
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8. To delete an existing load case, select the load case from the load case list box then press 
the DELETE button.

9. Press OK button to exit the dialog box so that spSlab will use these load cases.

Note: Only one case of live load can be defined. Load case label must be unique for each of the 
load cases. To ignore self weight in both strength and deflection calculations remove load case 
SELF from the list of load cases.

4.7.27 Defining Load Combinations

spSlab allows you to change the magnification factors applied to the load cases. The default values 
depend on the code selected with the General Information command.

To define load factors:

1. Select Load Combinations from the Input menu or click the  button from the tool bar. 
The dialog box of Figure 4-46 will appear if the ACI code was selected in the GENERAL 
INFORMATION dialog box.

Figure 4-46 Define Load Combinations

2. The load cases and the corresponding factors that are defined in the Load Cases dialog box 
are shown on the top of the Load Combinations dialog box.

3. Enter the load factors for each of the load cases in the input box below the corresponding 
load case label. 

4. Press the ADD button to add the combination defined above into the big list box in the 
lower part of the dialog box.
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5. Repeat steps 2 to 4 to define all the load combinations. Up to fifty load combinations may 
be defined. All the combinations are indexed automatically from U1 to U50.

6. To change the factors of an existing combination, select the load combination from the 
load combination list box on the lower part of the dialog box then change the factors as 
mentioned above. Press the MODIFY button when finished to update the data in the load 
combination list box.

7. To delete an existing combination, select the load combination from the load combination 
list box then press the DELETE button.

8. Select OK button when all the desired load factors have been modified to exit so that 
spSlab will use the new data.

4.7.28 Span Loads

spSlab computes the self weight of the floor system. Other loads applied to the structure have to be 
specified by the user. There are several types of applied loads that may be entered. They are found 
in the Input menu. Surface loads are placed over the entire strip. Partial loads consist of uniform 
or trapezoidal loads, concentrated loads, and concentrated moments that may exist anywhere 
within the span length. For beams/one-way slab systems torsional loads can be defined either as 
concentrated or distributed torques.

Figure 4-47 Span Load Types

Note: The loads shown in the Figure 4-47 are all positive and may not match the typical sign 
conventions.
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The following table describes input for the span load types shown in Figure 4-48.

Wa For uniformly distributed loads, Wa is the intensity of the load in units of lbs/ft [kN/m], 
positive Wa is downward. For trapezoidal loads, Wa is the intensity at the left end in 
units of lbs/ft [kN/m], positive Wa is downward. For concentrated force, Wa is the 
force P in units of kips [kN], positive Wa is downward. For concentrated moments, Wa
is the moment M in units of ft-kips [kNm], positive Wa is clockwise. For concentrated 
torque, Wa is the external torque T in units of ft-kips [kNm], positive Wa is such that 
applying the right hand screw rule the torque vector points to the right. For distributed 
torque, Wa is the external torque intensity Ta in units of ft-kips/ft [kNm/m], positive Wa
is such that applying the right hand screw rule the torque vector points to the right.

Wb For trapezoidal loads, Wb is the intensity at the right end in units of lbs/ft [kN/m], 
positive Wb is downward. For distributed torque, Wb is the external torque intensity Tb
in units of ft-kips/ft [kNm/m], positive Wa is such that applying the right hand screw 
rule the torque vector points to the right. For all the other partial load types, Wb is not 
available.

La For distributed loads, La is the distance where the load begins from the centerline of the 
column at the left of the span, in units of ft [m]. For concentrated loads and moments, 
La is the distance where the load exists from the centerline of the column at the left of 
the span in units of ft [m].

Lb For distributed loads, Lb is the distance where the load ends from the centerline of the 
column at the left of the span, in units of ft [m]. For concentrated loads and moments, 
Lb is unavailable. 
Note: Although the particular loading may not actually act over the entire transverse 
width, all line loading is converted internally by spSlab to act over the full width of the 
slab. In the design direction, partial loads given as acting over less than 1/20 of the 
span length will be averaged over 1/20 by the program.

4.7.29 Defining Area Load on Span

Area loads are uniform loads acting over the entire strip. These loads have units of lb/ft2 [kN/m2]. 

To input area loads:

1. Select the Span Loads command from the Input menu or click the  button on the tool 
bar. Select the AREA LOAD from the TYPE drop-down list on the SPAN LOADS dialog box. 
The dialog box of Figure 4-48 will appear.
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Figure 4-48 Defining Area Load on Span

2. Select the load case from the CURRENT CASE list box on the upper left corner as shown in 
the dialog above.

3. Select the span on which the area loads will be applied from the SPAN drop-down list.
4. Enter the unfactored superimposed area load magnitude acting over the entire area of the 

strip in the Magnitude edit box. Positive surface loads act downward. 
5. Press the ADD button to update the area loads in the area load list box on the lower part of 

the dialog box.
6. Repeat steps 2 through 5 until the loads have been updated. You can use the COPY button 

as a shortcut.
7. To change the data of an existing area load, select the area load from the area load list box 

then change the magnitude as mentioned above. Press the MODIFY button when finished to 
update the data in the area load list box.

8. To delete an existing area load, select the load from the area load list box then press the 
DELETE button.

9. Press OK button to exit the dialog box so that spSlab will use the new data.

4.7.30 Defining Line Load on Span

You may enter uniform or trapezoidal loads that do not span from column centerline to column 
centerline in the direction of analysis. These loads are called line loads and are input through the 
SPAN LOADS dialog of the Input menu. Partial loads are assumed to act over the entire strip width.

To input line loads:
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1. Select the Span Loads command from the Input menu or click the  button on the tool 
bar. Select the LINE LOAD from the TYPE drop-down list. The dialog box of Figure 4-49 
will appear.

2. Select the load case of the line load that will be defined from the Current Case list box.
3. From the Span drop-down list, select the span number of the span whose line loads you 

would like to input.
4. Define unfactored load values and their locations in the corresponding text boxes. 

Figure 4-49 Defining Line Load on Span

5. Select Add to add the line load defined into the line load list box.
6. Repeat steps 2 through 5 until all the line loads have been entered then press OK button to 

exit the dialog box so that spSlab will use the new loads.

To change line loads data:

• Select the line load you want to change from the line load list box on the lower part of the 
dialog box by clicking the left mouse button on the load or tabbing to the list box and 
using the arrow up and down keys.

• Make your changes to the load by modifying the load type, the load magnitude, and/or 
location.

• Select Modify to replace the old data with the new data.

To delete line load data:

• Select the line load you want to delete from the line load list box by clicking the left 
mouse button on the load or tabbing to the list box and using the arrow up and down keys.
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• Press the DELETE button.

4.7.31 Defining Point Force on Span

You may enter concentrated vertical loads. These loads are input through the Span Load 
command of the Input menu. Point loads are assumed to act over the entire strip width.

To input point loads:

1. Select the Span Loads command from the Input menu or click the  button on the tool 
bar. Select the Point Force from the Type drop-down list. The dialog box of Figure 4-50 
will appear.

Figure 4-50 Defining Point Forces on Span

2. Select the load case of the point force that will be defined from the Current Case list box.
3. From the Span drop-down list, select the span number of the span whose point loads you 

would like to input.
4. Define unfactored load values and their locations in the corresponding text boxes. 
5. Select Add to add the point load defined into the point load list box on the lower part of 

the dialog box.
6. Repeat steps 2 through 5 until all the point loads have been entered then press OK button 

to exit the dialog box so that spSlab will use the new loads.

To change point load data:

• Select the point force you want to change from the point load list box by clicking the left 
mouse button on the load or tabbing to the list box and using the arrow up and down keys.
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• Make your changes to the load by modifying the load type, the load magnitude, and/or 
location.

• Select Modify to replace the old data with the new data.

To delete point load data:

• Select the point force you want to delete from the point load list box to the right by click-
ing the left mouse button on the load or tabbing to the list box and using the arrow up and 
down keys.

• Press the DELETE button.

4.7.32 Defining Point Moment on Span

You may enter concentrated moment. This load is input through the Span Load command of the 
Input menu. Point moments are assumed to act over the entire strip width.

To input point moments:

1. Select the Span Loads command from the Input menu or click the  button on the tool 
bar. Select the Point Moment from the Type drop-down list. The dialog box of Figure 4-
51 will appear.

2. Select the load case of the point moment that will be defined from the Current Case list 
box.

3. From the Span drop-down list, select the span number of the span whose point moments 
you would like to input.

4. Define unfactored moment values and their locations in the corresponding text boxes. 
5. Select Add to add the point moment defined into the point moment list box on the lower 

part of the dialog box.
6. Repeat steps 2 through 5 until all the point moments have been entered then press OK

button to exit the dialog box so that spSlab will use the new moments.
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Figure 4-51 Defining Point Moments on Span

To change point moment data:

• Select the point moment you want to change from the point moment list box by clicking 
the left mouse button on the load or tabbing to the list box and using the arrow up and 
down keys.

• Make your changes to the moment by modifying the moment type, the moment magni-
tude, and/or location.

• Select Modify to replace the old data with the new data.

To delete point moment data:

• Select the point moment you want to delete from the point moment list box to the right by 
clicking the left mouse button on the load or tabbing to the list box and using the arrow up 
and down keys.

• Press the DELETE button.

4.7.33 Defining Line Torque on Span

You may enter line torque for beams/one-way slab systems if Torsion Analysis and Design is 
selected in the GENERAL INFORMATION dialog box. This load is input through the Span Load 
command of the Input menu.
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To input line torque:

1. Select the Span Loads command from the Input menu or click the  button on the tool 
bar. Select the LINE TORQUE from the TYPE drop-down list. The dialog box of Figure 4-52 
will appear.

Figure 4-52 Defining Line Torque on Span

2. Select the load case of the line load that will be defined from the CURRENT CASE list box.
3. From the SPAN drop-down list, select the span number of the span whose line loads you 

would like to input.
4. Define unfactored torque values and their locations in the corresponding text boxes. 
5. Select Add to add the line torque defined into the list box.
6. Repeat steps 2 through 5 until all the line torques have been entered. Then press OK button 

to exit the dialog box so that spSlab will use the new loads.

To change line torque data:

• Select the line torque you want to change from the load list box on the lower part of the 
dialog box by clicking the left mouse button on the load or tabbing to the list box and 
using the arrow up and down keys.

• Make your changes to the load by modifying the load type, the load magnitude, and/or 
location.

• Select Modify to replace the old data with the new data.
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To delete line torque data:

• Select the line torque you want to delete from the load list box by clicking the left mouse 
button on the load or tabbing to the list box and using the arrow up and down keys.

• Press the DELETE button.

4.7.34 Defining Point Torque on Span

You may enter point torque for beams/one-way slab systems if Torsion Analysis and Design is 
selected in the GENERAL INFORMATION dialog box. This load is input through the Span Load 
command of the Input menu.

To input point torque:

1. Select the Span Loads command from the Input menu or click the  button on the tool 
bar. Select the POINT TORQUE from the TYPE drop-down list. The dialog box of Figure 4-
53 will appear.

2. Select the load case of the point torque that will be defined from the CURRENT CASE list 
box.

3. From the SPAN drop-down list, select the span number of the span whose point moments 
you would like to input.

4. Define unfactored torque values and their locations in the corresponding text boxes. 
5. Select ADD to add the point torque defined into the list box on the lower part of the dialog 

box.
6. Repeat steps 2 through 5 until all the point torques have been entered. Then press OK

button to exit the dialog box so that spSlab will use the new torques.
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Figure 4-53 Defining Point Torque on Span

To change point torque data:

• Select the point torque you want to change from the list box by clicking the left mouse 
button on the load or tabbing to the list box and using the arrow up and down keys.

• Make your changes to the moment by modifying the torque magnitude, and/or location.

• Select MODIFY to replace the old data with the new data.

To delete point torque data:

• Select the point torque you want to delete from the point moment list box by clicking the 
left mouse button on the load or tabbing to the list box and using the arrow up and down 
keys.

• Press the DELETE button.

4.7.35 Defining Support Loads and Displacements

You may enter prescribed support displacements and rotations as well as apply concentrated 
forces and moments to the system at support locations. These loads are input through the Support 
Loads and Displacements command of the Input menu.

To input support loads and displacements:

1. Select the Support Loads and Displacements command from the Input menu or click 
the  button on the tool bar. The dialog box of Figure 4-54 will appear.
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Figure 4-54 Defining Support Loads and Displacements

2. Select the load case of the support loads and displacements that will be defined from the 
CURRENT CASE list box.

3. From the SUPPORT drop-down list, select the support number of the support whose loads 
you would like to input.

4. Define unfactored values of the displacement, rotation, forces, and moment. 
5. Select Add to add the support loads and displacements defined into the load list box on the 

lower part of the dialog box.
6. Repeat steps 2 through 5 until all the support loads and displacements have been entered 

then press OK button to exit the dialog box so that spSlab will use the new moments.

To change support and displacement loads data:

• Select the entry you want to change from the load list box by clicking the left mouse but-
ton on the load or tabbing to the list box and using the arrow up and down keys.

• Make your changes to the values.

• Select Modify to replace the old data with the new data.

To delete support and displacement load data:

• Select the entry you want to delete from the load list box by clicking the left mouse button 
on the load or tabbing to the list box and using the arrow up and down keys.

• Press the DELETE button.
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4.7.36 Defining Lateral Effects

spSlab can combine the gravity load analysis with a lateral load analysis. Lateral loads are entered 
as joint moments obtained elsewhere by a frame analysis. The joint moments are combined with 
the gravity load moments to produce load patterns 5 through 8.

To input lateral load moments:

1. Define at least one lateral load case from the Load Cases dialog box. 
2. Select Lateral Effects from the Input menu. If no lateral case is defined this command is 

disabled. Once selected, Figure 4-55 will appear.

Figure 4-55 Lateral Moment dialog box

3. Select load cases from the CURRENT CASE list box. At least one lateral load case must be 
defined in the LOAD CASES dialog box before you can see the load case in the CURRENT 
CASE list box.

4. Select span number on which lateral loads will be defined from the SPAN drop-down list.
5. Enter the moments at the left end and right end of the span in the Moment at Left and 

Moment at Right input boxes, respectively.
6. Press the ADD button to add the lateral load defined above into the lateral load list box in 

the lower part of the dialog box.
7. Repeat steps 2 through 5 to define all the lateral loads. 
8. To change an existing lateral load, select the load from the lateral load list box then change 

the moments as mentioned above. Press the MODIFY button when finished to update the 
data in the lateral load list box.
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9. To delete an existing lateral load, select the load from the lateral load list box then press 
the DELETE button.

10. Select OK button when all the desired lateral loads have been modified to exit so that 
spSlab will use the new data.

4.8 Executing Calculations (menu Solve)

4.8.1 Execute

The Execute command starts the design portion of spSlab after you have finished inputting all the 
data. 

To design the system:

Select the Execute command from the Solve menu or click the  button on the tool bar. If any 
data required to analyze and design the system has not been input prior to executing this 
command, spSlab will display an "Invalid model!" message. You must complete the data before 
execution. 

An analysis status window shows the current state of the execution as shown in Figure 4-56. If the 
state of each of the computations is OK, the analysis is successful. If any error is encountered 
ERROR will be shown and the computation is terminated.

Figure 4-56 Analysis Status Window

4.8.2 Viewing Results

Once the analysis and/or design is performed, you can view the results, shear and moment 
diagrams, and deflected shapes. This section provides procedures performing these functions.
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To view the analysis and design results:

• Select Results command from the Solve menu or click the  button from the tool bar. 
Alternatively you can also press the F6 key. This will launch the spResults module.

Figure 4-57 spResults Module

• Select the results tables you want to view from the explorer. The table displayed in the pre-
view space will be changed based on your selection.

• To copy results, select desired data from the table and right click, press the COPY button to 
copy the current results into the Windows clipboard. Then you may use CTRL + V to 
paste the contents of the clipboard to any other editors such as Word or Notepad.

• Press the CLOSE on the top right corner to close the result dialog box.

4.9 View Program Output (menu View)

4.9.1 Zooming in on Floor System

In order to view the floor system in greater detail, spSlab allows you to magnify a portion of the 
floor system for closer analysis.

Using zoom with a magnifier:

• Select Zoom from the View menu then a sub menu appears beside the View menu.
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• Select Window from the sub menu. Notice that the Window command is checked and the 
cursor is changed to a magnifier. The other way to magnify window is to click the  but-
ton on the tool bar.

• Move the cross cursor to the upper left corner of the portion of the system you want to 
enlarge.

• Press and hold down the left mouse button while dragging the cursor to the lower right 
portion of the system enclosing the desired area within the dashed box. 

• Release the mouse to enlarge that portion.

Using Zoom In and Zoom Out command:

• Select Zoom from the View menu and a sub menu appears.

• Select the In(2x) menu command from the sub menu. The current active window will be 
magnified by two times. The other way to do this is to click the  button on the tool bar.

• Select the Out(0.5x) menu command from the sub menu. The current active window will 
be reduced by two times. The other way to do this is to click the  button on the tool bar.

Note: To return to original (default) zoom, select Restore from the View menu, or select  from 
tool bar. To move model in a view window, use Pan from the View menu, or select  from tool 
bar.

4.9.2 Change Isometric View Angle

You can modify the X and Z angles at which the floor system is displayed in the isometric view 
window. By default, the floor system is viewed at -45° about the X axis and 45° about the Z axis. 
The right hand rule is used to determine the angle of rotation about the X and Z axes and the X axis 
is always rotated first.

To change angles:

• Select Change View Angle from the View menu. The dialog box of Figure 4-58 appears 
displaying the currently set angles.
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Figure 4-58 Isometric View dialog box

• Change the angles of rotation about the X and Z axes. The X axis is rotated first then the Z 
axis is rotated. The floor system is rotated about the axis using the right hand rule.

• Select OK button to accept the new angles and to modify the isometric view.

Note: A more convenient way to change the view angles instantly without entering angles in the 
dialog box is to use the keyboard shortcut CTRL + ARROW Keys. For example, press CTRL + 
and CTRL +  to rotate the floor system around Z axis and press CTRL +  or CTRL +  to rotate 
around X axis.

4.9.3 Viewing Specific Member Type

In order to see the floor system members in greater detail, you can select specific member types to 
view by enabling and disabling them.

To select member type:

• Select the View Options command from the View menu. The dialog box of Figure 4-62 
will appear showing the currently displayed member types. Depending on the floor sys-
tem, some of the member types will be shaded gray and unavailable.

• To hide a member type from a view of the floor system you must remove the  sign from 
the check box. Click the left mouse button on the check box of the member type you 
would like to hide. To view a previously hidden member type, click the left mouse button 
on the check box to add the  sign to the check box.

• Select OK button to view only the selected member types.
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Figure 4-59 View Options dialog box

4.9.4 Plan View

To switch to plan view:

1. Select the Plan View command from the View menu or click  button on the tool bar. The 
dialog box of Figure 4-60 will appear. 

Figure 4-60 Plan View Window

2. Right click on the view window to show the pop-up menu. You may save the current view 
window as bitmap (BMP) file or metafile (EMF) onto the Windows clipboard by selecting 
Copy Bitmap or Copy Metafile, respectively. You may also select the commands from the 
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pop-up menu to zoom in or zoom out the view window and preview it before printing it 
out. 

Figure 4-61 Pop-up Menu of View Window

1. Select the Options command from the pop-up menu, and then you may decide what 
geometry members need to be shown on the view window as shown in Figure 4-62. To 
hide a member type from a view of the floor system you must remove the  sign from the 
check box. Click the left mouse button on the check box of the member type you would 
like to hide. To view a previously hidden member type, click the left mouse button on the 
check box to add the  sign to the check box.

2. Select OK button to view only the selected member types.

Figure 4-62 Geometry Options of Elevated View

4.9.5 Elevated View

To switch to elevated view:

• Select the Elevated View command from the View menu or click  button from the tool 
bar. The dialog box of Figure 4-63 will appear.
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Figure 4-63 Elevated View Window

• Right click on the view window to show the pop-up menu. You may save the current view 
window as bitmap (BMP) file or metafile (EMF) onto the Windows clipboard by selecting 
Copy Bitmap or Copy Metafile, respectively. You may also select the commands from the 
pop-up menu to zoom in or zoom out the view window and preview it before printing it 
out. 

Figure 4-64 Pop-up Menu of View Window

• Select the Options command from the pop-up menu, and then you may decide what 
geometry members need to be shown on the view window as shown in Figure 4-65. To 
hide a member type from a view of the floor system you must remove the  sign from the 
check box. Click the left mouse button on the check box of the member type you would 
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like to hide. To view a previously hidden member type, click the left mouse button on the 
check box to add the  sign to the check box.

• Select OK button to view only the selected member types.

Figure 4-65 Geometry Options of Elevated View

4.9.6 Side View

To switch to side view:

• Select the Elevated View command from the View menu or click  button from the tool 
bar. The dialog box of Figure 4-66 will appear. 

Figure 4-66 Side View window

• Right click on the view window to show the pop-up menu. You may save the current view 
window as bitmap (BMP) file or metafile (EMF) onto the Windows clipboard by selecting 
Copy Bitmap or Copy Metafile, respectively. You may also select the commands from the 
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pop-up menu to zoom in or zoom out the view window and preview it before printing it 
out. 

Figure 4-67 Pop-up Menu of View Window

• Select the Options command from the pop-up menu, and then you may decide what 
geometry members need to be shown on the view window as shown in Figure 4-68. To 
hide a member type from a view of the floor system you must remove the  sign from the 
check box. Click the left mouse button on the check box of the member type you would 
like to hide. To view a previously hidden member type, click the left mouse button on the 
check box to add the  sign to the check box.

Figure 4-68 Geometry Options of Side View

• Select OK button to view only the selected member types.

4.9.7 Isometric View

To switch to isometric view:

• Select the Isometric View command from the View menu or click  button on the tool 
bar. The dialog box of Figure 4-69 will appear. 
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Figure 4-69 Isometric View Window

• Right click on the view window to show the pop-up menu. You may save the current view 
window as bitmap (BMP) file or metafile (EMF) onto the Windows clipboard by selecting 
Copy Bitmap or Copy Metafile, respectively. You may also select the commands from the 
pop-up menu to zoom in or zoom out the view window and preview it before printing it 
out. 

Figure 4-70 Pop-up Menu of View Window

• Select the Options command from the pop-up menu, and then you may decide what 
geometry members need to be shown on the view window as shown in Figure4-71. To 
hide a member type from a view of the floor system you must remove the  sign from the 
check box. Click the left mouse button on the check box of the member type you would 
like to hide. To view a previously hidden member type, click the left mouse button on the 
check box to add the  sign to the check box.
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Figure 4-71 Geometry Options of Isometric View

• Select OK button to view only the selected member types.

4.9.8 Loads

To show the loads:

• Select the Loads command from the View menu or click  button from the tool bar. The 
dialog box of Figure 4-72 will appear. 

Figure 4-72 Loads View Window

• Right click on the view window to show the pop-up menu. You may save the current view 
window as bitmap (BMP) file or metafile (EMF) onto the Windows clipboard by selecting 
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Copy Bitmap or Copy Metafile, respectively. You may also select the commands from the 
pop-up menu to zoom in or zoom out the view window and preview it before printing it 
out. 

Figure 4-73 Pop-up menu of View Window

• Select the Options command from the pop-up menu, and then you may decide what kind 
of loads need to be shown on the view window as shown in Figure 4-74. To hide a load 
case, load type, or live load pattern you must remove the  sign from the check box. Click 
the left mouse button on the check box of the member type you would like to hide. To 
view a previously hidden load type, click the left mouse button on the check box to add the 
 sign to the check box.

Figure 4-74 Loads Options

• If you want to hide the load values, remove the  sign before SHOW VALUES check box. 

• If you want to hide the load units, remove the  sign before SHOW UNITS check box. 

• Select OK button to view only the selected member types.

4.9.9 View Graphical Results

4.9.9.1 Viewing Internal Forces Diagrams

Once the design has been performed, you may view the shear, moment, and internal torque 
(beams/one-way slab systems with torsion) diagrams for any span at any available load 
combination.
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To view shears and moments diagram:

• Select the Internal Forces command from the View menu or click the  button on the 
tool bar. A view window similar to Figure 4-75 will appear. The upper half view window 
shows the shear diagram and the lower half the view window shows the moment diagram. 
If torsion is enabled for beams/one-way slab systems than internal torque diagram will 
also be shown in this window.

Figure 4-75 View Internal Forces Diagram

• The current coordinate values can be captured based on the position of the mouse cursor. 
The status bar in Figure 4-76 shows the name of the diagram, two coordinate values of the 
current mouse cursor position, and the current design code used in the project.

Figure 4-76 Coordinate Value Shown in Status Bar

• Click the right mouse button anywhere on the view window to show the pop-up menu. 
You may Restore, Zoom, Pan or Print View directly by selecting commands from this 
pop-up menu.

• Click the Options command from the pop-up menu to change the span for which the inter-
nal forces diagrams will be shown and to choose if legend will be displayed or not. Figure 
4-77 shows the OPTIONS dialog box. Select a span number from the SHOW DIAGRAM FOR
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drop-down list and select a load Envelope or combination from the SELECT LOAD COMBI-
NATIONS check list box. Use DRAW LEGEND checkbox to control whether legend is drawn 
or not. Press the OK button to close the dialog box and redraw the view windows.

Figure 4-77 View Internal Forces Diagram Options

Note: The pop-up menu can be accessed from each of the view windows of spSlab.

The Restore command cannot be executed in the pop-up menu until the Zoom or Pan command 
is stopped by pressing the ESC key. Without stopping the Zoom/Pan command, one can only 
restore a view using the Restore command in View menu or  button in the tool bar. This occurs 
in all spSlab view windows.

4.9.9.2 Viewing Moment Capacity

Once the design has been performed, you may view the moment capacity diagrams for any span. 
The moment capacity window will be split in half horizontally. The middle strip moment capacity 
will occupy the upper half and the column strip moment capacity will occupy the lower half where 
each diagram will be scaled to fill the entire half of the window. 

To view moment capacity:

1. Select the Moment Capacity command from the View menu or click the  button on the 
tool bar. A view window similar to Figure 4-78 will appear.

2. Right click on the Moment Capacity view window and select Options command from the 
pop-up menu. A dialog box similar to Figure 4-79 will appear.

3. The current coordinate values can be captured based on the position of the mouse cursor. 
The status bar shows the name of the diagram, two coordinate values of the current mouse 
cursor position, and the current design code used in the project.
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Figure 4-78 View Moment Capacity Diagram

4. Click the right mouse button anywhere on the view window to show the pop-up menu. 
You may Restore, Zoom, Pan or Print View directly by selecting commands from this 
pop-up menu.

5. Click the Options command from the pop-up menu to change the span for which the 
moment capacity will be shown. Select which span will be shown in the SHOW DIAGRAM 
FOR drop-down list. Use DRAW LEGEND checkbox to control whether legend is drawn or 
not. Use VALUES AND ZONES checkbox to control whether values at critical sections 
within the zones are drawn or not.Select which part of the selected span will be shown in 
the Show frame box.
To view capacity of longitudinal reinforcement, use COMBINED M-V-T checkbox (Figure 
4-79b) for beams designed or investigated per CSA A23.3-14/04200 with Combined M-V-
T option.

6. Press the OK button to close the dialog box and redraw the view windows. 
7. The magnitude of the bending moment at the critical sections is displayed and indicated 

by an asterisk where the bending moment diagram intersects the critical section.

200.CSA A23.3-14, 11.3.9.2, 11.3.9.3, 11.3.10.6; CSA A23.3-04, 11.3.9.2, 11.3.9.3, 11.3.10.6
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a)  b) 

Figure 4-79 View Moment Capacity Option dialog box (a) two-way system (b) beam with 
M-V-T option selected in Solve Options (CSA A23.3-14/04 only)

4.9.9.3 Viewing Shear Capacity

Once the design has been performed, you may view the slab shear capacity diagrams for any span.

To view shear capacity:

1. Select the Shear Capacity command from the View menu or click the  button on the 
tool bar. A view window similar to Figure 4-80 will appear.

Figure 4-80 View Shear Capacity
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• Right click on the Shear Capacity view window and select Options command from the 
pop-up menu. A dialog box similar to Figure 4-81 will appear.

a)  b) 

Figure 4-81 View Shear Capacity Option dialog box(a) One-way and two-way system (b) 
Two-way system with shear distributed to slab strips

• The current coordinate values can be captured based on the position of the mouse cursor. 
The status bar shows the name of the diagram, two coordinate values of the current mouse 
cursor position, and the current design code used in the project.

• Click the right mouse button anywhere on the view window to show the pop-up menu. 
You may Restore, Zoom, Pan or Print View directly by selecting commands from this 
pop-up menu.

• Click the Options command from the pop-up menu to change the span for which the shear 
capacity will be shown. Select which span will be shown in the SHOW DIAGRAM FOR drop-
down list. Use DRAW LEGEND checkbox and CRITICAL SECTION checkbox to control if the 
legend and critical sections are drawn or not. Select which part of the selected span will be 
shown in the SHOW frame box.

• The magnitude of the shear at critical sections is displayed and indicated by an asterisk 
where the shear force diagram intersects the critical section.

• Press the OK button to close the dialog box and redraw the view windows.

4.9.9.4 Viewing Reinforcement

Once the design has been performed, you may view the reinforcement diagrams for any span. The 
reinforcement window will be split in half horizontally. The middle strip reinforcement will 
occupy the upper half, and the column strip reinforcement will occupy the lower half where each 
diagram will be scaled to fill the entire half of the window. 

To view reinforcement:
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• Select the Reinforcement command from the View menu or click the  button on the tool 
bar. A view window similar to Figure 4-82 will appear.

Figure 4-82 View Reinforcement

• Right click on the Reinforcements view window and select Options command from the 
pop-up menu. A dialog box similar to Figure 4-83 will appear.

• The current coordinate values can be captured based on the position of the mouse cursor. 
The status bar shows the name of the diagram, coordinate value of the current mouse cur-
sor position in the design direction, and the current design code used in the project.

• Click the right mouse button anywhere on the view window to show the pop-up menu. 
You may Restore, Zoom, Pan or Print View directly by selecting commands from this 
pop-up menu.
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Figure 4-83 View Reinforcement Options dialog box

• Click the Options command from the pop-up menu to change the span for which the shear 
capacity will be shown. Select the span you want to show from the Show diagram for
drop-down list. Select which part of the selected span will be shown from the Show frame 
box. Checking the SHOW BAR LABELS will show labels beside each reinforcement on the 
view. Similarly bar length can be included by checking INCLUDE BAR LENGTH. Bar labels 
can also be arranged vertically if ROTATE BAR LABELS is checked. Set the vertical scale 
(relative to the horizontal scale which is set automatically) to which members are drawn in 
the SLAB THICKNESS SCALE edit box.

• Press the OK button to close the dialog box and redraw the view windows.

4.9.9.5 Viewing Deflected Shapes

Once the design has been performed, you may view the deflection shapes for any span.

To view the deflection shapes:

• Select the Deflection command from the View menu or click the  button on the tool bar. 
A view window similar to Figure 4-84 will appear.

• Right click on the deflection view window and select Options command from the pop-up 
menu. A dialog box similar to Figure 4-85 will appear.
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Figure 4-84 View Deflection Diagram

• The current coordinate values can be captured based on the position of the mouse cursor. 
The status bar shows the name of the diagram, two coordinate values of the current mouse 
cursor position, and the current design code used in the project.

• Click the right mouse button anywhere on the view window to show the pop-up menu. 
You may Restore, Zoom, Pan or Print View directly by selecting commands from this 
pop-up menu.

Figure 4-85 View Deflection Option dialog box

• Click the Options command from the pop-up menu to change the span for which the 
deflection will be shown. Select the span you want to show from the SHOW DIAGRAM FOR
drop-down list. Check the Draw Legend checkbox to include the legend in the drawing. 
Enter the scale factor in the SCALE FACTOR edit box. The bigger the scale factor, the more 
apparent the deflections will be on the diagram. 
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• Press the OK button to close the dialog box and redraw the view windows.

4.9.10 Printing Results

4.9.10.1 Printing Analysis and Design Results

Once the analysis and/or design is performed, you can print the results. This section provides 
procedures for performing these functions.

To print the analysis and design results:

Select Reporter command from the Solve menu or click the  button from the tool bar. 
Alternatively you can also press the F7 key. This will launch the spReporter module.

Figure 4-86 View and Print dialog box

• Only Word/PDF and Text reports can be previewed and directly printed. Select the format 
you want to print the results in from the panel on the left. The preview will be changed 
depending on your selection.

• You can adjust the paper size, page orientation margins and print range using the Print/
Export panel on the left.
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• Press the PRINT button on the dialog box to print the results through a printer. The printer 
could be a local printer which is connected to your computer directly, or a network printer.

• Press the CLOSE button to close spReporter when printing job is done.

4.9.10.2 Printing Current View Window

Once the design has been performed, you may print the diagrams and views for any span at any 
available loading pattern by selecting the Print View command from the File menu.

To print a displaying window:

• To select the diagram or view you want to print, single click the left mouse button on the 
diagram or view window.

• Select the Print View command from the File menu. A print preview window similar to 
Figure 4-87 will be shown
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Figure 4-87 Print Preview Window

• Press the ZOOM IN or ZOOM OUT buttons or simply click the left mouse button on the pre-
view to magnify or reduce the size of the preview paper. 

• Press the NEXT PAGE button if more than one page need to be printed.

• Press the PRINT button to print the view. The printer could be a local printer which is con-
nected to your computer directly, or a network printer.

• Press the CLOSE button to close the preview window and go back to spSlab.

4.9.11 Print Preview

The Print Preview command allows you to preview and print the current view window (floor 
system geometry in the plan, elevated and isometric views, prints the shear and moment diagrams, 
and the deflected shapes). 
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• To obtain a view window you must first perform the design, then select what you want to 
view from the View menu. You may have more than one view window opened. The cur-
rent view window is the one activated and on top of the others on your screen. 

• Selecting this command closes the spSlab main window and opens the print preview win-
dow as shown in Figure 4-87.

• On the print preview window, press the ZOOM IN or ZOOM OUT buttons or simply click the 
left mouse button on the preview window to magnify or reduce the size of the preview 
paper. 

• Press the NEXT PAGE button if more than one page needs to be printed. 

• Press the PRINT button to print the view. The printer could be a local printer which is con-
nected to your computer directly, or a network printer. 

• Press the CLOSE button to close the preview window and go back to spSlab.

4.9.12 Copy Graphs to Clipboard

Copy Bitmap (BMP format)

spSlab can copy any of the ten view windows onto Windows clipboard as bitmap. The bitmap on 
clipboard can then be pasted into Microsoft Word or other Windows applications including 
presentation software such as Microsoft PowerPoint.

To copy view window to clipboard as bitmap:

• Select the view window that will be copied by single clicking left mouse button on it.

• Select  from the tool bar to copy the selected view window to clipboard.

• Switch to other word processing software, such as Microsoft Word, then press the CTRL + 
V to paste the bitmap on clipboard to a Word file.

Copy Metafile (EMF format)

Since bitmap files cannot easily be resized or re-proportioned without significant distortion to the 
image, metafiles are generally used for situations requiring scalability of the image.

Advantages of metafiles are:

• Large, simply structured images require less memory than bitmaps for display and make 
optimal use of the resolution of the output device.

• Metafiles can be resized with none of the distortion which normally accompanies resizing 
of bitmaps.

• A metafile can contain SelectPalette statements, allowing custom palettes to be displayed 
in applications such as Microsoft Word.
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The Enhanced MetaFile (EMF) format is an extension of the Windows metafiles format developed 
for use with 32 bit Windows applications. It is only available to native 32 bit applications.

To copy view window to clipboard as Enhanced MetaFile (EMF):

• Select the view window that will be copied by single clicking left mouse button on it.

• Select  from the tool bar to copy the selected view window to clipboard.

• Switch to other word processing software, such as Microsoft Word, then press the CTRL + 
V to paste the bitmap on clipboard to a Word file.

4.10 Customizing Program (menu Options)

4.10.1 Changing Colors

Colors can be changed for background of views, geometry items such as slabs and beams, text on 
views, result diagrams, etc.

To change colors:

• Select Colors command from the Options menu. Figure 4-88 will appear.

• From the General frame box on the left side, select the item whose color needs to be 
changed from the list box.

• Select a color from the Change color to drop-down list. Once a new color is selected from 
the drop-down list the color in the list box above the drop-down list is updated instantly.

• From the Results category box on the right side, select the item whose color needs to be 
changed from the list box.

• Select a color from the Change color to drop-down list. Once a new color is selected from 
the drop-down list the color in the list box above the drop-down list is updated instantly.

• If you want to print views in black and white, select the Print Black and White check 
box.

• If you want to save the settings as default, select the Save setting for future use check box.
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Figure 4-88 Changing Colors dialog box

• Input the line thickness in the Printed Line Thickness edit box. The diagram line thickness 
will be based on the number you input.

• Press the OK button to save the settings and close the dialog box.

4.10.2 Changing Fonts

Fonts can be selected separately for graphical on screen, graphical output and the text output via 
Options|Font command.

To change the graphical on screen or graphical output fonts:

• Select the Font|Graphical, On Screen or Font|Graphical, Output command from the 
Options menu. A view window similar to Figure 4-89 will appear.
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Figure 4-89 Changing Graphical Output Font dialog box

• Select the font, font style and size from the lists. Font sizes different from those on the list 
can be typed in the Size text box.

• In the EFFECT frame select if strikeout and/or underline effect have to be applied. Alterna-
tively to the COLOR dialog box, the font color can be chosen in this dialog box too.

• The script of the font by default is Western and should not be changed.

• Press the OK button to save the new setting and close the dialog box.

To change the text output font follow the same procedure as for the graphical output font except 
that font effects are not available for text output and the list of fonts only contains non-
proportional fonts which are suitable for tabulated text output (Figure 4-90).

Figure 4-90 Changing Text Output Font dialog box
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4.11 Working with View Windows (menu Window)

Cascade

The Cascade command displays all the open windows in the same size, arranging them on top of 
each other so that the title bar of each is visible. The current active view widow will be on the top 
after the execution of the Cascade command.

Tile Horizontal

The Tile Horizontal command arranges all open windows horizontally so that no window 
overlaps another. The current active view widow will be on the most left or on the upper-left 
corner of the screen after the execution of the Tile Horizontal command.

Tile Vertical

The Tile Vertical command arranges all open windows vertically so that no window overlaps 
another. The current active view widow will be on the most left or on the upper-left corner of the 
screen after the execution of the Tile Vertical command.

Remaining Commands

The remaining menu items are in a list of the windows that are available for viewing. Selecting 
any window from this menu will restore the window to its previous size and position from an icon. 

4.12 Obtaining Help Information (menu Help)

4.12.1 Opening Table of Contents of the Help System

To open table of contents of the Help system:

• Select Help from the Help menu.

• Select the chapter you need from the content tree view in the left pane of the browser win-
dow. The contents of the selected chapter appear in the right pane of the browser window.

4.12.2 Displaying the Manual

To display the manual:

• Select Manual from the Help menu.

• The manual will be displayed in the default browser window.
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4.12.3 Checking for Updates

To check if a newer version of the program is available:

• Select Check for Updates from the Help menu.

• The program will open the default browser window with the page where the newer version 
can be requested or downloaded. 

4.12.4 Obtaining Information about the Program

The following information about the program is displayed in the ABOUT SPSLAB dialog box:

• program version and short description

• licensing information

• the copyright information

The licensing information depends on the type of license being used. If it is a trial license then the 
LICENSE EXP field shows when the trial period expires and the LOCKING CODE field displays a 
unique fingerprint of the computer on which the program is running. This locking code needs to be 
provided to StructurePoint in order to generate a permanent license. For other, non-trial licenses, 
license ID is displayed. You may be asked to provide this ID when you contact StructurePoint for 
technical support.

To obtain the information about the program:

• Select the About spSlab command from the Help menu. A dialog box of Figure 4-91 will 
appear.

• Press OK button to exit the dialog box.
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a)  b) 

Figure 4-91 About spSlab dialog boxes with (a) a trial license (b) a network license
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5.1 Output Elements

spSlab generates the text and graphical output of the input data and the results of the calculations. 
The text output is generated when user opens the Results Report dialog window. An ASCII text 
file is generated in the same sub-folder as the input data file. The name of the output file is created 
by adding the extension ".OUT" to the name of the input data file. Depending on the report options 
selected, the text output will contain a selection of the following sections (see the illustrated 
examples in the following chapter):

• Cover & Contents

• Input Echo

• Design Results

• Deflection Results: Summary

• Detailed Results

• Diagrams

5.2 Cover & Contents

The cover page consists of the program logo, program version, and a diagram of the section being 
investigated. Additionally, legal disclaimer is displayed at the bottom of the first page. The 
program version number appears at the top of each report page along with the licensing and 
copyright information.

The contents lists out all the headings and sub-headings for the sections contained in the report.

5.3 Input Echo

Section Input Echo reports the data used in the analysis. spSlab defaults common data; all other 
data must be input. Carefully check the contents of the section and compare it with the intended 
design model. The following paragraphs describe the blocks included in the section.

5.3.1 General Information

This block is similar in its content to the dialog window General Information. It contains the 
information on project input data file name, project description, selected design code and units, 
selected reinforcement database, calculation mode (design or investigation), number of supports, 
cantilevers. The selections available in the SOLVE OPTIONS dialog box are also listed in this block.
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5.3.2 Material Properties

This block contains the information on concrete properties for slabs, beams and columns. It also 
contains the information on reinforcing steel properties for slabs and beams.

5.3.3 Reinforcement Database

This block lists the properties of the bars from the bar table selected for the project. Bar diameter, 
cross-section area and unit weight for each bar are reported. The values reported are consistent 
with the units used in particular model.

5.3.4 Span Data

This block is similar in its content to the dialog window Span Data. The block is divided into two 
parts. First part reports the span-by-span geometry of the concrete slab (length, left and right side 
width, depth and code required minimum thickness). The second part contains the span-by-span 
geometry of longitudinal beams and ribs (for joist slabs): width, depth, and offset (eccentricity) 
from column centroid.

5.3.5 Support Data

This block is similar in its content to the dialog window Support Data. The block is divided into 
four parts. The first part reports the geometry of top and bottom columns and the stiffness share 
factor. For circular column the transverse dimension C2 is reported as zero. The second part 
contains the geometry of drop panels: thickness, lengths, widths. If dimensions of a drop panel are 
invalid it will be marked. Invalid or excessive drop panel geometry is not used in the analysis. The 
third part contains the geometry of column capitals: depth, slope (depth/extension ratio), 
extensions. The fourth part contains the geometry of transverse beams: width, depth, and offset) 
from column centroid.

5.3.6 Load Data

This block contains the complete information on load input. The block is divided into three parts. 
The first part reports the defined load cases, load combinations and corresponding load factors. 
This part summarizes the contents of the dialog windows Load Cases and Load Combinations. 
The second part reports the magnitudes of defined span loads. It summarizes the contents of the 
dialog window Span Loads. The third part reports the magnitudes of lateral actions (joint 
moments) if defined in the model. It summarizes the contents of the dialog window Lateral Load 
Effects.
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5.3.7 Reinforcement Criteria

This block is similar in its content to the dialog window Reinforcement Criteria. The block is 
divided into three parts. The first part reports the requirements for slab and rib bars. The second 
part reports the requirements for longitudinal beams. Both parts contain the information on bar 
sizes, covers, spacing, and user selected allowable steel percentages. The requirements for top and 
bottom bars are given. For longitudinal beams additionally the criteria for transverse bars 
(stirrups) are listed.

5.3.8 Reinforcing Bars

This block is available only when Investigation Mode is selected. This block is similar in its 
content to the dialog window Reinforcing Bars. The block is divided into three parts. The first part 
reports the span-by span user selected top bars for column, middle and beam strips accordingly. 
Similarly, the second part reports the user selected bottom bars for column, middle and beam. For 
longitudinal bars the program reports bar sizes, lengths and concrete cover. The third part presents 
the beam transverse reinforcement (stirrups) defined by the user.

Note: When switching from Design Mode to Investigation Mode, spSlab automatically assumes 
the results of the Design Mode as an input for Investigation Mode.

5.4 Design Results

Section Design Results presents the summary of the design results of the slab system. The 
following paragraphs describe the blocks included in the section.

5.4.1 Strip Widths and Distribution Factors

This block is available only for two-way systems. It contains the information on design strip 
widths, moment distribution factors, and shear distribution factors (for CSA A23.3-14/04 standard 
and optionally for other standards if distribution of shear to slab strips is selected).

5.4.2 Top Reinforcement

This block is available only when Design Mode is selected. It reports the negative reinforcement 
requirements. The block contains the values of corresponding design strip widths (column, 
middle, and beam), maximum factored design moments per strip and critical location, minimum 
and maximum steel areas, spacing for bars selected based on required reinforcement area, steel 
areas required by ultimate condition, selected bar sizes and numbers. The quantities are given for 
left, center and right location of each span. For a detailed discussion, see Chapter 2, “Area of 
Reinforcement”. 
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Note: This block does not include reinforcement quantities necessary to transfer unbalanced 
moments at supports. In case of CSA standard, the reported spacing is averaged between 
reinforcement placed in the bb band and in the remaining portion of the column strip outside of the 
bb band.

5.4.3 Top Bar Details

The block contains a span-by-span listing of the longitudinal bars selected in column, middle and 
beam strips. This reinforcement schedule is intended as a guide for bar placement. In more 
complex cases the bar schedule selected by the program may have to be adjusted by the user for 
constructability reasons. The selected bar sizes are limited by user specified minimum and 
maximum sizes. Bar sizes and numbers are selected to satisfy the minimum and required steel 
areas in conjunction with the bar spacing requirements of the code. The program calculates the bar 
lengths based on the computed inflection points and the recommended minima of the code. The 
bar lengths are adjusted by appropriate development lengths. Hooks and bends are not included in 
bar length tables and figures. For beams bars are placed in single a layer (see Figure 2-21), 
provided there is sufficient beam width. For a detailed discussion, see Chapter 4, "Reinforcement 
Selection".

Note: This block does not include additional reinforcement bars necessary to transfer negative 
unbalanced moment at supports.

5.4.4 Band Reinforcement at Supports

Available only when the CSA code is selected, this section describes how the negative 
reinforcement in column strips should be concentrated over supports. It reports the total width of 
the strip from which reinforcement is concentrated, the width of the bb band, and the remaining 
width. The total width of the subdivided strip will be equal to the column strip width when no wide 
beams (width greater than bb) and no slab bands are present. If either one is present then its width 
will be used. If a beam narrower than bb frames into an exterior support then both the total strip 
width and the bb width will be reduced to the beam width.

The section also gives the area of reinforcement and the number of bars required in each strip. The 
sum of number of bars in the band strip and in the remaining strip should be equal to the total 
number of bars over each support in the strip from which the bars were concentrated. The total 
number of bars in this strip should also be consistent with the number of bars listed in the Top Bar 
Details table.

Note: This output block does not include additional reinforcement bars necessary to transfer 
negative unbalanced moment at supports.
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5.4.5 Bottom Reinforcement

This block is available only when Design Mode is selected. It reports the positive reinforcement 
requirements. The block contains the values of corresponding design strip widths (column, 
middle, and beam), maximum factored design moments per strip and critical location, minimum 
and maximum steel areas, spacing for bars selected based on required reinforcement area, steel 
areas required by ultimate condition, selected bar sizes and numbers. The quantities are given for 
mid-span regions of each span. For a detailed discussion, see Chapter 2, “Area of Reinforcement”.

5.4.6 Bottom Bar Details - Bottom Bar Development Lengths

This block contains a span-by-span listing of the longitudinal bars selected in column, middle and 
beam strips. The reinforcement schedule is intended as a guide for bar placement. In more 
complex cases the bar schedule selected by the program may have to be adjusted by the user for 
constructability reasons. The selected bar sizes are limited by user specified minimum and 
maximum sizes. Bar sizes and numbers are selected to satisfy the minimum and required steel 
areas in conjunction with the bar spacing requirements of the code. The program calculates the bar 
lengths based on the computed inflection points and the recommended minimums of the code. The 
bar lengths are adjusted by appropriate development lengths. Bottom bar development lengths are 
tabulated directly below the bottom bar details block. Hooks and bends are not included in bar 
length tables and figures. For beams bars are placed in single a layer (see Figure 2-21), provided 
there is sufficient beam width. For a detailed discussion, see Chapter 2, “Reinforcement 
Selection”.

5.4.7 Flexural Capacity

This block lists the selected top and bottom steel areas and corresponding negative and positive 
moment capacity values in each span. The data is subdivided between column, middle and beam 
strips. Each span is subdivided into segments reflecting the changes in geometry and bar 
placement.

5.4.8 Longitudinal Beam Shear Reinforcement Required

This block is available only when Design Mode is selected. It reports the requirements of 
transverse reinforcement for each longitudinal beam. The capacity of concrete cross-section 
VΦ cin each span is shown. The table contains the segmental values of the factored shear force Vu 

and required intensity of stirrups (Av/s). The segmental values cover the distance between left and 
right critical sections, and include locations where there is change of geometry of loading.
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5.4.9 Longitudinal Beam Shear Reinforcement Details

This block is available only when Design Mode is selected. It is intended as a guide for stirrup 
placement. The output presents the program selected stirrup sizes, numbers, and spacing. 
Distances between groups of stirrups are also reported. 

5.4.10 Beam Shear (and Torsion) Capacity

If torsion is not considered then this block lists the concrete section shear capacity VΦ c, selected 
stirrup intensities and spacing, and corresponding beam shear capacity VΦ n values in each span. 
For CSA A23.3-14/04 code, the program additionally reports value of factor β. The maximum 
factored shear forces Vu in beam strip along the span is also reported.

In the case of combined shear and torsion analysis (beams/one-way slab systems only), this block 
lists section properties, shear and torsion transverse reinforcement capacity, and longitudinal 
torsional reinforcement capacity. The provided and required capacities are expressed in terms of 
the provided and required areas of reinforcement.

5.4.11 Slab Shear Capacity

This block lists the values of one-way slab shear capacity VΦ c in each span. For CSA A23.3-04 
code, the program additionally reports value of factor β. The maximum factored shear force Vu
and the location of the critical section Xu are also reported.

5.4.12 Flexural Transfer of Unbalanced Moments at Supports

There are two blocks reporting the design values for additional reinforcement necessary to transfer 
unbalanced support moments. One block is for negative unbalanced moments and the other for 
positive unbalanced moment. These blocks contain the results for critical (effective) section width 
as per the code, width of the effective section on the tension side (for negative unbalanced 
moments) or on the compression side (for positive unbalanced moments), distances to the 
centroids of tension and compression reinforcement (if compression reinforcement option is 
selected), the maximum negative or positive unbalanced moment, the corresponding load 
combination and governing load pattern, the reinforcing steel areas provided and additional steel 
required. The provided reinforcement area (main longitudinal bars) is reduced by the ratio of 
critical (effective) strip width to total strip width and does not include the required area due to 
unbalanced moments. The additional reinforcement is the difference between that required by 
unbalanced moment transfer by flexure and that provided for design bending moment. When 
additional reinforcement is required, it is selected based on the bar sizes already provided at the 
support. For a detailed discussion, see Chapter 2, "Area of Reinforcement" and "Additional 
Reinforcement at Support".
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5.4.13 Punching Shear Around Columns

The block contains two tables with values pertaining to punching shear check in critical sections 
around the columns. The first table lists geometrical properties of punching shear critical section. 
The reported properties of the critical section are overall dimensions in the direction of analysis, 
b1, and in the perpendicular direction, b2, perimeter, b0, location of centroid with respect to 
column center line, davg, average distance from the slab bottom to centroid of the slab tension 
reinforcement, CG, distance from centroid to the left, cleft, and right, cright, edge of critical section, 
area of concrete resisting shear transfer, Ac, and moment of inertia of critical section, Jc. The 
second table lists two sets of punching shear calculations – direct shear alone and direct shear with 
moment transfer. The output contains the values of the allowable shear stress vΦ c, reactions Vu, 
unbalanced moments Munb, governing load pattern, fraction of unbalanced moment VΦ , 
punching shear stress vu. The calculation for moment transfer adjusts the unbalanced moment to 
the centroid of the critical section. The "shear transfer" is the unbalanced moment multiplied by γv. 
When calculated shear stress vu exceeds the allowable value vΦ c, the program prints a warning 
flags for this support. For a detailed discussion, see Chapter 2, "Shear Analysis of Slabs".

5.4.14 Punching Shear Around Drops

The block contains two tables with values pertaining to punching shear check in a critical section 
around the drop panels. The first table lists geometrical properties of punching shear critical 
section (see description in the Punching shear around Columns block). The second table displays 
the reactions Vu, governing load pattern, the punching shear stress around the drop vu, and the 
allowable shear stress vΦ c. When calculated shear stress vu exceeds the allowable value vΦ c, the 
program prints a warning flags for this drop panel. For a detailed discussion, see Chapter 2, "Shear 
Analysis of Slabs".

5.4.15 Integrity Reinforcement at Supports

This section is available only when the CSA code is selected. It lists the shear transferred to the 
column and the minimum area of bottom reinforcement crossing one face of the periphery of a 
column and connecting slab to the column to provide structural integrity. For a detailed discussion, 
see Chapter 2, "Integrity Reinforcement".

5.4.16 Corner Reinforcement

This block refers to the reinforcement required in the exterior corners of a slab with beams 
between columns. The ratio of flexural stiffness of beam section to flexural stiffness of slab is 
listed as well as the area of reinforcement and the distance over which the reinforcement is 
required. The area applies to each layer of reinforcement in each direction. For a detailed 
discussion, see Chapter 2, "Slab Corners".
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5.4.17 Shear Resistance at Corner Columns

This section is available only when the CSA code is selected in design mode. It reports results of 
one-way shear check at corner columns. The results include the factored shear resistance and the 
factored shear force at the column. Also, the minimum length of the critical shear section and, for 
the 1994 edition, the angle at which the minimum length is obtained are listed. For a detailed 
discussion, see Chapter 2, "Shear Resistance at Corner Columns" in “Shear Analysis of Slabs”.

5.4.18 Material Takeoff

This block lists the approximate total and unit quantities of concrete, and reinforcement. Note that 
the reinforcement estimate is for one direction only and ignores items such as hooks, bends, and 
waste. For a detailed discussion, see Chapter 2, "Material Quantities". 

5.5 Deflection Results: Summary

Section Deflection Results presents the summary of the deflection results of the slab system. This 
section lists the summary of frame section properties, for positive and negative moments, frame 
effective section properties for load levels, strip section properties at midspan (two-way systems 
only), instantaneous deflections and long-term deflections, if they are selected in solve options. 
Also, if a solution option "Gross (uncracked) sections" is selected, only gross moment of inertia, 
Ig, is reported in the section properties table and the values of all deflections reported are based on 
gross section properties. If solution option "Effective (cracked) sections" is used, the values of 
deflections reported are based on averaged effective moments of inertia, Ie,avg, which are then 
reported in the section properties table together with other properties of cracked sections. For 
a detailed discussion, see Chapter 2, "Deflection Calculation". 

5.6 Detailed Results

5.6.1 Column Forces and Redistributed Column 
Forces

Sections Column Forces and Redistributed Column Forces present the summary of axial forces (reactions) 
and bending moments in bottom and top columns and in springs attached to the column-slab joints. Also, 
moments at far ends of columns are reported. All reported values represent forces and moments at column 
ends, i.e. at joint level (not at slab or drop panel surface level). If moment redistribution is selected (beams/
one-way slab systems only) both redistributed and un-redistributed values can be included. The values 
reported represent the loading of a single floor only. Any actions on the columns from the floors above 
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must be added to this story’s actions to properly analyze/design the columns. The output contains column 
axial forces and moments due to all load cases, including all live load patterns, and all load combinations. 
Positive axial forces mean compression and positive moments mean that fibers on the left hand side are in 
tension for top columns and for bottom column fibers on the right hand side are in tension. Also, reactions 
of additional translational and rotational springs applied at joints are reported in this block. Positive values 
mean upward translational spring reaction and clockwise rotational spring reaction.

5.6.2 Non – Redistributed and Redistributed Internal Forces: M – V

Load Cases

This section presents the summary of unfactored bending moments and shear forces for individual 
load cases including selfweight, dead load, live load and lateral cases. The reported values are 
presented using span-by-span segmental approach. If moment redistribution is selected (beams/
one-way slab systems only) both redistributed and un-redistributed values can be included.

Load Combinations

This section presents the summary of bending moments and shear forces for each load 
combination. The reported values for each load combination are presented using span-by-span 
segmental approach. The negative and positive values of bending moments and shear forces are 
presented in separate columns in order to provide consistent format with enveloped output. If 
moment redistribution is selected (beams/one-way slab systems only) both redistributed and un-
redistributed values can be included.

Envelopes

This section presents the summary of bending moments and shear forces for envelope of all load 
combinations. The reported values are presented using span-by-span segmental approach. The 
negative and positive values of bending moments and shear forces are presented in separate 
columns for user convenience. The factored values presented in this section are used for design 
purposes (longitudinal and transverse reinforcement). If moment redistribution is selected (beams/
one-way slab systems only) both redistributed and un-redistributed values can be included.

This section presents the summary of unfactored bending moments and shear forces for individual 
load cases including selfweight, dead load, live load and lateral cases. The reported values are 
presented using span-by-span segmental approach. If moment redistribution is selected (beams/
one-way slab systems only) both redistributed and un-redistributed values can be included.

5.6.3 Internal Forces: T

Load Cases

This section presents the summary of unfactored beam torsion forces (beams/one-way slab 
systems with torsion analysis and design only) for individual load cases including selfweight, dead 
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load, live load and lateral cases. The reported values are presented using span-by-span segmental 
approach. 

Load Combinations

This section presents the summary of beam torsion forces (beams/one-way slab systems with 
torsion analysis and design only) for each load combination. The reported values for each load 
combination are presented using span-by-span segmental approach. The negative and positive 
values of torsion forces are presented in separate columns in order to provide consistent format 
with enveloped output.

Envelopes

This section presents the summary of beam torsion forces (beams/one-way slab systems with 
torsion analysis and design only) for envelope of all load combinations. The reported values are 
presented using span-by-span segmental approach. The negative and positive values of torsion 
forces are presented in separate columns for user convenience. The factored values presented in 
this section are used for design purposes (longitudinal and transverse reinforcement). 

5.6.4 Deflections - Load Cases

This section presents the summary of instantaneous deflections for unfactored (service) load cases 
including selfweight and dead load (DL), live load (LL), sustained load (DL+LLsustained), and 
total load (DL+LL) cases, and summary of long-term deflections for unfactored incremental and 
total deflections for one-way systems. For two-way systems, instantaneous frame deflections for 
fixed-end, end-rotation, and total (fixed-end and end rotation combined), instantaneous strip 
deflections, and long-term strip deflections. The reported values are presented using span-by-span 
segmental approach. For a detailed discussion, see Chapter 2, "Deflection Calculation". 

5.6.5 Required Reinforcement

This section presents the summary of enveloped design moments and the required areas of 
longitudinal reinforcement required for flexure. If combined M-V-T option (available only for 
beam design/investigation per CSA A23.3-04) is selected in the Solve Option window then 
longitudinal reinforcement required for combined flexure, shear, and torsion (M-V-T) is also 
reported with the corresponding values of bending moment, shear force, and torsional moment. 
The values are tabulated for every design strip at every design segment.

5.7 Graphical Output

spSlab provides the following graphical output features:

• Diagrams of Internal Forces,
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• Moment (and longitudinal reinforcement capacity due to combined M-V-T action, avail-
able only for beams designed/investigated per CSA A23.3-14/04) Capacity Diagram,

• Shear (and Torsion) Capacity Diagram,

• Deflection Diagram,

• Reinforcement Diagram.

These diagram windows can be customized. The Options dialog allows selecting either a single 
span or all spans. Other elements of the graphs can also be modified. spSlab print preview of the 
current graphical window. The user has also the choice to export the graphics to a metafile or 
bitmap file.

Detailed information on using the graphical output features is included in chapter "Operating the 
Program".
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In this chapter several examples are presented to demonstrate capabilities of the program. 
Generally program results match closely the results found in the referenced text books. When 
discrepancies are observed, they result from variations in assumptions and solutions methods, and 
numerical accuracy.

Both beams/one-way slab systems as well as two-way slab systems are presented in the examples. 
The output of beams/one-way slab examples shows that spBeam program was used to solve them. 
This is to illustrate that spBeam program is available as a limited version of spSlab including only 
beams/one-way slab capabilities.

6.1 Example 1 Spandrel Beam with Moment 
Redistribution

6.1.1 Problem Formulation

Determine the required reinforcement for the spandrel beam at an intermediate floor level as 
shown, using moment redistribution to reduce total reinforcement required. (Note: the self weight 
is already included in the specified dead load below.) This example refers to Example 8-2 from 
PCA Notes on ACI 318 Building Code Requirements for Structural Concrete.

Columns: 16  16 in.
Story height: 10 ft
Spandrel beam: 12  16 in.
fc = 4000 psi
fy = 60,000 psi
DL = 1167 lb/ft
LL = 450 lb/ft

Figure 6.1 Example spandrel beam problem
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6.1.2 Preparing Input
1. From the Input menu, select General Information. A dialog box appears.

– In the LABELS section, input the names of the project, frame, and engineer. 
– In the FRAME section, input 4 for NO OF SUPPORTS. 
– In the FLOOR SYSTEM section, click the radial button next to ONE WAY / BEAM. 
– Leave all other options in the General Information tab to their default settings of ACI 

318-14 design code, ASTM A615 reinforcement, and DESIGN run mode option. 
– In the Solve Options tab, click the check box next to MOMENT REDISTRIBUTION. Press 

OK.

6.1.3 Assigning Properties
2. Nothing needs to be changed in the Material Properties dialog box. 
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3. From the Input menu, select Spans. A dialog box appears.
– Under the Slabs/Flanges tab, input 25 for LENGTH, 0 for THICKNESS, and 0 for 

WIDTH LEFT and WIDTH RIGHT. Press MODIFY. 
– Press the drop down arrow next to SPAN and select Span 2. Input 15 for LENGTH, 0 for 

THICKNESS, and 0 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY. 
– Press the drop down arrow next to SPAN and select Span 3. Input 20 for LENGTH, 0 for 

THICKNESS, and 0 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY. 
– Select the Longitudinal Beams tab. Input 12 for WIDTH and 16 for DEPTH. Press 

MODIFY.
– Press COPY. Press the CHECK ALL button. Press OK.
– Press OK again.
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4. From the Input menu, select Supports. A dialog box appears.
– Under the Columns tab, input 16 for both the C1 and C2 values in both the ABOVE and 

BELOW rows. Press MODIFY. (Note: the default HEIGHT ABOVE and HEIGHT BELOW 
values of 10 are correct.)

– Press COPY. Press the CHECK ALL button. Press OK.
– Under the Moment Redistribution tab, click on SUPPORT 2 in the list in the bottom 

half of the SUPPORT DATA dialog box.
– Input 20 for both the LEFT and RIGHT REDISTRIBUTION LIMITS. Press MODIFY.
– Press COPY. Click the check box next to SPAN 3. Press OK. 
– Press OK again.

5. From the Input menu, select Reinforcement Criteria. A dialog box appears.
– Under the Beams tab, select #8 for MAX BAR SIZE for TOP BARS and BOTTOM BARS.
– Press OK.
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6. From the Input menu, select Load Cases. A dialog box appears.
– Since we are not considering lateral forces, click on WIND in the LABEL column on the 

list in the bottom half of the LOAD CASES dialog box and press the DELETE button.
– Click on EQ in the LABEL column and press the DELETE button. Press OK.

7. From the Input menu, select Load Combinations. A dialog box appears. 
– Delete all the load combinations by clicking anywhere on the list in the bottom half of 

the LOAD COMBINATIONS dialog box and pressing the DELETE button. Repeat this pro-
cedure until all the load combinations are gone. 

– Input 0 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE field. Press 
ADD.

– Press OK.
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8. From the Input menu, select Span Loads. A dialog box appears.
– Press the drop down arrow next to TYPE, and select LINE LOAD.
– Input 1167 for both the START and END MAGNITUDE. 
– Input 25 for the END LOCATION. Press ADD.
– Use the drop down arrow next to SPAN to select SPAN 2. Keep the START and END 

MAGNITUDES of 1167 lb/ft but change the END LOCATION to 15. Click the ADD but-
ton.

– Again use the drop down arrow next to SPAN to select SPAN 3. Keep the START and 
END MAGNITUDES of 1167 lb/ft but change the END LOCATION to 20. Click the ADD
button
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9. In the top left corner of the SPAN LOADS dialog box, there is a section called CURRENT 
CASE. Click on LIVE.
– Use the drop down arrow next to SPAN to select SPAN 1.
– Making sure that LINE LOAD is still the selected LOAD TYPE, input 450 for both the 

START and END MAGNITUDE.
– Input 25 for the END LOCATION. Press ADD.
– Use the drop down arrow next to SPAN to select SPAN 2. Keep the START and END 

MAGNITUDES of 450 lb/ft but change the END LOCATION to 15. Click the ADD but-
ton.

– Again use the drop down arrow next to SPAN to select SPAN 3. Keep the START and 
END MAGNITUDES of 1167 lb/ft but change the END LOCATION to 20. Click the ADD
button

– Press OK.

6.1.4 Solving
10. From the Solve menu, select Execute. Press CLOSE.
11. From the Solve menu, select Results.

– Use the explorer to browse through the results tables. 
– Use the ARROW keys or the mouse wheel to browse through different parts of the 

table quickly. Press the CLOSE button to close the SPRESULTS.
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6.1.5 Viewing and Printing Results
12. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear Capacity,

Deflection, or Reinforcement from the View menu. Right click in any of these diagrams 
to get new copy, printing, or display options. 

13. You may print the results report by using the spReporter module. To print any of the 
diagrams you selected to view, use the Print Preview command found by right clicking in 
the diagram’s window. After viewing the results, you may decide to investigate the input 
beams under the same loads but with a modified reinforcement configuration. 

14. From the Input menu, select General Information. In the General Information dialog 
box change the RUN MODE option to INVESTIGATION. Do not change any of the other 
options. Press OK

15. From the Input menu, select the different commands under Reinforcement Criteria and 
Reinforcing Bars to modify the reinforcement configuration computed by the program.

16. Repeat steps 10 and subsequent to perform the investigation and view the results. 



EXAMPLES

|   234   |
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1. Input Echo  
 
 

1.1. General Information  
 

File Name ...\Example 1 - PCA Notes on ACI 318-
Example 8... 

Project spSlab/spBeam Manual, Example 1 
Frame PCA Notes on ACI 318-Example 8-2 
Engineer StructurePoint 
Code ACI 318-14 
Reinforcement 
Database 

ASTM A615 

Mode Design 
Number of supports =  4 
Floor System One-Way/Beam 

 
 

1.2. Solve Options  
 

Live load pattern ratio = 100% 
Deflections are based on cracked section properties. 
In negative moment regions, Ig and Mcr DO NOT include flange/slab contribution (if available) 
Long-term deflections are calculated for load duration of 60 months. 
0% of live load is sustained. 
Compression reinforcement calculations NOT selected. 
Default incremental rebar design selected. 
Moment redistribution selected. 
Effective flange width calculations NOT selected. 
Rigid beam-column joint NOT selected. 
Torsion analysis and design NOT selected. 

 
 

1.3. Material Properties  
 
 

1.3.1. Concrete: Slabs / Beams  
 

wc 150 lb/ft3 
f'c 4 ksi 
Ec 3834.3 ksi 
fr 0.474342 ksi 

 
 

1.3.2. Concrete: Columns  
 

wc 150 lb/ft3 
f'c 4 ksi 
Ec 3834.3 ksi 
fr 0.47434 ksi 

 
 

1.3.3. Reinforcing Steel  
 

fy 60 ksi 
fyt 60 ksi 
Es 29000 ksi 
Epoxy coated bars No  
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1.4. Reinforcement Database  
 

Size Db Ab Wb Size Db Ab Wb 
 in in2 lb/ft  in in2 lb/ft 

#3 0.38 0.11 0.38 #4 0.50 0.20 0.67 
#5 0.63 0.31 1.04 #6 0.75 0.44 1.50 
#7 0.88 0.60 2.04 #8 1.00 0.79 2.67 
#9 1.13 1.00 3.40 #10 1.27 1.27 4.30 

#11 1.41 1.56 5.31 #14 1.69 2.25 7.65 
#18 2.26 4.00 13.60     

 
 

1.5. Span Data  
 
 

1.5.1. Slabs  
 

Span Loc L1 t wL wR Hmin  
  ft in ft ft in  

1 Int 25.000 0.00 0.500 0.500 0.00  
2 Int 15.000 0.00 0.500 0.500 0.00  
3 Int 20.000 0.00 0.500 0.500 0.00  

 
 

1.5.2. Ribs and Longitudinal Beams  
 

Notes: 
*b - Span depth is less than minimum. Deflection check required. 
 

Span Ribs Beams Span  
 b h Sp b h Hmin  
 in in in in in in  

1 0.00 0.00 0.00 12.00 16.00 16.22 *b 
2 0.00 0.00 0.00 12.00 16.00 8.57  
3 0.00 0.00 0.00 12.00 16.00 12.97  

 
 

1.6. Support Data  
 
 

1.6.1. Columns  
 

Support c1a c2a Ha c1b c2b Hb Red %  
 in in ft in in ft   

1 16.00 16.00 10.000 16.00 16.00 10.000 100  
2 16.00 16.00 10.000 16.00 16.00 10.000 100  
3 16.00 16.00 10.000 16.00 16.00 10.000 100  
4 16.00 16.00 10.000 16.00 16.00 10.000 100  

 
 

1.6.2. Moment Redistribution Limits  
 

Support Left Right 
 % % 

1 0 0 
2 20 20 
3 20 20 
4 0 0 

 
 

1.6.3. Boundary Conditions  
 

Support Spring Far End 
 Kz Kry Above Below 
 kip/in kip-in/rad   

1 0 0 Fixed Fixed 
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Support Spring Far End 

 Kz Kry Above Below 
 kip/in kip-in/rad   

2 0 0 Fixed Fixed 
3 0 0 Fixed Fixed 
4 0 0 Fixed Fixed 

 
 

1.7. Load Data  
 
 

1.7.1. Load Cases and Combinations  
 

Case SELF Dead Live 
Type DEAD DEAD LIVE 

U1 0.000 1.200 1.600 
 
 

1.7.2. Line Loads  
 

Case/Patt Span Wa La Wb Lb 
  lb/ft ft lb/ft ft 

SELF 1 200.00 0.000 200.00 25.000 
 2 200.00 0.000 200.00 15.000 
 3 200.00 0.000 200.00 20.000 

Dead 1 1167.00 0.000 1167.00 25.000 
 2 1167.00 0.000 1167.00 15.000 
 3 1167.00 0.000 1167.00 20.000 

Live 1 450.00 0.000 450.00 25.000 
 2 450.00 0.000 450.00 15.000 
 3 450.00 0.000 450.00 20.000 

Live/Odd  1 450.00 0.000 450.00 25.000 
 3 450.00 0.000 450.00 20.000 

Live/Even 2 450.00 0.000 450.00 15.000 
Live/S1  1 450.00 0.000 450.00 25.000 
Live/S2  1 450.00 0.000 450.00 25.000 

 2 450.00 0.000 450.00 15.000 
Live/S3  2 450.00 0.000 450.00 15.000 

 3 450.00 0.000 450.00 20.000 
Live/S4  3 450.00 0.000 450.00 20.000 

 
 

1.8. Reinforcement Criteria  
 
 

1.8.1. Slabs and Ribs  
 

 Units Top Bars Bottom Bars 
  Min. Max. Min. Max. 
Bar Size  #5 #8 #5 #8 
Bar spacing in 1.00 18.00 1.00 18.00 
Reinf ratio % 0.14 5.00 0.14 5.00 
Clear Cover in 1.50  1.50  

There is NOT more than 12 in of concrete below top bars. 
 
 
 

1.8.2. Beams  
 

 Units Top Bars Bottom Bars Stirrups 
  Min. Max. Min. Max. Min. Max. 
Bar Size  #8 #8 #8 #8 #3 #5 
Bar spacing in 1.00 18.00 1.00 18.00 6.00 18.00 
Reinf ratio % 0.14 5.00 0.14 5.00   
Clear Cover in 1.50  1.50    
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 Units Top Bars Bottom Bars Stirrups 
  Min. Max. Min. Max. Min. Max. 
Layer dist. in 1.00  1.00    
No. of legs      2 6 
Side cover in     1.50  
1st Stirrup in     3.00  

There is NOT more than 12 in of concrete below top bars. 
 
 
 

2. Design Results  
 
 

2.1.1. Moment Redistribution Factors  
 

 Calculated User Applied 
Support Side  Org. Mu  Iter.# ɛt Factor Limit Factor 

   k-ft    % % % 
1 Right  83.53  7 0.01796 17.96 0.00 0.00 
2 Left  91.92  6 0.01526 15.26 20.00 15.26 
2 Right  41.57  2 0.04168 20.00 20.00 20.00 
3 Left  32.97  2 0.05368 20.00 20.00 20.00 
3 Right  57.21  2 0.02909 20.00 20.00 20.00 
4 Left  49.30  2 0.03446 20.00 0.00 0.00 

 
 

2.2. Top Reinforcement  
 

Notes: 
*3 - Design governed by minimum reinforcement. 
 

Span Zone Width Mmax Xmax As,min As,max As,req SpProv Bars  
  ft k-ft ft in2 in2 in2 in   

1 Left    1.00 83.10 0.667 0.560 3.035 1.426 6.311 2-#8  
 Midspan 1.00 0.00 12.500 0.000 3.035 0.000 0.000 ---  
 Right   1.00 75.67 24.333 0.560 3.035 1.288 6.311 2-#8  
           

2 Left    1.00 31.23 0.667 0.560 3.035 0.509 6.311 2-#8  *3 
 Midspan 1.00 0.00 7.500 0.000 3.035 0.000 0.000 ---  
 Right   1.00 24.35 14.333 0.525 3.035 0.395 6.311 2-#8  *3 
           

3 Left    1.00 43.45 0.667 0.560 3.035 0.717 6.311 2-#8  
 Midspan 1.00 0.00 10.000 0.000 3.035 0.000 0.000 ---  
 Right   1.00 48.84 19.333 0.560 3.035 0.810 6.311 2-#8  

 
 

2.3. Top Bar Details  
 

NOTES: 
* - Bar cut-off location does not meet ACI 318, 12.10.5.1. Revise location, unless the requirements of either 12.10.5.2 or 12.10.5.3 are 
manually checked and satisfied. 
 

 Left Continuous Right 
Span Bars  Length Bars  Length Bars  Length Bars  Length Bars  Length 

   ft   ft   ft   ft   ft 
1 1-#8  6.13 1-#8 * 3.34 ---   1-#8  5.88 1-#8 * 3.08 
                

2 1-#8  4.82 1-#8 * 1.83 ---   1-#8  4.32 1-#8 * 1.83 
                

3 1-#8  4.57 1-#8 * 2.01 ---   1-#8  4.82 1-#8 * 2.19 
 
 



EXAMPLES

|   239   |

STRUCTUREPOINT - spSlab v5.50 Debug - Mar 29 2018 Page | 7 
Licensed to: -- Unknown User --. License ID: 00000-0000000 3/30/2018 
C:\Program Files (x86)\StructurePoint\spSlab\Ex...\Example 1 - PCA Notes on ACI 318-Example 8-2.slb 11:14 AM 
 
2.4. Top Bar Development Lengths  
 

 Left Continuous Right 
Span Bars  DevLen Bars  DevLen Bars  DevLen Bars  DevLen Bars  DevLen 

   in   in   in   in   in 
1 1-#8  32.10 1-#8  32.10 ---   1-#8  29.01 1-#8  29.01 
                

2 1-#8  12.00 1-#8  12.00 ---   1-#8  12.00 1-#8  12.00 
                

3 1-#8  16.14 1-#8  16.14 ---   1-#8  18.23 1-#8  18.23 
 
 

2.5. Bottom Reinforcement  
 

Notes: 
*3 - Design governed by minimum reinforcement. 
 

Span Width Mmax Xmax As,min As,max As,req SpProv Bars  
 ft k-ft ft in2 in2 in2 in   

1 1.00 69.82 12.625 0.560 3.035 1.182 6.311 2-#8  
          

2 1.00 25.96 7.624 0.560 3.035 0.421 6.311 2-#8  *3 
          

3 1.00 47.12 9.876 0.560 3.035 0.780 6.311 2-#8  
 
 

2.6. Bottom Bar Details  
 

 Long Bars Short Bars 
Span Bars  Start Length Bars  Start Length 

   ft ft   ft ft 
1 2-#8  0.00 25.00 ---    
         

2 2-#8  0.00 15.00 ---    
         

3 2-#8  0.00 20.00 ---    
 
 

2.7. Bottom Bar Development Lengths  
 

 Long Bars Short Bars 
Span Bars  DevLen Bars  DevLen 

   in   in 
1 2-#8  26.61 ---   
       

2 2-#8  12.00 ---   
       

3 2-#8  17.56 ---   
 
 

2.8. Flexural Capacity  
 

 Top Bottom 
Span x As,top ΦMn- Mu- Comb Pat Status As,bot ΦMn+ Mu+ Comb Pat Status 

 ft in2 k-ft k-ft    in2 k-ft k-ft    
1 0.000 1.58 -91.28 -100.54 U1 Odd  --- 1.58 91.28 0.00 U1 All  --- 
 0.222 1.58 -91.28 -94.62 U1 Odd  --- 1.58 91.28 0.00 U1 All  --- 
 0.667 1.58 -91.28 -83.10 U1 Odd  OK 1.58 91.28 0.00 U1 All  OK 
 3.342 0.79 -47.70 -22.57 U1 Odd  OK 1.58 91.28 0.00 U1 All  OK 
 3.457 0.79 -47.70 -20.31 U1 Odd  OK 1.58 91.28 0.00 U1 All  OK 
 6.132 0.00 0.00 0.00 U1 All  OK 1.58 91.28 24.64 U1 S2 OK 
 8.950 0.00 0.00 0.00 U1 All  OK 1.58 91.28 55.09 U1 Odd  OK 
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 Top Bottom 
Span x As,top ΦMn- Mu- Comb Pat Status As,bot ΦMn+ Mu+ Comb Pat Status 

 ft in2 k-ft k-ft    in2 k-ft k-ft    
 12.500 0.00 0.00 0.00 U1 All  OK 1.58 91.28 69.78 U1 Odd  OK 
 12.625 0.00 0.00 0.00 U1 All  OK 1.58 91.28 69.82 U1 Odd  OK 
 16.050 0.00 0.00 0.00 U1 All  OK 1.58 91.28 57.75 U1 Odd  OK 
 19.117 0.00 0.00 0.00 U1 All  OK 1.58 91.28 25.84 U1 Odd  OK 
 21.535 0.79 -47.70 -14.56 U1 S2 OK 1.58 91.28 0.00 U1 All  OK 
 21.916 0.79 -47.70 -21.91 U1 S2 OK 1.58 91.28 0.00 U1 All  OK 
 24.333 1.58 -91.28 -75.67 U1 S2 OK 1.58 91.28 0.00 U1 All  OK 
 25.000 1.58 -91.28 -92.68 U1 S2 --- 1.58 91.28 0.00 U1 All  --- 
              

2 0.000 1.58 -91.28 -41.95 U1 S2 --- 1.58 91.28 0.00 U1 All  --- 
 0.667 1.58 -91.28 -31.23 U1 S2 OK 1.58 91.28 0.00 U1 All  OK 
 0.833 1.58 -91.28 -28.71 U1 S2 OK 1.58 91.28 0.00 U1 All  OK 
 1.833 0.79 -47.70 -14.74 U1 S2 OK 1.58 91.28 0.00 U1 All  OK 
 3.815 0.79 -47.70 0.00 U1 All  OK 1.58 91.28 10.41 U1 S3 OK 
 4.815 0.00 0.00 0.00 U1 All  OK 1.58 91.28 17.30 U1 Even OK 
 5.450 0.00 0.00 0.00 U1 All  OK 1.58 91.28 20.72 U1 Even OK 
 7.500 0.00 0.00 0.00 U1 All  OK 1.58 91.28 25.92 U1 Even OK 
 7.624 0.00 0.00 0.00 U1 All  OK 1.58 91.28 25.96 U1 Even OK 
 9.550 0.00 0.00 0.00 U1 All  OK 1.58 91.28 22.21 U1 Even OK 
 10.682 0.00 0.00 0.00 U1 All  OK 1.58 91.28 16.45 U1 S2 OK 
 11.682 0.79 -47.70 0.00 U1 All  OK 1.58 91.28 9.53 U1 S2 OK 
 13.167 0.79 -47.70 -8.94 U1 S3 OK 1.58 91.28 0.00 U1 All  OK 
 14.167 1.58 -91.28 -21.98 U1 S3 OK 1.58 91.28 0.00 U1 All  OK 
 14.333 1.58 -91.28 -24.35 U1 S3 OK 1.58 91.28 0.00 U1 All  OK 
 15.000 1.58 -91.28 -34.46 U1 S3 --- 1.58 91.28 0.00 U1 All  --- 
              

3 0.000 1.58 -91.28 -56.96 U1 S3 --- 1.58 91.28 0.00 U1 All  --- 
 0.667 1.58 -91.28 -43.45 U1 S3 OK 1.58 91.28 0.00 U1 All  OK 
 2.011 0.79 -47.70 -19.09 U1 S3 OK 1.58 91.28 0.00 U1 All  OK 
 3.226 0.79 -47.70 -1.18 U1 Even OK 1.58 91.28 1.03 U1 Odd  OK 
 4.571 0.00 0.00 0.00 U1 All  OK 1.58 91.28 17.91 U1 Odd  OK 
 7.200 0.00 0.00 0.00 U1 All  OK 1.58 91.28 39.84 U1 Odd  OK 
 9.876 0.00 0.00 0.00 U1 All  OK 1.58 91.28 47.12 U1 Odd  OK 
 10.000 0.00 0.00 0.00 U1 All  OK 1.58 91.28 47.08 U1 Odd  OK 
 12.800 0.00 0.00 0.00 U1 All  OK 1.58 91.28 37.70 U1 Odd  OK 
 15.180 0.00 0.00 0.00 U1 All  OK 1.58 91.28 16.97 U1 S3 OK 
 16.699 0.79 -47.70 -3.07 U1 Odd  OK 1.58 91.28 0.00 U1 All  OK 
 17.814 0.79 -47.70 -20.64 U1 Odd  OK 1.58 91.28 0.00 U1 All  OK 
 19.333 1.58 -91.28 -48.84 U1 Odd  OK 1.58 91.28 0.00 U1 All  OK 
 20.000 1.58 -91.28 -62.76 U1 Odd  --- 1.58 91.28 0.00 U1 All  --- 

 
 

2.9. Longitudinal Beam Transverse Reinforcement Demand and Capacity  
 
 

2.9.1. Section Properties  
 

Span d (Av/s)min ΦVc 
 in in2/in kip 

1 14.00 0.0100 15.94 
2 14.00 0.0100 15.94 
3 14.00 0.0100 15.94 
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2.9.2. Beam Transverse Reinforcement Demand  
 

Notes: 
*8 - Minimum transverse (stirrup) reinforcement governs. 
 

   Required Demand 
Span Start End Xu Vu Comb/Patt Av/s Av/s  

 ft ft ft kip  in2/in in2/in  
1 0.917 4.881 1.833 22.99 U1/Odd  0.0112 0.0112  
 4.881 7.929 4.881 16.53 U1/Odd  0.0009 0.0100  *8 
 7.929 10.976 7.929 10.07 U1/Odd  0.0000 0.0100  *8 
 10.976 14.024 10.976 3.61 U1/Odd  0.0000 0.0000  
 14.024 17.071 17.071 9.41 U1/S2 0.0000 0.0100  *8 
 17.071 20.119 20.119 15.87 U1/S2 0.0000 0.0100  *8 
 20.119 24.083 23.167 22.34 U1/S2 0.0102 0.0102  
         

2 0.917 3.452 1.833 12.91 U1/S2 0.0000 0.0100  *8 
 3.452 5.071 3.452 9.47 U1/S2 0.0000 0.0100  *8 
 5.071 6.690 5.071 6.04 U1/S2 0.0000 0.0000  
 6.690 8.310 6.690 2.61 U1/S2 0.0000 0.0000  
 8.310 9.929 9.929 5.12 U1/S3 0.0000 0.0000  
 9.929 11.548 11.548 8.55 U1/S3 0.0000 0.0100  *8 
 11.548 14.083 13.167 11.98 U1/S3 0.0000 0.0100  *8 
         

3 0.917 4.167 1.833 17.08 U1/S3 0.0018 0.0100  *8 
 4.167 6.500 4.167 12.13 U1/S3 0.0000 0.0100  *8 
 6.500 8.833 6.500 7.18 U1/S3 0.0000 0.0000  
 8.833 11.167 11.167 2.86 U1/Odd  0.0000 0.0000  
 11.167 13.500 13.500 7.80 U1/Odd  0.0000 0.0000  
 13.500 15.833 15.833 12.75 U1/Odd  0.0000 0.0100  *8 
 15.833 19.083 18.167 17.70 U1/Odd  0.0028 0.0100  *8 

 
 

2.9.3. Beam Transverse Reinforcement Details  
 

Span Size Stirrups (2 legs each unless otherwise noted) 
1 #3  18 @ 6.9 + <-- 36.6 --> + 18 @ 6.9  
2 #3  8 @ 6.6 + <-- 58.3 --> + 8 @ 6.6  
3 #3  11 @ 6.4 + <-- 84.0 --> + 11 @ 6.4  

 
 

2.9.4. Beam Transverse Reinforcement Capacity  
 

Notes: 
*8 - Minimum transverse (stirrup) reinforcement governs. 
 

 Required Provided 
Span Start End Xu Vu Comb/Patt Av/s Av Sp Av/s ΦVn  

 ft ft ft kip  in2/in in2 in in2/in kip  
1 0.000 0.917 1.833 22.99 U1/Odd ----- ----- ----- ----- -----  
 0.917 10.976 1.833 22.99 U1/Odd 0.0112 0.22 6.9 0.0319 36.03  
 10.976 14.024 10.976 3.61 U1/Odd 0.0000 ----- ----- ----- 7.97  
 14.024 24.083 23.167 22.34 U1/S2 0.0102 0.22 6.9 0.0319 36.03  
 24.083 25.000 23.167 22.34 U1/S2 ----- ----- ----- ----- -----  
            

2 0.000 0.917 1.833 12.91 U1/S2 ----- ----- ----- ----- -----  
 0.917 5.071 1.833 12.91 U1/S2 0.0000 0.22 6.6 0.0331 36.79  *8 
 5.071 9.929 5.071 6.04 U1/S2 0.0000 ----- ----- ----- 7.97  
 9.929 14.083 13.167 11.98 U1/S3 0.0000 0.22 6.6 0.0331 36.79  *8 
 14.083 15.000 13.167 11.98 U1/S3 ----- ----- ----- ----- -----  
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 Required Provided 
Span Start End Xu Vu Comb/Patt Av/s Av Sp Av/s ΦVn  

 ft ft ft kip  in2/in in2 in in2/in kip  
3 0.000 0.917 1.833 17.08 U1/S3 ----- ----- ----- ----- -----  
 0.917 6.500 1.833 17.08 U1/S3 0.0018 0.22 6.4 0.0345 37.66  *8 
 6.500 13.500 13.500 7.80 U1/Odd 0.0000 ----- ----- ----- 7.97  
 13.500 19.083 18.167 17.70 U1/Odd 0.0028 0.22 6.4 0.0345 37.66  *8 
 19.083 20.000 18.167 17.70 U1/Odd ----- ----- ----- ----- -----  

 
 

2.10. Slab Shear Capacity  
 

Span b d Vratio ΦVc Vu Xu  
 in in  kip kip ft  

1 --- Not checked --- 
2 --- Not checked --- 
3 --- Not checked --- 

 
 

2.11. Material TakeOff  
 
 

2.11.1. Reinforcement in the Direction of Analysis  
 

Top Bars 119.7 lb <=> 1.99 lb/ft <=> 1.995 lb/ft2 
Bottom Bars 320.4 lb <=> 5.34 lb/ft <=> 5.340 lb/ft2 
Stirrups 102.0 lb <=> 1.70 lb/ft <=> 1.700 lb/ft2 
Total Steel 542.1 lb <=> 9.04 lb/ft <=> 9.035 lb/ft2 
Concrete 80.0 ft3 <=> 1.33 ft3/ft <=> 1.333 ft3/ft2 
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6.2 Example 2 Spandrel Beam with Torsion

6.2.1 Problem Formulation

Design a precast, nonprestressed concrete spandrel beam for combined shear and torsion. Roof 
members are simply supported on spandrel ledge. Spandrel beams are connected to columns to 
transfer torsion. Continuity between spandrel beams is not provided. This example refers to 
Example 13-1 from PCA Notes on ACI 318 Building Code Requirements for Structural Concrete.

Design Criteria:
Live load = 30 lb/ft2

Dead load = 90 lb/ft2 (double tee + topping + insulation + roofing)
fc = 5000 psi (wc = 150 pcf)
fy =  60,000 psi

Roof members are 10 ft wide double tee units, 30 in. deep with 2 in. topping.. Design of these units 
is not included in this design example. For lateral support, alternate ends of roof members are 
fixed to supporting beams.
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6.2.2 Preparing Input
1. From the Input menu, select General Information. A dialog box appears.

– In the LABELS section, input the names of the project, frame, and engineer. 
– In the FRAME section, input 2 for NO OF SUPPORTS. 
– In the FLOOR SYSTEM section, click the radial button next to ONE WAY / BEAM. 
– Leave all other options in the General Information tab to their default settings of ACI 

318-14 design code, ASTM A615 reinforcement, and DESIGN run mode option. 
– In the Solve Options tab, click the check box next to TORSION ANALYSIS AND 

DESIGN.
– Under TORSION TYPE, click the radial button next to EQUILIBRIUM. 
– Under the heading STIRRUPS IN FLANGES, click the radial button next to YES.
– Press OK. 
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6.2.3 Assigning Properties
2. From the Input menu, select Material Properties. A dialog box appears.

– Input 5 for Comp. strength for both Slabs and Beams and Columns. 
– Press OK. 
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3. From the Input menu, select Spans. A dialog box appears.
– Under the Slabs/Flanges tab, input 40 for LENGTH, 16 for THICKNESS, and 0.667

for WIDTH LEFT and 1.333 WIDTH RIGHT. Press MODIFY. 
– Select the Longitudinal Beams tab. Input 16 for WIDTH and 48 for DEPTH. Press 

MODIFY.
– Press OK.

4. From the Input menu, select Supports. A dialog box appears.
– Under the Columns tab, input 0 for STIFFNESS SHARE %.
– Next, input 16 for both the C1 and C2 values in both the ABOVE and BELOW rows. 

Press MODIFY. (Note: the default HEIGHT ABOVE and HEIGHT BELOW values of 10 are 
correct.)

– Press COPY. Press the CHECK ALL button. Press OK. 
– Press OK again.
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5. From the Input menu, select Reinforcement Criteria. A dialog box appears. 
– Under the Slabs and Ribs tab, change the CLEAR COVER for both TOP and BOTTOM 

BARS to 1.75.
– Under the Beams tab, change the CLEAR COVER for both TOP and BOTTOM BARS

again to 1.75.
– Use the drop down arrow for MINIMUM STIRRUP BAR SIZE to select #4. 
– Press OK.
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6. From the Input menu, select Load Cases. A dialog box appears.
– Since we are not considering lateral forces, click on WIND in the LABEL column on the 

list in the bottom half of the LOAD CASES dialog box and press the DELETE button.
– Click on EQ in the LABEL column and press the DELETE button.
– Press OK.

7. From the Input menu, select Load Combinations. A dialog box appears. 
– Delete all the load combinations by clicking anywhere on the list in the bottom half of 

the LOAD COMBINATIONS dialog box and pressing the DELETE button. Repeat this pro-
cedure until all the load combinations are gone. 

– Input 0 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE field. Press 
ADD.

– Press OK.
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8. From the Input menu, select Span Loads. A dialog box appears.
– Press the drop down arrow next to TYPE, and select LINE LOAD.
– Input 4080 for both the START and END MAGNITUDE. (Note: this value was obtained 

by converting the area loads on the roof and the beam’s self weight into line loads.) 
Dead Load = Superimposed Load + Self Weight of Spandrel Beam = 

– Input 40 for the END LOCATION. Press ADD.
– Critical section for torsion is at the face of the support because of concentrated torques 

applied by the double tee stems at a distance less than d from the face of the support. 
The critical section for shear is also at the face of support because the load on the span-
drel beam is not applied close to the top of the member and because the concentrated 
forces transferred by the double tee stems are at a distance less than d from the face of 
support. A small dummy load of 0.001 kips at the face of support is therefore intro-



  


      psf ft ft ft ft ft pcf kip ft90

70
2

[(1.33 4.00 ) (1.33 0.67 )] 150 0.93 /
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duced in order to move the critical section for shear from the default location of d 
away from the support to the face of the support.

– Use the drop down arrow next to TYPE, and select POINT FORCE.
– Input 0.001 for the MAGNITUDE and 0.667 for the LOCATION. Press ADD.
– Use the drop down arrow next to TYPE, and select POINT FORCE.
– Input 0.001 for the MAGNITUDE and 39.333 for the LOCATION. Press ADD.
– Use the drop down arrow next to TYPE, and select LINE TORQUE.
– Input 3.15 for both the START and END MAGNITUDE. (Note: this value was obtained 

by multiplying the superimposed line load by the moment arm of 12 in.)

Torsion Line Load (Dead) = 

– Keep the END LOCATION of 40 and press ADD. 



  


   psf ft in

in ft
kip ft ft90

70
2

12
12 /

3.15 /
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9. In the top left corner of the SPAN LOADS dialog box, there is a section called CURRENT 
CASE. Click on LIVE.
– Use the drop down arrow next to TYPE to select LINE LOAD. I
– Input 1050 for both the START and END MAGNITUDE. (Note: this value was obtained 

by converting the area loads on the roof to line loads on the beam.)

Live Load = 

– Input 40 for the END LOCATION. Press ADD.
– Use the drop down arrow next to TYPE, and select LINE TORQUE.
– Input 1.05 for both the START and END MAGNITUDE. (Note: this value was obtained 

by multiplying the live line load by the moment arm of 12 in.)

– Input 40 for the END LOCATION. Press ADD.
– Press OK. 

6.2.4 Solving
10. From the Solve menu, select Execute. Press CLOSE.
11. From the Solve menu, select Results.

– Use the explorer to browse through the results tables. 
– Use the ARROW keys or the mouse wheel to browse through different parts of the 

table quickly. Press the CLOSE button to close the SPRESULTS.

 





 psf ft lb ft30

70
2

1050 /




  










   psf ft in

in ft
kip ft ft30

70
2

12
12 /

1.05 /
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6.2.5 Viewing and Printing Results
12. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear Capacity,

Deflection, or Reinforcement from the View menu. Right click in any of these diagrams 
to get new copy, printing, or display options. 

13. You may print the results report by using the spReporter module. To print any of the 
diagrams you selected to view, use the Print Preview command found by right clicking in 
the diagram’s window. After viewing the results, you may decide to investigate the input 
beams under the same loads but with a modified reinforcement configuration. 

14. From the Input menu, select General Information. In the General Information dialog 
box change the RUN MODE option to INVESTIGATION. Do not change any of the other 
options. Press OK.

15. From the Input menu, select the different commands under Reinforcement Criteria and 
Reinforcing Bars to modify the reinforcement configuration computed by the program.

16. Repeat steps 10 and subsequent to perform the investigation and view the results. 
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1. Input Echo  
 
 

1.1. General Information  
 

File Name ...\Example 2 - PCA Notes on ACI 318-
Example 1... 

Project spSlab/spBeam Manual, Example 2 
Frame PCA Notes on ACI 318-Example 13-1 
Engineer StructurePoint 
Code ACI 318-14 
Reinforcement 
Database 

ASTM A615 

Mode Design 
Number of supports =  2 
Floor System One-Way/Beam 

 
 

1.2. Solve Options  
 

Live load pattern ratio = 100% 
Deflections are based on cracked section properties. 
In negative moment regions, Ig and Mcr DO NOT include flange/slab contribution (if available) 
Long-term deflections are calculated for load duration of 60 months. 
0% of live load is sustained. 
Compression reinforcement calculations NOT selected. 
Default incremental rebar design selected. 
Moment redistribution NOT selected. 
Effective flange width calculations NOT selected. 
Rigid beam-column joint NOT selected. 
Torsion analysis and design selected. 
Stirrups in flanges (if available) selected. 
Compatibility torsion NOT selected. 

 
 

1.3. Material Properties  
 
 

1.3.1. Concrete: Slabs / Beams  
 

wc 150 lb/ft3 
f'c 5 ksi 
Ec 4286.8 ksi 
fr 0.53033 ksi 

 
 

1.3.2. Concrete: Columns  
 

wc 150 lb/ft3 
f'c 5 ksi 
Ec 4286.8 ksi 
fr 0.53033 ksi 

 
 

1.3.3. Reinforcing Steel  
 

fy 60 ksi 
fyt 60 ksi 
Es 29000 ksi 
Epoxy coated bars No  
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1.4. Reinforcement Database  
 

Size Db Ab Wb Size Db Ab Wb 
 in in2 lb/ft  in in2 lb/ft 

#3 0.38 0.11 0.38 #4 0.50 0.20 0.67 
#5 0.63 0.31 1.04 #6 0.75 0.44 1.50 
#7 0.88 0.60 2.04 #8 1.00 0.79 2.67 
#9 1.13 1.00 3.40 #10 1.27 1.27 4.30 

#11 1.41 1.56 5.31 #14 1.69 2.25 7.65 
#18 2.26 4.00 13.60     

 
 

1.5. Span Data  
 
 

1.5.1. Slabs  
 

Span Loc L1 t wL wR Hmin  
  ft in ft ft in  

1 Int 40.000 16.00 0.667 1.333 0.00  
 
 

1.5.2. Ribs and Longitudinal Beams  
 

Span Ribs Beams Span  
 b h Sp b h Hmin  
 in in in in in in  

1 0.00 0.00 0.00 16.00 48.00 30.00  
 
 

1.6. Support Data  
 
 

1.6.1. Columns  
 

Support c1a c2a Ha c1b c2b Hb Red %  
 in in ft in in ft   

1 16.00 16.00 10.000 16.00 16.00 10.000 0  
2 16.00 16.00 10.000 16.00 16.00 10.000 0  

 
 

1.6.2. Boundary Conditions  
 

Support Spring Far End 
 Kz Kry Above Below 
 kip/in kip-in/rad   

1 0 0 Fixed Fixed 
2 0 0 Fixed Fixed 

 
 

1.7. Load Data  
 
 

1.7.1. Load Cases and Combinations  
 

Case SELF Dead Live 
Type DEAD DEAD LIVE 

U1 1.400 1.400 0.000 
U2 1.200 1.200 1.600 

 
 

1.7.2. Area Loads  
 

Case/Patt Span Wa 
  lb/ft2 

SELF 1 200.00 
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1.7.3. Line Loads  
 

Case/Patt Span Wa La Wb Lb 
  lb/ft ft lb/ft ft 

SELF 1 533.33 0.000 533.33 40.000 
Dead 1 4080.00 0.000 4080.00 40.000 
Live 1 1050.00 0.000 1050.00 40.000 

Live/Odd  1 1050.00 0.000 1050.00 40.000 
Live/S1  1 1050.00 0.000 1050.00 40.000 
Live/S2  1 1050.00 0.000 1050.00 40.000 

 
 

1.7.4. Point Forces  
 

Case/Patt Span Wa La 
  kip ft 
Dead 1 0.00 0.667 
 1 0.00 39.333 

 
 

1.7.5. Line Torque  
 

Case/Patt Span Wa La Wb Lb 
  k-ft/ft ft k-ft/ft ft 

Dead 1 3.15 0.000 3.15 40.000 
Live 1 1.05 0.000 1.05 40.000 

Live/Odd  1 1.05 0.000 1.05 40.000 
Live/S1  1 1.05 0.000 1.05 40.000 
Live/S2  1 1.05 0.000 1.05 40.000 

SELF 1 0.13 0.000 0.13 40.000 
 
 

1.8. Reinforcement Criteria  
 
 

1.8.1. Slabs and Ribs  
 

 Units Top Bars Bottom Bars 
  Min. Max. Min. Max. 
Bar Size  #5 #8 #5 #8 
Bar spacing in 1.00 18.00 1.00 18.00 
Reinf ratio % 0.14 5.00 0.14 5.00 
Clear Cover in 1.75  1.75  

There is NOT more than 12 in of concrete below top bars. 
 
 
 

1.8.2. Beams  
 

 Units Top Bars Bottom Bars Stirrups 
  Min. Max. Min. Max. Min. Max. 
Bar Size  #5 #5 #11 #11 #4 #4 
Bar spacing in 1.00 18.00 1.00 18.00 6.00 18.00 
Reinf ratio % 0.14 5.00 0.14 5.00   
Clear Cover in 1.75  1.75    
Layer dist. in 1.00  1.00    
No. of legs      2 6 
Side cover in     1.25  
1st Stirrup in     3.00  

There is NOT more than 12 in of concrete below top bars. 
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2. Design Results  
 
 

2.1. Top Reinforcement  
 

Span Zone Width Mmax Xmax As,min As,max As,req SpProv Bars  
  ft k-ft ft in2 in2 in2 in   

1 Left    2.00 0.00 0.667 0.000 15.619 0.000 0.000 ---  
 Midspan 2.00 0.00 20.000 0.000 15.619 0.000 0.000 ---  
 Right   2.00 0.00 39.333 0.000 15.619 0.000 0.000 ---  

 
 

2.2. Top Bar Details  
 

 Left Continuous Right 
Span Bars  Length Bars  Length Bars  Length Bars  Length Bars  Length 

   ft   ft   ft   ft   ft 
1 ---   ---   ---   ---   ---   

 
 

2.3. Top Bar Development Lengths  
 

 Left Continuous Right 
Span Bars  DevLen Bars  DevLen Bars  DevLen Bars  DevLen Bars  DevLen 

   in   in   in   in   in 
1 ---   ---   ---   ---   ---   

 
 

2.4. Bottom Reinforcement  
 

Span Width Mmax Xmax As,min As,max As,req SpProv Bars  
 ft k-ft ft in2 in2 in2 in   

1 1.33 1539.20 20.000 2.531 22.818 8.073 3.639 6-#11 2L 
 
 

2.5. Bottom Bar Details  
 

 Long Bars Short Bars 
Span Bars  Start Length Bars  Start Length 

   ft ft   ft ft 
1 6-#11  0.00 40.00 ---    

 
 

2.6. Bottom Bar Development Lengths  
 

 Long Bars Short Bars 
Span Bars  DevLen Bars  DevLen 

   in   in 
1 6-#11  59.98 ---   

 
 

2.7. Flexural Capacity  
 

 Top Bottom 
Span x As,top ΦMn- Mu- Comb Pat Status As,bot ΦMn+ Mu+ Comb Pat Status 

 ft in2 k-ft k-ft    in2 k-ft k-ft    
1 0.000 0.00 0.00 0.00 U1 All  --- 9.36 1768.57 0.00 U1 All  --- 
 0.667 0.00 0.00 0.00 U1 All  OK 9.36 1768.57 100.90 U2 All  OK 
 14.200 0.00 0.00 0.00 U1 All  OK 9.36 1768.57 1409.75 U2 All  OK 
 20.000 0.00 0.00 0.00 U1 All  OK 9.36 1768.57 1539.20 U2 All  OK 
 25.800 0.00 0.00 0.00 U1 All  OK 9.36 1768.57 1409.75 U2 All  OK 
 39.333 0.00 0.00 0.00 U1 All  OK 9.36 1768.57 100.91 U2 All  OK 
 40.000 0.00 0.00 0.00 U1 All  --- 9.36 1768.57 0.00 U1 All  --- 
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2.8. Longitudinal Beam Shear and Torsion Reinforcement Required  
 
 

2.8.1. Section Geometrical Properties  
 

Span d pcp ph Acp Aoh Ao  
 in in in in2 in2 in2  

1 44.74 144.00 132.00 896.000 689.000 585.650  
 
 

2.8.2. Section Strength Properties  
 

Span (Av/s)min ΦVc ΦTcr ΦSvt 
 in2/in kip k-ft ksi 

1 0.0141 75.93 98.55 0.530 
 
 

2.8.3. Transverse Reinforcement Demand  
 

Notes: 
*2 - Torsion ignored (Tu < PhiTcr/4). 
 

   Required Demand 
Span Start End Xu Vu Tu vf Comb/Patt Av/s At/s A(v+2t)/s A(v+2t)/s  

 ft ft ft kip k-ft ksi  in2/in in2/in in2/in in2/in  
1 0.667 6.190 0.67 148.79 108.65 0.298 U2/All 0.0362 0.0247 0.0857 0.0857  
 6.190 11.714 6.19 106.28 77.61 0.213 U2/All 0.0151 0.0177 0.0504 0.0504  
 11.714 17.238 11.71 63.77 46.56 0.128 U2/All 0.0000 0.0106 0.0212 0.0212  
 17.238 22.762 17.24 21.26 15.52 0.043 U2/All 0.0000 0.0000 0.0000 0.0000  *2 
 22.762 28.286 28.29 63.77 46.56 0.128 U2/All 0.0000 0.0106 0.0212 0.0212  
 28.286 33.810 33.81 106.28 77.61 0.213 U2/All 0.0151 0.0177 0.0504 0.0504  
 33.810 39.333 39.33 148.79 108.65 0.298 U2/All 0.0362 0.0247 0.0857 0.0857  

 
 

2.8.4. Required Longitudinal Reinforcement  
 

Notes: 
*2 - Torsion ignored (Tu < PhiTcr/4). 
*5 - Minimum longitudinal reinforcement required. 
 

Span Start End Xu Tu Comb/Patt Al  
 ft ft ft k-ft  in2  

1 0.667 6.190 0.67 108.65 U2/All 3.265  
 6.190 11.714 11.71 46.56 U2/All 3.880  *5 
 11.714 17.238 14.97 28.25 U2/All 4.400  *5 
 17.238 22.762 17.24 15.52 U2/All 0.000  *2 
 22.762 28.286 24.64 26.08 U2/All 4.400  *5 
 28.286 33.810 28.29 46.56 U2/All 3.880  *5 
 33.810 39.333 39.33 108.65 U2/All 3.265  

 
 

2.8.5. Beam Transverse Reinforcement Details  
 

Span Size Stirrups (2 legs each unless otherwise noted) 
1 #4  10 @ 6.7 [3L] + 9 @ 7.4 + 6 @ 11.0 + <-- 66.3 --> + 6 @ 11.0 + 9 @ 7.4 + 10 @ 6.7 [3L]  

 
 

2.8.6. Longitudinal Torsional Reinforcement Details  
 

 Long Bars Short Bars 
Span Bars  Start Length Bars  Start Length 

   ft ft   ft ft 
1 ---    12-#6  0.00 17.22 
 ---    12-#6  22.78 17.22 
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2.8.7. Beam Shear and Torsion Transverse Reinforcement Capacity in Terms of Required Area  
 

Notes: 
*2 - Torsion ignored (Tu < PhiTcr/4). 
 

   Required 
Span Start End Xu Vu Tu vf Comb/Patt Av/s At/s A(v+2t)/s  

 ft ft ft kip k-ft ksi  in2/in in2/in in2/in  
1 0.000 0.917 0.67 148.79 108.65 0.30 U2/All ----- ----- -----  
 0.917 6.190 0.92 146.87 107.25 0.29 U2/All 0.0352 0.0244 0.0841  
 6.190 11.714 6.19 106.28 77.61 0.21 U2/All 0.0151 0.0177 0.0504  
 11.714 15.747 11.71 63.77 46.56 0.13 U2/All 0.0000 0.0106 0.0212  
 15.747 17.238 15.75 32.73 23.90 0.07 U2/All 0.0000 0.0000 0.0000  *2 
 17.238 22.762 17.24 21.26 15.52 0.04 U2/All 0.0000 0.0000 0.0000  *2 
 22.762 24.253 24.25 32.73 23.90 0.07 U2/All 0.0000 0.0000 0.0000  *2 
 24.253 28.286 28.29 63.77 46.56 0.13 U2/All 0.0000 0.0106 0.0212  
 28.286 33.810 33.81 106.28 77.61 0.21 U2/All 0.0151 0.0177 0.0504  
 33.810 39.083 39.08 146.87 107.25 0.29 U2/All 0.0352 0.0244 0.0841  
 39.083 40.000 39.33 148.79 108.65 0.30 U2/All ----- ----- -----  

 
 

2.8.8. Beam Shear and Torsion Transverse Reinforcement Capacity in Terms of Provided Area  
 

Notes: 
*2 - Torsion ignored (Tu < PhiTcr/4). 
 

   Provided 
Span Start End A(v+2t) Sp A(v+2t)/s  

 ft ft in2 in in2/in  
1 0.000 0.917 ----- ----- ------  
 0.917 6.190 0.600 6.66 0.0901  
 6.190 11.714 0.400 7.37 0.0543  
 11.714 15.747 0.400 11.05 0.0362  
 15.747 17.238 0.400 11.05 0.0362  *2 
 17.238 22.762 ----- ----- ------  *2 
 22.762 24.253 0.400 11.05 0.0362  *2 
 24.253 28.286 0.400 11.05 0.0362  
 28.286 33.810 0.400 7.37 0.0543  
 33.810 39.083 0.600 6.66 0.0901  
 39.083 40.000 ----- ----- ------  

 
 

2.8.9. Beam Torsion Longitudinal Reinforcement Capacity in Terms of Required and Provided Area  
 

Notes: 
*2 - Torsion ignored (Tu < PhiTcr/4). 
*5 - Minimum longitudinal reinforcement required. 
 

   Required Provided 
Span Start End Xu Tu Comb/Patt A1 A1  

 ft ft ft k-ft  in2 in2  
1 0.000 0.917 0.67 108.65 U2/All 3.265 -----  
 0.917 6.190 0.92 107.25 U2/All 3.223 5.280  
 6.190 11.714 11.71 46.56 U2/All 3.880 5.280  *5 
 11.714 15.747 14.97 28.25 U2/All 4.400 5.280  *5 
 15.747 17.238 15.75 23.90 U2/All 0.000 -----  *2 
 17.238 22.762 17.24 15.52 U2/All 0.000 -----  *2 
 22.762 24.253 22.76 15.52 U2/All 0.000 -----  *2 
 24.253 28.286 24.64 26.08 U2/All 4.400 5.280  *5 
 28.286 33.810 28.29 46.56 U2/All 3.880 5.280  *5 
 33.810 39.083 39.08 107.25 U2/All 3.223 5.280  
 39.083 40.000 39.33 108.65 U2/All 3.265 -----  
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2.9. Slab Shear Capacity  
 

Span b d Vratio ΦVc Vu Xu  
 in in  kip kip ft  

1 --- Not checked --- 
 
 

2.10. Material TakeOff  
 
 

2.10.1. Reinforcement in the Direction of Analysis  
 

Top Bars 0.0 lb <=> 0.00 lb/ft <=> 0.000 lb/ft2 
Bottom Bars 1275.1 lb <=> 31.88 lb/ft <=> 15.939 lb/ft2 
Torsion Bars 620.9 lb <=> 15.52 lb/ft <=> 7.761 lb/ft2 
Stirrups 387.4 lb <=> 9.69 lb/ft <=> 4.843 lb/ft2 
Total Steel 2283.4 lb <=> 57.09 lb/ft <=> 28.543 lb/ft2 
Concrete 248.9 ft3 <=> 6.22 ft3/ft <=> 3.111 ft3/ft2 
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6.3 Example 3 Design of a Continuous Beam

6.3.1 Problem Formulation

The system shown in the following figure consists of five spans symmetric about the centerline. 
We will be designing beam ABCD assuming that the other half of the beam will be loaded and 
designed the same way. All beams have a width of 12 in. and a depth of 22 in. – including the 5 in. 
thick deck. Span length and widths are shown in the figure. Columns have a 12 in.  12in. cross-
section and a length equal to a typical story height of 13 ft. The system will be analyzed and 
designed under a uniform live load of 130 psf and a dead load that consists of the slab system’s 
own weight plus 80 psf. Use f’c = 4 ksi, fy = 60 ksi, and concrete = 150 pcf. This example refers to 
example 16.1 from Structural Concrete: Theory and Design by Hassoun and Al-Manaseer, Third 
Edition, 2008.
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6.3.2 Preparing Input
1. From the Input menu, select General Information. A dialog box appears.

– In the LABELS section, input the names of the project, frame, and engineer. 
– In the FRAME section, input 6 for NO OF SUPPORTS as the spBeam models the entire 

continuous beam. 
– In the FLOOR SYSTEM section, click the radial button next to ONE-WAY / BEAM. 
– Leave all other options in the General Information tab to their default settings of ACI 

318-14 design code, ASTM A615 reinforcement, and DESIGN run mode option. 
– In the Solve Options tab, keep the default settings. Press OK.

6.3.3 Assigning Properties
2. Nothing needs to be changed in the Material Properties menu. 
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3. From the Input menu, select Spans. A dialog box appears.
– Under the Slabs/Flanges tab, input 24 for LENGTH, 5 for THICKNESS, and 0 for 

WIDTH LEFT and WIDTH RIGHT. Press MODIFY. (Note: Since the slab has no width, we 
must convert the area loads to line loads along the beam and also add the self-weight 
of the slab to the dead load. This calculation will be shown in Step 8.)

– Press COPY. Select the check box next to Span 5. Press OK. This will give Span 5 the 
same geometry as Span 1.

– Press the drop down arrow next to SPAN and select Span 2. Input 26 for LENGTH, 5 for 
THICKNESS, and 0 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY. 

– Press COPY. Unselect the check box next to Span 1 and select the check boxes next to 
Spans 3 and 4. Press OK.

– Select the Longitudinal Beams tab. Input 12 for WIDTH and 22 for DEPTH. Press 
MODIFY.

– Press COPY. Press the CHECK ALL button. Press OK.
– Press OK again.
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4. From the Input menu, select Supports. A dialog box appears.
– Under the Columns tab, input 13 for both HEIGHT ABOVE and HEIGHT BELOW. Press 

MODIFY. (Note: the default C1 and C2 values for both the column above and below the 
support can be left alone since all the columns’ cross sections are 12 in.  12 in.)

– Press COPY. Press the CHECK ALL button. Press OK.
– Press OK again.
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5. From the Input menu, select Reinforcement Criteria. A dialog box appears.
– Under the Beams tab, use the drop down arrows to change both the MIN and MAX 

BAR SIZE for TOP BARS to #9. 
– Use the drop down arrows to change both the MIN and MAX BAR SIZE for BOTTOM 

BARS to #8. Press OK.

6. From the Input menu, select Load Cases. A dialog box appears.
– Since we are not considering lateral forces, click on WIND in the LABEL column on the 

list in the bottom half of the LOAD CASES dialog box and press the DELETE button.
– Click on EQ in the LABEL column and press the DELETE button. Press OK.
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7. From the Input menu, select Load Combinations. A dialog box appears. 
– Delete all the load combinations by clicking anywhere on the list in the bottom half of 

the LOAD COMBINATIONS dialog box and pressing the DELETE button. Repeat this pro-
cedure until all the load combinations are gone. 

– Input 1.2 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE field. Press 
ADD.

– Press OK.
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8. From the Input menu, select Span Loads. A dialog box appears.
– Press the drop down arrow next to TYPE, and select LINE LOAD.
– Input 1647.5 for both the START and END MAGNITUDE. (Note: This value was 

obtained by converting the area loads of the of the slab’s self weight (without the 
beam) and superimposed dead load into a line load.)

Dead Load = 

– Input 24 for the END LOCATION. Press ADD.
– Click on SPAN 1 on the list in the bottom half of the SPAN LOADS dialog box. Press the 

COPY button. (Note: there is a CASE COPY button that should not be pressed.)
– Click the check box next to SPAN 5 and press OK.
– Back in the SPAN LOADS dialog box, use the drop down arrow next to SPAN to select 

SPAN 2. Keep the START and END MAGNITUDES of 1647.5 lb/ft but change the END 
LOCATION to 26. Click the ADD button.

– Click on SPAN 2 in the list at the bottom half of the SPAN LOADS dialog box. Press the 
COPY button.

– Click the check boxes next to SPAN 3 and 4. Press OK.

–
–

   






ft pcf ft psf ft in in
in ft

pcf

lb ft

( 5
12

150 12 ) (80 * 12 ) ( 5 12
144 /

150 )

1647.5 /

2 2
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9. In the top left corner of the SPAN LOADS dialog box, there is a section called CURRENT 
CASE. Click on LIVE.
– Use the drop down arrow next to SPAN to select SPAN 1.
– Making sure that LINE LOAD is still the selected LOAD TYPE, input 1560 for both the 

START and END MAGNITUDE.

Live Load = 
– Input 24 for the END LOCATION. Press ADD.
– Click on SPAN 1 on the list in the bottom half of the SPAN LOADS dialog box. Press the 

COPY button. (Note: the CASE COPY button should not be pressed.)
– Click the check box next to SPAN 5 and press OK.
– Back in the SPAN LOADS dialog box, use the drop down arrow next to SPANS to select 

SPAN 2. Keep the START and END MAGNITUDES of 1560 lb/ft but change the END 
LOCATION to 26. Click the ADD button.

– Click on SPAN 2 in the list at the bottom half of the SPAN LOADS dialog box. Press the 
COPY button.

– Click the check boxes next to SPAN 3 AND 4. Press OK.
– Press OK again.

6.3.4 Solving
10. From the Solve menu, select Execute. Press CLOSE.

 psf ft lb ft(130 12 ) 1560 /
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11. From the Solve menu, select Results.
– Use the explorer to browse through the results tables. 
– Use the ARROW keys or the mouse wheel to browse through different parts of the 

table quickly. Press the CLOSE button to close the SPRESULTS.

6.3.5 Viewing and Printing Results
12. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear Capacity,

Deflection, or Reinforcement from the View menu. Right click in any of these diagrams 
to get new copy, printing, or display options. 

13. You may print the results report by using the spReporter module. To print any of the 
diagrams you selected to view, use the Print Preview command found by right clicking in 
the diagram’s window. After viewing the results, you may decide to investigate the input 
beams under the same loads but with a modified reinforcement configuration. 

14. From the Input menu, select General Information. In the General Information dialog 
box change the RUN MODE option to INVESTIGATION. Do not change any of the other 
options. Press OK

15. From the Input menu, select the different commands under Reinforcement Criteria and 
Reinforcing Bars to modify the reinforcement configuration computed by the program.

16. Repeat steps 10 and subsequent to perform the investigation and view the results.
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Licensee stated above acknowledges that STRUCTUREPOINT (SP) is not and cannot be responsible for either the accuracy or adequacy of the material supplied 
as input for processing by the spSlab computer program. Furthermore, STRUCTUREPOINT neither makes any warranty expressed nor implied with respect to the 
correctness of the output prepared by the spSlab program. Although STRUCTUREPOINT has endeavored to produce spSlab error free the program is not and 
cannot be certified infallible. The final and only responsibility for analysis, design and engineering documents is the licensee's. Accordingly, STRUCTUREPOINT 
disclaims all responsibility in contract, negligence or other tort for any analysis, design or engineering documents prepared in connection with the use of the spSlab 
program.Licensed to: -- Unknown User --. License ID: 00000-0000000 
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1. Input Echo  
 
 

1.1. General Information  
 

File Name ...\Example 3 - Structural Concrete by 
Hassoun... 

Project spSlab/spBeam Manual Example 3 
Frame Structural Concrete by Hassoun-Example 

16.1 
Engineer StructurePoint 
Code ACI 318-14 
Reinforcement 
Database 

ASTM A615 

Mode Design 
Number of supports =  6 
Floor System One-Way/Beam 

 
 

1.2. Solve Options  
 

Live load pattern ratio = 100% 
Deflections are based on cracked section properties. 
In negative moment regions, Ig and Mcr DO NOT include flange/slab contribution (if available) 
Long-term deflections are calculated for load duration of 60 months. 
0% of live load is sustained. 
Compression reinforcement calculations NOT selected. 
Default incremental rebar design selected. 
Moment redistribution NOT selected. 
Effective flange width calculations NOT selected. 
Rigid beam-column joint NOT selected. 
Torsion analysis and design NOT selected. 

 
 

1.3. Material Properties  
 
 

1.3.1. Concrete: Slabs / Beams  
 

wc 150 lb/ft3 
f'c 4 ksi 
Ec 3834.3 ksi 
fr 0.474342 ksi 

 
 

1.3.2. Concrete: Columns  
 

wc 150 lb/ft3 
f'c 4 ksi 
Ec 3834.3 ksi 
fr 0.47434 ksi 

 
 

1.3.3. Reinforcing Steel  
 

fy 60 ksi 
fyt 60 ksi 
Es 29000 ksi 
Epoxy coated bars No  
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1.4. Reinforcement Database  
 

Size Db Ab Wb Size Db Ab Wb 
 in in2 lb/ft  in in2 lb/ft 

#3 0.38 0.11 0.38 #4 0.50 0.20 0.67 
#5 0.63 0.31 1.04 #6 0.75 0.44 1.50 
#7 0.88 0.60 2.04 #8 1.00 0.79 2.67 
#9 1.13 1.00 3.40 #10 1.27 1.27 4.30 

#11 1.41 1.56 5.31 #14 1.69 2.25 7.65 
#18 2.26 4.00 13.60     

 
 

1.5. Span Data  
 
 

1.5.1. Slabs  
 

Span Loc L1 t wL wR Hmin  
  ft in ft ft in  

1 Int 24.000 5.00 0.500 0.500 0.00  
2 Int 26.000 5.00 0.500 0.500 0.00  
3 Int 26.000 5.00 0.500 0.500 0.00  
4 Int 26.000 5.00 0.500 0.500 0.00  
5 Int 24.000 5.00 0.500 0.500 0.00  

 
 

1.5.2. Ribs and Longitudinal Beams  
 

Span Ribs Beams Span  
 b h Sp b h Hmin  
 in in in in in in  

1 0.00 0.00 0.00 12.00 22.00 15.57  
2 0.00 0.00 0.00 12.00 22.00 14.86  
3 0.00 0.00 0.00 12.00 22.00 14.86  
4 0.00 0.00 0.00 12.00 22.00 14.86  
5 0.00 0.00 0.00 12.00 22.00 15.57  

 
 

1.6. Support Data  
 
 

1.6.1. Columns  
 

Support c1a c2a Ha c1b c2b Hb Red %  
 in in ft in in ft   

1 12.00 12.00 13.000 12.00 12.00 13.000 100  
2 12.00 12.00 13.000 12.00 12.00 13.000 100  
3 12.00 12.00 13.000 12.00 12.00 13.000 100  
4 12.00 12.00 13.000 12.00 12.00 13.000 100  
5 12.00 12.00 13.000 12.00 12.00 13.000 100  
6 12.00 12.00 13.000 12.00 12.00 13.000 100  

 
 

1.6.2. Boundary Conditions  
 

Support Spring Far End 
 Kz Kry Above Below 
 kip/in kip-in/rad   

1 0 0 Fixed Fixed 
2 0 0 Fixed Fixed 
3 0 0 Fixed Fixed 
4 0 0 Fixed Fixed 
5 0 0 Fixed Fixed 
6 0 0 Fixed Fixed 
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1.7. Load Data  
 
 

1.7.1. Load Cases and Combinations  
 

Case SELF Dead Live 
Type DEAD DEAD LIVE 

U1 1.400 1.400 0.000 
U2 1.200 1.200 1.600 

 
 

1.7.2. Area Loads  
 

Case/Patt Span Wa 
  lb/ft2 

SELF 1 62.50 
 2 62.50 
 3 62.50 
 4 62.50 
 5 62.50 

 
 

1.7.3. Line Loads  
 

Case/Patt Span Wa La Wb Lb 
  lb/ft ft lb/ft ft 

SELF 1 212.50 0.000 212.50 24.000 
 2 212.50 0.000 212.50 26.000 
 3 212.50 0.000 212.50 26.000 
 4 212.50 0.000 212.50 26.000 
 5 212.50 0.000 212.50 24.000 

Dead 1 1647.50 0.000 1647.50 24.000 
 2 1647.50 0.000 1647.50 26.000 
 3 1647.50 0.000 1647.50 26.000 
 4 1647.50 0.000 1647.50 26.000 
 5 1647.50 0.000 1647.50 24.000 

Live 1 1560.00 0.000 1560.00 24.000 
 2 1560.00 0.000 1560.00 26.000 
 3 1560.00 0.000 1560.00 26.000 
 4 1560.00 0.000 1560.00 26.000 
 5 1560.00 0.000 1560.00 24.000 

Live/Odd  1 1560.00 0.000 1560.00 24.000 
 3 1560.00 0.000 1560.00 26.000 
 5 1560.00 0.000 1560.00 24.000 

Live/Even 2 1560.00 0.000 1560.00 26.000 
 4 1560.00 0.000 1560.00 26.000 

Live/S1  1 1560.00 0.000 1560.00 24.000 
Live/S2  1 1560.00 0.000 1560.00 24.000 

 2 1560.00 0.000 1560.00 26.000 
Live/S3  2 1560.00 0.000 1560.00 26.000 

 3 1560.00 0.000 1560.00 26.000 
Live/S4  3 1560.00 0.000 1560.00 26.000 

 4 1560.00 0.000 1560.00 26.000 
Live/S5  4 1560.00 0.000 1560.00 26.000 

 5 1560.00 0.000 1560.00 24.000 
Live/S6  5 1560.00 0.000 1560.00 24.000 
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1.8. Reinforcement Criteria  
 
 

1.8.1. Slabs and Ribs  
 

 Units Top Bars Bottom Bars 
  Min. Max. Min. Max. 
Bar Size  #9 #9 #8 #8 
Bar spacing in 1.00 18.00 1.00 18.00 
Reinf ratio % 0.14 5.00 0.14 5.00 
Clear Cover in 1.50  1.50  

There is NOT more than 12 in of concrete below top bars. 
 
 
 

1.8.2. Beams  
 

 Units Top Bars Bottom Bars Stirrups 
  Min. Max. Min. Max. Min. Max. 
Bar Size  #9 #9 #8 #8 #3 #5 
Bar spacing in 1.00 18.00 1.00 18.00 6.00 18.00 
Reinf ratio % 0.14 5.00 0.14 5.00   
Clear Cover in 1.50  1.50    
Layer dist. in 1.00  1.00    
No. of legs      2 6 
Side cover in     1.50  
1st Stirrup in     3.00  

There is NOT more than 12 in of concrete below top bars. 
 
 
 

2. Design Results  
 
 

2.1. Top Reinforcement  
 

Span Zone Width Mmax Xmax As,min As,max As,req SpProv Bars  
  ft k-ft ft in2 in2 in2 in   

1 Left    1.00 77.75 0.500 0.797 4.321 0.896 6.220 2-#9  
 Midspan 1.00 0.00 12.000 0.000 4.321 0.000 0.000 ---  
 Right   1.00 268.24 23.500 0.776 4.206 3.549 3.110 4-#9 2L 
           

2 Left    1.00 267.45 0.500 0.776 4.206 3.537 3.110 4-#9 2L 
 Midspan 1.00 0.00 13.000 0.000 4.321 0.000 0.000 ---  
 Right   1.00 264.30 25.500 0.776 4.206 3.488 3.110 4-#9 2L 
           

3 Left    1.00 265.14 0.500 0.776 4.206 3.501 3.110 4-#9 2L 
 Midspan 1.00 0.00 13.000 0.000 4.321 0.000 0.000 ---  
 Right   1.00 265.14 25.500 0.776 4.206 3.501 3.110 4-#9 2L 
           

4 Left    1.00 264.30 0.500 0.776 4.206 3.488 3.110 4-#9 2L 
 Midspan 1.00 0.00 13.000 0.000 4.321 0.000 0.000 ---  
 Right   1.00 267.45 25.500 0.776 4.206 3.537 3.110 4-#9 2L 
           

5 Left    1.00 268.24 0.500 0.776 4.206 3.549 3.110 4-#9 2L 
 Midspan 1.00 0.00 12.000 0.000 4.321 0.000 0.000 ---  
 Right   1.00 77.75 23.500 0.797 4.321 0.896 6.220 2-#9  
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2.2. Top Bar Details  
 

NOTES: 
* - Bar cut-off location does not meet ACI 318, 12.10.5.1. Revise location, unless the requirements of either 12.10.5.2 or 12.10.5.3 are 
manually checked and satisfied. 
 

 Left Continuous Right 
Span Bars  Length Bars  Length Bars  Length Bars  Length Bars  Length 

   ft   ft   ft   ft   ft 
1 1-#9  3.91 1-#9 * 2.14 ---   2-#9  9.62 2-#9 * 4.80 
                

2 2-#9  10.37 2-#9 * 4.79 ---   2-#9  10.37 2-#9 * 4.73 
                

3 2-#9  10.12 2-#9 * 4.75 ---   2-#9  10.12 2-#9 * 4.75 
                

4 2-#9  10.37 2-#9 * 4.73 ---   2-#9  10.37 2-#9 * 4.79 
                

5 2-#9  9.62 2-#9 * 4.80 ---   1-#9  3.91 1-#9 * 2.14 
 
 

2.3. Top Bar Development Lengths  
 

 Left Continuous Right 
Span Bars  DevLen Bars  DevLen Bars  DevLen Bars  DevLen Bars  DevLen 

   in   in   in   in   in 
1 1-#9  19.66 1-#9  19.66 ---   2-#9  51.66 2-#9  51.66 
                

2 2-#9  51.48 2-#9  51.48 ---   2-#9  50.76 2-#9  50.76 
                

3 2-#9  50.95 2-#9  50.95 ---   2-#9  50.95 2-#9  50.95 
                

4 2-#9  50.76 2-#9  50.76 ---   2-#9  51.48 2-#9  51.48 
                

5 2-#9  51.66 2-#9  51.66 ---   1-#9  19.66 1-#9  19.66 
 
 

2.4. Bottom Reinforcement  
 

Span Width Mmax Xmax As,min As,max As,req SpProv Bars  
 ft k-ft ft in2 in2 in2 in   

1 1.00 183.86 11.000 0.800 4.335 2.225 3.155 3-#8  
          

2 1.00 171.61 13.250 0.800 4.335 2.063 3.155 3-#8  
          

3 1.00 177.76 13.000 0.800 4.335 2.144 3.155 3-#8  
          

4 1.00 171.61 12.750 0.800 4.335 2.063 3.155 3-#8  
          

5 1.00 183.86 13.000 0.800 4.335 2.225 3.155 3-#8  
 
 

2.5. Bottom Bar Details  
 

Notes: 
* - Bar cut-off location does not meet ACI 318, 12.10.5.1. Revise location, unless the requirements of either 12.10.5.2 or 12.10.5.3 are 
manually checked and satisfied. 
 

 Long Bars Short Bars 
Span Bars  Start Length Bars  Start Length 

   ft ft   ft ft 
1 2-#8  0.00 24.00 1-#8 * 2.85 16.17 
         

2 2-#8  0.00 26.00 1-#8 * 5.96 14.46 
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 Long Bars Short Bars 
Span Bars  Start Length Bars  Start Length 

   ft ft   ft ft 
         

3 2-#8  0.00 26.00 1-#8  5.33 15.34 
         

4 2-#8  0.00 26.00 1-#8 * 5.58 14.46 
         

5 2-#8  0.00 24.00 1-#8 * 4.98 16.17 
 
 

2.6. Bottom Bar Development Lengths  
 

 Long Bars Short Bars 
Span Bars  DevLen Bars  DevLen 

   in   in 
1 2-#8  42.34 1-#8  42.34 
       

2 2-#8  39.26 1-#8  39.26 
       

3 2-#8  40.80 1-#8  40.80 
       

4 2-#8  39.26 1-#8  39.26 
       

5 2-#8  42.34 1-#8  42.34 
 
 

2.7. Flexural Capacity  
 

 Top Bottom 
Span x As,top ΦMn- Mu- Comb Pat Status As,bot ΦMn+ Mu+ Comb Pat Status 

 ft in2 k-ft k-ft    in2 k-ft k-ft    
1 0.000 2.00 -166.19 -103.42 U2 Odd  --- 1.58 133.94 0.00 U1 All  --- 
 0.500 2.00 -166.19 -77.75 U2 Odd  OK 1.58 133.94 0.00 U1 All  OK 
 2.138 1.00 -86.40 -2.11 U2 Odd  OK 1.58 133.94 9.83 U2 Even OK 
 2.273 1.00 -86.40 0.00 U1 All  OK 1.58 133.94 11.91 U2 Even OK 
 2.852 0.65 -56.65 0.00 U1 All  OK 1.58 133.94 32.58 U2 S2 OK 
 3.911 0.00 0.00 0.00 U1 All  OK 1.82 152.63 67.00 U2 S2 OK 
 6.380 0.00 0.00 0.00 U1 All  OK 2.37 194.71 133.94 U2 Odd  OK 
 8.550 0.00 0.00 0.00 U1 All  OK 2.37 194.71 170.15 U2 Odd  OK 
 11.000 0.00 0.00 0.00 U1 All  OK 2.37 194.71 183.86 U2 Odd  OK 
 12.000 0.00 0.00 0.00 U1 All  OK 2.37 194.71 181.15 U2 Odd  OK 
 14.383 0.00 0.00 0.00 U1 All  OK 2.37 194.71 155.32 U2 Odd  OK 
 15.450 0.50 -43.66 0.00 U1 All  OK 2.37 194.71 134.94 U2 Odd  OK 
 15.497 0.52 -45.54 0.00 U1 All  OK 2.37 194.71 133.94 U2 Odd  OK 
 18.688 2.00 -166.19 -50.91 U2 Even OK 1.66 139.92 39.58 U2 Odd  OK 
 19.025 2.00 -166.19 -58.70 U2 Even OK 1.58 133.94 26.78 U2 Odd  OK 
 19.195 2.00 -166.19 -62.75 U2 Even OK 1.58 133.94 20.08 U2 Odd  OK 
 23.500 4.00 -296.33 -268.24 U2 S2 OK 1.58 133.94 0.00 U1 All  OK 
 24.000 4.00 -296.33 -300.91 U2 S2 --- 1.58 133.94 0.00 U1 All  --- 
              

2 0.000 4.00 -296.33 -299.70 U2 S2 --- 1.58 133.94 0.00 U1 All  --- 
 0.500 4.00 -296.33 -267.45 U2 S2 OK 1.58 133.94 0.00 U1 All  OK 
 4.790 2.00 -166.19 -60.38 U2 S1 OK 1.58 133.94 8.87 U2 S3 OK 
 5.959 2.00 -166.19 -36.03 U2 S1 OK 1.58 133.94 48.30 U2 S3 OK 
 6.077 2.00 -166.19 -33.75 U2 S1 OK 1.61 136.21 51.91 U2 S3 OK 
 9.231 0.53 -46.60 0.00 U1 All  OK 2.37 194.71 133.94 U2 Even OK 
 9.250 0.52 -45.82 0.00 U1 All  OK 2.37 194.71 134.32 U2 Even OK 
 10.367 0.00 0.00 0.00 U1 All  OK 2.37 194.71 152.43 U2 Even OK 
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 Top Bottom 
Span x As,top ΦMn- Mu- Comb Pat Status As,bot ΦMn+ Mu+ Comb Pat Status 

 ft in2 k-ft k-ft    in2 k-ft k-ft    
 13.000 0.00 0.00 0.00 U1 All  OK 2.37 194.71 171.53 U2 Even OK 
 13.250 0.00 0.00 0.00 U1 All  OK 2.37 194.71 171.61 U2 Even OK 
 15.633 0.00 0.00 0.00 U1 All  OK 2.37 194.71 157.26 U2 Even OK 
 16.750 0.53 -46.45 0.00 U1 All  OK 2.37 194.71 141.20 U2 Even OK 
 17.150 0.72 -62.64 0.00 U1 All  OK 2.37 194.71 133.94 U2 Even OK 
 19.863 2.00 -166.19 -32.00 U2 Odd  OK 1.71 144.61 64.67 U2 Even OK 
 20.422 2.00 -166.19 -41.23 U2 Odd  OK 1.58 133.94 46.02 U2 Even OK 
 21.270 2.00 -166.19 -56.62 U2 Odd  OK 1.58 133.94 14.87 U2 Even OK 
 25.500 4.00 -296.33 -264.30 U2 S3 OK 1.58 133.94 0.00 U1 All  OK 
 26.000 4.00 -296.33 -296.36 U2 S3 --- 1.58 133.94 0.00 U1 All  --- 
              

3 0.000 4.00 -296.33 -297.34 U2 S3 --- 1.58 133.94 0.00 U1 All  --- 
 0.500 4.00 -296.33 -265.14 U2 S3 OK 1.58 133.94 0.00 U1 All  OK 
 4.746 2.00 -166.19 -53.82 U2 Even OK 1.58 133.94 14.15 U2 Odd  OK 
 5.329 2.00 -166.19 -43.14 U2 Even OK 1.58 133.94 36.41 U2 Odd  OK 
 5.871 2.00 -166.19 -33.88 U2 Even OK 1.71 143.91 55.67 U2 Odd  OK 
 8.729 0.65 -57.24 0.00 U1 All  OK 2.37 194.71 133.94 U2 Odd  OK 
 9.250 0.41 -36.08 0.00 U1 All  OK 2.37 194.71 143.99 U2 Odd  OK 
 10.117 0.00 0.00 0.00 U1 All  OK 2.37 194.71 157.76 U2 Odd  OK 
 13.000 0.00 0.00 0.00 U1 All  OK 2.37 194.71 177.76 U2 Odd  OK 
 15.883 0.00 0.00 0.00 U1 All  OK 2.37 194.71 157.76 U2 Odd  OK 
 16.750 0.41 -36.08 0.00 U1 All  OK 2.37 194.71 143.99 U2 Odd  OK 
 17.271 0.65 -57.24 0.00 U1 All  OK 2.37 194.71 133.94 U2 Odd  OK 
 20.129 2.00 -166.19 -33.88 U2 Even OK 1.71 143.91 55.67 U2 Odd  OK 
 20.671 2.00 -166.19 -43.14 U2 Even OK 1.58 133.94 36.41 U2 Odd  OK 
 21.254 2.00 -166.19 -53.82 U2 Even OK 1.58 133.94 14.15 U2 Odd  OK 
 25.500 4.00 -296.33 -265.14 U2 S4 OK 1.58 133.94 0.00 U1 All  OK 
 26.000 4.00 -296.33 -297.34 U2 S4 --- 1.58 133.94 0.00 U1 All  --- 
              

4 0.000 4.00 -296.33 -296.36 U2 S4 --- 1.58 133.94 0.00 U1 All  --- 
 0.500 4.00 -296.33 -264.30 U2 S4 OK 1.58 133.94 0.00 U1 All  OK 
 4.730 2.00 -166.19 -56.62 U2 Odd  OK 1.58 133.94 14.87 U2 Even OK 
 5.578 2.00 -166.19 -41.23 U2 Odd  OK 1.58 133.94 46.02 U2 Even OK 
 6.137 2.00 -166.19 -32.00 U2 Odd  OK 1.71 144.61 64.67 U2 Even OK 
 8.850 0.72 -62.64 0.00 U1 All  OK 2.37 194.71 133.94 U2 Even OK 
 9.250 0.53 -46.45 0.00 U1 All  OK 2.37 194.71 141.20 U2 Even OK 
 10.367 0.00 0.00 0.00 U1 All  OK 2.37 194.71 157.26 U2 Even OK 
 12.750 0.00 0.00 0.00 U1 All  OK 2.37 194.71 171.61 U2 Even OK 
 13.000 0.00 0.00 0.00 U1 All  OK 2.37 194.71 171.53 U2 Even OK 
 15.633 0.00 0.00 0.00 U1 All  OK 2.37 194.71 152.43 U2 Even OK 
 16.750 0.52 -45.82 0.00 U1 All  OK 2.37 194.71 134.32 U2 Even OK 
 16.769 0.53 -46.60 0.00 U1 All  OK 2.37 194.71 133.94 U2 Even OK 
 19.923 2.00 -166.19 -33.75 U2 S6 OK 1.61 136.21 51.91 U2 S4 OK 
 20.041 2.00 -166.19 -36.03 U2 S6 OK 1.58 133.94 48.30 U2 S4 OK 
 21.210 2.00 -166.19 -60.38 U2 S6 OK 1.58 133.94 8.87 U2 S4 OK 
 25.500 4.00 -296.33 -267.45 U2 S5 OK 1.58 133.94 0.00 U1 All  OK 
 26.000 4.00 -296.33 -299.70 U2 S5 --- 1.58 133.94 0.00 U1 All  --- 
              

5 0.000 4.00 -296.33 -300.91 U2 S5 --- 1.58 133.94 0.00 U1 All  --- 
 0.500 4.00 -296.33 -268.24 U2 S5 OK 1.58 133.94 0.00 U1 All  OK 
 4.805 2.00 -166.19 -62.75 U2 Even OK 1.58 133.94 20.08 U2 Odd  OK 
 4.975 2.00 -166.19 -58.70 U2 Even OK 1.58 133.94 26.78 U2 Odd  OK 
 5.312 2.00 -166.19 -50.91 U2 Even OK 1.66 139.92 39.58 U2 Odd  OK 
 8.503 0.52 -45.54 0.00 U1 All  OK 2.37 194.71 133.94 U2 Odd  OK 
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 Top Bottom 
Span x As,top ΦMn- Mu- Comb Pat Status As,bot ΦMn+ Mu+ Comb Pat Status 

 ft in2 k-ft k-ft    in2 k-ft k-ft    
 8.550 0.50 -43.66 0.00 U1 All  OK 2.37 194.71 134.94 U2 Odd  OK 
 9.617 0.00 0.00 0.00 U1 All  OK 2.37 194.71 155.32 U2 Odd  OK 
 12.000 0.00 0.00 0.00 U1 All  OK 2.37 194.71 181.15 U2 Odd  OK 
 13.000 0.00 0.00 0.00 U1 All  OK 2.37 194.71 183.86 U2 Odd  OK 
 15.450 0.00 0.00 0.00 U1 All  OK 2.37 194.71 170.15 U2 Odd  OK 
 17.620 0.00 0.00 0.00 U1 All  OK 2.37 194.71 133.94 U2 Odd  OK 
 20.089 0.00 0.00 0.00 U1 All  OK 1.82 152.63 67.00 U2 S5 OK 
 21.148 0.65 -56.65 0.00 U1 All  OK 1.58 133.94 32.58 U2 S5 OK 
 21.727 1.00 -86.40 0.00 U1 All  OK 1.58 133.94 11.91 U2 Even OK 
 21.862 1.00 -86.40 -2.11 U2 Odd  OK 1.58 133.94 9.83 U2 Even OK 
 23.500 2.00 -166.19 -77.75 U2 Odd  OK 1.58 133.94 0.00 U1 All  OK 
 24.000 2.00 -166.19 -103.42 U2 Odd  --- 1.58 133.94 0.00 U1 All  --- 

 
 

2.8. Longitudinal Beam Transverse Reinforcement Demand and Capacity  
 
 

2.8.1. Section Properties  
 

Span d (Av/s)min ΦVc 
 in in2/in kip 

1 19.40 0.0100 22.09 
2 19.40 0.0100 22.09 
3 19.40 0.0100 22.09 
4 19.40 0.0100 22.09 
5 19.40 0.0100 22.09 

 
 

2.8.2. Beam Transverse Reinforcement Demand  
 

Notes: 
*8 - Minimum transverse (stirrup) reinforcement governs. 
 

   Required Demand 
Span Start End Xu Vu Comb/Patt Av/s Av/s  

 ft ft ft kip  in2/in in2/in  
1 0.750 4.941 2.117 42.36 U2/Odd  0.0232 0.0232  
 4.941 7.764 4.941 28.80 U2/Odd  0.0077 0.0100  *8 
 7.764 10.588 7.764 15.24 U2/Odd  0.0000 0.0100  *8 
 10.588 13.412 13.412 15.70 U2/S2 0.0000 0.0100  *8 
 13.412 16.236 16.236 29.27 U2/S2 0.0082 0.0100  *8 
 16.236 19.059 19.059 42.83 U2/S2 0.0238 0.0238  
 19.059 23.250 21.883 56.39 U2/S2 0.0393 0.0393  
         

2 0.750 5.226 2.117 55.52 U2/S2 0.0383 0.0383  
 5.226 8.336 5.226 40.59 U2/S2 0.0212 0.0212  
 8.336 11.445 8.336 25.66 U2/S2 0.0041 0.0100  *8 
 11.445 14.555 11.445 10.72 U2/S2 0.0000 0.0000  
 14.555 17.664 17.664 25.29 U2/S3 0.0037 0.0100  *8 
 17.664 20.774 20.774 40.23 U2/S3 0.0208 0.0208  
 20.774 25.250 23.883 55.16 U2/S3 0.0379 0.0379  
         

3 0.750 5.226 2.117 55.45 U2/S3 0.0382 0.0382  
 5.226 8.336 5.226 40.51 U2/S3 0.0211 0.0211  
 8.336 11.445 8.336 25.58 U2/S3 0.0040 0.0100  *8 
 11.445 14.555 11.445 10.64 U2/S3 0.0000 0.0000  
 14.555 17.664 17.664 25.58 U2/S4 0.0040 0.0100  *8 
 17.664 20.774 20.774 40.51 U2/S4 0.0211 0.0211  
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   Required Demand 
Span Start End Xu Vu Comb/Patt Av/s Av/s  

 ft ft ft kip  in2/in in2/in  
 20.774 25.250 23.883 55.45 U2/S4 0.0382 0.0382  
         

4 0.750 5.226 2.117 55.16 U2/S4 0.0379 0.0379  
 5.226 8.336 5.226 40.23 U2/S4 0.0208 0.0208  
 8.336 11.445 8.336 25.29 U2/S4 0.0037 0.0100  *8 
 11.445 14.555 14.555 10.72 U2/S5 0.0000 0.0000  
 14.555 17.664 17.664 25.66 U2/S5 0.0041 0.0100  *8 
 17.664 20.774 20.774 40.59 U2/S5 0.0212 0.0212  
 20.774 25.250 23.883 55.52 U2/S5 0.0383 0.0383  
         

5 0.750 4.941 2.117 56.39 U2/S5 0.0393 0.0393  
 4.941 7.764 4.941 42.83 U2/S5 0.0238 0.0238  
 7.764 10.588 7.764 29.27 U2/S5 0.0082 0.0100  *8 
 10.588 13.412 10.588 15.70 U2/S5 0.0000 0.0100  *8 
 13.412 16.236 16.236 15.24 U2/Odd  0.0000 0.0100  *8 
 16.236 19.059 19.059 28.80 U2/Odd  0.0077 0.0100  *8 
 19.059 23.250 21.883 42.36 U2/Odd  0.0232 0.0232  

 
 

2.8.3. Beam Transverse Reinforcement Details  
 

Span Size Stirrups (2 legs each unless otherwise noted) 
1 #3  7 @ 7.7 + 14 @ 9.7 + 4 @ 8.5 + 10 @ 5.3  
2 #3  10 @ 5.7 + 8 @ 9.3 + <-- 37.3 --> + 8 @ 9.3 + 10 @ 5.7  
3 #3  10 @ 5.7 + 8 @ 9.3 + <-- 37.3 --> + 8 @ 9.3 + 10 @ 5.7  
4 #3  10 @ 5.7 + 8 @ 9.3 + <-- 37.3 --> + 8 @ 9.3 + 10 @ 5.7  
5 #3  10 @ 5.3 + 4 @ 8.5 + 14 @ 9.7 + 7 @ 7.7  

 
 

2.8.4. Beam Transverse Reinforcement Capacity  
 

Notes: 
*8 - Minimum transverse (stirrup) reinforcement governs. 
 

 Required Provided 
Span Start End Xu Vu Comb/Patt Av/s Av Sp Av/s ΦVn  

 ft ft ft kip  in2/in in2 in in2/in kip  
1 0.000 0.750 2.117 42.36 U2/Odd ----- ----- ----- ----- -----  
 0.750 4.941 2.117 42.36 U2/Odd 0.0232 0.22 7.7 0.0284 46.92  
 4.941 16.236 16.236 29.27 U2/S2 0.0082 0.22 9.7 0.0227 41.93  *8 
 16.236 19.059 19.059 42.83 U2/S2 0.0238 0.22 8.5 0.0260 44.77  
 19.059 23.250 21.883 56.39 U2/S2 0.0393 0.22 5.3 0.0416 58.38  
 23.250 24.000 21.883 56.39 U2/S2 ----- ----- ----- ----- -----  
            

2 0.000 0.750 2.117 55.52 U2/S2 ----- ----- ----- ----- -----  
 0.750 5.226 2.117 55.52 U2/S2 0.0383 0.22 5.7 0.0389 56.06  
 5.226 11.445 5.226 40.59 U2/S2 0.0212 0.22 9.3 0.0236 42.68  
 11.445 14.555 11.445 10.72 U2/S2 0.0000 ----- ----- ----- 11.04  
 14.555 20.774 20.774 40.23 U2/S3 0.0208 0.22 9.3 0.0236 42.68  
 20.774 25.250 23.883 55.16 U2/S3 0.0379 0.22 5.7 0.0389 56.06  
 25.250 26.000 23.883 55.16 U2/S3 ----- ----- ----- ----- -----  
            

3 0.000 0.750 2.117 55.45 U2/S3 ----- ----- ----- ----- -----  
 0.750 5.226 2.117 55.45 U2/S3 0.0382 0.22 5.7 0.0389 56.06  
 5.226 11.445 5.226 40.51 U2/S3 0.0211 0.22 9.3 0.0236 42.68  
 11.445 14.555 11.445 10.64 U2/S3 0.0000 ----- ----- ----- 11.04  
 14.555 20.774 20.774 40.51 U2/S4 0.0211 0.22 9.3 0.0236 42.68  
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 Required Provided 
Span Start End Xu Vu Comb/Patt Av/s Av Sp Av/s ΦVn  

 ft ft ft kip  in2/in in2 in in2/in kip  
 20.774 25.250 23.883 55.45 U2/S4 0.0382 0.22 5.7 0.0389 56.06  
 25.250 26.000 23.883 55.45 U2/S4 ----- ----- ----- ----- -----  
            

4 0.000 0.750 2.117 55.16 U2/S4 ----- ----- ----- ----- -----  
 0.750 5.226 2.117 55.16 U2/S4 0.0379 0.22 5.7 0.0389 56.06  
 5.226 11.445 5.226 40.23 U2/S4 0.0208 0.22 9.3 0.0236 42.68  
 11.445 14.555 14.555 10.72 U2/S5 0.0000 ----- ----- ----- 11.04  
 14.555 20.774 20.774 40.59 U2/S5 0.0212 0.22 9.3 0.0236 42.68  
 20.774 25.250 23.883 55.52 U2/S5 0.0383 0.22 5.7 0.0389 56.06  
 25.250 26.000 23.883 55.52 U2/S5 ----- ----- ----- ----- -----  
            

5 0.000 0.750 2.117 56.39 U2/S5 ----- ----- ----- ----- -----  
 0.750 4.941 2.117 56.39 U2/S5 0.0393 0.22 5.3 0.0416 58.38  
 4.941 7.764 4.941 42.83 U2/S5 0.0238 0.22 8.5 0.0260 44.77  
 7.764 19.059 7.764 29.27 U2/S5 0.0082 0.22 9.7 0.0227 41.93  *8 
 19.059 23.250 21.883 42.36 U2/Odd 0.0232 0.22 7.7 0.0284 46.92  
 23.250 24.000 21.883 42.36 U2/Odd ----- ----- ----- ----- -----  

 
 

2.9. Slab Shear Capacity  
 

Span b d Vratio ΦVc Vu Xu  
 in in  kip kip ft  

1 --- Not checked --- 
2 --- Not checked --- 
3 --- Not checked --- 
4 --- Not checked --- 
5 --- Not checked --- 

 
 

2.10. Material TakeOff  
 
 

2.10.1. Reinforcement in the Direction of Analysis  
 

Top Bars 850.9 lb <=> 6.75 lb/ft <=> 6.753 lb/ft2 
Bottom Bars 877.4 lb <=> 6.96 lb/ft <=> 6.964 lb/ft2 
Stirrups 312.3 lb <=> 2.48 lb/ft <=> 2.479 lb/ft2 
Total Steel 2040.6 lb <=> 16.20 lb/ft <=> 16.195 lb/ft2 
Concrete 178.5 ft3 <=> 1.42 ft3/ft <=> 1.417 ft3/ft2 

 
 



EXAMPLES

|   295   |



EXAMPLES

|   296   |



EXAMPLES

|   297   |



EXAMPLES

|   298   |



EXAMPLES

|   299   |



EXAMPLES

|   300   |



EXAMPLES

|   301   |

6.4 Example 4 Flat Plate Floor System

6.4.1 Problem Formulation

An office building is planned using a flat plate floor system with the column layout as shown in 
figure below. No beams, drop panels, or column capitals are permitted. Specified live load is 100 
psf and dead load will include the weight of the slab plus an allowance of 20 psf for finish floor 
plus suspended loads. The columns will be 18 in. square, and the floor-to-floor height of the 
structure will be 12 ft. The slab thickness will be 8.5 in. according to ACI Code. Design the 
interior panel C, using material strengths fy = 60,000 psi and f’c = 4000 psi. Straight-bar 
reinforcement will be used. This example refers to Example 13-3 from Design of Concrete 
Structures by Nilson, Darwin, and Dolan, Thirteenth Edition, 2004. 
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6.4.2 Preparing Input
1. From the Input menu, select General Information. A dialog box appears. 

– In the LABELS section, input the names of the project, frame, and engineer. 
– In the FRAME section, input 4 for NO OF SUPPORTS. Then, Click the check boxes next 

to LEFT CANTILEVER and RIGHT CANTILEVER.
– In the FLOOR SYSTEM section, click the radial button next to TWO-WAY. 
– Leave all other options in the General Information tab to their default settings of ACI 

318-14 design code, ASTM A615 reinforcement, and DESIGN run mode option. 

6.4.3 Assigning Properties
2. Nothing needs to be changed in the Material Properties menu. 
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3. From the Input menu, select Spans. A dialog box appears.
– Under the Slabs/Flanges tab, for Span No. 1 input 0.75 for LENGTH, 8.5 for 

THICKNESS, and 11 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY. 
– Press COPY. Click the check box next to SPAN NO. 5. Press OK.
– Under the Slabs/Flanges tab, for Span No. 2 input 22 for LENGTH, 8.5 for THICK-

NESS, and 11 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY. 
– Click the check boxes next to SPAN NO. 3, and SPAN NO. 4. Press OK.
– Press OK again.
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4. From the Input menu, select Supports. A dialog box appears.
– Under the Columns tab, input 12 for the HEIGHT in both the ABOVE and BELOW rows.
– Input 18 for both the C1 and C2 values in both the ABOVE and BELOW rows. Press 

MODIFY. 
– Press COPY. Press the CHECK ALL button. Press OK. 
– Press OK again.

5. From the Input menu, select Reinforcement Criteria. 
– Use the drop down arrow next to MAX BAR SIZE for both TOP BARS and BOTTOM 

BARS to select #6 bars. 
– Press OK. 
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6. From the Input menu, select Load Cases. A dialog box appears.
– Since we are not considering snow loads, click on SNOW in the LABEL column on the 

list in the bottom half of the LOAD CASES dialog box and press the DELETE button.
– Since we are not considering lateral forces, click on WIND in the LABEL column on the 

list in the bottom half of the LOAD CASES dialog box and press the DELETE button.
– Click on EQ in the LABEL column and press the DELETE button. Press OK.
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7. From the Input menu, select Load Combinations. A dialog box appears. 
– Delete all the load combinations by clicking anywhere on the list in the bottom half of 

the LOAD COMBINATIONS dialog box and pressing the DELETE button. Repeat this pro-
cedure until all the load combinations are deleted. 

– Input 1.2 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE field. Press 
ADD.

– Press OK.

8. From the Input menu, select Span Loads. A dialog box appears.
– Input 20 for the MAGNITUDE. Press ADD. 
– Press COPY. Press the CHECK ALL button. Press OK.
– In the top left corner of the SPAN LOADS dialog box, there is a section called CURRENT 

CASE. Click on LIVE.
– Input 100 for MAGNITUDE. Press ADD.
– Press COPY. Press the CHECK ALL button. Press OK.
– Press OK again.
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6.4.4 Solving
9. From the Solve menu, select Execute. Press CLOSE.
10. From the Solve menu, select Results.

– Use the explorer to browse through result tables. 
– Use the ARROW keys or the mouse wheel to browse through different parts of the 

table quickly. Press the CLOSE button to close the SPRESULTS.
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6.4.5 Viewing and Printing Results
11. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear Capacity,

Deflection, or Reinforcement from the View menu. Right click in any of these diagrams 
to get new copy, printing, or display options. 

12. You may print the results report by using the spReporter module. To print any of the 
diagrams you selected to view, use the Print Preview command found by right clicking in 
the diagram’s window. After viewing the results, you may decide to investigate the input 
beams under the same loads but with a modified reinforcement configuration. 

13. From the Input menu, select General Information. In the General Information dialog 
box change the RUN MODE option to INVESTIGATION. Do not change any of the other 
options. Press OK

14. From the Input menu, select the different commands under Reinforcement Criteria and 
Reinforcing Bars to modify the reinforcement configuration computed by the program.

15. Repeat steps 10 and subsequent to perform the investigation and view the results.
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1. Input Echo  
 
 

1.1. General Information  
 

File Name ...\Example 4 - Design of Concrete 
Structures ... 

Project spSlab/spBeam Manual, Example 4 
Frame Design of Concrete Structures by Nilson-

Example 13.3 
Engineer StructurePoint 
Code ACI 318-14 
Reinforcement 
Database 

ASTM A615 

Mode Design 
Number of supports =  4 + Left cantilever + Right cantilever 
Floor System Two-Way 

 
 

1.2. Solve Options  
 

Live load pattern ratio = 75% 
Minimum free edge distance for punching shear = 4 times slab thickness. 
Circular critical section around circular supports used (if possible). 
Deflections are based on cracked section properties. 
In negative moment regions, Ig and Mcr DO NOT include flange/slab contribution (if available) 
Long-term deflections are calculated for load duration of 60 months. 
0% of live load is sustained. 
Only deflections for direction of analysis will be calculated. 
Compression reinforcement calculations NOT selected. 
Default incremental rebar design selected. 
User-defined slab strip widths NOT selected. 
User-defined distribution factors NOT selected. 
One-way shear in drop panel NOT selected. 
Distribution of shear to strips NOT selected. 
Beam T-section design NOT selected. 
Longitudinal beam contribution in negative reinforcement design over support NOT selected. 
Transverse beam contribution in negative reinforcement design over support NOT selected. 

 
 

1.3. Material Properties  
 
 

1.3.1. Concrete: Slabs / Beams  
 

wc 150 lb/ft3 
f'c 4 ksi 
Ec 3834.3 ksi 
fr 0.474342 ksi 

 
 

1.3.2. Concrete: Columns  
 

wc 150 lb/ft3 
f'c 4 ksi 
Ec 3834.3 ksi 
fr 0.47434 ksi 
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1.3.3. Reinforcing Steel  
 

fy 60 ksi 
fyt 60 ksi 
Es 29000 ksi 
Epoxy coated bars No  

 
 

1.4. Reinforcement Database  
 

Size Db Ab Wb Size Db Ab Wb 
 in in2 lb/ft  in in2 lb/ft 

#3 0.38 0.11 0.38 #4 0.50 0.20 0.67 
#5 0.63 0.31 1.04 #6 0.75 0.44 1.50 
#7 0.88 0.60 2.04 #8 1.00 0.79 2.67 
#9 1.13 1.00 3.40 #10 1.27 1.27 4.30 

#11 1.41 1.56 5.31 #14 1.69 2.25 7.65 
#18 2.26 4.00 13.60     

 
 

1.5. Span Data  
 
 

1.5.1. Slabs  
 

Notes: 
Deflection check required for panels where code-specified Hmin for two-way construction doesn't apply due to: 
*i - cantilever end span (LC, RC) support condition 
 

Span Loc L1 t wL wR L2L L2R Hmin  
  ft in ft ft ft ft in  

1 Int 0.750 8.50 11.000 11.000 22.000 22.000 --- LC *i 
2 Int 22.000 8.50 11.000 11.000 22.000 22.000 8.20  
3 Int 22.000 8.50 11.000 11.000 22.000 22.000 7.45  
4 Int 22.000 8.50 11.000 11.000 22.000 22.000 8.20  
5 Int 0.750 8.50 11.000 11.000 22.000 22.000 --- RC *i 

 
 

1.6. Support Data  
 
 

1.6.1. Columns  
 

Support c1a c2a Ha c1b c2b Hb Red %  
 in in ft in in ft   

1 18.00 18.00 12.000 18.00 18.00 12.000 100  
2 18.00 18.00 12.000 18.00 18.00 12.000 100  
3 18.00 18.00 12.000 18.00 18.00 12.000 100  
4 18.00 18.00 12.000 18.00 18.00 12.000 100  

 
 

1.6.2. Boundary Conditions  
 

Support Spring Far End 
 Kz Kry Above Below 
 kip/in kip-in/rad   

1 0 0 Fixed Fixed 
2 0 0 Fixed Fixed 
3 0 0 Fixed Fixed 
4 0 0 Fixed Fixed 
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1.7. Load Data  
 
 

1.7.1. Load Cases and Combinations  
 

Case SELF Dead Live 
Type DEAD DEAD LIVE 

U1 1.400 1.400 0.000 
U2 1.200 1.200 1.600 

 
 

1.7.2. Area Loads  
 

Case/Patt Span Wa 
  lb/ft2 

SELF 1 106.25 
 2 106.25 
 3 106.25 
 4 106.25 
 5 106.25 

Dead 2 20.00 
 3 20.00 
 4 20.00 
 1 20.00 
 5 20.00 

Live 2 100.00 
 3 100.00 
 4 100.00 
 1 100.00 
 5 100.00 

Live/Odd  3 75.00 
 1 75.00 
 5 75.00 

Live/Even 2 75.00 
 4 75.00 

Live/S1  2 75.00 
 1 75.00 

Live/S2  2 75.00 
 3 75.00 

Live/S3  3 75.00 
 4 75.00 

Live/S4  4 75.00 
 5 75.00 

 
 

1.8. Reinforcement Criteria  
 
 

1.8.1. Slabs and Ribs  
 

 Units Top Bars Bottom Bars 
  Min. Max. Min. Max. 
Bar Size  #5 #6 #5 #6 
Bar spacing in 1.00 18.00 1.00 18.00 
Reinf ratio % 0.14 5.00 0.14 5.00 
Clear Cover in 1.50  1.50  

There is NOT more than 12 in of concrete below top bars. 
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1.8.2. Beams  
 

 Units Top Bars Bottom Bars Stirrups 
  Min. Max. Min. Max. Min. Max. 
Bar Size  #5 #8 #5 #8 #3 #5 
Bar spacing in 1.00 18.00 1.00 18.00 6.00 18.00 
Reinf ratio % 0.14 5.00 0.14 5.00   
Clear Cover in 1.50  1.50    
Layer dist. in 1.00  1.00    
No. of legs      2 6 
Side cover in     1.50  
1st Stirrup in     3.00  

There is NOT more than 12 in of concrete below top bars. 
 
 
 

2. Design Results*  
 

*Unless otherwise noted, all results are in the direction of analysis only. Another analysis in the perpendicular direction has to be carried out 
for two-way slab systems. 
 
 

2.1. Strip Widths and Distribution Factors  
 

Notes: 
*Used for bottom reinforcement. **Used for top reinforcement. 
 

 Width Moment Factor 
Span Strip Left ** Right ** Bottom * Left ** Right ** Bottom * 

  ft ft ft ft ft ft 
1 Column 11.00 11.00 11.00 1.000 1.000 0.600 
 Middle 11.00 11.00 11.00 0.000 0.000 0.400 
        

2 Column 11.00 11.00 11.00 1.000 0.750 0.600 
 Middle 11.00 11.00 11.00 0.000 0.250 0.400 
        

3 Column 11.00 11.00 11.00 0.750 0.750 0.600 
 Middle 11.00 11.00 11.00 0.250 0.250 0.400 
        

4 Column 11.00 11.00 11.00 0.750 1.000 0.600 
 Middle 11.00 11.00 11.00 0.250 0.000 0.400 
        

5 Column 11.00 11.00 11.00 1.000 1.000 0.600 
 Middle 11.00 11.00 11.00 0.000 0.000 0.400 

 
 

2.2. Top Reinforcement  
 

Notes: 
*3 - Design governed by minimum reinforcement. 
*5 - Number of bars governed by maximum allowable spacing. 
 

Span Strip Zone Width Mmax Xmax As,min As,max As,req SpProv Bars  
   ft k-ft ft in2 in2 in2 in   

1 Column Left 11.00 0.19 0.217 2.020 15.945 0.006 16.500 8-#5  *3 *5 
  Midspan 11.00 0.61 0.402 2.020 15.945 0.020 16.500 8-#5  *3 *5 
  Right 11.00 1.37 0.619 2.020 15.945 0.045 14.667 9-#5  *3 *5 
            
 Middle Left 11.00 0.00 0.000 2.020 15.945 0.000 16.500 8-#5  *3 *5 
  Midspan 11.00 0.00 0.309 2.020 15.945 0.000 16.500 8-#5  *3 *5 
  Right 11.00 0.00 0.619 2.020 15.945 0.000 16.500 8-#5  *3 *5 
            

2 Column Left 11.00 81.23 0.750 2.020 15.945 2.776 14.667 9-#5  
  Midspan 11.00 0.00 11.000 0.000 15.945 0.000 0.000 ---  
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Span Strip Zone Width Mmax Xmax As,min As,max As,req SpProv Bars  
   ft k-ft ft in2 in2 in2 in   
  Right 11.00 198.56 21.250 2.020 15.945 7.102 5.739 23-#5  
            
 Middle Left 11.00 0.36 1.500 2.020 15.945 0.012 16.500 8-#5  *3 *5 
  Midspan 11.00 0.00 11.000 0.000 15.945 0.000 0.000 ---  
  Right 11.00 66.19 21.250 2.020 15.945 2.250 16.500 8-#5  
            

3 Column Left 11.00 182.11 0.750 2.020 15.945 6.470 5.739 23-#5  
  Midspan 11.00 0.00 11.000 0.000 15.945 0.000 0.000 ---  
  Right 11.00 182.11 21.250 2.020 15.945 6.470 5.739 23-#5  
            
 Middle Left 11.00 60.70 0.750 2.020 15.945 2.060 16.500 8-#5  *5 
  Midspan 11.00 0.00 11.000 0.000 15.945 0.000 0.000 ---  
  Right 11.00 60.70 21.250 2.020 15.945 2.060 16.500 8-#5  *5 
            

4 Column Left 11.00 198.56 0.750 2.020 15.945 7.102 5.739 23-#5  
  Midspan 11.00 0.00 11.000 0.000 15.945 0.000 0.000 ---  
  Right 11.00 81.23 21.250 2.020 15.945 2.776 14.667 9-#5  
            
 Middle Left 11.00 66.19 0.750 2.020 15.945 2.250 16.500 8-#5  
  Midspan 11.00 0.00 11.000 0.000 15.945 0.000 0.000 ---  
  Right 11.00 0.36 20.500 2.020 15.945 0.012 16.500 8-#5  *3 *5 
            

5 Column Left 11.00 1.37 0.131 2.020 15.945 0.045 14.667 9-#5  *3 *5 
  Midspan 11.00 0.61 0.348 2.020 15.945 0.020 16.500 8-#5  *3 *5 
  Right 11.00 0.19 0.533 2.020 15.945 0.006 16.500 8-#5  *3 *5 
            
 Middle Left 11.00 0.00 0.131 2.020 15.945 0.000 16.500 8-#5  *3 *5 
  Midspan 11.00 0.00 0.441 2.020 15.945 0.000 16.500 8-#5  *3 *5 
  Right 11.00 0.00 0.750 2.020 15.945 0.000 16.500 8-#5  *3 *5 

 
 

2.3. Top Bar Details  
 

  Left Continuous Right 
Span Strip Bars  Length Bars  Length Bars  Length Bars  Length Bars  Length 

    ft   ft   ft   ft   ft 
1 Column ---   ---   8-#5  0.75 1-#5  0.75 ---   
 Middle ---   ---   8-#5  0.75 ---   ---   
                 

2 Column 7-#5  7.52 2-#5  4.85 ---   12-#5  7.53 11-#5  4.85 
 Middle 8-#5  5.26 ---   ---   8-#5  7.53 ---   
                 

3 Column 12-#5  8.53 11-#5  4.85 ---   12-#5  8.53 11-#5  4.85 
 Middle 8-#5  8.53 ---   ---   8-#5  8.53 ---   
                 

4 Column 12-#5  7.53 11-#5  4.85 ---   7-#5  7.52 2-#5  4.85 
 Middle 8-#5  7.53 ---   ---   8-#5  5.26 ---   
                 

5 Column 1-#5  0.75 ---   8-#5  0.75 ---   ---   
 Middle ---   ---   8-#5  0.75 ---   ---   
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2.4. Top Bar Development Lengths  
 

  Left Continuous Right 
Span Strip Bars  DevLen Bars  DevLen Bars  DevLen Bars  DevLen Bars  DevLen 

    in   in   in   in   in 
1 Column ---   ---   8-#5  12.00 1-#5  12.00 ---   
 Middle ---   ---   8-#5  12.00 ---   ---   
                 

2 Column 7-#5  14.16 2-#5  14.16 ---   12-#5  14.18 11-#5  14.18 
 Middle 8-#5  12.00 ---   ---   8-#5  12.91 ---   
                 

3 Column 12-#5  12.91 11-#5  12.91 ---   12-#5  12.91 11-#5  12.91 
 Middle 8-#5  12.00 ---   ---   8-#5  12.00 ---   
                 

4 Column 12-#5  14.18 11-#5  14.18 ---   7-#5  14.16 2-#5  14.16 
 Middle 8-#5  12.91 ---   ---   8-#5  12.00 ---   
                 

5 Column 1-#5  12.00 ---   8-#5  12.00 ---   ---   
 Middle ---   ---   8-#5  12.00 ---   ---   

 
 

2.5. Bottom Reinforcement  
 

Notes: 
*3 - Design governed by minimum reinforcement. 
*5 - Number of bars governed by maximum allowable spacing. 
 

Span Strip Width Mmax Xmax As,min As,max As,req SpProv Bars  
  ft k-ft ft in2 in2 in2 in   

1 Column 11.00 0.00 0.309 0.000 15.945 0.000 0.000 ---  
 Middle 11.00 0.00 0.309 0.000 15.945 0.000 0.000 ---  
           

2 Column 11.00 115.71 9.750 2.020 15.945 4.005 10.154 13-#5  
 Middle 11.00 77.14 9.750 2.020 15.945 2.633 14.667 9-#5  
           

3 Column 11.00 80.78 11.000 2.020 15.945 2.761 14.667 9-#5  
 Middle 11.00 53.86 11.000 2.020 15.945 1.823 16.500 8-#5  *3 *5 
           

4 Column 11.00 115.71 12.250 2.020 15.945 4.005 10.154 13-#5  
 Middle 11.00 77.14 12.250 2.020 15.945 2.633 14.667 9-#5  
           

5 Column 11.00 0.00 0.441 0.000 15.945 0.000 0.000 ---  
 Middle 11.00 0.00 0.441 0.000 15.945 0.000 0.000 ---  

 
 

2.6. Bottom Bar Details  
 

  Long Bars Short Bars 
Span Strip Bars  Start Length Bars  Start Length 

    ft ft   ft ft 
1 Column ---    ---    
 Middle ---    ---    
          

2 Column 13-#5  0.00 22.00 ---    
 Middle 7-#5  0.00 22.00 2-#5  0.00 18.70 
          

3 Column 9-#5  0.00 22.00 ---    
 Middle 7-#5  0.00 22.00 1-#5  3.30 15.40 
          

4 Column 13-#5  0.00 22.00 ---    
 Middle 7-#5  0.00 22.00 2-#5  3.30 18.70 
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  Long Bars Short Bars 
Span Strip Bars  Start Length Bars  Start Length 

    ft ft   ft ft 
          

5 Column ---    ---    
 Middle ---    ---    

 
 

2.7. Bottom Bar Development Lengths  
 

  Long Bars Short Bars 
Span Strip Bars  DevLen Bars  DevLen 

    in   in 
1 Column ---   ---   
 Middle ---   ---   
        

2 Column 13-#5  14.14 ---   
 Middle 7-#5  13.43 2-#5  13.43 
        

3 Column 9-#5  14.08 ---   
 Middle 7-#5  12.00 1-#5  12.00 
        

4 Column 13-#5  14.14 ---   
 Middle 7-#5  13.43 2-#5  13.43 
        

5 Column ---   ---   
 Middle ---   ---   

 
 

2.8. Flexural Capacity  
 

  Top Bottom 
Span Strip x As,top ΦMn- Mu- Comb Pat Status As,bot ΦMn+ Mu+ Comb Pat Status 

  ft in2 k-ft k-ft    in2 k-ft k-ft    
1 Column 0.000 2.79 -81.62 0.00 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.217 2.79 -81.62 -0.19 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.375 2.79 -81.62 -0.54 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.402 2.79 -81.62 -0.61 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.619 2.79 -81.62 -1.37 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.750 2.79 -81.62 -1.93 U2 All  --- 0.00 0.00 0.00 U1 All  --- 
 Middle 0.000 2.48 -72.78 0.00 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.217 2.48 -72.78 0.00 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.375 2.48 -72.78 0.00 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.402 2.48 -72.78 0.00 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.619 2.48 -72.78 0.00 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.750 2.48 -72.78 0.00 U2 All  --- 0.00 0.00 0.00 U1 All  --- 
               

2 Column 0.000 2.79 -81.62 -130.31 U2 All  --- 4.03 116.39 0.00 U1 All  --- 
  0.500 2.79 -81.62 -97.06 U2 All  --- 4.03 116.39 0.00 U1 All  --- 
  0.750 2.79 -81.62 -81.23 U2 All  OK 4.03 116.39 0.00 U1 All  OK 
  3.670 2.79 -81.62 0.00 U1 All  OK 4.03 116.39 41.09 U2 All  OK 
  4.850 2.17 -63.89 0.00 U1 All  OK 4.03 116.39 67.45 U2 All  OK 
  6.335 2.17 -63.89 0.00 U1 All  OK 4.03 116.39 92.49 U2 All  OK 
  7.515 0.00 0.00 0.00 U1 All  OK 4.03 116.39 105.95 U2 All  OK 
  7.925 0.00 0.00 0.00 U1 All  OK 4.03 116.39 109.25 U2 All  OK 
  9.750 0.00 0.00 0.00 U1 All  OK 4.03 116.39 115.71 U2 All  OK 
  11.000 0.00 0.00 0.00 U1 All  OK 4.03 116.39 112.20 U2 All  OK 
  14.075 0.00 0.00 0.00 U1 All  OK 4.03 116.39 80.81 U2 Even OK 
  14.469 0.00 0.00 0.00 U1 All  OK 4.03 116.39 74.95 U2 Even OK 
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  Top Bottom 
Span Strip x As,top ΦMn- Mu- Comb Pat Status As,bot ΦMn+ Mu+ Comb Pat Status 

  ft in2 k-ft k-ft    in2 k-ft k-ft    
  15.650 3.72 -107.79 0.00 U1 All  OK 4.03 116.39 53.96 U2 Even OK 
  17.150 3.72 -107.79 -24.34 U2 Odd  OK 4.03 116.39 20.13 U2 Even OK 
  18.331 7.13 -199.28 -51.08 U2 Odd  OK 4.03 116.39 0.00 U1 All  OK 
  21.250 7.13 -199.28 -198.56 U2 All  OK 4.03 116.39 0.00 U1 All  OK 
  21.500 7.13 -199.28 -212.70 U2 All  --- 4.03 116.39 0.00 U1 All  --- 
  22.000 7.13 -199.28 -241.57 U2 All  --- 4.03 116.39 0.00 U1 All  --- 
 Middle 0.000 2.48 -72.78 1.18 U2 All  --- 2.79 81.62 0.00 U1 All  --- 
  0.750 2.48 -72.78 0.00 U2 All  OK 2.79 81.62 0.00 U1 All  OK 
  1.500 2.48 -72.78 -0.36 U2 Even OK 2.79 81.62 0.00 U1 All  OK 
  4.260 2.48 -72.78 0.00 U1 All  OK 2.79 81.62 36.67 U2 All  OK 
  5.260 0.00 0.00 0.00 U1 All  OK 2.79 81.62 50.20 U2 All  OK 
  7.925 0.00 0.00 0.00 U1 All  OK 2.79 81.62 72.84 U2 All  OK 
  9.750 0.00 0.00 0.00 U1 All  OK 2.79 81.62 77.14 U2 All  OK 
  11.000 0.00 0.00 0.00 U1 All  OK 2.79 81.62 74.80 U2 All  OK 
  14.075 0.00 0.00 0.00 U1 All  OK 2.79 81.62 53.88 U2 Even OK 
  14.469 0.00 0.00 0.00 U1 All  OK 2.79 81.62 49.96 U2 Even OK 
  15.545 2.48 -72.78 0.00 U1 All  OK 2.79 81.62 37.37 U2 Even OK 
  17.581 2.48 -72.78 -8.73 U2 Odd  OK 2.79 81.62 5.94 U2 Even OK 
  18.700 2.48 -72.78 -18.63 U2 All  OK 2.17 63.89 0.00 U1 All  OK 
  21.250 2.48 -72.78 -66.19 U2 All  OK 2.17 63.89 0.00 U1 All  OK 
  21.750 2.48 -72.78 -78.16 U2 All  --- 2.17 63.89 0.00 U1 All  --- 
  22.000 2.48 -72.78 -84.50 U2 All  --- 2.17 63.89 0.00 U1 All  --- 
               

3 Column 0.000 7.13 -199.28 -223.07 U2 All  --- 2.79 81.62 0.00 U1 All  --- 
  0.250 7.13 -199.28 -209.10 U2 All  --- 2.79 81.62 0.00 U1 All  --- 
  0.750 7.13 -199.28 -182.11 U2 All  OK 2.79 81.62 0.00 U1 All  OK 
  3.774 7.13 -199.28 -51.16 U2 S1 OK 2.79 81.62 0.00 U1 All  OK 
  4.850 3.72 -107.79 -30.73 U2 S1 OK 2.79 81.62 14.42 U2 S3 OK 
  7.455 3.72 -107.79 0.00 U1 All  OK 2.79 81.62 58.25 U2 Odd  OK 
  7.925 2.10 -61.75 0.00 U1 All  OK 2.79 81.62 63.82 U2 Odd  OK 
  8.531 0.00 0.00 0.00 U1 All  OK 2.79 81.62 69.85 U2 Odd  OK 
  11.000 0.00 0.00 0.00 U1 All  OK 2.79 81.62 80.78 U2 Odd  OK 
  13.469 0.00 0.00 0.00 U1 All  OK 2.79 81.62 69.85 U2 Odd  OK 
  14.075 2.10 -61.75 0.00 U1 All  OK 2.79 81.62 63.82 U2 Odd  OK 
  14.545 3.72 -107.79 0.00 U1 All  OK 2.79 81.62 58.25 U2 Odd  OK 
  17.150 3.72 -107.79 -30.73 U2 S4 OK 2.79 81.62 14.42 U2 S2 OK 
  18.226 7.13 -199.28 -51.16 U2 S4 OK 2.79 81.62 0.00 U1 All  OK 
  21.250 7.13 -199.28 -182.11 U2 All  OK 2.79 81.62 0.00 U1 All  OK 
  21.750 7.13 -199.28 -209.10 U2 All  --- 2.79 81.62 0.00 U1 All  --- 
  22.000 7.13 -199.28 -223.07 U2 All  --- 2.79 81.62 0.00 U1 All  --- 
 Middle 0.000 2.48 -72.78 -74.36 U2 All  --- 2.17 63.89 0.00 U1 All  --- 
  0.750 2.48 -72.78 -60.70 U2 All  OK 2.17 63.89 0.00 U1 All  OK 
  3.300 2.48 -72.78 -21.50 U2 All  OK 2.17 63.89 0.00 U1 All  OK 
  4.300 2.48 -72.78 -13.60 U2 S1 OK 2.48 72.78 1.85 U2 S3 OK 
  7.531 2.48 -72.78 0.00 U1 All  OK 2.48 72.78 39.47 U2 Odd  OK 
  7.925 1.50 -44.57 0.00 U1 All  OK 2.48 72.78 42.54 U2 Odd  OK 
  8.531 0.00 0.00 0.00 U1 All  OK 2.48 72.78 46.57 U2 Odd  OK 
  11.000 0.00 0.00 0.00 U1 All  OK 2.48 72.78 53.86 U2 Odd  OK 
  13.469 0.00 0.00 0.00 U1 All  OK 2.48 72.78 46.57 U2 Odd  OK 
  14.075 1.50 -44.57 0.00 U1 All  OK 2.48 72.78 42.54 U2 Odd  OK 
  14.469 2.48 -72.78 0.00 U1 All  OK 2.48 72.78 39.47 U2 Odd  OK 
  17.700 2.48 -72.78 -13.60 U2 S4 OK 2.48 72.78 1.85 U2 S2 OK 
  18.700 2.48 -72.78 -21.50 U2 All  OK 2.17 63.89 0.00 U1 All  OK 
  21.250 2.48 -72.78 -60.70 U2 All  OK 2.17 63.89 0.00 U1 All  OK 
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  Top Bottom 
Span Strip x As,top ΦMn- Mu- Comb Pat Status As,bot ΦMn+ Mu+ Comb Pat Status 

  ft in2 k-ft k-ft    in2 k-ft k-ft    
  22.000 2.48 -72.78 -74.36 U2 All  --- 2.17 63.89 0.00 U1 All  --- 
               

4 Column 0.000 7.13 -199.28 -241.57 U2 All  --- 4.03 116.39 0.00 U1 All  --- 
  0.500 7.13 -199.28 -212.70 U2 All  --- 4.03 116.39 0.00 U1 All  --- 
  0.750 7.13 -199.28 -198.56 U2 All  OK 4.03 116.39 0.00 U1 All  OK 
  3.669 7.13 -199.28 -51.08 U2 Odd  OK 4.03 116.39 0.00 U1 All  OK 
  4.850 3.72 -107.79 -24.34 U2 Odd  OK 4.03 116.39 20.13 U2 Even OK 
  6.350 3.72 -107.79 0.00 U1 All  OK 4.03 116.39 53.96 U2 Even OK 
  7.531 0.00 0.00 0.00 U1 All  OK 4.03 116.39 74.95 U2 Even OK 
  7.925 0.00 0.00 0.00 U1 All  OK 4.03 116.39 80.81 U2 Even OK 
  11.000 0.00 0.00 0.00 U1 All  OK 4.03 116.39 112.20 U2 All  OK 
  12.250 0.00 0.00 0.00 U1 All  OK 4.03 116.39 115.71 U2 All  OK 
  14.075 0.00 0.00 0.00 U1 All  OK 4.03 116.39 109.25 U2 All  OK 
  14.485 0.00 0.00 0.00 U1 All  OK 4.03 116.39 105.95 U2 All  OK 
  15.665 2.17 -63.89 0.00 U1 All  OK 4.03 116.39 92.49 U2 All  OK 
  17.150 2.17 -63.89 0.00 U1 All  OK 4.03 116.39 67.45 U2 All  OK 
  18.330 2.79 -81.62 0.00 U1 All  OK 4.03 116.39 41.09 U2 All  OK 
  21.250 2.79 -81.62 -81.23 U2 All  OK 4.03 116.39 0.00 U1 All  OK 
  21.500 2.79 -81.62 -97.06 U2 All  --- 4.03 116.39 0.00 U1 All  --- 
  22.000 2.79 -81.62 -130.31 U2 All  --- 4.03 116.39 0.00 U1 All  --- 
 Middle 0.000 2.48 -72.78 -84.50 U2 All  --- 2.17 63.89 0.00 U1 All  --- 
  0.250 2.48 -72.78 -78.16 U2 All  --- 2.17 63.89 0.00 U1 All  --- 
  0.750 2.48 -72.78 -66.19 U2 All  OK 2.17 63.89 0.00 U1 All  OK 
  3.300 2.48 -72.78 -18.63 U2 All  OK 2.17 63.89 0.00 U1 All  OK 
  4.419 2.48 -72.78 -8.73 U2 Odd  OK 2.79 81.62 5.94 U2 Even OK 
  6.455 2.48 -72.78 0.00 U1 All  OK 2.79 81.62 37.37 U2 Even OK 
  7.531 0.00 0.00 0.00 U1 All  OK 2.79 81.62 49.96 U2 Even OK 
  7.925 0.00 0.00 0.00 U1 All  OK 2.79 81.62 53.88 U2 Even OK 
  11.000 0.00 0.00 0.00 U1 All  OK 2.79 81.62 74.80 U2 All  OK 
  12.250 0.00 0.00 0.00 U1 All  OK 2.79 81.62 77.14 U2 All  OK 
  14.075 0.00 0.00 0.00 U1 All  OK 2.79 81.62 72.84 U2 All  OK 
  16.740 0.00 0.00 0.00 U1 All  OK 2.79 81.62 50.20 U2 All  OK 
  17.740 2.48 -72.78 0.00 U1 All  OK 2.79 81.62 36.67 U2 All  OK 
  20.500 2.48 -72.78 -0.36 U2 Even OK 2.79 81.62 0.00 U1 All  OK 
  21.250 2.48 -72.78 0.00 U2 All  OK 2.79 81.62 0.00 U1 All  OK 
  22.000 2.48 -72.78 1.18 U2 All  --- 2.79 81.62 0.00 U1 All  --- 
               

5 Column 0.000 2.79 -81.62 -1.93 U2 All  --- 0.00 0.00 0.00 U1 All  --- 
  0.131 2.79 -81.62 -1.37 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.348 2.79 -81.62 -0.61 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.375 2.79 -81.62 -0.54 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.533 2.79 -81.62 -0.19 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.750 2.79 -81.62 0.00 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
 Middle 0.000 2.48 -72.78 0.00 U2 All  --- 0.00 0.00 0.00 U1 All  --- 
  0.131 2.48 -72.78 0.00 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.348 2.48 -72.78 0.00 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.375 2.48 -72.78 0.00 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.533 2.48 -72.78 0.00 U2 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.750 2.48 -72.78 0.00 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
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2.9. Slab Shear Capacity  
 

Span b d Vratio ΦVc Vu Xu  
 in in  kip kip ft  

1 264.00 6.69 1.000 167.49 0.00 0.00  
2 264.00 6.69 1.000 167.49 75.38 20.69  
3 264.00 6.69 1.000 167.49 66.42 20.69  
4 264.00 6.69 1.000 167.49 75.38 1.31  
5 264.00 6.69 1.000 167.49 0.00 0.00  

 
 

2.10. Flexural Transfer of Negative Unbalanced Moment at Supports  
 

Support Width Width-c d Munb Comb Patt γf As,req As,prov Add Bars  
 in in in k-ft    in2 in2   

1 43.50 43.50 6.69 127.20 U2 All 0.617 2.857 0.919 7-#5  
2 43.50 43.50 6.69 63.54 U2 Even 0.600 1.320 2.350 ---  
3 43.50 43.50 6.69 63.54 U2 Even 0.600 1.320 2.350 ---  
4 43.50 43.50 6.69 127.20 U2 All 0.617 2.857 0.919 7-#5  

 
 

2.11. Punching Shear Around Columns  
 
 

2.11.1. Critical Section Properties  
 

Support Type b1 b2 b0 davg CG c(left) c(right) Ac Jc 
  in in in in in in in in2 in4 

1 Rect 21.34 24.69 67.38 6.69 5.58 14.58 6.76 450.57 23814 
2 Rect 24.69 24.69 98.75 6.69 0.00 12.34 12.34 660.39 68312 
3 Rect 24.69 24.69 98.75 6.69 0.00 12.34 12.34 660.39 68312 
4 Rect 21.34 24.69 67.38 6.69 -5.58 6.76 14.58 450.57 23814 

 
 

2.11.2. Punching Shear Results  
 

Support Vu vu Munb Comb Patt γv vu ΦVc  
 kip psi k-ft    psi psi  

1 70.43 156.3 94.43 U2 All 0.383 279.4 189.7 *EXCEEDED 
2 158.40 239.9 -28.64 U2 All 0.400 264.7 189.7 *EXCEEDED 
3 158.40 239.9 28.64 U2 All 0.400 264.7 189.7 *EXCEEDED 
4 70.43 156.3 -94.43 U2 All 0.383 279.4 189.7 *EXCEEDED 

 
 

2.12. Material TakeOff  
 
 

2.12.1. Reinforcement in the Direction of Analysis  
 

Top Bars 1137.0 lb <=> 16.85 lb/ft <=> 0.766 lb/ft2 
Bottom Bars 1379.1 lb <=> 20.43 lb/ft <=> 0.929 lb/ft2 
Stirrups 0.0 lb <=> 0.00 lb/ft <=> 0.000 lb/ft2 
Total Steel 2516.1 lb <=> 37.28 lb/ft <=> 1.694 lb/ft2 
Concrete 1051.9 ft3 <=> 15.58 ft3/ft <=> 0.708 ft3/ft2 
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6.5 Example 5 Two-way Slab System

6.5.1 Problem Formulation

Using the Equivalent Frame Method, determine design moments for the slab system in the 
direction shown, for an intermediate floor. This example refers to Example 20-2 from PCA Notes 
on ACI 318 Building Code Requirements for Structural Concrete.

Story height = 12 ft
Edge beam dimensions = 14  27 in.
Interior beam dimensions = 14  20 in.
Column dimensions = 18  18 in. 
Service live load = 100 psf
Dead load = self weight
fc = 4000 psi (for all members), normal weight concrete
fy = 60,000 psi
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6.5.2 Preparing Input
1. From the Input menu, select General Information. A dialog box appears. 

– In the LABELS section, input the names of the project, frame, and engineer. 
– In the FRAME section, input 4 for NO OF SUPPORTS. . Then, Click the check boxes next 

to LEFT CANTILEVER and RIGHT CANTILEVER.
– In the FLOOR SYSTEM section, click the radial button next to TWO-WAY. 
– Leave all other options in the General Information tab to their default settings of ACI 

318-1 design code, ASTM A615 reinforcement, and DESIGN run mode option. 

6.5.3 Assigning Properties
2. Nothing needs to be changed in the Material Properties menu. 
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3. From the Input menu, select Spans. A dialog box appears.
– Under the Slabs/Flanges tab, for Span No. 1 input 0.75 for LENGTH, 6 for THICK-

NESS, and 11 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY. 
– Press COPY. Click the check box next to SPAN NO. 5. Press OK.
– Under the Slabs/Flanges tab, for Span No. 2 input 17.5 for LENGTH, 6 for THICK-

NESS, and 11 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY. 
– Press COPY. Click the check boxes next to SPAN NO. 3 and SPAN NO. 4. Press OK.
– Select the Longitudinal Beams tab. Input 14 for WIDTH and 20 for DEPTH. Press 

MODIFY.
– Press COPY. Press the CHECK ALL button. Press OK.
– Press OK again.
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4. From the Input menu, select Supports. A dialog box appears.
– Under the Columns tab, input 12 for the HEIGHT in both the ABOVE and BELOW rows.
– Input 18 for both the C1 and C2 values in both the ABOVE and BELOW rows. Press 

MODIFY. 
– Press COPY. Press the CHECK ALL button. Press OK.
– Under the Transverse Beams tab, input 14 for WIDTH and 27 for DEPTH. Press MOD-

IFY.
– Press COPY. Click the check box next to SUPPORT 4. Press OK. 
– Use the drop down arrow next to SUPPORT to select SUPPORT 2. 
– Input 14 for WIDTH and 20 for DEPTH. Press MODIFY. 
– Press COPY. Click the check box next to SUPPORT 3 and unclick the check box next to 

SUPPORT 1. Press OK. 
– Press OK again.
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5. Nothing needs to be changed in the Reinforcement Criteria menu. 

6. From the Input menu, select Load Cases. A dialog box appears.
– Since the Self weight is to be entered under DEAD Load Label to match the Refer-

ence’s input, click on SELF in the LABEL column on the top of the list of the LOAD 
CASES dialog box and press the DELETE button.

– Since we are not considering snow loads, click on SNOW in the LABEL column on the 
list in the bottom half of the LOAD CASES dialog box and press the DELETE button.

– Since we are not considering lateral forces, click on WIND in the LABEL column on the 
list in the bottom half of the LOAD CASES dialog box and press the DELETE button.

– Click on EQ in the LABEL column and press the DELETE button. Press OK.
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7. From the Input menu, select Load Combinations. A dialog box appears. 
– Delete all the load combinations by clicking anywhere on the list in the bottom half of 

the LOAD COMBINATIONS dialog box and pressing the DELETE button. Repeat this pro-
cedure until all the load combinations are gone. 

– Input 1.2 in the DEAD field, and 1.6 in the LIVE field. Press ADD.
– Press OK.

8. From the Input menu, select Span Loads. A dialog box appears.
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– In the top left corner of the SPAN LOADS dialog box, there is a section called CURRENT 
CASE. Click on DEAD.

– Input 84.3 for MAGNITUDE. Press ADD.
– Press COPY. Press the CHECK ALL button. Press OK.
– Then, click on LIVE in the CURRENT CASE section.
– Input 100 for MAGNITUDE. Press ADD.
– Press COPY. Press the CHECK ALL button. Press OK.
– Press OK again.
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6.5.4 Solving
9. From the Solve menu, select Execute. Press CLOSE.
10. From the Solve menu, select Results.

– Use the explorer to browse through result tables. 
– Use the ARROW keys or the mouse wheel to browse through different parts of the 

table quickly. Press the CLOSE button to close the SPRESULTS.

6.5.5 Viewing and Printing Results
11. To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear Capacity,

Deflection, or Reinforcement from the View menu. Right click in any of these diagrams 
to get new copy, printing, or display options. 

12. You may print the results report by using the spReporter module. To print any of the 
diagrams you selected to view, use the Print Preview command found by right clicking in 
the diagram’s window. After viewing the results, you may decide to investigate the input 
beams under the same loads but with a modified reinforcement configuration. 

13. From the Input menu, select General Information. In the General Information dialog 
box change the RUN MODE option to INVESTIGATION. Do not change any of the other 
options. Press OK

14. From the Input menu, select the different commands under Reinforcement Criteria and 
Reinforcing Bars to modify the reinforcement configuration computed by the program.

15. Repeat steps 10 and subsequent to perform the investigation and view the results. 
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Licensee stated above acknowledges that STRUCTUREPOINT (SP) is not and cannot be responsible for either the accuracy or adequacy of the material supplied 
as input for processing by the spSlab computer program. Furthermore, STRUCTUREPOINT neither makes any warranty expressed nor implied with respect to the 
correctness of the output prepared by the spSlab program. Although STRUCTUREPOINT has endeavored to produce spSlab error free the program is not and 
cannot be certified infallible. The final and only responsibility for analysis, design and engineering documents is the licensee's. Accordingly, STRUCTUREPOINT 
disclaims all responsibility in contract, negligence or other tort for any analysis, design or engineering documents prepared in connection with the use of the spSlab 
program.Licensed to: -- Unknown User --. License ID: 00000-0000000 
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1. Input Echo  
 
 

1.1. General Information  
 

File Name ...\Example 5 - PCA Notes on ACI 318-
Example 2... 

Project spSlab/spBeam Manual, Example 5 
Frame PCA Notes on ACI 318-Example 20-2 
Engineer StructurePoint 
Code ACI 318-14 
Reinforcement 
Database 

ASTM A615 

Mode Design 
Number of supports =  4 + Left cantilever + Right cantilever 
Floor System Two-Way 

 
 

1.2. Solve Options  
 

Live load pattern ratio = 75% 
Minimum free edge distance for punching shear = 4 times slab thickness. 
Circular critical section around circular supports used (if possible). 
Deflections are based on cracked section properties. 
In negative moment regions, Ig and Mcr DO NOT include flange/slab contribution (if available) 
Long-term deflections are calculated for load duration of 60 months. 
0% of live load is sustained. 
Only deflections for direction of analysis will be calculated. 
Compression reinforcement calculations NOT selected. 
Default incremental rebar design selected. 
User-defined slab strip widths NOT selected. 
User-defined distribution factors NOT selected. 
One-way shear in drop panel NOT selected. 
Distribution of shear to strips NOT selected. 
Beam T-section design NOT selected. 
Longitudinal beam contribution in negative reinforcement design over support NOT selected. 
Transverse beam contribution in negative reinforcement design over support NOT selected. 

 
 

1.3. Material Properties  
 
 

1.3.1. Concrete: Slabs / Beams  
 

wc 150 lb/ft3 
f'c 4 ksi 
Ec 3834.3 ksi 
fr 0.474342 ksi 

 
 

1.3.2. Concrete: Columns  
 

wc 150 lb/ft3 
f'c 4 ksi 
Ec 3834.3 ksi 
fr 0.47434 ksi 
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1.3.3. Reinforcing Steel  
 

fy 60 ksi 
fyt 60 ksi 
Es 29000 ksi 
Epoxy coated bars No  

 
 

1.4. Reinforcement Database  
 

Size Db Ab Wb Size Db Ab Wb 
 in in2 lb/ft  in in2 lb/ft 

#3 0.38 0.11 0.38 #4 0.50 0.20 0.67 
#5 0.63 0.31 1.04 #6 0.75 0.44 1.50 
#7 0.88 0.60 2.04 #8 1.00 0.79 2.67 
#9 1.13 1.00 3.40 #10 1.27 1.27 4.30 

#11 1.41 1.56 5.31 #14 1.69 2.25 7.65 
#18 2.26 4.00 13.60     

 
 

1.5. Span Data  
 
 

1.5.1. Slabs  
 

Notes: 
Deflection check required for panels where code-specified Hmin for two-way construction doesn't apply due to: 
*i - cantilever end span (LC, RC) support condition 
 

Span Loc L1 t wL wR L2L L2R Hmin  
  ft in ft ft ft ft in  

1 Int 0.750 6.00 11.000 11.000 22.000 22.000 --- LC *i 
2 Int 17.500 6.00 11.000 11.000 22.000 22.000 5.79  
3 Int 17.500 6.00 11.000 11.000 22.000 22.000 5.79  
4 Int 17.500 6.00 11.000 11.000 22.000 22.000 5.79  
5 Int 0.750 6.00 11.000 11.000 22.000 22.000 --- RC *i 

 
 

1.5.2. Ribs and Longitudinal Beams  
 

Span Ribs Beams  
 b h Sp b h Offset  
 in in in in in in  

1 0.00 0.00 0.00 14.00 20.00 0.00  
2 0.00 0.00 0.00 14.00 20.00 0.00  
3 0.00 0.00 0.00 14.00 20.00 0.00  
4 0.00 0.00 0.00 14.00 20.00 0.00  
5 0.00 0.00 0.00 14.00 20.00 0.00  

 
 

1.6. Support Data  
 
 

1.6.1. Columns  
 

Support c1a c2a Ha c1b c2b Hb Red %  
 in in ft in in ft   

1 18.00 18.00 12.000 18.00 18.00 12.000 100  
2 18.00 18.00 12.000 18.00 18.00 12.000 100  
3 18.00 18.00 12.000 18.00 18.00 12.000 100  
4 18.00 18.00 12.000 18.00 18.00 12.000 100  
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1.6.2. Transverse Beams  
 

Supports b h Ecc 
 in in in 

1 14.00 27.00 0.00 
2 14.00 20.00 0.00 
3 14.00 20.00 0.00 
4 14.00 27.00 0.00 

 
 

1.6.3. Boundary Conditions  
 

Support Spring Far End 
 Kz Kry Above Below 
 kip/in kip-in/rad   

1 0 0 Fixed Fixed 
2 0 0 Fixed Fixed 
3 0 0 Fixed Fixed 
4 0 0 Fixed Fixed 

 
 

1.7. Load Data  
 
 

1.7.1. Load Cases and Combinations  
 

Case Dead Live 
Type DEAD LIVE 

U1 1.200 1.600 
 
 

1.7.2. Area Loads  
 

Case/Patt Span Wa 
  lb/ft2 

Dead 1 84.30 
 2 84.30 
 3 84.30 
 4 84.30 
 5 84.30 

Live 1 100.00 
 2 100.00 
 3 100.00 
 4 100.00 
 5 100.00 

Live/Odd  1 75.00 
 3 75.00 
 5 75.00 

Live/Even 2 75.00 
 4 75.00 

Live/S1  1 75.00 
 2 75.00 

Live/S2  2 75.00 
 3 75.00 

Live/S3  3 75.00 
 4 75.00 

Live/S4  4 75.00 
 5 75.00 
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1.8. Reinforcement Criteria  
 
 

1.8.1. Slabs and Ribs  
 

 Units Top Bars Bottom Bars 
  Min. Max. Min. Max. 
Bar Size  #5 #8 #5 #8 
Bar spacing in 1.00 18.00 1.00 18.00 
Reinf ratio % 0.14 5.00 0.14 5.00 
Clear Cover in 1.50  1.50  

There is NOT more than 12 in of concrete below top bars. 
 
 
 

1.8.2. Beams  
 

 Units Top Bars Bottom Bars Stirrups 
  Min. Max. Min. Max. Min. Max. 
Bar Size  #5 #8 #5 #8 #3 #5 
Bar spacing in 1.00 18.00 1.00 18.00 6.00 18.00 
Reinf ratio % 0.14 5.00 0.14 5.00   
Clear Cover in 1.50  1.50    
Layer dist. in 1.00  1.00    
No. of legs      2 6 
Side cover in     1.50  
1st Stirrup in     3.00  

There is NOT more than 12 in of concrete below top bars. 
 
 
 

2. Design Results*  
 

*Unless otherwise noted, all results are in the direction of analysis only. Another analysis in the perpendicular direction has to be carried out 
for two-way slab systems. 
 
 

2.1. Strip Widths and Distribution Factors  
 

Notes: 
*Used for bottom reinforcement. **Used for top reinforcement. 
 

 Width Moment Factor 
Span Strip Left ** Right ** Bottom * Left ** Right ** Bottom * 

  ft ft ft ft ft ft 
1 Column 7.58 7.58 7.58 0.122 0.122 0.113 
 Middle 13.25 13.25 13.25 0.188 0.188 0.250 
 Beam 1.17 1.17 1.17 0.690 0.690 0.637 
        

2 Column 7.58 7.58 7.58 0.113 0.101 0.101 
 Middle 13.25 13.25 13.25 0.246 0.327 0.327 
 Beam 1.17 1.17 1.17 0.641 0.572 0.572 
        

3 Column 7.58 7.58 7.58 0.101 0.101 0.101 
 Middle 13.25 13.25 13.25 0.327 0.327 0.327 
 Beam 1.17 1.17 1.17 0.572 0.572 0.572 
        

4 Column 7.58 7.58 7.58 0.101 0.113 0.101 
 Middle 13.25 13.25 13.25 0.327 0.246 0.327 
 Beam 1.17 1.17 1.17 0.572 0.641 0.572 
        

5 Column 7.58 7.58 7.58 0.122 0.122 0.113 
 Middle 13.25 13.25 13.25 0.188 0.188 0.250 
 Beam 1.17 1.17 1.17 0.690 0.690 0.637 
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2.2. Top Reinforcement  
 

Notes: 
*3 - Design governed by minimum reinforcement. 
*5 - Number of bars governed by maximum allowable spacing. 
 

Span Strip Zone Width Mmax Xmax As,min As,max As,req SpProv Bars  
   ft k-ft ft in2 in2 in2 in   

1 Column Left 7.58 0.02 0.217 0.983 6.883 0.001 11.375 8-#5  *3 *5 
  Midspan 7.58 0.06 0.402 0.983 6.883 0.003 11.375 8-#5  *3 *5 
  Right 7.58 0.14 0.619 0.983 6.883 0.007 11.375 8-#5  *3 *5 
            
 Middle Left 13.25 0.03 0.217 1.717 12.026 0.002 11.357 14-#5  *3 *5 
  Midspan 13.25 0.10 0.402 1.717 12.026 0.005 11.357 14-#5  *3 *5 
  Right 13.25 0.22 0.619 1.717 12.026 0.011 11.357 14-#5  *3 *5 
            
 Beam Left 1.17 0.11 0.217 0.356 4.599 0.001 8.576 2-#5  *3 
  Midspan 1.17 0.35 0.402 0.356 4.599 0.004 8.576 2-#5  *3 
  Right 1.17 0.79 0.619 0.356 4.599 0.010 4.288 3-#5  *3 
            

2 Column Left 7.58 7.06 0.750 0.983 6.883 0.378 11.375 8-#5  *3 *5 
  Midspan 7.58 0.00 8.750 0.000 6.883 0.000 0.000 ---  
  Right 7.58 14.23 16.750 0.983 6.883 0.769 11.375 8-#5  *3 *5 
            
 Middle Left 13.25 15.36 0.750 1.717 12.026 0.824 11.357 14-#5  *3 *5 
  Midspan 13.25 0.00 8.750 0.000 12.026 0.000 0.000 ---  
  Right 13.25 46.12 16.750 1.717 12.026 2.533 11.357 14-#5  *5 
            
 Beam Left 1.17 40.00 0.750 0.661 4.599 0.497 4.288 3-#5  *3 
  Midspan 1.17 0.00 8.750 0.000 4.599 0.000 0.000 ---  
  Right 1.17 80.63 16.750 0.849 4.599 1.021 2.859 4-#5  
            

3 Column Left 7.58 12.91 0.750 0.983 6.883 0.696 11.375 8-#5  *3 *5 
  Midspan 7.58 0.15 11.150 0.983 6.883 0.008 11.375 8-#5  *3 *5 
  Right 7.58 12.91 16.750 0.983 6.883 0.696 11.375 8-#5  *3 *5 
            
 Middle Left 13.25 41.84 0.750 1.717 12.026 2.290 11.357 14-#5  *5 
  Midspan 13.25 0.47 11.150 1.717 12.026 0.025 11.357 14-#5  *3 *5 
  Right 13.25 41.84 16.750 1.717 12.026 2.290 11.357 14-#5  *5 
            
 Beam Left 1.17 73.15 0.750 0.849 4.599 0.923 2.859 4-#5  
  Midspan 1.17 0.83 11.150 0.356 4.599 0.010 8.576 2-#5  *3 
  Right 1.17 73.15 16.750 0.849 4.599 0.923 2.859 4-#5  
            

4 Column Left 7.58 14.23 0.750 0.983 6.883 0.769 11.375 8-#5  *3 *5 
  Midspan 7.58 0.00 8.750 0.000 6.883 0.000 0.000 ---  
  Right 7.58 7.06 16.750 0.983 6.883 0.378 11.375 8-#5  *3 *5 
            
 Middle Left 13.25 46.12 0.750 1.717 12.026 2.533 11.357 14-#5  *5 
  Midspan 13.25 0.00 8.750 0.000 12.026 0.000 0.000 ---  
  Right 13.25 15.36 16.750 1.717 12.026 0.824 11.357 14-#5  *3 *5 
            
 Beam Left 1.17 80.63 0.750 0.849 4.599 1.021 2.859 4-#5  
  Midspan 1.17 0.00 8.750 0.000 4.599 0.000 0.000 ---  
  Right 1.17 40.00 16.750 0.661 4.599 0.497 4.288 3-#5  *3 
            

5 Column Left 7.58 0.14 0.131 0.983 6.883 0.007 11.375 8-#5  *3 *5 
  Midspan 7.58 0.06 0.348 0.983 6.883 0.003 11.375 8-#5  *3 *5 
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Span Strip Zone Width Mmax Xmax As,min As,max As,req SpProv Bars  
   ft k-ft ft in2 in2 in2 in   
  Right 7.58 0.02 0.533 0.983 6.883 0.001 11.375 8-#5  *3 *5 
            
 Middle Left 13.25 0.22 0.131 1.717 12.026 0.011 11.357 14-#5  *3 *5 
  Midspan 13.25 0.10 0.348 1.717 12.026 0.005 11.357 14-#5  *3 *5 
  Right 13.25 0.03 0.533 1.717 12.026 0.002 11.357 14-#5  *3 *5 
            
 Beam Left 1.17 0.79 0.131 0.356 4.599 0.010 4.288 3-#5  *3 
  Midspan 1.17 0.35 0.348 0.356 4.599 0.004 8.576 2-#5  *3 
  Right 1.17 0.11 0.533 0.356 4.599 0.001 8.576 2-#5  *3 

 
 

2.3. Top Bar Details  
 

NOTES: 
* - Bar cut-off location does not meet ACI 318, 12.10.5.1. Revise location, unless the requirements of either 12.10.5.2 or 12.10.5.3 are 
manually checked and satisfied. 
 

  Left Continuous Right 
Span Strip Bars  Length Bars  Length Bars  Length Bars  Length Bars  Length 

    ft   ft   ft   ft   ft 
1 Column ---   ---   8-#5  0.75 ---   ---   
 Middle ---   ---   14-#5  0.75 ---   ---   
 Beam ---   ---   2-#5  0.75 1-#5  0.75 ---   
                 

2 Column 4-#5  3.75 4-#5  1.75 ---   4-#5  6.75 4-#5  1.75 
 Middle 14-#5  3.75 ---   ---   14-#5  6.75 ---   
 Beam 3-#5  4.27 ---   ---   3-#5  7.27 1-#5 * 2.51 
                 

3 Column ---   ---   8-#5  17.50 ---   ---   
 Middle ---   ---   14-#5  17.50 ---   ---   
 Beam 1-#5 * 3.22 1-#5 * 2.25 2-#5  17.50 1-#5 * 3.22 1-#5 * 2.25 
                 

4 Column 4-#5  6.75 4-#5  1.75 ---   4-#5  3.75 4-#5  1.75 
 Middle 14-#5  6.75 ---   ---   14-#5  3.75 ---   
 Beam 3-#5  7.27 1-#5 * 2.51 ---   3-#5  4.27 ---   
                 

5 Column ---   ---   8-#5  0.75 ---   ---   
 Middle ---   ---   14-#5  0.75 ---   ---   
 Beam 1-#5  0.75 ---   2-#5  0.75 ---   ---   

 
 

2.4. Top Bar Development Lengths  
 

  Left Continuous Right 
Span Strip Bars  DevLen Bars  DevLen Bars  DevLen Bars  DevLen Bars  DevLen 

    in   in   in   in   in 
1 Column ---   ---   8-#5  12.00 ---   ---   
 Middle ---   ---   14-#5  12.00 ---   ---   
 Beam ---   ---   2-#5  12.00 1-#5  12.00 ---   
                 

2 Column 4-#5  12.00 4-#5  12.00 ---   4-#5  12.00 4-#5  12.00 
 Middle 14-#5  12.00 ---   ---   14-#5  12.00 ---   
 Beam 3-#5  12.00 ---   ---   3-#5  12.81 1-#5  12.81 
                 

3 Column ---   ---   8-#5  12.00 ---   ---   
 Middle ---   ---   14-#5  12.00 ---   ---   
 Beam 1-#5  12.00 1-#5  12.00 2-#5  12.00 1-#5  12.00 1-#5  12.00 
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  Left Continuous Right 
Span Strip Bars  DevLen Bars  DevLen Bars  DevLen Bars  DevLen Bars  DevLen 

    in   in   in   in   in 
4 Column 4-#5  12.00 4-#5  12.00 ---   4-#5  12.00 4-#5  12.00 
 Middle 14-#5  12.00 ---   ---   14-#5  12.00 ---   
 Beam 3-#5  12.81 1-#5  12.81 ---   3-#5  12.00 ---   
                 

5 Column ---   ---   8-#5  12.00 ---   ---   
 Middle ---   ---   14-#5  12.00 ---   ---   
 Beam 1-#5  12.00 ---   2-#5  12.00 ---   ---   

 
 

2.5. Bottom Reinforcement  
 

Notes: 
*3 - Design governed by minimum reinforcement. 
*5 - Number of bars governed by maximum allowable spacing. 
 

Span Strip Width Mmax Xmax As,min As,max As,req SpProv Bars  
  ft k-ft ft in2 in2 in2 in   

1 Column 7.58 0.00 0.309 0.000 6.883 0.000 0.000 ---  
 Middle 13.25 0.00 0.309 0.000 12.026 0.000 0.000 ---  
 Beam 1.17 0.00 0.309 0.000 4.599 0.000 0.000 ---  
           

2 Column 7.58 8.50 8.000 0.983 6.883 0.456 11.375 8-#5  *3 *5 
 Middle 13.25 27.55 8.000 1.717 12.026 1.492 11.357 14-#5  *3 *5 
 Beam 1.17 48.17 8.000 0.799 4.599 0.601 4.288 3-#5  *3 
           

3 Column 7.58 6.47 8.750 0.983 6.883 0.346 11.375 8-#5  *3 *5 
 Middle 13.25 20.96 8.750 1.717 12.026 1.129 11.357 14-#5  *3 *5 
 Beam 1.17 36.65 8.750 0.605 4.599 0.455 8.576 2-#5  *3 
           

4 Column 7.58 8.50 9.500 0.983 6.883 0.456 11.375 8-#5  *3 *5 
 Middle 13.25 27.55 9.500 1.717 12.026 1.492 11.357 14-#5  *3 *5 
 Beam 1.17 48.17 9.500 0.799 4.599 0.601 4.288 3-#5  *3 
           

5 Column 7.58 0.00 0.441 0.000 6.883 0.000 0.000 ---  
 Middle 13.25 0.00 0.441 0.000 12.026 0.000 0.000 ---  
 Beam 1.17 0.00 0.441 0.000 4.599 0.000 0.000 ---  

 
 

2.6. Bottom Bar Details  
 

  Long Bars Short Bars 
Span Strip Bars  Start Length Bars  Start Length 

    ft ft   ft ft 
1 Column ---    ---    
 Middle ---    ---    
 Beam ---    ---    
          

2 Column 8-#5  0.00 17.50 ---    
 Middle 7-#5  0.00 17.50 7-#5  0.00 14.88 
 Beam 3-#5  0.00 17.50 ---    
          

3 Column 8-#5  0.00 17.50 ---    
 Middle 7-#5  0.00 17.50 7-#5  2.63 12.25 
 Beam 2-#5  0.00 17.50 ---    
          

4 Column 8-#5  0.00 17.50 ---    
 Middle 7-#5  0.00 17.50 7-#5  2.63 14.88 
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  Long Bars Short Bars 
Span Strip Bars  Start Length Bars  Start Length 

    ft ft   ft ft 
 Beam 3-#5  0.00 17.50 ---    
          

5 Column ---    ---    
 Middle ---    ---    
 Beam ---    ---    

 
 

2.7. Bottom Bar Development Lengths  
 

  Long Bars Short Bars 
Span Strip Bars  DevLen Bars  DevLen 

    in   in 
1 Column ---   ---   
 Middle ---   ---   
 Beam ---   ---   
        

2 Column 8-#5  12.00 ---   
 Middle 7-#5  12.00 7-#5  12.00 
 Beam 3-#5  12.00 ---   
        

3 Column 8-#5  12.00 ---   
 Middle 7-#5  12.00 7-#5  12.00 
 Beam 2-#5  12.00 ---   
        

4 Column 8-#5  12.00 ---   
 Middle 7-#5  12.00 7-#5  12.00 
 Beam 3-#5  12.00 ---   
        

5 Column ---   ---   
 Middle ---   ---   
 Beam ---   ---   

 
 

2.8. Flexural Capacity  
 

  Top Bottom 
Span Strip x As,top ΦMn- Mu- Comb Pat Status As,bot ΦMn+ Mu+ Comb Pat Status 

  ft in2 k-ft k-ft    in2 k-ft k-ft    
1 Column 0.000 2.48 -44.05 0.00 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.217 2.48 -44.05 -0.02 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.375 2.48 -44.05 -0.05 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.402 2.48 -44.05 -0.06 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.619 2.48 -44.05 -0.14 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.750 2.48 -44.05 -0.20 U1 All  --- 0.00 0.00 0.00 U1 All  --- 
 Middle 0.000 4.34 -77.08 0.00 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.217 4.34 -77.08 -0.03 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.375 4.34 -77.08 -0.08 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.402 4.34 -77.08 -0.10 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.619 4.34 -77.08 -0.22 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.750 4.34 -77.08 -0.30 U1 All  --- 0.00 0.00 0.00 U1 All  --- 
 Beam 0.000 0.93 -73.66 0.00 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.217 0.93 -73.66 -0.11 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.375 0.93 -73.66 -0.31 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.402 0.93 -73.66 -0.35 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.619 0.93 -73.66 -0.79 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.750 0.93 -73.66 -1.12 U1 All  --- 0.00 0.00 0.00 U1 All  --- 
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  Top Bottom 
Span Strip x As,top ΦMn- Mu- Comb Pat Status As,bot ΦMn+ Mu+ Comb Pat Status 

  ft in2 k-ft k-ft    in2 k-ft k-ft    
               

2 Column 0.000 2.48 -44.05 -10.78 U1 All  --- 2.48 44.05 0.00 U1 All  --- 
  0.750 2.48 -44.05 -7.06 U1 All  OK 2.48 44.05 0.00 U1 All  OK 
  1.750 1.24 -22.70 -2.95 U1 Even OK 2.48 44.05 0.00 U1 All  OK 
  2.750 1.24 -22.70 0.00 U1 All  OK 2.48 44.05 0.83 U1 All  OK 
  3.750 0.00 0.00 0.00 U1 All  OK 2.48 44.05 3.52 U1 All  OK 
  6.350 0.00 0.00 0.00 U1 All  OK 2.48 44.05 7.81 U1 All  OK 
  8.000 0.00 0.00 0.00 U1 All  OK 2.48 44.05 8.50 U1 All  OK 
  8.750 0.00 0.00 0.00 U1 All  OK 2.48 44.05 8.29 U1 All  OK 
  10.750 0.00 0.00 0.00 U1 All  OK 2.48 44.05 6.46 U1 Even OK 
  11.150 0.50 -9.24 0.00 U1 All  OK 2.48 44.05 5.94 U1 Even OK 
  11.750 1.24 -22.70 0.00 U1 All  OK 2.48 44.05 5.02 U1 Even OK 
  15.750 1.24 -22.70 -9.46 U1 All  OK 2.48 44.05 0.00 U1 All  OK 
  16.750 2.48 -44.05 -14.23 U1 All  OK 2.48 44.05 0.00 U1 All  OK 
  17.500 2.48 -44.05 -18.14 U1 All  --- 2.48 44.05 0.00 U1 All  --- 
 Middle 0.000 4.34 -77.08 -22.97 U1 All  --- 4.34 77.08 0.00 U1 All  --- 
  0.750 4.34 -77.08 -15.36 U1 All  OK 4.34 77.08 0.00 U1 All  OK 
  2.750 4.34 -77.08 0.00 U1 All  OK 4.34 77.08 2.68 U1 All  OK 
  3.750 0.00 0.00 0.00 U1 All  OK 4.34 77.08 11.41 U1 All  OK 
  6.350 0.00 0.00 0.00 U1 All  OK 4.34 77.08 25.30 U1 All  OK 
  8.000 0.00 0.00 0.00 U1 All  OK 4.34 77.08 27.55 U1 All  OK 
  8.750 0.00 0.00 0.00 U1 All  OK 4.34 77.08 26.88 U1 All  OK 
  10.750 0.00 0.00 0.00 U1 All  OK 4.34 77.08 20.94 U1 Even OK 
  11.150 1.74 -31.96 0.00 U1 All  OK 4.34 77.08 19.25 U1 Even OK 
  11.750 4.34 -77.08 0.00 U1 All  OK 4.34 77.08 16.26 U1 Even OK 
  13.875 4.34 -77.08 -8.12 U1 Odd  OK 4.34 77.08 1.02 U1 Even OK 
  14.875 4.34 -77.08 -17.71 U1 All  OK 2.17 39.72 0.00 U1 All  OK 
  16.750 4.34 -77.08 -46.12 U1 All  OK 2.17 39.72 0.00 U1 All  OK 
  17.500 4.34 -77.08 -59.82 U1 All  --- 2.17 39.72 0.00 U1 All  --- 
 Beam 0.000 0.93 -73.66 -61.08 U1 All  --- 0.93 73.66 0.00 U1 All  --- 
  0.750 0.93 -73.66 -40.00 U1 All  OK 0.93 73.66 0.00 U1 All  OK 
  3.266 0.93 -73.66 0.00 U1 All  OK 0.93 73.66 12.96 U1 All  OK 
  4.266 0.00 0.00 0.00 U1 All  OK 0.93 73.66 26.53 U1 All  OK 
  6.350 0.00 0.00 0.00 U1 All  OK 0.93 73.66 44.24 U1 All  OK 
  8.000 0.00 0.00 0.00 U1 All  OK 0.93 73.66 48.17 U1 All  OK 
  8.750 0.00 0.00 0.00 U1 All  OK 0.93 73.66 46.99 U1 All  OK 
  10.234 0.00 0.00 0.00 U1 All  OK 0.93 73.66 39.73 U1 Even OK 
  11.150 0.80 -63.46 0.00 U1 All  OK 0.93 73.66 33.65 U1 Even OK 
  11.302 0.93 -73.66 0.00 U1 All  OK 0.93 73.66 32.42 U1 Even OK 
  14.987 0.93 -73.66 -34.90 U1 All  OK 0.93 73.66 0.00 U1 All  OK 
  16.054 1.24 -97.13 -61.53 U1 All  OK 0.93 73.66 0.00 U1 All  OK 
  16.750 1.24 -97.13 -80.63 U1 All  OK 0.93 73.66 0.00 U1 All  OK 
  17.500 1.24 -97.13 -102.80 U1 All  --- 0.93 73.66 0.00 U1 All  --- 
               

3 Column 0.000 2.48 -44.05 -16.55 U1 All  --- 2.48 44.05 0.00 U1 All  --- 
  0.750 2.48 -44.05 -12.91 U1 All  OK 2.48 44.05 0.00 U1 All  OK 
  6.350 2.48 -44.05 -0.15 U1 Even OK 2.48 44.05 5.05 U1 Odd  OK 
  8.750 2.48 -44.05 0.00 U1 All  OK 2.48 44.05 6.47 U1 Odd  OK 
  11.150 2.48 -44.05 -0.15 U1 Even OK 2.48 44.05 5.05 U1 Odd  OK 
  16.750 2.48 -44.05 -12.91 U1 All  OK 2.48 44.05 0.00 U1 All  OK 
  17.500 2.48 -44.05 -16.55 U1 All  --- 2.48 44.05 0.00 U1 All  --- 
 Middle 0.000 4.34 -77.08 -53.65 U1 All  --- 2.17 39.72 0.00 U1 All  --- 
  0.750 4.34 -77.08 -41.84 U1 All  OK 2.17 39.72 0.00 U1 All  OK 
  2.625 4.34 -77.08 -16.97 U1 All  OK 2.17 39.72 0.00 U1 All  OK 
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  Top Bottom 
Span Strip x As,top ΦMn- Mu- Comb Pat Status As,bot ΦMn+ Mu+ Comb Pat Status 

  ft in2 k-ft k-ft    in2 k-ft k-ft    
  3.625 4.34 -77.08 -9.01 U1 S1 OK 4.34 77.08 1.12 U1 S3 OK 
  6.350 4.34 -77.08 -0.47 U1 Even OK 4.34 77.08 16.37 U1 Odd  OK 
  8.750 4.34 -77.08 0.00 U1 All  OK 4.34 77.08 20.96 U1 Odd  OK 
  11.150 4.34 -77.08 -0.47 U1 Even OK 4.34 77.08 16.37 U1 Odd  OK 
  13.875 4.34 -77.08 -9.01 U1 S4 OK 4.34 77.08 1.12 U1 S2 OK 
  14.875 4.34 -77.08 -16.97 U1 All  OK 2.17 39.72 0.00 U1 All  OK 
  16.750 4.34 -77.08 -41.84 U1 All  OK 2.17 39.72 0.00 U1 All  OK 
  17.500 4.34 -77.08 -53.65 U1 All  --- 2.17 39.72 0.00 U1 All  --- 
 Beam 0.000 1.24 -97.13 -93.79 U1 All  --- 0.62 49.65 0.00 U1 All  --- 
  0.750 1.24 -97.13 -73.15 U1 All  OK 0.62 49.65 0.00 U1 All  OK 
  1.246 1.24 -97.13 -60.51 U1 All  OK 0.62 49.65 0.00 U1 All  OK 
  2.217 0.94 -74.37 -38.14 U1 All  OK 0.62 49.65 0.00 U1 All  OK 
  2.246 0.92 -72.95 -37.49 U1 All  OK 0.62 49.65 0.00 U1 All  OK 
  3.217 0.62 -49.65 -19.05 U1 S1 OK 0.62 49.65 0.00 U1 All  OK 
  6.350 0.62 -49.65 -0.83 U1 Even OK 0.62 49.65 28.62 U1 Odd  OK 
  8.750 0.62 -49.65 0.00 U1 All  OK 0.62 49.65 36.65 U1 Odd  OK 
  11.150 0.62 -49.65 -0.83 U1 Even OK 0.62 49.65 28.62 U1 Odd  OK 
  14.283 0.62 -49.65 -19.05 U1 S4 OK 0.62 49.65 0.00 U1 All  OK 
  15.254 0.92 -72.95 -37.49 U1 All  OK 0.62 49.65 0.00 U1 All  OK 
  15.283 0.94 -74.37 -38.14 U1 All  OK 0.62 49.65 0.00 U1 All  OK 
  16.254 1.24 -97.13 -60.51 U1 All  OK 0.62 49.65 0.00 U1 All  OK 
  16.750 1.24 -97.13 -73.15 U1 All  OK 0.62 49.65 0.00 U1 All  OK 
  17.500 1.24 -97.13 -93.79 U1 All  --- 0.62 49.65 0.00 U1 All  --- 
               

4 Column 0.000 2.48 -44.05 -18.14 U1 All  --- 2.48 44.05 0.00 U1 All  --- 
  0.750 2.48 -44.05 -14.23 U1 All  OK 2.48 44.05 0.00 U1 All  OK 
  1.750 1.24 -22.70 -9.46 U1 All  OK 2.48 44.05 0.00 U1 All  OK 
  5.750 1.24 -22.70 0.00 U1 All  OK 2.48 44.05 5.02 U1 Even OK 
  6.350 0.50 -9.24 0.00 U1 All  OK 2.48 44.05 5.94 U1 Even OK 
  6.750 0.00 0.00 0.00 U1 All  OK 2.48 44.05 6.46 U1 Even OK 
  8.750 0.00 0.00 0.00 U1 All  OK 2.48 44.05 8.29 U1 All  OK 
  9.500 0.00 0.00 0.00 U1 All  OK 2.48 44.05 8.50 U1 All  OK 
  11.150 0.00 0.00 0.00 U1 All  OK 2.48 44.05 7.81 U1 All  OK 
  13.750 0.00 0.00 0.00 U1 All  OK 2.48 44.05 3.52 U1 All  OK 
  14.750 1.24 -22.70 0.00 U1 All  OK 2.48 44.05 0.83 U1 All  OK 
  15.750 1.24 -22.70 -2.95 U1 Even OK 2.48 44.05 0.00 U1 All  OK 
  16.750 2.48 -44.05 -7.06 U1 All  OK 2.48 44.05 0.00 U1 All  OK 
  17.500 2.48 -44.05 -10.78 U1 All  --- 2.48 44.05 0.00 U1 All  --- 
 Middle 0.000 4.34 -77.08 -59.82 U1 All  --- 2.17 39.72 0.00 U1 All  --- 
  0.750 4.34 -77.08 -46.12 U1 All  OK 2.17 39.72 0.00 U1 All  OK 
  2.625 4.34 -77.08 -17.71 U1 All  OK 2.17 39.72 0.00 U1 All  OK 
  3.625 4.34 -77.08 -8.12 U1 Odd  OK 4.34 77.08 1.02 U1 Even OK 
  5.750 4.34 -77.08 0.00 U1 All  OK 4.34 77.08 16.26 U1 Even OK 
  6.350 1.74 -31.96 0.00 U1 All  OK 4.34 77.08 19.25 U1 Even OK 
  6.750 0.00 0.00 0.00 U1 All  OK 4.34 77.08 20.94 U1 Even OK 
  8.750 0.00 0.00 0.00 U1 All  OK 4.34 77.08 26.88 U1 All  OK 
  9.500 0.00 0.00 0.00 U1 All  OK 4.34 77.08 27.55 U1 All  OK 
  11.150 0.00 0.00 0.00 U1 All  OK 4.34 77.08 25.30 U1 All  OK 
  13.750 0.00 0.00 0.00 U1 All  OK 4.34 77.08 11.41 U1 All  OK 
  14.750 4.34 -77.08 0.00 U1 All  OK 4.34 77.08 2.68 U1 All  OK 
  16.750 4.34 -77.08 -15.36 U1 All  OK 4.34 77.08 0.00 U1 All  OK 
  17.500 4.34 -77.08 -22.97 U1 All  --- 4.34 77.08 0.00 U1 All  --- 
 Beam 0.000 1.24 -97.13 -102.80 U1 All  --- 0.93 73.66 0.00 U1 All  --- 
  0.750 1.24 -97.13 -80.63 U1 All  OK 0.93 73.66 0.00 U1 All  OK 
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  Top Bottom 
Span Strip x As,top ΦMn- Mu- Comb Pat Status As,bot ΦMn+ Mu+ Comb Pat Status 

  ft in2 k-ft k-ft    in2 k-ft k-ft    
  1.446 1.24 -97.13 -61.53 U1 All  OK 0.93 73.66 0.00 U1 All  OK 
  2.513 0.93 -73.66 -34.90 U1 All  OK 0.93 73.66 0.00 U1 All  OK 
  6.198 0.93 -73.66 0.00 U1 All  OK 0.93 73.66 32.42 U1 Even OK 
  6.350 0.80 -63.46 0.00 U1 All  OK 0.93 73.66 33.65 U1 Even OK 
  7.266 0.00 0.00 0.00 U1 All  OK 0.93 73.66 39.73 U1 Even OK 
  8.750 0.00 0.00 0.00 U1 All  OK 0.93 73.66 46.99 U1 All  OK 
  9.500 0.00 0.00 0.00 U1 All  OK 0.93 73.66 48.17 U1 All  OK 
  11.150 0.00 0.00 0.00 U1 All  OK 0.93 73.66 44.24 U1 All  OK 
  13.234 0.00 0.00 0.00 U1 All  OK 0.93 73.66 26.53 U1 All  OK 
  14.234 0.93 -73.66 0.00 U1 All  OK 0.93 73.66 12.96 U1 All  OK 
  16.750 0.93 -73.66 -40.00 U1 All  OK 0.93 73.66 0.00 U1 All  OK 
  17.500 0.93 -73.66 -61.08 U1 All  --- 0.93 73.66 0.00 U1 All  --- 
               

5 Column 0.000 2.48 -44.05 -0.20 U1 All  --- 0.00 0.00 0.00 U1 All  --- 
  0.131 2.48 -44.05 -0.14 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.348 2.48 -44.05 -0.06 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.375 2.48 -44.05 -0.05 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.533 2.48 -44.05 -0.02 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.750 2.48 -44.05 0.00 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
 Middle 0.000 4.34 -77.08 -0.30 U1 All  --- 0.00 0.00 0.00 U1 All  --- 
  0.131 4.34 -77.08 -0.22 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.348 4.34 -77.08 -0.10 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.375 4.34 -77.08 -0.08 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.533 4.34 -77.08 -0.03 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.750 4.34 -77.08 0.00 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
 Beam 0.000 0.93 -73.66 -1.12 U1 All  --- 0.00 0.00 0.00 U1 All  --- 
  0.131 0.93 -73.66 -0.79 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.348 0.93 -73.66 -0.35 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.375 0.93 -73.66 -0.31 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.533 0.93 -73.66 -0.11 U1 All  OK 0.00 0.00 0.00 U1 All  OK 
  0.750 0.93 -73.66 0.00 U1 All  OK 0.00 0.00 0.00 U1 All  OK 

 
 

2.9. Longitudinal Beam Transverse Reinforcement Demand and Capacity  
 
 

2.9.1. Section Properties  
 

Span d (Av/s)min ΦVc 
 in in2/in kip 

1 18.19 0.0117 24.16 
2 18.19 0.0117 24.16 
3 18.19 0.0117 24.16 
4 18.19 0.0117 24.16 
5 18.19 0.0117 24.16 

 
 

2.9.2. Beam Transverse Reinforcement Demand  
 

Notes: 
*8 - Minimum transverse (stirrup) reinforcement governs. 
 

   Required Demand 
Span Start End Xu Vu Comb/Patt Av/s Av/s  

 ft ft ft kip  in2/in in2/in  
1 0.000 0.000 0.000 0.00 U1/All  0.0000 0.0000  
         

2 1.000 4.118 2.266 32.35 U1/All  0.0100 0.0117  *8 
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   Required Demand 
Span Start End Xu Vu Comb/Patt Av/s Av/s  

 ft ft ft kip  in2/in in2/in  
 4.118 5.971 4.118 21.70 U1/All  0.0000 0.0117  *8 
 5.971 7.824 5.971 11.38 U1/Even 0.0000 0.0000  
 7.824 9.676 9.676 10.23 U1/All  0.0000 0.0000  
 9.676 11.529 11.529 20.88 U1/All  0.0000 0.0117  *8 
 11.529 13.382 13.382 31.52 U1/All  0.0090 0.0117  *8 
 13.382 16.500 15.234 42.17 U1/All  0.0220 0.0220  
         

3 1.000 4.118 2.266 37.26 U1/All  0.0160 0.0160  
 4.118 5.971 4.118 26.61 U1/All  0.0030 0.0117  *8 
 5.971 7.824 5.971 15.97 U1/All  0.0000 0.0117  *8 
 7.824 9.676 9.676 6.78 U1/S3 0.0000 0.0000  
 9.676 11.529 11.529 15.97 U1/All  0.0000 0.0117  *8 
 11.529 13.382 13.382 26.61 U1/All  0.0030 0.0117  *8 
 13.382 16.500 15.234 37.26 U1/All  0.0160 0.0160  
         

4 1.000 4.118 2.266 42.17 U1/All  0.0220 0.0220  
 4.118 5.971 4.118 31.52 U1/All  0.0090 0.0117  *8 
 5.971 7.824 5.971 20.88 U1/All  0.0000 0.0117  *8 
 7.824 9.676 7.824 10.23 U1/All  0.0000 0.0000  
 9.676 11.529 11.529 11.38 U1/Even 0.0000 0.0000  
 11.529 13.382 13.382 21.70 U1/All  0.0000 0.0117  *8 
 13.382 16.500 15.234 32.35 U1/All  0.0100 0.0117  *8 
         

5 0.750 0.750 0.750 0.00 U1/All  0.0000 0.0000  
 
 

2.9.3. Beam Transverse Reinforcement Details  
 

Span Size Stirrups (2 legs each unless otherwise noted) 
1 #5 --- None --- 
2 #3  8 @ 8.0 + <-- 44.5 --> + 10 @ 8.6  
3 #3  10 @ 8.6 + <-- 22.2 --> + 10 @ 8.6  
4 #3  10 @ 8.6 + <-- 44.5 --> + 8 @ 8.0  
5 #5 --- None --- 

 
 

2.9.4. Beam Transverse Reinforcement Capacity  
 

Notes: 
*8 - Minimum transverse (stirrup) reinforcement governs. 
 

 Required Provided 
Span Start End Xu Vu Comb/Patt Av/s Av Sp Av/s ΦVn  

 ft ft ft kip  in2/in in2 in in2/in kip  
1 0.000 0.750 0.000 0.00 U1/All ----- ----- ----- ----- -----  
            

2 0.000 1.000 2.266 32.35 U1/All ----- ----- ----- ----- -----  
 1.000 5.971 2.266 32.35 U1/All 0.0100 0.22 8.0 0.0277 46.79  *8 
 5.971 9.676 5.971 11.38 U1/Even 0.0000 ----- ----- ----- 12.08  
 9.676 16.500 15.234 42.17 U1/All 0.0220 0.22 8.6 0.0255 45.05  
 16.500 17.500 15.234 42.17 U1/All ----- ----- ----- ----- -----  
            

3 0.000 1.000 2.266 37.26 U1/All ----- ----- ----- ----- -----  
 1.000 7.824 2.266 37.26 U1/All 0.0160 0.22 8.6 0.0255 45.05  
 7.824 9.676 9.676 6.78 U1/S3 0.0000 ----- ----- ----- 12.08  
 9.676 16.500 15.234 37.26 U1/All 0.0160 0.22 8.6 0.0255 45.05  
 16.500 17.500 15.234 37.26 U1/All ----- ----- ----- ----- -----  
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 Required Provided 
Span Start End Xu Vu Comb/Patt Av/s Av Sp Av/s ΦVn  

 ft ft ft kip  in2/in in2 in in2/in kip  
            

4 0.000 1.000 2.266 42.17 U1/All ----- ----- ----- ----- -----  
 1.000 7.824 2.266 42.17 U1/All 0.0220 0.22 8.6 0.0255 45.05  
 7.824 11.529 11.529 11.38 U1/Even 0.0000 ----- ----- ----- 12.08  
 11.529 16.500 15.234 32.35 U1/All 0.0100 0.22 8.0 0.0277 46.79  *8 
 16.500 17.500 15.234 32.35 U1/All ----- ----- ----- ----- -----  
            

5 0.000 0.750 0.750 0.00 U1/All ----- ----- ----- ----- -----  
 
 

2.10. Slab Shear Capacity  
 

Span b d Vratio ΦVc Vu Xu  
 in in  kip kip ft  

1 250.00 4.19 0.000 99.32 0.00 0.00  
2 250.00 4.19 0.000 99.32 0.00 16.40  
3 250.00 4.19 0.000 99.32 0.00 16.40  
4 250.00 4.19 0.000 99.32 0.00 1.10  
5 250.00 4.19 0.000 99.32 0.00 0.00  

 
 

2.11. Flexural Transfer of Negative Unbalanced Moment at Supports  
 

Support Width Width-c d Munb Comb Patt γf As,req As,prov Add Bars  
 in in in k-ft    in2 in2   

1 36.00 36.00 4.19 93.21 U1 All 0.612 3.931 1.530 8-#5  
2 36.00 36.00 4.19 46.73 U1 Even 0.600 1.646 1.840 ---  
3 36.00 36.00 4.19 46.73 U1 Even 0.600 1.646 1.840 ---  
4 36.00 36.00 4.19 93.21 U1 All 0.612 3.931 1.530 8-#5  

 
 

2.12. Punching Shear Around Columns  
 
 

2.12.1. Critical Section Properties  
 

Support Type b1 b2 b0 davg CG c(left) c(right) Ac Jc 
  in in in in in in in in2 in4 

1 Rect 20.09 22.19 62.38 16.76 3.24 12.24 7.86 1045.2 77428 
2 Rect 22.19 22.19 88.75 13.02 0.00 11.09 11.09 1155.6 99277 
3 Rect 22.19 22.19 88.75 13.02 0.00 11.09 11.09 1155.6 99277 
4 Rect 20.09 22.19 62.38 16.76 -3.24 7.86 12.24 1045.2 77428 

 
 

2.12.2. Punching Shear Results  
 

Support Vu vu Munb Comb Patt γv vu ΦVc  
 kip psi k-ft    psi psi  

1 48.86 46.8 80.04 U1 All 0.388 84.6 189.7  
2 104.56 90.5 -16.77 U1 All 0.400 99.5 189.7  
3 104.56 90.5 16.77 U1 All 0.400 99.5 189.7  
4 48.86 46.8 -80.04 U1 All 0.388 84.6 189.7  

 
 

2.13. Material TakeOff  
 
 

2.13.1. Reinforcement in the Direction of Analysis  
 

Top Bars 989.4 lb <=> 18.32 lb/ft <=> 0.833 lb/ft2 
Bottom Bars 1274.0 lb <=> 23.59 lb/ft <=> 1.072 lb/ft2 
Stirrups 98.3 lb <=> 1.82 lb/ft <=> 0.083 lb/ft2 
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Total Steel 2361.7 lb <=> 43.74 lb/ft <=> 1.988 lb/ft2 
Concrete 817.2 ft3 <=> 15.13 ft3/ft <=> 0.688 ft3/ft2 
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7.1 Program Description

spReporter is a module of the spSlab program. It enables the user to view, customize, print and 
export reports in different formats. 

spReporter is accessed from within spSlab. Once a successful run has been performed, you can open 
spReporter by selecting the Reporter command from the View menu. Alternatively, spReporter can also be 
accessed by pressing the F7 key or by clicking on the spReporter button in the program toolbar. 
Immediately after opening spReporter, you can export and/or print the default report by pressing Export/
Print button. Various options to customize the report before printing and/or exporting it are also provided. 
Once the work in spReporter is complete click the close button in the top right corner to exit the spReporter 
window.

7.2 Toolbar

Previous page
Displays the previous page of the report.
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Next page
Displays the next page of the report.

Page number box
Displays the page with the page number entered in the box.

Zoom in
 Zooms in on the report (Ctrl + Mouse wheel up).

Zoom out
 Zooms out on the report (Ctrl + Mouse wheel down).

Zoom box
Zooms on the report preview to the extent typed in the box or selected from the dropdown 
list.

Fit to window width and enable scrolling
Fits the width of report to the preview space width and enables scrolling.

Fit one full page to window
Fits one full page in the preview space.

Pan
When toggled on and if the report is bigger than preview window, enables panning the 
report.

 Text selection
When toggled on enables selecting text in the report.

Settings
Modifies settings for report and explorer panel.
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– Report Settings
Regenerate automatically: Enables automatic regeneration of report when content 
selection is modified by the user.
Split long tables: Displays table headings in all pages when tables are split along sev-
eral pages.

– Explorer Settings
Location: Displays explorer panel on the left or right side of screen depending on 
selection.
Hide inactive items: Hides unused tables from the explorer view.
Keep explorer configurations: Saves the explorer configuration i.e. information about 
selected tables and opened/closed sections so that it is available the next time user 
opens spReporter

Explorer
Shows or hides the explorer panel.

7.3 Export / Print Panel

Export
Exports the report in the selected format.

Print
Prints the report in the selected format when the option is available.
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Type
Provides 5 format options to print and/or export the reports
– Word: Produces a Microsoft Word file with .docx extension.
– PDF: Produces an Adobe Acrobat file with .pdf extension.
– Text: Produces a Text file with .txt extension.
– Excel: Produces a Microsoft Excel file with .xlsx extension.
– CSV: Produces a Comma Separated file with .csv extension.

Printer
Provides the option to select available printers and change printer properties.

Settings
Provides the options to modify print settings.
– Paper: Provides the options to select from available paper sizes.
– Orientation: Provides the options to select between landscape or portrait paper orien-

tation.
– Margins: Provides the options to use narrow, normal, wide or custom margins to the 

report.

– Print range: Provides the options to select the pages to print and/or export.

7.4 Explorer panel

The explorer panel consists of all the available report items classified into sections and arranged 
hierarchically. Each item listed in the explorer panel is preceded by a checkbox. The user can 
check/uncheck the checkbox to include or exclude from the report, the items or sections.
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Expand all
Expands item list.

Collapse all
Collapses item list.
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8.1 Introduction

spResults is a module of the spSlab program. It enables the user to view program input and output 
in tables and export them in different formats.

spResults is accessed from within spSlab. Once a model has been successfully executed, you can open 
spResults by selecting the Results command from the View menu. Alternatively, spResults can also be 
accessed by pressing the F6 key or by clicking on the spResults button in the program toolbar. Once the 
work in spReporter is complete click the close button in the top right corner to exit spResults window.

8.2 Toolbar

Previous table
Displays the previous table.

Next table
Displays the next table.

Table number box
Displays the table with the table number entered in the box.
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Auto fit column width to view area
When toggled on always fits the width of table to the preview space width.

Maintain maximum column width
Switches all table columns to their default maximum width.

Export current table
Exports the table being viewed in the selected format.

Settings
Modifies settings for tables and explorer panel.

– Tables settings
Highlight critical items: Enables highlighting of critical items in the “Loads and 
Capacities” table.
Highlighting color: Provides color options for highlighting critical items.

– Explorer settings
Location: Displays explorer panel on the left or right side of screen depending on 
selection
Hide inactive items: Hides unused tables from the explorer view.
Keep explorer configuration: Saves the explorer configuration i.e. information about 
selected tables and opened /closed sections so that it is available the next time suer 
opens spReporter.

Explorer
Shows or hides the explorer panel.
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8.3 Explorer panel

The explorer panel consists of all the available items of the result classified into sections 
and arranged hierarchically. Any item in the explorer panel can be clicked on to display 
the corresponding table in the preview space.

Expand all
Expands item list.

Collapse all
Collapses item list.
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A.1 Conversion Factors - English to SI

A.2 Conversion Factors - SI to English

To convert from To Multiply by
in. m (1000 mm) 0.025400
ft m 0.304800
lb N (0.001 kN) 4.448222

kip (1000 lbs) kN 4.448222
plf (lb/ft) N/m 14.593904

psi (lb/in.2) kPa 6.894757
ksi (kips/in.2) MPa 6.894757

psf (lb/ft2) N/m2 (Pa) 47.88026
pcf (lb/ft3) kg/m3 16.018460

ft-kips kN • m 1.355818

To convert from To Multiply by 
m (1000 mm) in 39.37008 

m ft 3.28084 
N (0.001 kN) lb 0.224809 

kN kip (1000 lbs) 0.224809 
kN/m plf (lb/ft) 68.52601 
MPa psi (lb/in2) 145.0377 
MPa ksi (kips/in2) 0.145038 

kN/m2 (kPa) psf (lb/ft2) 20.88555 
kg/m3 pcf (lb/ft3) 0.062428 
kN • m ft-kips 0.737562 



Web Site: http://www.StructurePoint.org
E-mail: info@StructurePoint.org

 
support@StructurePoint.org

 
StructurePoint, LLC. 
5420 Old Orchard Road 
Skokie, IL 60077 
USA 

Phone: +1- 847- 966- 4357 
Fax: +1- 847- 966- 1542 
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A.3 Contact Information
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